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About This Guide

Purpose
This manual describes how to set up, run, and administer the Cisco Internet Service Node (ISN) product. 

Audience
This document is intended for Call Center managers, ISN system managers, ICM/NAM system 
managers, VoIP technical experts, and IVR application developers. Readers of this manual should 
already have a general understanding of the NAM product, as discussed in the Cisco Network 
Applications Manager (NAM) Product Description. Readers should be familiar with general ICM 
installation and setup procedures. 

Organization
The manual is divided into the following chapters.

Chapter Description

Chapter 1, “Introduction 
to ISN”

Introduces the ISN components and how they 
interact with the NAM/ICM

Chapter 2, “Using 
NAM/ICM with the ISN 
IVR Solution”

Discusses NAM/ICM configuration and script 
editing

Chapter 3, “Prompt 
Recording and 
Distribution”

Provides information about ISN media file 
handling and details about the system media files 
distributed with ISN Version 2.0.

Chapter 4, “Voice 
Browser Administration”

Gives an overview of the ISN Voice Browser and 
instructions for using the VB Admin tool and 
commands.

Chapter 5, “Application 
Server Administration”

Provides an overview of the ISN Application 
Server and instructions for using the Application 
Administrator tool.
ix
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Conventions
Conventions
This manual uses the following conventions:

Chapter 6, “Node 
Manager and ICM 
Service Control”

Describes how ISN uses ICM Node Manager and 
ICM Service Control.

Chapter 7, “Alarm 
Handling and Logging”

Gives an overview of the Standalone Distributed 
Diagnostics and Services Network (SDDSN) and 
introduces ISN logging and error reporting.

Chapter 8, “VoIP 
Configuration”

Describes inbound and outbound routing.

Appendix A, 
“Troubleshooting”

Provides troubleshooting information for the ISN 
and the Cisco products it interacts with.

Appendix B, 
“Transferring and 
Queuing Calls with ISN”

Contains additional information about transferring 
and queuing calls with ISN.

Appendix C, “ISN 
Deployment”

Provides background information and check-off 
lists for the various deployment options available 
for ISN.

Appendix D, 
“Configuring Cisco 
Content Services Switch 
(CSS) for Use with ISN”

Outlines the general approach and configuration 
specifics for using Cisco Content Services Switch 
with ISN deployments.

Chapter Description

Format Example

Boldface type is used for user 
entries, keys, buttons, and folder 
and submenu names.

Choose Script > Call Type Manager.

Italic type indicates one of the 
following:

• A newly introduced term

• For emphasis

• A generic syntax item that 
you must replace with a 
specific value

• A title of a publication

• A skill group is a collection of agents 
who share similar skills.

• Do not use the numerical naming 
convention that is used in the 
predefined templates (for example, 
persvc01).

• IF (condition, true-value, 
false-value)

• For more information, see the Cisco 
ICM Software Database Schema 
Handbook.

An arrow (>) indicates an item 
from a pull-down menu.

The Save command from the File menu is 
referenced as File > Save.
x
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Other Publications
Other Publications
For additional information about Cisco Intelligent Contact Management (ICM) software, see the Cisco 
web site listing ICM documentation.

Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and other technical 
resources. These sections explain how to obtain technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco web sites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco Documentation CD-ROM 
package, which may have shipped with your product. The Documentation CD-ROM is updated monthly 
and may be more current than printed documentation. The CD-ROM package is available as a single unit 
or through an annual subscription.

Registered Cisco.com users can order the Documentation CD-ROM (product number 
DOC-CONDOCCD=) through the online Subscription Store:

http://www.cisco.com/go/subscription

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Networking Products MarketPlace:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Registered Cisco.com users can order the Documentation CD-ROM (Customer Order Number 
DOC-CONDOCCD=) through the online Subscription Store:

http://www.cisco.com/go/subscription
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Obtaining Technical Assistance
• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, U.S.A.) at 408 526-7208 or, elsewhere 
in North America, by calling 800 553-NETS (6387). 

Documentation Feedback
You can submit comments electronically on Cisco.com. On the Cisco Documentation home page, click 
Feedback at the top of the page.

You can e-mail your comments to bug-doc@cisco.com.

You can submit your comments by mail by using the response card behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center (TAC) Website, as a 
starting point for all technical assistance. Customers and partners can obtain online documentation, 
troubleshooting tips, and sample configurations from the Cisco TAC website. Cisco.com registered users 
have complete access to the technical support resources on the Cisco TAC website, including TAC tools 
and utilities. 

Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access Cisco information, 
networking solutions, services, programs, and resources at any time, from anywhere in the world. 

Cisco.com provides a broad range of features and services to help you with these tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com at this URL:

http://www.cisco.com
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Obtaining Technical Assistance
Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with a Cisco product, 
technology, or solution. Two levels of support are available: the Cisco TAC website and the Cisco TAC 
Escalation Center. The avenue of support that you choose depends on the priority of the problem and the 
conditions stated in service contracts, when applicable.

We categorize Cisco TAC inquiries according to urgency:

• Priority level 4 (P4)—You need information or assistance concerning Cisco product capabilities, 
product installation, or basic product configuration.

• Priority level 3 (P3)—Your network performance is degraded. Network functionality is noticeably 
impaired, but most business operations continue.

• Priority level 2 (P2)—Your production network is severely degraded, affecting significant aspects 
of business operations. No workaround is available.

• Priority level 1 (P1)—Your production network is down, and a critical impact to business operations 
will occur if service is not restored quickly. No workaround is available.

Cisco TAC Website

You can use the Cisco TAC website to resolve P3 and P4 issues yourself, saving both cost and time. The 
site provides around-the-clock access to online tools, knowledge bases, and software. To access the 
Cisco TAC website, go to this URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract have complete access to 
the technical support resources on the Cisco TAC website. Some services on the Cisco TAC website 
require a Cisco.com login ID and password. If you have a valid service contract but do not have a login 
ID or password, go to this URL to register:

http://tools.cisco.com/RPF/register/register.do

If you are a Cisco.com registered user, and you cannot resolve your technical issues by using the Cisco 
TAC website, you can open a case online at this URL:

http://www.cisco.com/en/US/support/index.html

If you have Internet access, we recommend that you open P3 and P4 cases through the Cisco TAC 
website so that you can describe the situation in your own words and attach any necessary files.

Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 issues. These 
classifications are assigned when severe network degradation significantly impacts business operations. 
When you contact the TAC Escalation Center with a P1 or P2 problem, a Cisco TAC engineer 
automatically opens a case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the level of Cisco support 
services to which your company is entitled: for example, SMARTnet, SMARTnet Onsite, or Network 
Supported Accounts (NSA). When you call the center, please have available your service agreement 
number and your product serial number.
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Obtaining Additional Publications and Information
Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• The Cisco Product Catalog describes the networking products offered by Cisco Systems as well as 
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of networking publications. Cisco suggests these titles for new 
and experienced users: Internetworking Terms and Acronyms Dictionary, Internetworking 
Technology Handbook, Internetworking Troubleshooting Guide, and the Internetworking Design 
Guide. For current Cisco Press titles and other information, go to Cisco Press online at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco monthly periodical that provides industry professionals with the latest 
information about the field of networking. You can access Packet magazine at this URL:

http://www.cisco.com/en/US/about/ac123/ac114/about_cisco_packet_magazine.html

• iQ Magazine is the Cisco monthly periodical that provides business leaders and decision makers 
with the latest information about the networking industry. You can access iQ Magazine at this URL:

http://business.cisco.com/prod/tree.taf%3fasset_id=44699&public_view=true&kbns=1.html

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in the design, development, and operation of public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_protocol_journal.html

• Training—Cisco offers world-class networking training, with current offerings in network training 
listed at this URL:

http://www.cisco.com/en/US/learning/le31/learning_recommended_training_list.html
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H A P T E R 1

Introduction to ISN

This chapter introduces the ISN components and how they interact with the NAM/ICM. It includes:

• A brief overview of the ISN and its IVR functional models.

• A Sample ICM Script.

• A description of how NAM/ICM and the ISN exchange information.

Note This chapter contains important information for IVR application developers. It also may be of interest 
to Call Center Managers, ISN System Managers, and ICM/NAM System Managers. 

ISN: A Brief Overview
The Cisco Internet Service Node (ISN) is an Internet Protocol (IP)-capable Interactive Voice 
Response (IVR) platform. 

Figure 1-1 shows a Voice Over IP (VoIP) ISN system. The ISN components—centered in the 
“cloud”—consist of the following:

• Application Server. A Web Server application which interprets messages from the Cisco ICM 
software and generates VXML documents that it uses to communicate with the Voice Browser. 
(For more information about the Application Server, see Chapter 5, “Application Server 
Administration.”)

• Voice Browser. Processes PSTN and IP telephone calls, converts the voice signals into events 
for processing by the Application Server, and acts upon VXML commands received from the 
Application Server. (For more information about the Voice Browser, see Chapter 4, “Voice 
Browser Administration.”)

• Media Server. An off-the-shelf component—or set of components— which administers the 
media files that contain messages and prompts callers will hear. The Media Server uses standard 
Web access methods. (For more information about the Media Server, see Chapter 3, “Prompt 
Recording and Distribution.”)
1-1
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ISN: A Brief Overview
Figure 1-1 A VoIP ISN-based System

Note For a complete description of ISN Version 2.0 feature set, including examples of different call handling 
scenarios, see the Cisco Internet Service Node (ISN) Product Description.

The Cisco Network Application Manager (NAM)/Intelligent Contact Management (ICM) software 
uses ICM/IVR messaging technology to direct the ISN’s actions and to receive the ISN’s responses. 
The NAM/ICM software and ISN work together to perform such tasks as:

• Playing media—such as a recording stating office hours—to a caller.

• Retrieving caller-entered data, DTMF, or speech.

• Playing back different types of data—such as an account number or balance—to a caller.

• Moving calls to other destinations—for example, forwarding to an agent. 

These tasks are driven by instructions that are sent to the ISN from the NAM/ICM.
1-2
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Example: “Welcome to XYZ Corporation”
Example: “Welcome to XYZ Corporation”
Suppose you want to create an ISN script that simply plays a message, “Welcome to XYZ 
Corporation.” From the NAM/ICM’s perspective, there is no difference between a script written for 
a standard “black box” IVR or the ISN, so you can create a script such as the one shown in Figure 1-2. 

Figure 1-2 Play Welcome Script

This simple script performs three functions: 

• Sends the Run VRU Script request to the ISN.

• Indicates the location of the “Welcome” media file.

• Releases the call.

Note In a “real life” application, any ISN script you create should include error checking to ensure that 
micro-applications instructions are properly executed. To see examples of more elaborate scripts, turn 
to Appendix B, “Transferring and Queuing Calls with ISN.”

However, there is one important difference between a script written for the ISN and one written for 
a “black box” IVR: ISN micro-applications.
1-3
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What are Micro-Applications?
Micro-applications are a set of specific IVR functions in the ISN that can be invoked by the ICM 
software, enabling communication with the caller. There are five ISN micro-applications:

• Play Media. Plays a message (.wav file) to the caller.

• Play Data. Retrieves data from a storage area and plays it to the caller in a specific format called 
a data play back type. 

• Get Digits. Plays a media file and retrieves digits from the caller.

• Menu. Plays a menu media file and retrieves a single telephone keypad entry from the caller. 

• Get Speech. Collects ASR or DTMF input after prompting a caller. 

Note Each of these micro-applications are described in detail in Chapter 2, “Using NAM/ICM with the ISN 
IVR Solution.”

Micro-applications reside on the ISN’s Application Server.The Application Server takes information 
in the messages sent by the NAM/ICM, interprets it using the micro-applications, and generates 
VXML code that it sends to the Voice Browser for processing.

Micro-applications also accept HTTP requests from the Voice Browser that the Application Server 
then processes and sends back to the NAM/ICM using ICM/IVR Service Control tool.

The ICM/ISN Micro-Application Connection
Before the ISN IVR solution can be accessible through the Script Editor’s Run VRU Script node, you 
must first set up the NAM/ICM software with special ISN parameters using the ICM Configuration 
Manager tool. 

Your first step would be to use the ICM Configuration Manager’s Network VRU Script window to 
define the ISN parameters. Figure 1-3 shows a Network VRU Script tool’s Attribute tab set up to send 
the following information to the ISN: 

• PM,Welcome. (VRU Script Name field.) This means: “Use the instructions in the Play Media 
micro-application to play the Welcome.wav media file.”

• N. (Configuration Param field.) This means: “Do not allow barge-in.” (Barge-in is when the 
caller can interrupt message play by entering a digit, causing the script to move to the next 
prompt.) Defaults are used for all other settings in the VRU Script Name and Configuration 
Param fields.
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Figure 1-3 Network VRU Script settings for Play Welcome

Once the ICM Configuration Manager’s settings have been saved, the information is available to the 
Script Editor. When you place a Run VRU Script node in the Script Editor workspace and open the 
Properties dialog box, it displays all the script names defined in the system.

Figure 1-4 Run VRU Script Properties 

The Run VRU Script node in Figure 1-2 shows that the ICM Script Name Play_Welcome was 
selected.

Passed from the
Name field of
Network VRU
Script Configuration

Passed from the
VRU Script Name
field of Network
VRU Script 
Configuration
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Information Exchange Between NAM/ICM and ISN
When a NAM/ICM processes a Run VRU Script node, parameters are sent to the ISN. These 
parameters contain instructions about how to interact with a caller, such as:

• What micro-application to use.

• The location of the media files to be played to the caller.

• Timeout settings that should be used during caller digit entry.

Some IVR parameters are passed to the ISN through Expanded Call Context (ECC) variables, 
described in Chapter 2, “Using NAM/ICM with the ISN IVR Solution.” Other parameters are sent in 
the normal VRU messaging interface (ICM/IVR Service Control Interface).

NAM/ICM Data Handling 
In defining scripts, you might specify strings, numbers, or formulas to be sent to the ISN. When 
passing numbers to the ISN, you should always put quotes around them so that they will be processed 
as a string. This is especially important if:

• Leading 0’s are significant to the data type (times, character), enter the number as a quoted string 
(example: “031524”). 

• Τrailing 0’s after a decimal point are significant to the data type (number, character, currency), 
enter the number as a quoted string (examples: “42.00” or “42.10”).

• The number is very large (example: a number normally expressed through exponential notation).

ISN Error Checking
The ISN uses the user.microapp.error_code ECC variable to return information regarding problems 
encountered while running a script. 

ISN tests for the following conditions:

• Network Error. Failure of an IP network connection.

• System Error. Unexpected failure of an ISN component. 

• Unknown micro-application. Micro-application name passed from the ICM to the Application 
Server did not exist on the Application Server. 

• Invalid VRU Script Name format. VRU Script Name data passed from the ICM to the 
Application Server does not contain the expected components (micro-application name, media 
file name, media file type, uniqueness value).

• Invalid Configuration Param. Data passed from the ICM to the Application Server is not 
consistent with what the micro-application requires for processing.

• Misconfigured ECC variable. An ECC variable was set to a value the Application Server did 
not recognize. ECC variable definitions must be the same in ICM and ISN.

• Unavailable Media file. Media file name passed from the ICM to the Application Server did not 
exist on the Media Server.

• Unsupported VXML format. The VXML Interpreter (that is, Gateway, Voice Browser, or 
ASR/TTS Engine) did not recognize a VXML format passed from the Application Server.
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• Unsupported VXML element. The VXML Interpreter (that is, Gateway, Voice Browser, or 
ASR/TTS Engine) did not recognize a VXML element passed from the Application Server.

• Invalid variable data. The variable data passed was not valid for the script type being processed.

• Reached Maximum Invalid Tries. Caller was unsuccessful in entering digits during each of the 
tries allowed by the micro-application. (Only applies to Get Digits, Menu, and Get Speech 
micro-applications.)

• Reached Maximum Number Entry Tries. Caller did not enter digits in response to the prompt 
for each of the tries allowed by the micro-application. (Only applies to Get Digits and Get Speech 
micro-applications.)

• Timed Out. Caller did not enter digits in response to the prompt in the time allowed by the 
micro-application.

• Unsupported locale. The VXML Interpreter (that is, Gateway, Voice Browser, or ASR/TTS 
Engine) did not recognize the locale passed from the Application Server.

Note Each ISN micro-application has individualized settings for user.microapp.error_code. For more 
information, see Chapter 2, “Using NAM/ICM with the ISN IVR Solution.”

Where to Next?
To get started using the ISN, turn toChapter 2, “Using NAM/ICM with the ISN IVR Solution.” 
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C H A P T E R 2

Using NAM/ICM with the ISN IVR Solution

This chapter discusses using NAM/ICM configuration and script editing to access the ISN IVR solution. 
It includes information about how to:

• Set up the NAM/ICM to interact with the ISN

• Write applications for the ISN

Note This chapter contains important information for IVR application developers. It also may be of interest 
to Call Center Managers, ISN System Managers, and ICM/NAM System Managers. 

Before You Begin
The information in this chapter assumes that you are already familiar with using the NAM/ICM software 
ICM Configuration Manager and Script Editor tools for call center operations and management.

Tips You should have a copy of the following Cisco ICM software documentation available in 
addition to this manual in order to successfully configure ICM software and use its features 
in conjunction with ISN: Cisco ICM Software Configuration Guide and Cisco ICM 
Software Script Editor Guide.

NAM/ICM Setup
Before you can use NAM/ICM features to access the ISN IVR solution, you must perform some initial 
setup tasks to enable communication between NAM/ICM and ISN. These setup tasks are determined by 
ISN deployment model; see Appendix C, “ISN Deployment” for complete setup instructions for each 
model.

Note For more information about the supported ISN deployment models, see the Cisco Internet Service Node 
(ISN) Product Description.
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Writing NAM/ICM Applications for the ISN
Once NAM/ICM-to-ISN initial setup is complete, you can create NAM/ICM applications to access ISN 
micro-applications. You do this using two ICM software tools:

• Configuration Manager

• Script Editor

The sections that follow give a brief overview of how to use these tools to access ISN functionality. 

How to configure an ISN Network VRU script

Step 1 Within the ICM Configuration Manager, select Tools > List Tools > Network VRU Script List. 

Step 2 In the Network VRU Script List window, enable the Add button by clicking Retrieve.

Step 3 Click Add. The Attributes property tab is enabled.

Step 4 Complete the Attributes tab as described below.

Caution The format of the strings for the VRU Script Name and Configuration Param fields are very 
specific and vary for different micro-applications (Play Media, Play Data, Get Digits, Menu, 
and Get Speech.)

• Network VRU. (Drop-down list.) The name of the Network VRU to be associated with the Network 
VRU script. 

• VRU Script Name. A 39-character, comma-delimited string used by the ISN to pass the following 
parameters to the Application Server:

– Micro-application. The script type. Valid options: PM (Play Media), PD (Play Data), GD (Get 
Digits), M (Menu), or GS (Get Speech).

– Media File Name. (For PM, GD, M, and GS micro-applications.) Name of the media file to be 
played or external (customer-defined) VXML to be loaded. Valid options: the name of the file 
or null (that is, nothing is inserted between two of the delimiting commas).
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Note A null setting (,,) causes the ISN to examine the contents of the user.microapp.inline_tts 
ECC variable. If this ECC variable contains a value, the ISN prompts using TTS. If this ECC 
variable is empty, no prompt is played. 

– Media Library Type. (For PM, GD, M, and GS micro-applications.) Flag indicating the 
location of the media files to be played. Valid options: A (Application, the default) and S 
(System).

Note PM has an additional valid option: V (external VXML). 

– Data Playback Type. (For PD, only.) The kind of the data to be returned (“played”) to the 
caller. Valid options: Number, Char (Character), Etime (Elapsed Time), TOD (Time of Day), 
24TOD (24-hour Time of Day), DOW (Day of Week), Date, Currency.

– Uniqueness value. (Optional.) A string identifying a VRU Script Name as unique.

Note This value is useful for organizing ISN VRU Script Names. For instance, you might want to 
create two Get_Password scripts with identical VRU Script Name parameters but different 
Configuration Params. The VRU Script Name field setting for one could be: 
GD,Password,A,short and the other could be: GD,Password,A,1ong. 

Examples are given in Table 2-2, Table 2-4, Table 2-7, Table 2-10, and Table 2-13.

• Name. A unique name for the VRU script. ICM software generates a name based on the Network 
VRU and script names.

• Timeout. The number of seconds ICM software should wait for a response after invoking the script. 
If ICM software does not receive a response from the VRU within this time, it assumes the ISN script 
has failed.

Caution This setting is designed to detect VRU failures only; attempting to use it as a technique for interrupting 
script processing can lead to unexpected results. Cisco recommends leaving the 180-second default, or 
lengthening the setting to a duration that is longer than the longest time the script is expected to take

• Configuration Param. A string used by the ISN to pass additional parameters to the Application 
Server. Content of string depends on the micro-application to be accessed. For more information on 
what to specify in this field, see: 

– “Play Media (PM) Micro-Application” section on page 2-7.

– “Play Data (PD) Micro-Application” section on page 2-12.

– “Get Digits (GD) Micro-Application” section on page 2-22.

– “Menu (M) Micro-Application” section on page 2-31.

– “Get Speech (GS) Micro-Application” section on page 2-39.

• Description. Any additional information about the script.

• Customer. (Optional.) A customer associated with the script. For Service Provider solutions, this 
field is mandatory, due to multiple tenancy solutions (customer-specific data needs to be separated).

• Interruptible. (Checkbox.) Whether ICM software can interrupt the script (for example, if a routing 
target becomes available). Options: Y or N.
2-3
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 2      Using NAM/ICM with the ISN IVR Solution
Writing NAM/ICM Applications for the ISN
• Overridable. (Checkbox.) Indicates whether the script can override its own Interruptible attribute. 
Options: Y or N. [Not applicable for ISN.]

Step 5 When finished, click Save to apply your changes. 

How to specify a Run VRU Script node that accesses an ISN micro-application

Step 1 Within Script Editor, place the Run VRU Script object in the workspace, right-click, and open the 
Properties dialog box.

The Run VRU Script Properties dialog box lists all Network VRU scripts currently configured. 

Note The ICM Script Name column reflects the values defined through the Name field in ICM 
Configuration Manager’s Network VRU Script List tool.

Step 2 Select the ICM Script/VRU Script Name you want to execute. 

Step 3 Optionally, modify the Comments tab.

Step 4 Optionally, modify the Labels tab.

Step 5 When finished, click OK to submit the changes and close the dialog box.
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ISN Micro-Applications

Note Different Voice Browsers use various parameters differently. This affects how third-party Voice 
Browsers interact with the ISN micro-applications. For example, although ISN allows timeout 
parameters to be set to a value in the range of 1 to 99 seconds, a particular Voice Browser only supports 
a range of 1 to 32 seconds. Another Voice Browser requires a "#" to indicate that digits should be 
collected before the inter-digit timeout is reached. Be sure to follow the instructions provided by your 
third-party vendor. Also, be sure to test all of your micro-applications before deploying them.

The sections that follow describe the parameters that can be defined through ICM Configuration 
Manager for each of the five ISN micro-applications.

Keep the following in mind as you configure each Network VRU Script to be used with the ISN:

• Each micro-application parameter in fields of the Network VRU Script List’s Attributes tab must be 
separated by a comma. 

• If a parameter value is not specified, the micro-application uses its default.

Each section concludes with sample ICM Configuration Manager and Script Editor screen captures for 
the micro-application.

Note For detailed examples of ISN IVR scripts, turn to Appendix B, “Transferring and Queuing Calls with 
ISN.”

How micro-applications use Automatic Speech Recognition (ASR) and 
Text-to-Speech (TTS)

ISN micro-applications can use ASR in three ways:

• To recognize digits with the Get Digits and Menu micro-applications. The 
user.microapp.input_type ECC variable specifies the collection type. The script writer uses this 
variable in a Script Editor Set node to allow the caller to input DTMF only (D) or both DTMF and 
Voice (B, the default). Regardless of the value of user.microapp.input_type, the recognized digit(s) 
are always returned to the NAM/ICM in the CED variable.

• To recognize data for built-in data types, such as numbers, dates or currency, using digits and/or 
voice. The user.microapp.input_type ECC variable specifies the collection type. The script writer 
uses this variable in a Set node to allow the caller to input DTMF only (D) or DTMF and Voice (B, 
the default). The recognized result is returned to the NAM/ICM in the user.microapp.input_type 
ECC variable.

• The Get Speech micro-application collects non-digit input—words—according to a specified 
grammar. The grammar to be used is specified either as inline grammar (through the setting in the 
user.microapp.grammar_choices ECC variable) or as an external grammar file (through a text file, 
the name of which is given in the Network VRU Script’s Configuration Param field). The recognized 
result is returned to the NAM/ICM in the user.microapp.caller_input ECC variable. 
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ISN micro-applications can use TTS for two purposes:

• As an alternative for playing recorded announcement prompts with the Play Media, Get Digits, 
Menu, and Get Speech micro-applications, using either the contents of the user.microapp.inline_tts 
or an external .vxml file. (For more information, see the “How micro-applications use External 
VXML” section on page 2-6). The ECC variable is useful if the amount of text is relatively short 
and simple. The external .vxml file is useful for more lengthy text or text that needs to be changed 
frequently using tools other than the ICM Script Editor.

• As a method of playing data using the Play Data micro-application. If the user.microapp.pd_tts 
ECC variable contains Y, the ISN should use TTS to speak the data (depending on the TTS locale 
support and capabilities); if N, the ISN should use the system recorded announcements to speak the 
data (depending on ISN Application Server locale support and capabilities).

Note These ECC variables must be set in the ICM script prior to executing the micro-application that they 
modify.

How micro-applications use External VXML
The Play Media micro-application can be used to render external .vxml, that is, text Voice-XML files. 
To access the external file, the Media File Component of the Network VRU Script’s VRU Script Name 
field must point to a .vxml file and specify V as the Media Library Type parameter.

The external VXML file must contain particular call control catch blocks and must not execute call 
control, as the ISN and ICM software must be responsible for all call control. (For more information, see 
the “External VXML File Contents” section on page 2-48.)

Caution Since violation of external VXML file restrictions cannot be enforced and would have serious 
consequences, this feature is not enabled by default. It must be enabled through the Application Server 
Administration interface.
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Play Media (PM) Micro-Application
The Play Media (PM) micro-application simply plays a message contained in a media file. Use the ICM 
Configuration Manager’s Network VRU Script List tool’s Attributes tab to specify parameters.

Note The VRU Script Name and Configuration Param fields are case-sensitive. For example, PM is a valid 
entry; pm is not. Enter the values exactly as specified in Table 2-1.

Table 2-2 shows several configuration examples for the Play Media.

Table 2-1 Play Media Network VRU Script Configuration Parameters

Field Name Setting Description and Valid Options

VRU Script Name field Micro-application This must be PM (Play Media)

Media File Name Name of the media file to be played (that is, the prompt file) or 
the name of the external VXML file. The valid options are: 

• A file name (for instance, a .wav file) 

• null - (default) If this field is left empty, ISN examines the 
contents of the user.microapp.inline_tts ECC variable. If 
this ECC variable contains a value, the ISN prompts using 
TTS. If the ECC is empty, no prompt is played.

Media Library Type Flag indicating the location of the media files to be played. The 
valid options are: 

• A - (default) Application

• S - System

• V - External VXML 

Uniqueness value Optional. A string identifying a VRU Script Name as unique.

Configuration Param (see 
page 2-14)

Barge-in Allowed Specifies whether barge-in (digit entry to interrupt media 
playback) is allowed. The valid options are:

• Y - (default) barge-in allowed 

• N - barge-in not allowed

Note ISN deals with barge-in as follows: If barge-in is not 
allowed, the Voice Browser/Gateway continues prompt 
play when a caller starts entering digits and the entered 
digits are discarded. If barge-in is allowed, the Voice 
Browser/Gateway discontinues prompt play when the 
caller starts entering digits. (For more information, see 
the “Type-Ahead Support for ASR” section on 
page 2-48.)

Note Any barge-in setting is ignored when using external 
VXML.
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Table 2-2 Play Media Configuration Examples

If the VRU Script Name 
field setting is… It means….

If the 
Configuration 
Param field 
setting is… It means….

PM,Welcome PM – Use the Play Media micro-app.

Welcome – Play the Media file named 
“Welcome.wav.”

Note If no file extension is specified, .wav is 
assumed.

Accept defaults for remaining settings. 

N Barge-in not allowed.

PM,July,S PM – Use the Play Media micro-app.

July – Play the Media file named “July.wav.”

S - Use the System Media library. 

null Accept default. (Barge-in 
allowed)

PM,WebSite,,0 PM – Use the Play Media micro-app.

Website – Play the Media file named 
“Website.wav.”

, (Skipped parameter) – Accept the default 
(Media Type: Application library)

0 – Uniqueness value.

null Accept default. (Barge-in 
allowed)

PM,WebSite,,1 PM – Use the Play Media micro-app.

Website – Play the Media file named 
“Website.wav.”

, (Skipped parameters) – Accept the default 
(Media Type: A, Application library)

1 – Uniqueness value.

N Barge-in not allowed.

PM,customer.vxml,V,1 PM – Use the Play Media micro-app.

customer.vxml – Play the external VXML file 
“customer.vxml.”

V – Use the VXML Media library

1 – Uniqueness value.

Note Any barge-in setting is ignored when 
using external VXML.

PM PM – Use the Play Media micro-app.

Note If the user.microapp.inline_tts ECC 
contains a value, the PM 
micro-application will play its contents 
(for example, “Hello world”).

N Barge-in not allowed.
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Play Media Error Code Settings

Play Media can set user.microapp.error_code ECC variable to any of the following Return Status error 
codes:

1 - (Unused)

2 - Network Error

3 - System Error

4 - (Unused)

5 - Unknown micro-application

6 - Invalid VRU Script Name format

7 - Invalid Configuration Param

8 - Misconfigured ECC variable

9 - Media file does not exist or invalid URL for Media file

10 - Semantic-Runtime Error

11 - Unsupported VXML format

12 - Unsupported VXML element

13 - Variable data is invalid

14 - Location of variable data is empty

21 - Timed out

30 - Unsupported locale

31 - Media Resource Error

32 - General Error

Note user.microapp.error_code is always zero, indicating success, if control proceeds out the Checkmark 
(success) branch of the Run VRU Script node. Usually, if control proceeds out the X (failure) branch, 
ISN sets this variable to one of the codes listed here. (Your routing should always test the error code after 
an X branch is taken. It should not automatically assume, for example, that the caller did not enter the 
expected number of digits.)

However, if a configuration error, or a network or component failure of some sort, prevents the 
micro-application from being executed at all, then ISN does not get a chance to set this variable at all. 
Such cases can be identified by using a Set node to pre-set user.microapp.error_code to some known 
invalid value such as -1, and then to t/est for that value using an If node, following the X branch of the 
Run VRU Script node

Two classes of problems can prevent the micro-application from being executed at all: (1) inability to 
route the call to an appropriate ISN Application Server (Advanced Speech deployment model only); (2) 
mismatch between Network VRU associated with the configured VRU script and Network VRU 
associated with the ISN that is handling the call. The second case can only be caused by an ICM 
configuration error, but the first case may also be caused by a temporary network outage or other 
component failure.
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Play Media Example: Play Welcome Message 

This example shows sample ICM Configuration Manager and Script Editor screen captures for a Play 
Media application that simply plays an announcement.

Figure 2-1 Play Media Configuration 

The Network VRU Script List tool’s Attribute tab in Figure 2-1 shows: 

1. The VRU Script Name field containing three ISN parameters:

– PM. Play Media.

– July. Media File Name.

– S. System Media Library Type.

2. The Configuration Param field containing the following ISN parameter: 

– Y. Barge-in allowed.

Figure 2-2 shows the contents of the script: 
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Figure 2-2 Play Media Script 
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Play Data (PD) Micro-Application
The Play Data micro-application retrieves data from a storage area and plays it to the caller in a specific 
format, called a data play back type. You use the ICM Configuration Manager’s Network VRU Script 
List tool’s Attributes tab to specify parameters. 

Note The VRU Script Name and Configuration Param fields are case-sensitive. For example, PD is a 
valid entry; pd is not. Enter the values exactly as specified in Table 2-3.

Table 2-3 Play Data Network VRU Script Configuration Parameters

Field Name Setting Description and Valid Options

VRU Script Name field Micro-application This must be PD (Play Data).

Data Playback Type. The kind of the data to be returned (“played”) to the caller. 

Note For more information about each of these playback types 
– including input format and output examples – turn to 
Table 2-5 on page 2-15.

The valid options are: 

• Number

• Char (character)

• Date

• Etime (elapsed time)

• TOD (Time of Day)

• 24TOD (24-hour Time of Day)

• DOW (Day of Week)

• Currency

Note 24TOD and DOW data play back types are not supported 
when using TTS. 

Uniqueness value Optional. A string identifying a VRU Script Name as unique.

Configuration Params Location of the data to be 
played. 

The valid options are: 

• null (default) - If you leave this option empty, uses the ECC 
variable user.microapp.play_data.

• A number representing a Call Peripheral Variable number 
(for example, a 1 to represent Call.PeripheralVariable1). 

Note For more information on data location, see the “Play Data 
and Data Storage” section on page 2-14.
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Configuration Param 
(continued)

Barge-in Allowed Specifies whether barge-in (digit entry to interrupt media 
playback) is allowed. The valid options are: 

• Y - (default) barge-in allowed 

• N - barge-in not allowed

ISN deals with barge-in as follows: If barge-in is not allowed, the 
Voice Browser/Gateway continues prompt play when a caller 
starts entering digits and the digits are discarded. If barge-in is 
allowed, the Voice Browser/Gateway discontinues prompt play 
when the caller starts entering digits. (For more information, see 
the “Type-Ahead Support for ASR” section on page 2-48.)

Barge-in works the same for ASR as DTMF. If the caller speaks 
during prompt play, the prompt play stops. Unlike DTMF input, 
ASR caller input is checked against the grammar that is defined. 
If a match isn’t found, an Invalid Entry error is generated and the 
caller input is deleted. If a caller barges in with ASR during a Play 
Media or Play Data script, the Invalid Entry error always appears 
because there is not a grammar specified for these 
micro-applications.

Invalid entry errors are only sent back to the Application Server 
for Get Digits, Menu or Get Speech micro-applications.

Note Barge-in is not used when providing external VXML.

Time Format Valid only for the time Data Playback types (Etime, TOD, 
24TOD). 

The available formats are: 

• null - leave this option empty for non-time formats

• HHMM - default for time formats

• HHMMSS

• HHMMAP - includes am or pm; valid only for TOD

Table 2-3 Play Data Network VRU Script Configuration Parameters (continued)

Field Name Setting Description and Valid Options
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Table 2-4 shows several configuration examples for Play Data.

Play Data and Data Storage 

Some possible sources of the data to be played back:

• Information retrieved from a database look-up.

• Information entered by the caller. 

Before this micro-application can be called, you must specify the location of the play back data. You do 
this with a Script Editor Set node that points to one of the following storage areas:

• One of the standard NAM/ICM Peripheral Variables (PeripheralVariable1 through 
PeripheralVariables10). 

• The user.microapp.play_data ECC variable. This is the preferred area for data playback storage. 
Using this ECC avoids the possibility of overwriting a call variable already being used either by this 
application or by other components within the system. 

Table 2-4 Play Data Configuration Examples

If the VRU Script Name 
field setting is… It means…

If the Configuration 
Param field is… It means…

PD,Number PD – Use the Play Data micro-app.

Number – Play back the data as a number.

empty Place the data in the default ECC, 
user.microapp.play_data, as a 
number.

PD,Char PD – Use the Play Data micro-app.

Char –Play back the data as individual 
characters.

1 1 – Play the data in Call 
PeripheralVariable 1 as a 
character.

PD,Etime,0 PD – Use the Play Data micro-app.

Etime – Play back the data as a Time. 

1,,HHMM 1 – Play the data in Call 
PeripheralVariable 1 as an 
elapsed time.

, – (Skipped parameter) Accept 
default setting (Y)

HHMM – Play the time in 
HHMM format (for example, 8 
hours, 30 minutes).

PD,Date PD – Use the Play Data micro-app.

Date – Play back the data as a Date.

1,N 1 – Play the data in Call Variable 
1 as a date.

N – No barge-in allowed.

PD,Currency PD – Use the Play Data micro-app.

Currency – Play back the data as a 
Currency.

4,N 4 – Play the data in Call 
Variable 4 s currency.

N – No barge-in allowed.

Note To enable Text-to-Speech (TTS) as the data play back source, you would need to need to insert a Set node in the script 
prior to the Run VRU Script node setting user.microapp.pd_tts to “Y”. 
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ISN Micro-Applications
Play Back Types for Voice Data

Configuring how voice data is presented to a caller is an important part of setting up your ISN IVR. 
Table 2-5 provides a complete list of ISN Data Play Back Types, along with sample valid values and 
formats for the locales supported by ISN Version 2.0 when not using TTS:

• en-us. English (United States)

• en-gb. English (Great Britain)

• es-mx. Spanish (Mexico)

• es-es. Spanish (Spain)

Locale is selected by setting the user.microapp.locale variable.

Note For information about locale support when using TTS, check with your third-party vendor.

Keep in mind that any string of characters typically used in the language may need to be spoken back 
character by character (this includes special keyboard symbols and numbers). If a particular symbol is 
not used by a particular language, there is still the possibility that a string containing that symbol will 
be spelled out with a Play Data with Char data type. 

For example, assume that an IVR application in the US (a locale of en-us) queries a database for an 
account owner’s name and spells the name back to the caller. If the name pulled from the database was 
“Hänschen Walther,” the media files that would need to be pulled from the Media Server would have 
been derived from a URL including the en-us locale. The symbol ä has a decimal value of 228, which is 
different than a with a value of 97. It is the translator’s task to record the proper word(s) for each symbol 
to be supported. For detailed information on character translation, turn to the “System Media Files” 
section in Chapter 3, “Prompt Recording and Distribution.”

Table 2-5 Data Play Back Types

Data Play 
Back Type Description Input Format Output Examples (When Not Using TTS)

Number Play the stored 
data as a number.

-###############.######

The leading minus (-) is optional and is played 
as “minus.” 

The whole number portion of the string can 
contain a maximum of 15 digits (for a maximum 
value of 999 trillion, 999 billion, etc.). 

The decimal point is represented as a period (.) 
and played as “point.” It is optional if there is no 
floating portion.

The floating point portion of the number is 
optional and can contain a maximum of 6 digits.

Trailing zeros are played.

en-us and en-gb typical spoken form:

• -123 = “minus one hundred twenty 
three”

• 35.67 = “thirty five point six seven”

• 1234.0 = “one thousand, two 
hundred, thirty four point zero”

es-mx and es-es typical spoken form:

• -120 = “menos ciento veinte”

• 10.60 = “diez coma seis cero”

• 1,100 = “mil cien”

Char Play the stored 
data as individual 
characters.

All printable American National Standards 
Institute (ANSI) characters are supported.

Note Code Page 1252 is ANSI standard. It 
contains ASCII (characters 0-127) and 
extended characters from 128 to 255.

en-us and en-gb typical spoken form:

• abc123= “A, B, C, one, two, three”

es-mx and es-es typical spoken form:

• abc123 = “A, B, C, uno, dos, tres”
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Date Play the stored 
data as a date.

YYYYMMDD, regardless of locale. 

YYYY options: the range of 1800 through 
9999. 

MM options: the range of 01 through 12. 

DD options: the range of 01 through 31. 

Note The software does not validate the date 
(for example, 20000231 is valid and 
played accordingly). However, a failure 
occurs if any bounds are broken (for 
example, 34 for month).

en-us typical spoken form:

• MMDDYYYY format:
20000114 = “January fourteenth, two 
thousand”

en-gb typical spoken form:

• DDMMYYYY format:
20000114 = “Fourteenth of January, 
two thousand”

es-mx and es-es typical spoken form:

• DDMMYYYY format:
20001012 = “el doce de octubre de 
dos mil”

Note All spoken forms use the proper 
grammar for the locale.

Etime
(elapsed 
time)

Play the stored 
data as an amount 
of elapsed time.

HHMM or HHMMSS

Maximum 99 hours, 59 minutes, 59 seconds

Leading zeros are ignored.

en-us and en-gb typical spoken form:

• HHMM format:
0830= “eight hours thirty minutes”

• HHMMSS format:
083020= “eight hours, thirty 
minutes, twenty seconds”

es-mx and es-es typical spoken form:

• HHMM format:
0205 = “dos horas cinco minutos”

• HHMMSSS format:
020101 = “dos horas un minuto un 
segundo”

Table 2-5 Data Play Back Types (continued)

Data Play 
Back Type Description Input Format Output Examples (When Not Using TTS)
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TOD
(Time of 
Day)

Play the stored 
data as a time of 
day.

HHMM or HHMMSS 24 hour time

HH options: 00 - 24

MM options: 00 - 59

SS options: 00 - 59

en-us and en-gb typical spoken form:

• HHMM format:
0800 = “eight o’clock”
0830 = “eight thirty” 
1430 = “two thirty”

• HHMMSS format:
083020 = “eight thirty and twenty 
seconds”

• HHMMAP format:
1430 = “two thirty p.m.”

es-mx and es-es typical spoken form:

• HHMM format:
0100 = “una a.m.”

• HHMMAP format:
1203 = “doce y tres p.m.”

• HHMMSS format:
242124 = “doce veintiuno a.m.”

24TOD
(24-hour 
Time of 
Day)

Play the stored 
data as military 
time.

HHMM or HHMMSS 24 hour time.

HH options: 00 - 24

Note 24-hour time and military time may 
have a discrepancy as to valid hours. 
ISN plays back the value 00 or 24 “as 
is.” The application developer is free to 
make alterations to the data passed to 
the micro-application, if so desired.

MM options: 00 - 59

SS options: 00 - 59

The ISN validates the ranges as stated above. 
For example, if a time ends in 00 minutes (that 
is, 2300), one would say “hundred hours” (that 
is, “twenty-three hundred hours”). The range is 
0000 (12 a.m.) through 2459 (after midnight) or 
0059, if you prefer. 1300 equals 1 o’clock in the 
afternoon.

Note The 24TOD play back type is not 
supported when using TTS.

en-us and en-gb typical spoken form:

• HHMM format:
0815 = “eight fifteen” 
2330 = “twenty three thirty” 
2300 = “twenty three hundred hours”

• HHMMSS format:
233029 = “twenty three thirty and 
twenty nine seconds”

es-mx and es-es typical spoken form:

• HHMM format:
2121 = “veintiuno veintiuno”
2100 = “veintiún horas”

Note In Spanish, when a time ends in 
00 minutes the spoken form is 
“hours,” not “hundred hours.”

• HHMMSS format:
050505 = “cinco y cinco y cinco 
segundos”

Table 2-5 Data Play Back Types (continued)

Data Play 
Back Type Description Input Format Output Examples (When Not Using TTS)
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DOW
(Day of 
Week)

Play the stored 
data as a day of 
week.

An integer from 1 through 7 (1 = Sunday, 
2 = Monday, etc.).

Note The DOW data play back type is not 
supported when using TTS.

en-us and en-gb typical spoken form:

• 7 = “Saturday”

es-mx and es-es typical spoken form:

• 7 = “Sabado”

Currency Play the stored 
data as currency. 

Format is [-]15(X)[.2(Y)] where the minus sign 
is optional as well as the decimal point and the 
2 digits after the decimal point. The whole 
number portion of the string can contain a 
maximum of 15 digits (for a maximum value of 
999 trillion, 999 billion).

Note No comma delimiters or currency 
symbols are recognized.

Leading and trailing zeros are played. If a 
number does not have a decimal point, the 
“cents” portion of the amount will not be 
spoken. (For example, the spoken form for the 
input 100 is “one hundred and zero cents.”

The grammar rules apply to the currency, not 
the locale. 

Note The user.microapp.currency ECC 
variable contains the currency indicator 
(USD, CAD, EUR, etc.) 

USD (US dollar) typical spoken form:

• 15.05 = “fifteen dollars and five 
cents”

• 3.00 = “three dollars and zero cents”

Note ISN Version 2.0 uses the 
USD_dollar.wav and 
USD_dollars.wav media files; the 
dollar.wav and dollars.wav used 
by ISN Version 1.0 are no longer 
installed.

CAD (Canadian dollar) typical spoken 
form:

• 15.05 = “fifteen dollars and five 
cents”

• 3.00 = “three dollars and zero cents”

EUR (Euro dollar) typical spoken form:

• 1.10 = “one point one zero euro”

GBP (Great Britain pound) typical 
spoken form:

• 1.10 = “one pound ten pence”

MXN (Mexican pesos) typical spoken 
form:

• 1.10 = “one peso and ten centavos”

Note The default spoken form for a 
negative amount (for all currency 
types) is “minus <amount>.”

Table 2-5 Data Play Back Types (continued)

Data Play 
Back Type Description Input Format Output Examples (When Not Using TTS)
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Play Data Error Code Settings

Play Data can set user.microapp.error_code ECC variable to any of the following Return Status error 
codes:

1 - (Unused)

2 - Network Error

3 - System Error

4 - (Unused)

5 - Unknown micro-application

6 - Invalid VRU Script Name format

7 - Invalid Configuration Param

8 - Misconfigured ECC Variable

9 - Media file does not exist or invalid URL for Media file

10 - Semantic-Runtime Error

11 - Unsupported VXML format

12 - Unsupported VXML element

13 - Variable data is invalid

14 - Location of variable data is empty

15 - Time format is invalid

16 - Data value out of range

21 - Timed out

30 - Unsupported locale

31 - Media Resource Error

32 - General Error

Note The value in user.microapp.error_code ECC is passed from the ISN to the NAM/ICM when the X 
(failure) branch is taken. See the discussion at the end of the section Play Media Error Code Settings.
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Play Data Example: Play Data as Number

This example shows sample ICM Configuration Manager and Script Editor screen captures for a a Play 
Data application that plays the contents of the user.microapp.play_data ECC in number format.

Figure 2-3 Play Data As Number Configuration

The Network VRU Script List tool’s Attribute tab in Figure 2-3 shows: 

1. The VRU Script Name field containing two ISN parameters:

– PD. Play Data.

– Number. Data Playback Type.

2. The Configuration Param field containing the value 1, so the playback data will come from the Call 
Peripheral variable, Call.PeripheralVariable1.
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Figure 2-4 shows the contents of the script: 

Figure 2-4 Play Data As Number Script

For example, if user.microapp.play_data referred to in Figure 2-4 contained the value 123, this number 
would be played backed “One hundred twenty three.”
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Get Digits (GD) Micro-Application
The Get Digits (GD) micro-application plays a media file and retrieves digits. You could use Get Digits 
in an application that prompts a caller to enter a password.

The ISN passes the retrieved digits back to the NAM/ICM for further processing using the 
Caller-Entered Digits (CED) field in the ICM/IVR Messaging interface. (This is available in the ICM 
script through the variable Call.CallerEnteredDigits.)

Use the ICM Configuration Manager’s Network VRU Script List tool’s Attribute tab to specify 
parameters. 

Note The VRU Script Name and Configuration Param fields are case-sensitive. For example, GD is a valid 
entry; gd is not. Enter the values exactly as specified in Table 2-6.

Table 2-6 Get Digits Network VRU Script Configuration Parameters

Field Name Setting Description and Valid Options

VRU Script Name Micro-application This must be GD (Get Digits).

Media File Name Name of the media file or external VXML to be played (that is, 
the prompt file). The valid options are: 

• A file name (for instance, a .wav file) 

• null - (default) If this field is empty, ISN examines the 
contents of the user.microapp.inline_tts ECC variable. If 
this ECC variable contains a value, the ISN prompts using 
TTS. If the ECC is empty, no prompt is played.

Media Library Type Flag indicating the location of the media files to be played. The 
valid options are: 

• A - (default) Application

• S - System

Note This value is ignored if using TTS.

Uniqueness value Optional. A string identifying a VRU Script Name as unique.

Configuration Param Minimum Field Length Minimum number of digits expected from the caller. The valid 
options are: 1-32 (the default is 1).

Maximum Field Length Maximum number of digits expected from the caller.The valid 
options are: 1-32 (the default is 1).

Note For information about Maximum Field Length and the 
DTMF Termination Key, see the Note in the “Get Digits 
and Digit Entry Completion” section on page 2-27.
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Configuration Param 
(continued)

Barge-in Allowed Specifies whether barge-in (digit entry to interrupt media 
playback) is allowed. The valid options are: 

• Y - (default) barge-in allowed 

• N - barge-in not allowed

Note ISN deals with barge-in as follows: If barge-in is not 
allowed, the Voice Browser/Gateway continues prompt 
play when a caller starts entering digits. If barge-in is 
allowed, the Voice Browser/Gateway discontinues prompt 
play when the caller starts entering digits. (For more 
information, see the “Type-Ahead Support for ASR” 
section on page 2-48.)

Inter-digit Timeout The number of seconds the caller is allowed between entering 
digits. If exceeded, the system times-out.The valid options are: 
1-99 (the default is 3).

Note This value is ignored if using ASR.

No Entry Timeout The number of seconds a caller is allowed to begin entering digits. 
If exceeded, the system times-out.The valid options are: 0-99 (the 
default is 5).

Number of No Entry 
Tries

Number of times the ISN repeats the “Get Digits” cycle when the 
caller does not enter any data after the prompt has been played. 
(Total includes the first cycle.) The valid options are: 1-9 (the 
default is 3). 

Number of Invalid Tries Number of times the ISN repeats the “Get digits” cycle when the 
caller enters invalid data. (Total includes the first cycle.) The valid 
options are: 1-9 (the default is 3).

Timeout Message 
Override

The valid options are: 

• Y - override the system default with a pre-recorded 
Application Media Library file

• N - (default) do not override the system default

Note This value is ignored if using TTS.

Invalid Entry Message 
Override

The valid options are: 

• Y - override the system default with a pre-recorded 
Application Media Library file

• N - (default) do not override the system default

Note This value is ignored if using TTS.

Note For more information about Timeout and Invalid Entry Messages, see System Media 
Files in Chapter 3, “Prompt Recording and Distribution.”

Table 2-6 Get Digits Network VRU Script Configuration Parameters (continued)

Field Name Setting Description and Valid Options
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Table 2-7 shows several configuration examples for Get Digits for an application that prompts using 
.wav files and retrieves input through DTMF: 

Configuration Param 
(continued)

DTMF Termination Key A single character that, when entered by the caller, indicates digit 
entry is complete. The valid options are: 

• 0-9, * (asterisk), # (pound sign, the default), N (No 
termination key)

Note For information about Maximum Field Length and the 
DTMF Termination Key, see the Note in the “Get Digits 
and Digit Entry Completion” section on page 2-27.

Note This value is ignored if using ASR.

Incomplete Timeout The amount of time after a caller stops speaking to generate an 
invalid entry error because the caller input does not match the 
defined grammar. The valid options are: 0-99 (the default is 3).

Note This value is ignored when not using ASR. If the value is 
set to 0, the Application Server treats the NoEntry 
Timeout as NoError.

Table 2-6 Get Digits Network VRU Script Configuration Parameters (continued)

Field Name Setting Description and Valid Options

Table 2-7 Get Digits Configuration Examples

If the VRU Script Name 
field setting is… It means…

If the Configuration 
Param field setting 
is… It means… 

GD,Password,A,0 GD –Use the Get Digits micro-app.

Password – Play the Media file named 
“Password.wav.”

A – Application Media Library. 

0 – Uniqueness value.

6,12

 

6 – Minimum field length.

12 – Maximum field length.

Accept defaults for all other 
settings. 

GD,Password,A,1 GD –Use the Get Digits micro-app.

Password - Play the Media file named 
“Password.wav.”

A - Application Media Library. 

1 – Uniqueness value.

6,12,N,3,5,2,2,N,Y,
#

6 – Minimum field length

12 – Maximum field length

N – No barge-in allowed.

3 – Inter-digit Timeout (seconds)

5 – No Entry Timeout (seconds)

2 – Number of no entry tries

2 – Number of invalid tries

N – Timeout Msg Override

Y– Invalid Entry Msg Override

# – DTMF Termination key
2-24
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 2      Using NAM/ICM with the ISN IVR Solution
ISN Micro-Applications
Note The two examples above both play the Password.wav file (“Please enter your password followed by the pound sign.”) 
and collect digits. They differ in that the first example accepts most of the default settings available through the 
Configuration Param field; the second field does not. 

GD,ssn GD – Use the Get Digits micro-app.

ssn – Play the Media file named “ssn.wav.”

9,9 9 – Minimum field length.

9 – Maximum field length.

Accept defaults for all other 
settings. 

GD GD –Use the Get Digits micro-app.

Since no Media field settings appear after 
GD, the ISN examines the contents of the 
user.microapp.inline_tts ECC variable. 
If this ECC variable contains a value—for 
example, “What is your account number?” 
— the ISN prompts using TTS. 

Note If the user.microapp.inline_tts is 
empty, no prompt is played.

In turn, if the user.microapp.input_type 
ECC variable is D, the ISN will be set to 
process any DTMF input the customer 
supplies.

6,12,N 6 – Minimum field length.

12 – Maximum field length.

N – No barge-in allowed.

Accept defaults for all other 
settings. 

Note Type-ahead can only be used with the Get Digits micro-application when user.microapp.input_type is set to D. For 
more information, see the “Type-Ahead Support for ASR” section on page 2-48.

Table 2-7 Get Digits Configuration Examples (continued)

If the VRU Script Name 
field setting is… It means…

If the Configuration 
Param field setting 
is… It means… 
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Table 2-8 shows several configuration examples for Get Digits for an ASR/TTS application:

Table 2-8 Get Digits Configuration Examples

If … It means… And, if... It means… 

The user.microapp.inline_tts 
ECC variable contains “What is 
your account number?”

and 

user.microapp.input_type 
contains: D (DTMF)

and

The VRU Script Name field 
contains: GD

Use the Get Digits 
micro-app to play the 
contents of the ECC variable 
and collect DTMF input.

The Configuration 
Param field contains:
6,12,N,3,5,2,2,N,Y,#

6 – Minimum field length

12 – Maximum field length

N – No barge-in allowed.

3 – Inter-digit Timeout 
(seconds)

5 – No Entry Timeout 
(seconds)

2 – Number of no entry tries

2 – Number of invalid tries

N – Timeout Msg Override

Y– Invalid Entry Msg 
Override

# – DTMF Termination key

The user.microapp.inline_tts 
ECC variable contains “What is 
your account number?” 

and 

user.microapp.input_type 
contains: B (the default, both 
DTMF and voice)

and

The VRU Script Name field 
contains: GD

Use the Get Digits 
micro-app to play the 
contents of the ECC variable 
and collect either voice or 
DTMF input.

The Configuration 
Param field contains:
6,12,N,,5,2,2,,,,4

6 – Minimum field length

12 – Maximum field length

N – No barge-in allowed.

,,,, – Accept timeouts for 
Inter-digit Timeout 
(seconds), No Entry 
Timeout (seconds), Number 
of no entry tries, Number of 
invalid tries, Timeout Msg 
Override, Invalid Entry Msg 
Override, DTMF 
Termination key

4 – Incomplete timeout

The user.microapp.inline_tts 
ECC variable contains “What is 
your account number?” 

and 

user.microapp.input_type 
contains: B (the default, both 
DTMF and voice)

and

The VRU Script Name field 
contains: GD

Use the Get Digits 
micro-app to play the 
contents of the ECC variable 
and collect DTMF or voice 
input.

6,12,N 6 – Minimum field length

12 – Maximum field length

N – No barge-in allowed

Accept defaults for all other 
settings. 

Note Type-ahead can only be used with the Get Digits micro-application when user.microapp.input_type is set to 
D. For more information, see the “Type-Ahead Support for ASR” section on page 2-48.
2-26
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 2      Using NAM/ICM with the ISN IVR Solution
ISN Micro-Applications
Get Digits and Digit Entry Completion

The ISN tests GD digit entry input against several conditions to determine whether digit entry is 
complete. The ISN considers digit entry to be complete if the caller enters any of the following:

• The maximum allowable number of digits (when terminator key is not used).

• The maximum number of digits, excluding a terminator key (when terminator key is used).

• Less than the maximum number of digits, followed by the terminator key.

• Less than the maximum number of digits and exceeding the inter-digit timeout.

• Nothing and reaching the no entry timeout.

Caution It is important that you set up your NAM/ICM script to test for all the scenarios mentioned below. 

If digit-entry input is complete

After digit-entry input is complete, the ISN validates the digit string to determine if it is >= (greater than 
or equal to) the minimum length and <= (less than or equal to) the maxi mum length. 

Note In variable-length data entry, the Maximum Field Length value does not accommodate the termination 
key. For example, if a GD micro-application is configured to accept a password that is between 6 and 12 
digits long and digit-entry completion is indicated through a termination key (or a timeout), the 
Minimum Field Length setting should be 6, the Maximum Field Length setting should be 12, and the 
DTMF Termination Key should be defined as a single character.

Before passing the result back to the Application Server, the Voice Browser would discard the 
termination key (that is, only the password digits will be included in the CED returned to ICM software). 

In this example, if the 13th digit is entered without reaching the interdigit timeout and the 13th digit is 
not the terminator key, a NOMATCH event (same as inter-digit timeout) occurs to clear the CED buffer 
on the Voice Browser.

After validating the digit string, the ISN does the following:

• If the string is valid, the ISN stores the digit string (not including the terminator key) in the 
Call.CallerEnteredDigits variable, exits the node through the Checkmark (success) branch, and 
returns control to ICM software. 

• If the string is not valid, the ISN considers it an invalid entry and does the following:

– If the Number of Invalid Entry Tries value has not been reached, the ISN plays an error message 
and re-plays the original prompt.

– If the Number of Invalid Entry Tries value has been reached, the ISN stores the last-entered digit 
string in the Call.CallerEnteredDigits variable, exits the node through the X (failure) branch, 
sets the user.microapp.error_code ECC variable to 16 (Reached Maximum Invalid Tries), and 
returns control to ICM software. 
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If No Entry Timeout occurs

If the caller does not enter input and No Entry Timeout period is exceeded, the following happens:

• If the Number of No Entry Tries value has not been reached, the ISN plays the “no entry” error 
message and re-plays the original prompt.

• If the Number of No Entry Tries value has been reached, the ISN exits the node through the X 
(failure) branch, sets the Call.CallerEnteredDigits variable to NULL, the 
user.microapp.error_code ECC variable to 17 (Reached Maximum No Entry Tries), and returns 
control to ICM software.

Get Digits Error Code Settings

Get Digits can set user.microapp.error_code ECC variable to any of the following Return Status error 
codes: 

1 - (Unused)

2 - Network Error

3 - System Error

4 - (Unused)

5 - Unknown micro-application

6 - Invalid VRU Script Name format

7 - Invalid Configuration Param

8 - Misconfigured ECC Variable

9 - Media file does not exist or invalid URL for Media file

10 - Semantic-Runtime Error

11 - Unsupported VXML format

12 - Unsupported VXML element

16 - Reached Maximum Invalid Tries

17 - Reached Maximum No Entry Tries

21 - Timed out

30 - Unsupported locale

31 - Media Resource Error

32 - General Error

Note The value in user.microapp.error_code ECC is passed from the ISN to the NAM/ICM when the X 
(failure) branch is taken. See the discussion at the end of the section Play Media Error Code Settings.
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Get Digits Example: Get Password 

This example shows sample ICM Configuration Manager and Script Editor screen captures for a Get 
Digits application that plays a prompt requesting a password, retrieves any caller-entered digits, and 
allows two no-entry tries and two invalid attempts.

Figure 2-5 Get Digits in Two Attempts Configuration 

The Network VRU Script List tool’s Attribute tab in Figure 2-5 shows: 

1. The VRU Script Name field containing five ISN parameters:

– GD. Get Digits

– Password. Media File Name

– A. Media Type, App Specific

– 1. The uniqueness string value

2. The Configuration Param field containing the following ISN parameters:

– 6. Minimum Field Length

– 12. Maximum Field Length

– N. Barge-in not allowed

– 3. Inter-digit Timeout (seconds)

– 5. No Entry Timeout (seconds)

– 2. Number of no entry tries

– 2. Number of invalid tries

– N. Timeout Msg Override

– Y. Invalid Entry Msg Override

– #. DTMF Termination Key 

Figure 2-6 shows the contents of the script: 
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Figure 2-6 Get Digits Script
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Menu (M) Micro-Application
This micro-application plays a menu media file and retrieves a defined digit. (Menu is similar to the Get 
Digit micro-application except that it only accepts one digit, which it checks for validity.)

The ISN passes the retrieved digit back to the NAM/ICM for further processing using the Caller-Entered 
Digits (CED) field in the ICM/IVR Messaging interface. 

Use the ICM Configuration Manager’s Network VRU Script List tool’s Attribute tab to specify 
parameters.

Note The VRU Script Name and Configuration Param fields are case-sensitive. For example, M is a valid 
entry; m is not. Enter the values exactly as specified in Table 2-9.

Table 2-9 Menu Network VRU Script Configuration Parameters

Field Name Setting Description

VRU Script Name field Micro-application This must be M (Menu).

Media File Name Name of the media file or external VXML to be played (that is, 
the prompt file). The valid options are: 

• A file name (for instance, a .wav file) 

• null - (default) If this field is empty, ISN examines the 
contents of the user.microapp.inline_tts ECC variable. If 
this ECC variable contains a value, the ISN prompts using 
TTS. If the ECC is empty, no prompt is played.

Media Library Type Flag indicating the location of the media files to be played. The 
valid options are: 

• A - (default) Application

• S - System

Uniqueness value Optional. A string identifying a VRU Script Name as unique.

Configuration Param A list of menu choices. The valid options are: 

• 0-9

• # (pound sign)

• * (asterisk)

Formats allowed include: 

• Individual options delimited by a / (forward slash)

• Ranges delimited by a - (hyphen) with no space)
2-31
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 2      Using NAM/ICM with the ISN IVR Solution
ISN Micro-Applications
Configuration Param 
(continued)

Barge-in Allowed Specifies whether barge-in (digit entry to interrupt media 
playback) is allowed. The valid options are: 

• Y - (default) barge-in allowed

• N - barge-in not allowed

Note ISN deals with barge-in as follows: If barge-in is not 
allowed, the Voice Browser/Gateway continues prompt 
play when a caller starts entering digits. If barge-in is 
allowed, the Voice Browser/Gateway discontinues prompt 
play when the caller starts entering digits. (For more 
information, see the “Type-Ahead Support for ASR” 
section on page 2-48.)

No Entry Timeout The number of seconds a caller is allowed to begin entering digits. 
If exceeded, the system times-out.The valid options are: 0-99 (the 
default is 5).

Number of No Entry 
Tries

Number of times the ISN repeats the prompt cycle when the caller 
does not enter any data after the prompt has been played. (Total 
includes the first cycle.) The valid options are: 1-9 (the default is 
3).

Number of Invalid Tries Number of times the ISN repeats the prompt cycle when the caller 
enters invalid data. (Total includes the first cycle.) The valid 
options are: 1-9 (the default is 3).

Timeout Message 
Override

The valid options are: 

• Y - override the system default with a pre-recorded 
Application Media Library file

• N - (default) do not override the system default

Invalid Entry Message 
Override

The valid options are: 

• Y - override the system default with a pre-recorded 
Application Media Library file

• N - (default) do not override the system default

Note For more information about Timeout and Invalid Entry Messages, see System Media 
Files in Chapter 3, “Prompt Recording and Distribution.”

Table 2-9 Menu Network VRU Script Configuration Parameters (continued)

Field Name Setting Description
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Table 2-10 shows several configuration examples for Menu when input type is DTMF

Table 2-10 shows several configuration examples for Menu is used in an ASR/TTS application:

Table 2-10 Menu Configuration Examples

If the VRU Script Name 
field setting is… It means…

If the Config Param 
setting is... It means…

M,Banking M – Use the Menu micro-app.

Banking – Play the Media file named 
“Banking.wav.” 

Note This file might contain a 
message such as: “For 
Checking, press 1. For Savings, 
press 2. For Money Market, 
press 3.” 

1-3 1-3 – Accept numbers 1, 2, 3.

Accept all other defaults (No Entry 
Timeout, Number of no entry tries, 
Number of invalid tries, Timeout 
Msg Override, Invalid Entry Msg 
Override).

M,Main_Menu M – Use the Menu micro-app.

Main_Menu – Play the Media file 
called “Main_Menu.wav.”

Note This file might contain a 
message such as: “For 
information or transactions on 
checking, press 1. For savings 
or club accounts, press 2. 
For other information, press 0. 
If you know your party’s 
extension, press 9.” 

0-2/9,,4,2,2 0-2/9 – Accept numbers 0, 1, 2, 
and 9.

, (Skipped parameter) – Accept the 
default barge-in setting (Y).

4 – No Entry Timeout value (in 
seconds).

2 – Number of no entry tries allowed.

2 – Number of invalid tries allowed.

Accept all other defaults (Timeout 
Msg Override, Invalid Entry Msg 
Override)
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Table 2-11 Menus Configuration Examples

If … It means… And, if... It means… 

The user.microapp.inline_tts 
ECC variable contains “Press 1 
for Sales and 2 for Support.”

and 

user.microapp.input_type 
contains: D (DTMF)

and

The VRU Script Name field 
contains: M

Use the Menu micro-app to 
play the contents of the 
user.microapp.inline_tts 
ECC variable and collect 
DTMF input.

The Configuration 
Param field contains:
1-2,Y,4,3

1-2 – Accept the DTMF 
digits 1 and 2.

Y – Barge-in allowed. 

4 – No Entry Timeout value 
(in seconds).

3– Number of no entry tries 
allowed.

The user.microapp.input_type 
ECC variable contains: D 
(DTMF)

and

The VRU Script Name field 
contains: M,SalesService,A

Use the Menu micro-app to 
play the media file named 
“SalesService.wav” (which 
is located in the Application 
Media library) and collect 
DTMF input.

The Configuration 
Param field contains:
1-2,N,4,3,2,Y,Y

1-2 – Accept the numbers 1 
and 2.

N – No barge-in allowed. 

4 – No Entry Timeout value 
(in seconds).

3– Number of no entry tries 
allowed.

2 – Number of invalid tries 
allowed.

Y– Allow Timeout Msg 
Override.

Y – Allow Invalid Entry 
Msg Override).

The user.microapp.inline_tts 
ECC variable contains “Press or 
Say 1 for Sales and 2 for 
Support.” 

and 

user.microapp.input_type 
contains: B (the default, both 
DTMF and voice)

and

The VRU Script Name field 
contains: M

Use the Menu micro-app to 
play the contents of the 
user.microapp.inline_tts 
ECC variable and collect 
either DTMF or voice input.

The Configuration 
Param field contains:
1-2,Y,4,3

1-2 – Accept the DTMF 
digits 1 and 2.

Y – Barge-in allowed. 

4 – No Entry Timeout value 
(in seconds).

3– Number of no entry tries 
allowed.
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Menu and Digit Entry Completion

The ISN tests Menu digit entry input against two conditions to determine whether digit entry is 
complete: 

• If a caller enters a digit, the ISN checks whether the digit is within the set of valid digits for this 
menu.

• If a caller does not enter a digit, the ISN checks whether the No Entry Timeout value has been 
reached.

Caution It is important that you set up your NAM/ICM script to test for all the scenarios mentioned below. 

If digit-entry is complete

After a caller enters a digit, the ISN validates the digit against the list of valid menu options that were 
defined through ICM Configuration Manager. Then the ISN does the following:

• If the digit is valid, the ISN stores the digit in the Call.CallerEnteredDigits variable, exits the node 
through the Checkmark (success) branch, and returns control to ICM software. 

• If the digit is not valid, the ISN considers it an invalid entry and does the following:

– If the Number of Invalid Entry Tries value has not been reached, the ISN plays the “invalid 
message” file and re-plays the menu prompt.

– If the Number of Invalid Entry Tries value has been reached, the ISN stores the last-entered 
invalid digit in the Call.CallerEnteredDigits variable, exits the node through the X (failure) 
branch, sets the user.microapp.error_code ECC variable to 16 (Reached Maximum Invalid 
Tries), and returns control to ICM software. 

The user.microapp.inline_tts 
ECC variable contains “Press 1 
for Sales and 2 for Support.” 

and 

user.microapp.input_type 
contains: B (the default, both 
DTMF and voice)

and

The VRU Script Name field 
contains: M

Use the Menu micro-app to 
play the contents of the 
user.microapp.inline_tts 
ECC variable and collect 
DTMF or voice input.

The Configuration 
Param field contains:
1-2,Y,4,3

1-2 – Accept the DTMF 
digits 1 and 2.

Y – Barge-in allowed. 

4 – No Entry Timeout value 
(in seconds).

3– Number of no entry tries 
allowed.

Note Type-ahead can only be used with the Menu micro-application when user.microapp.input_type is set to D. For 
more information, see the “Type-Ahead Support for ASR” section on page 2-48.

Table 2-11 Menus Configuration Examples (continued)

If … It means… And, if... It means… 
2-35
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 2      Using NAM/ICM with the ISN IVR Solution
ISN Micro-Applications
If No Entry Timeout occurs

If the caller does not enter a digit within the No Entry Timeout period:

• If the Number of No Entry Tries value has not been reached, the ISN plays the “no entry” error 
message and re-plays the menu prompt.

• If the Number of No Entry Tries value has been reached, the ISN exits the node through the X 
(failure) branch, sets the Call.CallerEnteredDigits variable to NULL, the 
user.microapp.error_code ECC variable to 17 (Reached Maximum No Entry Tries), and returns 
control to ICM software.

Menu Error Code Settings

Menu can set user.microapp.error_code ECC variable to any of the following Return Status error 
codes: 

1 - (Unused)

2 - Network Error

3 - System Error

4 - (Unused)

5 - Unknown micro-application

6 - Invalid VRU Script Name format

7 - Invalid Configuration Param

8 - Misconfigured ECC Variable

9 - Media file does not exist or invalid URL for Media file

10 - Semantic-Runtime Error

11 - Unsupported VXML format

12 - Unsupported VXML element

16 - Reached Maximum Invalid Tries

17 - Reached Maximum No Entry Tries

21 - Timed out

30 - Unsupported Locale

31 - Media Resource Error

32 - General Error

Note The value in user.microapp.error_code ECC is passed from the ISN to the NAM/ICM when the X 
(failure) branch is taken. See the discussion at the end of the section Play Media Error Code Settings.

Menu Example: Bank Menu Options 

This example shows sample ICM Configuration Manager and Script Editor screen captures for a Menu 
application that plays a prompt presenting a menu (“For Checking, press 1. For Savings, press 2. For 
Money Market, press 3.”), retrieves any caller-entered digits, and allows three no-entry tries and three 
invalid attempts (the defaults).
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Figure 2-7 Bank Menu Configuration 

The Network VRU Script List tool’s Attribute tab in Figure 2-7 shows:

1. The VRU Script Name field containing two ISN parameters:

– M. Menu

– Banking. Media File name

2. The Configuration Param field containing the following ISN parameters:

– 1-3. The numbers. 1, 2, and 3 are valid options
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Figure 2-8 Menu
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Get Speech (GS) Micro-Application
The Get Speech (GS) micro-application collects input that is not digits after prompting a caller. The 
prompt can be generated by a media file or a TTS source. 

The ISN passes the input back to the NAM/ICM for further processing using the 
user.microapp.caller_input ECC variable.

Use the ICM Configuration Manager’s Network VRU Script List tool’s Attribute tab to specify 
parameters. 

Note The VRU Script Name and Configuration Param fields are case-sensitive. For example, GS is a valid 
entry; gs is not. Enter the values exactly as specified in Table 2-6.

Get Speech and Grammar Specification

There are three ways to specify a grammar in the Get Speech micro-application:

• Include a Type of Data to Collect setting in the Get Speech Configuration Param field for built-in 
grammars such as dates and numbers. If the “Type of Data to Collect” setting is specified, the other 
grammar options will not be used by the Application Server. Conversely, if you do not specify a 
“Type of Data to Collect” setting, then you must include either a built-in or external grammar. 

• Include an external grammar file name in the Get Speech Configuration Param field’s “External 
Grammar File Name” setting. 

• Include a list of inline grammar choices in the user.microapp.grammar_choices ECC variable. 
These grammar choices will only be used if a “Type of Data to Collect” or “External Grammar File 
Name” setting is not specified. 

Note One of these grammar options must be used for each micro-application. If no grammar option is 
specified, an Invalid Config Param error will be sent back to ICM software.

Note If you are using an external grammar, be sure to follow the instructions provided by your third-party 
vendor.

For details on writing an external grammar file, see the “External VXML File Contents” section on 
page 2-48.
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Table 2-12 Get Speech Network VRU Script Configuration Parameters

Field Name Setting Description and Valid Options

VRU Script Name Micro-application This must be GS (Get Speech).

Media File Name Name of the media file or external VXML to be played (that is, 
the prompt file). The valid options are: 

• A file name (for instance, a.wav file) 

• null - (default) If this field is empty, ISN examines the 
contents of the user.microapp.inline_tts ECC variable. If 
this ECC variable contains a value, the ISN prompts using 
TTS. If the ECC is empty, no prompt is played.

Media Library Type Flag indicating the location of the media files to be played. The 
valid options are: 

• A - (default) Application

• S - System

Note This value is ignored if using TTS.

Uniqueness value Optional. A string identifying a VRU Script Name as unique.

Configuration Param Type of Data to Collect The type of data to collect. The valid options are:

• null - (default) Leave this option empty if you will be 
specifying an External Grammar File Name setting. 

• boolean - Affirmative and negative phrases appropriate to the 
current locale. 

• date - Phrases that specify a date, including a month, days 
and year. 

• currency - Phrases that specify a currency amount.

• number - Phrases that specify numbers. (For example, “one 
hundred twenty-three.”) 

• time - Phrases that specify a time, including hours and 
minutes. 

Note For information about the format of the currency data 
returned to ICM software in the 
user.microapp.caller_input ECC variable, see the “Get 
Speech Data Format” section on page 2-44.

External Grammar File 
Name

The name of the grammar file that holds the grammar definition 
for the ASR. The valid options are:

• null - (default) Leaving this option empty implies that an 
inline grammar, as given in the Type of Data to Collect 
setting, will be used.

• A grammar file name. The Gateway retrieves the grammar 
file from a Web Server using HTTP.

Note For more information about the “Type of Data to Collect” and “External Grammar” 
settings, see “Get Speech and Grammar Specification” section on page 2-39
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Configuration Param 
(continued)

Barge-in Allowed Specifies whether barge-in (digit entry to interrupt media 
playback) is allowed. The valid options are: 

• Y - (default) barge-in allowed 

• N - barge-in not allowed

Note ISN deals with barge-in as follows: If barge-in is not 
allowed, the Voice Browser/Gateway continues prompt 
play when a caller starts entering input. If barge-in is 
allowed, the Voice Browser/Gateway discontinues prompt 
play when the caller starts entering input. (For more 
information, see the “Type-Ahead Support for ASR” 
section on page 2-48.)

No Entry Timeout The number of seconds a caller is allowed to begin entering digits. 
If exceeded, the system times-out. The valid options are: 0-99 (the 
default is 5).

Number of No Entry 
Tries

Number of times the ISN repeats the “Get Speech” cycle when the 
caller does not enter any data after the prompt has been played. 
(Total includes the first cycle.) The valid options are: 1-9 (the 
default is 3). 

Number of Invalid Tries Number of times the ISN repeats the “Get Speech” cycle when the 
caller enters invalid data. (Total includes the first cycle.) The valid 
options are: 1-9 (the default is 3).

Timeout Message 
Override

The valid options are: 

• Y - override the system default with a pre-recorded 
Application Media Library file

• N - (default) do not override the system default

Note This value is ignored if using TTS.

Invalid Entry Message 
Override

The valid options are: 

• Y - override the system default with a pre-recorded 
Application Media Library file

• N - (default) do not override the system default

Note This value is ignored if using TTS.

Note For more information about Timeout and Invalid Entry Messages, see System Media 
Files in Chapter 3, “Prompt Recording and Distribution.”

Incomplete Timeout The amount of time after a caller stops speaking to generate an 
invalid entry error because the caller input does not match the 
defined grammar. The valid options are: 0-99 (the default is 3).

Note This value is ignored when not using ASR. If the value is 
set to 0, the Application Server treats the NoEntry 
Timeout as NoError.

Table 2-12 Get Speech Network VRU Script Configuration Parameters (continued)

Field Name Setting Description and Valid Options
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Table 2-7 shows several configuration examples for Get Speech.

Table 2-13 Get Speech Configuration Examples

If … It means… And, if... It means… 

The user.microapp.
inline_tts ECC 
variable contains 
“What is your account 
value”

and 

user.microapp.
input_type contains: 
B (the default, both 
DTMF and voice)

and

The VRU Script Name 
field contains: GS

Use the Get Speech micro-app to play the 
contents of the user.microapp.inline_tts 
ECC variable and collect account balance 
in voice or DTMF input, which it passes in 
the user.microapp.caller_input ECC 
variable.

The Configuration 
Param field 
contains:
Currency,,N,5,2,1

Currency – Collect a string of 
data in currency format

, – Accept the default External 
Grammar File Name setting 
(empty). 

Note You accept the default 
because you are 
specifying a Type of Data 
to Collect parameter 
(Currency).

N – No barge-in allowed.

5 – No Entry Timeout (seconds)

2 – Number of no entry tries

1 – Number of invalid tries
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The user.microapp.
inline_tts ECC 
variable contains 
“What department do 
you wish to speak to”

and 

user.microapp.
input_type contains: 
B (the default, both 
DTMF and voice)

and

user.microapp.
grammar_choices 
contains Sales/ 
Customer Service/ 
Help Desk

and

The VRU Script Name 
field contains: 
GS,Department,A

Use the Get Speech micro-app play the 
contents of the user.microapp.inline_tts 
ECC variable and collect the answer, 
which will be passed in either voice or 
DTMF format in the 
user.microapp.caller_input ECC 
variable.

The Configuration 
Param field 
contains:

,,N

, – Accept the default Type of 
Data to Collect parameter 
(empty)

Note You accept the default 
Type of Data to Collect 
parameter because you 
are specifying a value in 
the External Grammar 
File Name parameter. 

, – Accept the default External 
Grammar File Name setting 
(empty) and use the grammar in 
the user.microapp. 
grammar_choices ECC variable

Note This is an inline grammar
example. Each option in 
the list of choices 
specified in the 
user.grammar_choices 
ECC must be delimited 
by a forward slash (/). 

N – No barge-in allowed.

The user.microapp.
inline_tts ECC 
variable contains 
“What is your name”

and 

user.microapp.
input_type contains: 
B (the default, both 
DTMF and voice)

and

user.microapp.media
_server contains 
http://grammars.com

and

user.microapp.app_
media_lib contains 
Boston

and

The VRU Script Name 
field contains: 
GS,YourName,A

Use the Get Speech micro-app play the 
contents of the user.microapp.inline_tts 
ECC variable and collect the answer, 
which will be passed in either voice or 
DTMF format in the 
user.microapp.caller_input ECC 
variable.

The Configuration 
Param field 
contains:

,customers.grxml,
N

, – Accept the default Type of 
Data to Collect parameter 
(empty)

Note You accept the default 
Type of Data to Collect 
parameter because you 
are specifying a value in 
the External Grammar 
File Name setting 
parameter. 

customers.grxml – Use the 
grammar in this file

Note This is an external 
grammar file example. 
For details on writing an 
external grammar file, 
see the “External VXML 
File Contents” section on 
page 2-48.

N – No barge-in allowed.

Table 2-13 Get Speech Configuration Examples (continued)

If … It means… And, if... It means… 
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Get Speech and DTMF Input Collection

Contrary to its name, the Get Speech micro-application can also be used to collect DTMF input. For 
certain grammars, the caller could type a number, time, or currency rather than saying it. 

Although the Get Digits micro-application is capable of providing the same type of functionality, it does 
not allow for validation at collection time. If a caller inputs 2 5 0 0 in response to a Get Speech prompt 
prompting the caller to enter a time, the Get Speech micro-application would detect that “twenty-five 
hundred hours” is an invalid entry. With the Get Digits micro-application, this kind of validation would 
need to be done using additional Script Editor nodes.

Note The caller cannot mix DTMF and speech in a single input, even if both are enabled. Once he starts 
talking, he cannot key-in characters, and vice versa.

Table 2-14 lists the rules associated with using DTMF collection in the Get Speech micro-application.

Note Regardless of the collection type (that is, “voice” or “DTMF”), caller input from Get Speech is always 
written to the user.microapp.caller_input ECC variable.

Get Speech Data Format

The data type determines the format of the information returned to ICM software in the 
user.microapp.caller_input ECC variable:

• Boolean. Returned to ICM software as “true” or “false.” 

Table 2-14 DTMF Rules for Get Speech

Type of Data To Collect (as 
specified in the Config 
Params Allows DTMF Input? DTMF Rules1*

1. Source: Voice Extensible Markup Language (VoiceXML) Version 2.0, W3C Working Draft, 23 October 2001, 
This Version: http://www.w3.org/TR/2001/WD-voicexml20-20011023

boolean Yes Valid DTMF inputs are: 1 (Yes) and 2 (No). 

date Yes Valid DTMF inputs are: four digits for the 
year, followed by two digits for the month, 
and two digits for the day.*

currency Yes For DTMF input, the * (asterisk) key 
represents the decimal point.*

number Yes Valid DTMF input includes positive numbers 
entered using digits and the * (asterisk) key to 
represent a decimal point.

time Yes Since is no DTMF convention for specifying 
AM/PM, in the case of DTMF input, the result 
will always end with h or ?.

External Grammars No

Inline Grammars No
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• Date. Returned to ICM software as a fixed-length date string with the format yyyymmdd where yyyy 
is the year, mm is the month, and dd is the day.

• Currency. Returned to ICM software as a string with the format UUUmmm.mm or mmm.mm, where 
UUU is the three-character currency indicator (for example, USD), and mmm.mm is the currency 
amount with a decimal point. 

Note Whether UUU is used depends both on the ASR capabilities and on whether the caller said 
it unambiguously (for example, “dollar” and “peso” are ambiguous).

• Number.Returned to ICM software as a string of digits from 0 to 9 which can optionally include a 
decimal point and/or a plus or minus sign as a prefix to indicate that the numbers ia a positive or 
negative number. 

• Time. Returned to ICM software as a five-character string in the format hhmmx, where hh is hours, 
mm is minutes and x is one of the following:

– a - AM

– p - PM

– ? - unknown/ambiguous

Get Speech and Entry Completion

The ASR Engine tests Get Speech input entry against two conditions to determine whether entry is 
complete: 

• If a caller enters input, the ASR Engine checks whether the input is within the set of valid grammar 
for this script.

• If a caller does not enter input, the ASR Engine checks whether the No Entry Timeout value has 
been reached.

Caution It is important that you set up your NAM/ICM script to test for all the scenarios mentioned below. 

If input entry is complete

After a caller enters input, the ASR Engine validates the input against the valid grammar set that was 
defined using the Set node to define the user.microapp.grammar_choices ECC variable. Then the ISN 
does the following:

• If the input is valid, the ISN stores the input in the user.microapp.caller_input ECC variable, exits 
the node through the Checkmark (success) branch, and returns control to ICM software. 

• If the input is not valid, the ISN considers it an invalid entry and does the following:

– If the Number of Invalid Entry Tries value has not been reached, the ISN plays the “invalid 
message” file and re-plays the menu prompt.

– If the Number of Invalid Entry Tries value has been reached, the ISN stores the last-entered 
invalid digit in the Call.CallerEnteredDigits variable, exits the node through the X (failure) 
branch, sets the user.microapp.error_code ECC variable to 16 (Reached Maximum Invalid 
Tries), and returns control to ICM software. 
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If No Entry Timeout occurs

If the caller does not enter input within the No Entry Timeout period:

• If the Number of No Entry Tries value has not been reached, the ISN plays the “no entry” error 
message and re-plays the prompt.

• If the Number of No Entry Tries value has been reached, the ISN exits the node through the X 
(failure) branch, sets the user.microapp.caller_input ECC variable to NULL, the 
user.microapp.error_code ECC variable to 17 (Reached Maximum No Entry Tries), and returns 
control to ICM software.

Get Speech Error Code Settings

Get Speech can set user.microapp.error_code ECC variable to any of the following Return Status error 
codes: 

1 - (Unused)

2 - Network Error

3 - System Error

4 - (Unused)

5 - Unknown micro-application

6 - Invalid VRU Script Name format

7 - Invalid Configuration Param

8 - Misconfigured ECC Variable

9 - Media file does not exist or invalid URL for Media file

16 - Reached Maximum Invalid Tries

17 - Reached Maximum No Entry Tries

21 - Timed out

30 - Unsupported Locale

31 - Media Resource Error

32 - General Error

Note The value in user.microapp.error_code ECC is passed from the ISN to the NAM/ICM when the X 
(failure) branch is taken. See the discussion at the end of the section Play Media Error Code Settings.
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Get Speech Example: “Do you want Sales or Service?”

This example shows sample ICM Configuration Manager and Script Editor screen captures for a Get 
Speech application that plays a prompt that presents a menu (“For Sales, say “Sales.” For Service, say 
“Service”), retrieves ASR input and places it in the user.microapp.user_input ECC variable, and runs 
another script. (The second script that is run is determined by the ASR input.)

Figure 2-9 Get Speech Configuration 

The Network VRU Script List tool’s Attribute tab in Figure 2-5 shows: 

1. The VRU Script Name field containing the following ISN parameters:

– GS. Get Speech

– SalesService. Media File name

2. The Configuration Param field is empty; the ISN applies the defaults for parameters set through this 
field.

Figure 2-6 shows the contents of the script: 
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Figure 2-10 Get Speech Script

Type-Ahead Support for ASR
Type-ahead support for ASR is only supported for DTMF under the following conditions:

• When the ISN Voice Browser is the client.

• When the Gateway is the client and input type is set to D.

External VXML File Contents

An external VXML file must follow the following rules:
• It must not use the <Goto>, <submit>, <subdialog>, <transfer>, or <exit> elements.

• It must have <return> elements at all exit points in the document.
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• It must check for all error events and the “telephone.disconnect.hangup” event. Each event handler 
must have a <return> element that makes use of the “event” attribute. 

• If the “Id” attribute of the <form> element is used, it must exactly match the name of the external 
name defined in the Play Media VRU Script name. 

Example 2-1 illustrates the contents of a VXML document that follows these rules. 

Note Example 2-1assumes that the VRU Script Name value is PM,CustomerVXML,V.

Example 2-1 External VXML Document

<?xml version="2.0" encoding="iso-8859-1"?>

<vxml version="2.0">

<form id="CustomerVXML" scope="dialog"> 

<block> 

<prompt bargein="true">

<audio src="http://webserver.com/myapp/Hello_World.wav" /> 

</prompt>

</block>

<catch event="error.badfetch">

<return event="error.badfetch"/> 

</catch>

<catch event="error.semantic">

<return event="error.semantic"/> 

</catch>

<catch event = "error.unsupported.format">

<return event="error.unsupported.format"/> 

</catch>

<catch event = "error.unsupported.element">

<return event="error.unsupported.element"/> 

</catch>

<catch event="telephone.disconnect.hangup"> 

<return event="telephone.disconnect.hangup"/> 
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</catch> 

<catch event="error">

<return event="error"/> 

</catch>

<block>

<return/> 

</block>

</form> 

</vxml>

Note For a complete explanation of VXML file grammar format, see http://www.w3.org/TR/speech-grammar/. 
Also, consult the user documentation for your ASR Server for a list of supported grammar elements. 

Example 2-2 illustrates another external grammar file that might be used to prompt callers for the state 
that they live in. 

Example 2-2 External VXML Document

<?xml version = 1.0 ?>

<grammar version= 1.0 root= action xml:lang= en-us >

<rule id= action scope= public >

<one-of>

<item> California </item>

<item> Arizona </item>

<item> Connecticut </item>

</one-of>

</rule>

</grammar>

After a caller responds with the name of the state she lives in, the ASR Engine determines if the caller 
said California, Arizona, or Connecticut. If the caller said the name of one of these states, the text 
listed in the <item> element will be passed to the Application Server—and, in turn—ICM software. If 
a caller responds with a name not included in this list, an invalid entry error is returned to the Application 
Server. 
2-50
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Cisco Internet Service Node (ISN) 
OL-1251-02
C H A P T E R 3

Prompt Recording and Distribution

This chapter provides:

• Information about ISN media file handling.

• Details about the System Media Files distributed with ISN Version 2.0.

Note This chapter contains important information for IVR application developers. It also may be of interest 
to Call Center Managers, ISN System Managers, and ICM/NAM System Managers. 

Media File Overview
This section presents a brief overview of how ISN performs media file handling. It includes information 
about: 

• What the Media Server is.

• The media file names and types ISN supports.

• How to specify the address of a media file.

• Locale syntax backward compatibility.

Media Server
In ISN, the Media Server is a computer or set of computers, which “serve” the media files that contain 
messages and prompts that callers will hear. There are two types of Media Servers defined in ISN 
according to the mechanism where the media file is accessed:

1. File Media Server: Media Files are located on the same machine as the ISN Voice Browser and 
accessed by the ISN Voice Browser using File protocol.

2. HTTP Media Server: Media Files are located on a remote Web server and accessed by both ISN and 
the Non-ISN Voice Browser using HTTP protocol. This type of Media Server uses standard Web 
access methods.

There is no artificial limit on the number of prompts; these pages will be limited only by file system 
capacity.
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Note To maximize ISN performance, do not install the HTTP Media Server on the same machine as the ISN 
Voice Browser and Application Server.

Tools for prompt creation are off-the-shelf, such as Cool Edit Pro by Syntrillium Software Corporation 
(http://www.syntrillium.com), and Vox Studio (http://www.xentec.be). 

Note It is the customer’s responsibility to select the tool, select a voice talent, record the system and 
application media files in the supported locales, format and encoding, and contact the person who is 
responsible for the media files on the Media Server(s).

Media File Names and Types
A media file name is specified in the ICM VRU Script Configuration and used in the Run VRU Script 
request for the Play Media, Get Digits, Menu, and Get Speech (in non-TTS applications) 
micro-applications. The media file naming convention allows alpha-numeric characters with the 
underbar character as a separator. (Spaces or hyphens are not allowed.) This naming convention provides 
a mechanism for an “understandable” naming convention as opposed to numeric media file names 
typically used by stand-alone VRUs. 

Caution The ISN includes a library of media files/prompts for individual digits, months (referenced internally by 
ISN software for a Play Data script type request), and default error messages, etc. Creation of a full set 
of media/prompts for each locale referenced by the ISN customer is the responsibility of the 
customer’s Media Administrator. 

For specific comments on the Voice Browser critical media file, see the section System Media File Error 
Messages.

The media file types ISN supports are Mu-Law 8-bit .wav files and A-law 8-bit .wav files. Media files 
specified with an extension will be used “as is,” for example, hello.xxx. (The default file extension is 
.wav.)

Caution Any unexpected (and unsupported) type of media file encountered will generate the logging of an error 
and a result code of False will be returned to the ICM along with the ECC user.microapp.error_code 
set appropriately. From the caller’s perspective, nothing was played, however it is the Script Editor 
developer’s responsibility to write the script to handle this error condition.

Locations of Media Files on Hard Disk
Figure 3-1 displays the location of the media file when using File://../MediaFiles. The ISN installation 
will create the folder “MediaFiles” with a sample set of English system media files, if the component 
“System Media File” is checked.
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Figure 3-1 Location of Media File When Using File://../MediaFiles

Figure 3-2 displays the location of the media files when using HTTP protocol. Windows Internet 
Information server (IIS) is used as an example of the Web server.

Figure 3-2 Location of Media File When Using HTTP Protocol

Media File Address
The address for media files that reside on the Media Server(s) is generated by the ISN. The ICM provides 
information about the file location or base URL address in the ICM/IVR messages it passes when the 
Run VRU Script node is executed. The ICM/IVR messages include ECC variables for: locale, media 
server set address, as well as optional system and application library name overrides. (For details about 
the ICM/IVR messages passed to the ISN, see Chapter 2, “Using NAM/ICM with the ISN IVR 
Solution.”) 

The Table 3-1 summarizes the data that combines to form the address of the media file:
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Table 3-1 Media File Address Components

Parameter Location of Data Description Examples

Media Server 
Set

ECC variable: 
user.microapp.media_server

Default: file://../MediaFiles

Note You must insert two 
periods after the double 
slash (//).

File location or base URL for the Media 
Server.

When the Media Server URL is the 
DNS name and the DNS Server is 
configured to return multiple IP 
addresses for a host name, the ISN will 
attempt to get the media files from each 
Media Server IP address in sequence 
with the priority given to those on the 
subnet.

When using the Media Server set for 
external grammars or external VXML, 
if the Media Server URL is the DNS 
name with multiple IP addresses for the 
hostname, it is the ASR Engine’s 
responsibility to decide which machine 
to retrieve the grammar file from. 

File location example:
file://../MediaFiles

Base URL example:
http://www.machine1.com/di
r1/

dirs/cust1

Note By convention, the 
service provider may 
include their 
customers’ name at the 
end of the Media 
Server set. 

Locale ECC variable: 
user.microapp.locale

Default: en-us

This field is a combination of language 
and country with a default of en-us for 
English spoken in the United States.

en-us

Note In ISN Version 2.0, the supported locales are: en-us (English, United States) and en-gb (English, United Kingdom), 
es-es (Spanish, Spain), and es-mx (Spanish, Mexico). The locale defines the grammar of a Play Data script type. If a 
date is to be played with a locale of en-gb (English, United Kingdom), the date would be played in the order of day, 
month, then year; for en-us, it is month, day, year.

Media 
Library Type

The Media Library Type value 
passed from the VRU Script Name 
field. Valid options are:

A - Application prompt library. 

S - System prompt library. 

V - External VXML.

Default: A

The media library (directory) for the 
prompt is either the application prompt 
library defined by ECC variable 
user.microapp.app_media_lib (default 
“app”) or the system prompt library 
defined by ECC variable 
user.microapp.sys_media_lib (default 
“sys”).

Note When the Media Library Type 
is V (external VXML), the 
VXML file will reside in the 
Application Prompt Library.

A (user.microapp.app_media_
 lib= app_banking)
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Based on the examples shown in Table 3-1, two valid addresses for the Media File might be:

• http://www.machine1.com/dir1/dirs/cust1/en-us/app_banking/main_menu.wav

• file://../MediaFiles/en-us/sys/main_menu.wav

Locale Backward Compatibility
In ISN Version 2.0, the locale string values have been changed to be compatible with current industry 
nomenclature: 

• en_US has changed to en-us. That is, “en underscore US” (upper case) has changed to 
“en hyphen us” (lower case). 

• en_GB has changed to en-gb. That is, “en underscore GB” (upper case) has change to 
“en hyphen gb” (lower case).

ISN 2.0 will be backwards-compatible with existing ISN 1.0 scripts.

• en_US and en-us both map to U.S. English in the Application Server for use by the Application 
Server’s internal grammar.

• en_GB and en-gb both map to U.K. English in the Application Server for use by the Application 
Server’s internal grammar.

• The base URL for media prompts will use the locale that is specified, without making modifications. 
For example, if the locale is set to EN_US, the base URL will contain EN_US. if the locale is set to 
XX, the base URL will contain XX.

If you still want to use the ISN Version 1.0 default locale directory (for example, en_US), you will need 
to explicitly set it. When you upgrade to ISN 2.0, only the new files are installed under the ISN 2.0 
default locale directory, en-us.You want to have all your system prompts under one directory and all your 
application prompts and, optionally, external VXML in another directory. Use the user.microapp.locale 
ECC variable to set the locale directory you want to use, such as en_US. 

Media File 
Name

The Media File Name value passed 
from the VRU Script Name field. 
Valid options are the name of the 
.wav file to be played, or external 
VXML file name, or <blank>, 
which translates to playing no 
media. This file name will be 
ignored if TTS is being used (that 
is, if the user.microapp.inline_tts 
ECC variable contains a value.)

Default: none

Name of media file or external VXML 
file to be played. 

Main_menu

Note There are four possible reasons for using <blank> as the Media File Name: (1) For Get Digits, a prompt may not be 
necessary, (2) the customer may want to have a “placeholder” in the script for playing a prompt which may or may 
not be there (that is, an emergency conditions message), (3) change the value of barge-in to indicate a buffer flush, 
and (4) TTS is being used and this field is ignored. 

Media File 
Name Type

If not given as part of the Media 
File Name, the type is .wav

Type of media file to be played. .wav

Table 3-1 Media File Address Components (continued)

Parameter Location of Data Description Examples
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Note You do not need to set the user.microapp.locale ECC variable if you used the default en-us. Also, 
remember that all locale values are case-sensitive.

System Media Files
This section contains tables describing the System Media Files used by ISN Version 2.0. 

Note It is the Customer/Media Administrator’s responsibility to record all the system prompts for all the 
locales.

Table 3-2 lists the System Media File information for cardinal numbers.

Note If you intend on using the es-es and/or es-mx locales, you must record the system prompts noted in the 
tables below by an es in the Language Usage column or as not supplied as part of the ISN installation. 
The only characters denoted as es that are provided with the installation are punctuation, such as upside 
down question marks and exclamation points.

Table 3-2 System Media Files, Cardinal Numbers

Symbol (where 
applicable)

Decimal 
Value1 

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used

point point Number

minus minus Number

0 48 All 0 zero All except DOW

1 49 All 1 one (masculine 
version), uno (es-mx 
and es-es)

All except DOW

1 49 es 1_N Un (neutral) Time, elapsed time

1 49 es 1_F Una (for time with 1 
hour)

Time

2 50 All 2 two All except DOW

3 51 All 3 three All except DOW

4 52 All 4 four All except DOW

5 53 All 5 five All except DOW

6 54 All 6 six All except DOW

7 55 All 7 seven All except DOW

8 56 All 8 eight All except DOW

9 57 All 9 nine All except DOW

10 ten All except Char and DOW

11 eleven Same for the rest of all the 
numbers
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12 twelve

13 thirteen

14 fourteen

15 fifteen

16 sixteen

17 seventeen

18 eighteen

19 nineteen

20 twenty

21 twenty-one

es 21_N veintiún Time

es 21_F veintiuna Elapsed time with hours

22 twenty-two

23 twenty-three

24 twenty-four

25 twenty-five

26 twenty-six

27 twenty-seven

28 twenty-eight

29 twenty-nine

30 thirty

31 thirty-one

es 31_N treinta y un Time

es 31_F treinta y una Elapsed time with hours

32 thirty-two

33 thirty-three

34 thirty-four

35 thirty-five

36 thirty-six

37 thirty-seven

38 thirty-eight

39 thirty-nine

40 forty

41 forty-one

es 41_N cuarenta y un Time

Table 3-2 System Media Files, Cardinal Numbers (continued)

Symbol (where 
applicable)

Decimal 
Value1 

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used
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es 41_F cuarenta y una Elapsed time with hours

42 forty-two

43 forty-three

44 forty-four

45 forty-five

46 forty-six

47 forty-seven

48 forty-eight

49 forty-nine

50 fifty

51 fifty-one

es 51_N cincuenta y un Time

es 51_F cincuenta y una Elapsed time with hours

52 fifty-two

53 fifty-three

54 fifty-four

55 fifty-five

56 fifty-six

57 fifty-seven

58 fifty-eight

59 fifty-nine

60 sixty

61 sixty-one

es 61_N sesenta y un All except Char and DOW 

62 sixty-two

63 sixty-three

64 sixty-four

65 sixty-five

66 sixty-six

67 sixty-seven

68 sixty-eight

69 sixty-nine

70 seventy

71 seventy-one

es 71_N setenta y un Time

Table 3-2 System Media Files, Cardinal Numbers (continued)

Symbol (where 
applicable)

Decimal 
Value1 

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used
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72 seventy-two

73 seventy-three

74 seventy-four

75 seventy-five

76 seventy-six

77 seventy-seven

78 seventy-eight

79 seventy-nine

80 eighty

81 eighty-one

es 81_N ochenta y un Time

82 eighty-two

83 eighty-three

84 eighty-four

85 eighty-five

86 eighty-six

87 eighty-seven

88 eighty-eight

89 eighty-nine

90 ninety

91 ninety-one

es 91_N noventa y un Time

92 ninety-two

93 ninety-three

94 ninety-four

95 ninety-five

96 ninety-six

97 ninety-seven

98 ninety-eight

99 ninety-nine

es 500_es quinientos Number,Date,Currency

es 700_es setecientos Number,Date,Currency

es 900_es novecientos Number,Date,Currency

oh oh 24TOD, Date

hundred hundred Number,24TOD,Date,Currency

Table 3-2 System Media Files, Cardinal Numbers (continued)

Symbol (where 
applicable)

Decimal 
Value1 

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used
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Table 3-3 lists the System Media File information for ordinal numbers.

Note If ordinal system prompts are to be used in a script for a purpose other than dates, they should be 
recorded as application prompts with the true ordinal values.

es hundred_es1 ciento Number,Date,Currency

es hundred_es2 cientos Number,Date,Currency

thousand thousand Number,Date,Currency

million million Number,Currency

es million_es millones Number,Currency

billion billion Number,Currency

trillion trillion Number,Currency

es trillion_es billones Number,Currency

1. ANSI Code Page 1252 

Table 3-2 System Media Files, Cardinal Numbers (continued)

Symbol (where 
applicable)

Decimal 
Value1 

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used

Table 3-3 System Media Files, Ordinal Numbers

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content 

Data Play Back Types / 
When Media File Is Used

1ord first Date

2ord second Date for all the ordinal numbers

3ord third

4ord fourth

5ord fifth

6ord sixth

7ord seventh

8ord eighth

9ord ninth

10ord tenth

11ord eleventh

12ord twelfth

13ord thirteenth

14ord fourteenth

15ord fifteenth

16ord sixteenth

17ord seventeenth

18ord eighteenth
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Table 3-4 lists the System Media File information for measurement.

Table 3-5 lists the System Media File information for letter values.

19ord nineteenth

20ord twentieth

21ord twenty-first

22ord twenty-second

23ord twenty-third

24ord twenty-fourth

25ord twenty-fifth

26ord twenty-sixth

27ord twenty-seventh

28ord twenty-eighth

29ord twenty-ninth

30ord thirtieth

31ord thirty-first

1. ANSI Code Page 1252 

Table 3-3 System Media Files, Ordinal Numbers (continued)

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content 

Data Play Back Types / 
When Media File Is Used

Table 3-4 System Media Files, Measurement

Symbol (where 
applicable)

Decimal 
Value1

1. ANSI Code Page 1252 

Language 
Usage

Media File 
Name Media File Content 

Data Play Back Types / 
When Media File Is Used

½ 189 All one_half one half Char

¼ 188 All one_quarter one quarter Char

¾ 190 All three_quarters three quarters Char

Table 3-5 System Media Files, Letter

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content 

Data Play Back Types / 
When Media File Is Used

A,a 65,97 All a A Char

B,b 66,98 All b B Char 

C,c 67,99 All c C Char

D,d 68,100 All d D Char

E,e 69,101 All e E Char

F,f 70,102 All f F Char
3-11
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 3      Prompt Recording and Distribution
System Media Files
G,g 71,103 All g G Char

H,h 72,104 All h H Char

I,I 73,105 All i i Char

J,j 74,106 All j J Char

K,k 75,107 All k K Char

L,l 76,108 All l L Char

M,m 77,109 All m M Char

N,n 78,110 All n N Char

O,o 79,111 All o O Char

P,p 80,112 All p P Char

Q,q 81,113 All q Q Char

R,r 82,114 All r R Char

S,s 83,115 All s S Char

T,t 84,116 All t T Char

U,u 85,117 All u U Char

V,v 86,118 All v V Char

W,w 87,119 All w W Char

X,x 88,120 All x X Char

Y,y 89,121 All y Y Char

Z,z 90,122 All z Z Char

Œ, œ 140,156 oe_140_156 Ligature OE Char

À,à 192,224 a_192_224 A grave Char

Á, á 193,225 es a_193_225 A acute Char

Â, â 194,226 a_194_226 A circumflex Char

Ã, ã 195,227 a_195_227 A tilde Char

Ä, ä 196,228 a_196_228 A umlaut Char

Å, å 197,229 a_197_229 A with ring above Char

Æ, æ 198,230 ae_198_230 Ligature AE Char

Ç, ç 199,231 es c_199_231 C cedilla Char

È, è 200,232 e_200_232 E grave Char

É, é 201,233 es e_201_233 E acute Char

Ê, ê 202,234 e_202_234 E circumflex Char

Ë, ë 203,235 e_203_235 E umlaut Char

Ì, ì 204,236 i_204_236 I grave Char

Table 3-5 System Media Files, Letter (continued)

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content 

Data Play Back Types / 
When Media File Is Used
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Table 3-6 lists the System Media File information for month values.

Í. í 205,237 es i_205 I acute Char

Î, î 206,238 i_206 I circumflex Char

Ï, ï 207,239 i_207 I umlaut Char

Ð 208 char_208 character 208 Char

Ñ, ñ 209,241 es n_209_241 N tilde Char

É, é 201,233 e_201_233 E acute Char

Ê, ê 202,234 e_202_234 E circumflex Char

Ë, ë 203,235 e_203_235 E umlaut Char

ð 240 char_240 character 240 Char

Ò, ò 210,242 o_210_242 O grave Char

Ó, ó 211,243 es o_211_243 O acute Char

Ô, ô 212,244 o_212_244 O circumflex Char

Õ, õ 213,245 o_213_245 O tilde Char

Ö, ö 214,246 o_214_246 O umlaut Char

× 215 All multiply multiplication sign Char

Ø, ø 216,248 o_216_248 oh stroke Char

Ù, ù 217,249 u_217_249 U grave Char

Ú, ú 218,250 u_218_250 U acute Char

Û, û 219,251 u_219_251 U circumflex Char

Ü, ü 220,252 u_220_252 U umlaut Char

Ý, ý 221,253 y_221_253 Y acute Char

Þ 222 char_222 character 222 Char

ß 223 ss double s Char

÷ 247 All divide division sign Char

þ 254 char_254 character 254 Char

Ÿ,ÿ 159,255 y_159_255 character 159 or 255 Char

1. ANSI Code Page 1252 

Table 3-5 System Media Files, Letter (continued)

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content 

Data Play Back Types / 
When Media File Is Used

Table 3-6 System Media Files, Month

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used

January January 
(es = January of)

Date

February February
(es = February of)

Date
3-13
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 3      Prompt Recording and Distribution
System Media Files
Table 3-7 lists the System Media File information for day values.

March March
(es = March of)

Date

April April
(es = April of)

Date

May May
(es = May of)

Date

June June
(es = June of)

Date

July July
(es = July of)

Date

August August
(es = August of)

Date

September September
(es = September of)

Date

October October
(es = October of)

Date

November November
(es = November of)

Date

December December
(es = December of)

Date

1. ANSI Code Page 1252 

Table 3-6 System Media Files, Month (continued)

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used

Table 3-7 System Media Files, Day

Symbol (where 
applicable)

Decimal 
Value1

1. ANSI Code Page 1252 

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used

Sunday Sunday DOW

Monday Monday DOW

Tuesday Tuesday DOW

Wednesday Wednesday DOW

Thursday Thursday DOW

Friday Friday DOW

Saturday Saturday DOW
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Table 3-8 lists the System Media File information for time values.

Table 3-9 lists the System Media File information for currency values.

Note The customer’s Media Administrator may prefer to replace the contents of “currency_minus” (for the 
negative amount) and “currency_and” (the latter can even be changed to contain silence).

Table 3-8 System Media Files, Time

Symbol (where 
applicable)

Decimal 
Value1

1. ANSI Code Page 1252 

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used

hour hour Etime,24TOD per locale,TOD 
perlocale

hours hours Etime,24TOD,TOD per locale

minute minute Etime

minutes minutes Etime

second second Etime,24TOD

seconds seconds Etime24TOD

on on per locale(unused for en-us)

at at per locale(unused for en-us)

am a.m. TOD

pm p.m. TOD

oclock oclock TOD

Table 3-9 System Media Files, Currency

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content 

Data Play Back Types / 
When Media File Is Used

All currency_
minus

minus Currency

All currency_and and Currency

$ 36 All USD_dollar dollar Currency

Note ISN Version 2.0 uses the USD_dollar.wav and USD_dollars.wav 
media files; the dollar.wav and dollars.wav used by ISN Version 
1.0 are no longer installed.

$ 36 All CAD_dollar dollar Currency

All USD_dollars dollars Currency

All CAD_dollars dollars Currency 

¢ 162 All cent cent Currency

All cents cents Currency

All euro euro Currency
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Table 3-10 lists the System Media File information for gaps of silence and miscellaneous phrases.

Table 3-11 lists the System Media File information for ANSI Characters.

Pound symbol 163 All GBP_pound pound Currency

All GBP_pounds pounds Currency

All penny penny Currency

All pence pence Currency

All MXN_peso peso Currency

All MXN_pesos pesos Currency

All centavo centavo Currency

All centavos centavos Currency

1. ANSI Code Page 1252 

Table 3-9 System Media Files, Currency (continued)

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content 

Data Play Back Types / 
When Media File Is Used

Table 3-10 System Media Files, Silence and Miscellaneous Phrases

Symbol (where 
applicable)

Decimal 
Value1

1. ANSI Code Page 1252 

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used

silence_.1_
sec

(.1 second of 
silence)

Used for pauses where needed

silence_.25_
sec

(.25 second of 
silence)

Used for pauses where needed

silence_.5_
sec

(.5 second of 
silence)

Used for pauses where needed

silence__
sec

(1 second of silence) Used for pauses where needed

and and Etime,TOD,25TOD

Table 3-11 System Media Files, ANSI Characters

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used

 32 space space Char

! 33 exclamation_
mark

exclamation mark Char

" 34 double_
quote

double quote Char

# 35 pound pound Char

% 37 percent percent Char
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& 38 ampersand ampersand Char

' 39 apostrophe apostrophe Char

( 40 open_
parenthesis

open parenthesis Char

) 41 close_
parenthesis

close parenthesis Char

* 42 asterisk asterisk Char

+ 43 plus plus Char

, 44 comma comma Char

- 45 hyphen hyphen Char

. 46 period period Char

/ 47 slash slash Char

: 58 colon colon Char

; 59 semicolon semicolon Char

< 60 less_than less than Char

= 61 equal equal Char

> 62 greater_than greater than Char

? 63 question_
mark

question mark Char

@ 64 at_symbol at Char

[ 91 left_square_
bracket

left square bracket Char

\ 92 backslash backslash Char

] 93 right_square
_bracket

right square bracket Char

^ 94 caret caret Char

_ 95 underscore underscore Char

` 96 single_quote single quote Char

{ 123 open_brace open brace Char

| 124 pipe pipe Char

} 125 close_brace close brace Char

~ 126 tilde tilde Char

‚ 130 char_130 low single quote Char

ƒ 131 char_131 F with hook Char

„ 132 char_132 low double quote Char

… 133 ellipsis ellipsis Char

Table 3-11 System Media Files, ANSI Characters (continued)

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used
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† 134 char_134 character 134 Char

‡ 135 char_135 character 135 Char

ˆ 136 char_136 character 136 Char

‰ 137 per_mille per mille Char

Š 138 char_138 character 138 Char

‹ 139 left_pointing
_angle

left pointing angle Char

‘ 145 left_single_
quote

left single quote Char

’ 146 right_single_
quote

right single quote Char

“ 147 left_double_
quote

left double quote Char

” 148 right_double
_quote

right double quote Char

• 149 bullet bullet Char

150 en_dash en dash Char

– 151 em_dash em dash Char

˜ 152 small_tilde small tilde Char

™ 153 trade_mark trade mark Char

š 154 char_154 character 154 Char

› 155 char_155 character 155 Char

¡ 161 es exclamation_
mark_
inverted

inverted exclamation 
mark

Char

¤ 164 char_164 character 164 Char

¦ 166 broken_pipe broken pipe Char

§ 167 section section Char

¨ 168 char_168 character 168 Char

© 169 copyright copyright Char

ª 170 char_170 character 170 Char

« 171 left_double_
angle_
quote

left double angle 
quote

Char

¬ 172 not not Char

- 173 char_173 character 173 Char

® 174 registered registered Char

¯ 175 char_175 character 175 Char

Table 3-11 System Media Files, ANSI Characters (continued)

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used
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° 176 degree degree Char

± 177 plus_minus plus or minus Char

² 178 superscript_
2

superscript two Char

³ 179 superscript_
3

superscript three Char

´ 180 acute_accent acute accent Char

µ 181 micro micro Char

¶ 182 paragraph paragraph Char

· 183 middle_dot middle dot Char

¸ 184 cedilla cedilla Char

¹ 185 superscript_
1

superscript one Char

º 186 char_186 character 186 Char

» 187 right_double
_angle_
quote

right double angle 
quote

Char

¿ 191 es question_
mark_
inverted

inverted question 
mark

Char

1. ANSI Code Page 1252 

Table 3-11 System Media Files, ANSI Characters (continued)

Symbol (where 
applicable)

Decimal 
Value1

Language 
Usage

Media File 
Name Media File Content

Data Play Back Types / 
When Media File Is Used
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System Media File Error Messages
Three error messages are included with the System Media files:

• Critical media. Message played when system problem exists and the Voice Browser cannot process 
the call. (Example content for en-us: “We are currently experiencing technical difficulties with the 
site, please try again later and we can serve you much better.”) The critical media file is NOT located 
on the media server, but is instead located on the Voice Browser.

– ISN Voice Browser. Critical_Error_Alaw.wav and Critical_Error_Ulaw.wav under 
/Cisco/ISN/VoiceBrowser.

– Non-ISN Voice Browser. Error.wav in each configuration folder under 
/Cisco/ISN/ApplicationServer/Downloads.

Note You must record the “override” prompts to replace the critical media files, save them with the 
hard-coded names, and place them in their original locations.

• no_entry_error. Message played when the caller does not respond to a menu prompt. (Example 
content for en-us: “Please make a selection.”) The original prompt is then repeated.

• invalid_entry_error. Message played when the caller enters an incorrect response to a menu 
prompt. (Example content for en-us: “Your entry is invalid.”) The original prompt is then repeated.

These files are shared by all applications.

If a dialogue needs to be altered for a specific Get Digits or Menu request in the ICM script, override 
flags can be set in the Network VRU Script Configuration Parameters. 

Note Override flags are available for the Get Digits and Menu micro-applications, only. For more information, 
see Chapter 2, “Using NAM/ICM with the ISN IVR Solution.”

You must record the “override” prompts, save them with the hard coded names <prompt 
name>_no_entry_error.wav and <prompt_name>_invalid_entry_error.wav, and place them with other 
application-specific media files in the Application Media library.

Note This override will not work when there is not a specific file name used (for instance, when ISN is using 
the TTS feature).
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C H A P T E R 4

Voice Browser Administration

This chapter provides the following:

• An overview of the ISN Voice Browser.

• Instructions for using the VB Admin tool.

• Descriptions of each of the VB Admin commands.

Note The primary audience for this chapter is ISN System Managers.

Voice Browser Overview
The Voice Browser serves several key roles in the ISN architecture. It:

• Functions as the initial VoIP end-point for voice contacts.

• Coordinates the delivery of messages and prompts to a caller from the Media Server.

• Sends HTTP requests to the Applications Server. 

• Processes VXML messages from the Application Server.

Figure 4-1 illustrates these functions.
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Figure 4-1 Roles of the Voice Browser

On its incoming call side, the Voice Browser processes call and control signals from PSTN calls entering 
the system at a Cisco Gateway. (The Gateway converts them into H.323 messages before forwarding 
them to the Voice Browser.)

Once in control of the call, the Voice Browser converts the voice signals into events to be processed by 
a web server known as the Applications Server. The Voice Browser connects to the Applications Server 
through a pre-defined URL address. (For more information, see the “How does the Voice Browser 
connect to an Application Server?” section below.)

The Voice Browser remains in the call control path until the call’s logical completion. (The Applications 
Server never directly controls a telephone call.) 

On its outgoing side, the Voice Browser acts upon VXML commands received from the Application 
Server. The VXML commands contain instructions for:

• Transferring the telephone call.

• Delivering recorded messages and prompts.

• Processing user responses to the prompts. 
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How does the Voice Browser connect to an Application Server?
The Voice Browser needs to know an Application Server to send requests to; ISN installation sets the 
default Application Server address to localhost:8000/servlet/isn.

Note The Voice Browser configuration tool can be used to modify the list as needed. If the Application Server 
list changes, the first Application Server on the new list will be used.

There is one Application Server list for all calls. As shown in Figure 4-2, the Voice Browser selects an 
Application Server as follows:

1. When the Voice Browser starts up, it attempts to connect with the first Application Server in the list, 
AppServer W. 

2. If AppServer W does not respond, the Voice Browser will go to the next Application Server in the 
list, AppServer X. 

3. If the Voice Browser can communicate with Application Server AppServer X, the next call is 
handled by that Application Server.

Note If a call arrives and AppServers X, Y, and Z do not respond, the Voice Browser goes back to the 
beginning of the list and tries the Application Servers up to the original starting point (that is, AppServer 
W). If the Voice Browser tries all Application Servers and there is no response, an alarm is generated. 
The Voice Browser takes itself out of service and refuses calls. It will continue to communicate with each 
of the Application Servers and, when one of them is available, goes back in service.

Figure 4-2 Application Server 

If the Application Server list changes, the first Application Server on the new list will be used. The 
change will be used for new calls only.
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Out of Band Communications

The Voice Browser has two types of connections to the Application Server: 

• One initiated by the Voice Browser for “normal” call steps such as playing media.

• Another initiated by the Application Server for processing information asynchronous to the normal 
call steps, for example, for transferring a queued call. 

This later form of communication is referred to as out of band.

The Voice Browser Media File
The Voice Browser has one media file. This file contains a prompt to be played to a caller in case of a 
critical error where the ISN system cannot properly play information to the caller through the normal 
routes (that is, through the Application Server). 

The name and location of this .wav file is one of the following:

<target directory>\Critical_Error_Alaw.wav

<target directory>\Critical_Error_Ulaw.wav

where <target directory> is the path specified during installation, typically 
C:\Cisco\ISN\VoiceBrowser.

The customer should record the appropriate message for their installation and replace the placeholder 
one which was installed with the product—keeping the placeholder’s name and codec. The file should 
be either the A-law or u-law encoded file, depending on the encoding used in the system and configured 
in the Voice Browser. (For more information, see Chapter 3, “Prompt Recording and Distribution.”)

After the Voice Browser plays the message, it disconnects the call.

VB Admin Tool
The Voice Browser includes a configuration and administration tool—called VB Admin—to help you 
keep track of the Voice Browser’s interactions with the components described in the previous section. 
This tool provides a command line interface (CLI) you can use to:

• Gather statistics.

• Modify configuration settings.

• View system metrics and status.

• Control the Voice Browser. 

Note In order for the VB Admin tool to function, the Voice Browser must be running.

Since there are often many Voice Browsers in network installations, VB Admin can be run locally or 
remotely, or redirected to monitor a different Voice Browser. VB Admin can also accept a script as input, 
enabling you to execute a command or set of commands on a set of Voice Browsers.

The sections that follow describe the VB Admin tool, its commands, and how to use them.
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VB Admin Command Syntax
There are two types of VB Admin commands: Show commands let you view the configuration settings; 
Set commands let you change the settings. The syntax for the VB Admin commands is:

show<Parameter>[ /? | /help]

set<Parameter>[<NewValue> | /? | /help]

where:

• show<Parameter> or set<Parameter> is the command, for example, ShowGateKeeper or 
SetAppServerNumTries. 

• NewValue—only used with Set commands —is the new setting for the parameter. 

• /? and /help are two options for accessing VB Admin Online Help.

Note NewValue must be enclosed in quotes only if you are defining multiple settings for a parameter using 
one command. For example, to define one Application Server Name, you would enter: 
SetAppServerList AS_Lowell (no quotes). To define three Application Server Names at one time, you 
would enter: SetAppServerList “AS_Lowell AS_Salem AS_SanJose” (with quotes).

After you enter a “Show” or “Set” command, VB Admin responds with messages that fall into one of 
the following types:

• Informational/Online Help. Examples: “AppServerNumTries is currently 3.” 
“Valid values: 256 character string.”

• Confirmational. Example: “AppServerNumTries has been changed from 3 to 5.”

• Error. Example: “Entered value needs to be a positive integer.”

The first two message types are described in the Command tables in the “Using VB Admin” section. 
Error messages are described in “VB Admin Error Handling”. 
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VB Admin Online Help
When you enter /? or /help after a valid command, VB Admin displays Help text consisting of:

• A description of the command, including any default setting and when changes to configuration take 
effect.

• The syntax of the command.

Table 4-1 shows some Online Help examples.

Note To obtain an alphabetical list of all commands supported by VB Admin, enter mhelp at the VB Admin 
CLI prompt.

Table 4-1 VB Admin Online Help Examples

Command Help Message

ShowAppServerNumTries /? Maximum number of times the Voice Browser will try to connect to 
the Application Server before failing and reporting an error.

ShowAppServerNumTries [/? | /help] 

SetAppServerNumTries [<NewValue> | /? | /help]

SetTraceMask /help For use by Technical Support, only.

Default: 101003HEX

Changes to this value take effect immediately. (System shutdown 
and startup unnecessary.)

ShowTraceMask [/? | /help]

SetTraceMask [<NewValue> | /? | /help]
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Using VB Admin
This section describes how to use the VB Admin CLI tool.

How to use the VB Admin tool locally

Note In order for the VB Admin tool to function, the Voice Browser must be running.

Step 1 Select Start > Programs > Cisco Internet Service Node > Voice Browser > VB Admin. A window 
containing a command line prompt (>>>>) appears.

Step 2 Enter a show<Parameter> or set<Parameter> command you want to execute. 

Note VB Admin commands are not case-sensitive. 

Step 3 When finished using VB Admin, enter q. The VB Admin window closes.

How to use the VB Admin tool remotely

You can use VB Admin to access a remote machine by changing the pointer to the VB machine. 

Step 1 At the DOS prompt, enter the command:

vbadmin <VB machinename>

Step 2 Enter a show<Parameter> or set<Parameter> command you want to execute. 

Note VB Admin must be installed on any machine you want to access remotely. 

The sections that follow describe the VB Admin commands by category.
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VB Admin Configuration Commands
Table 4-2 VB Admin Configuration Commands

Show and Set Command Syntax Description

ShowAppServerList [/? | /help]

SetAppServerList [<List of AppServer base URLs,
delimited by spaces> | /? | /help]

(Shorthand commands: sASList, SetASList)

List of base URLs of Application Servers for the Voice Browser, 
delimited by spaces and the entire list enclosed in quotes. 

The syntax for the base URL is:

<AppServer>:<Port>/servlet/isn

where:

<AppServer> is the hostname or IP address of the machine that is 
running the Application Server. (Default: localhost.)

<Port> is the port number the Application Server is listening on. 
(Default: 8000.) 

/servlet/isn is a fixed string that you must append to each name in the 
AppServerList. 

Note A colon (:) must separate the <AppServer> and <Port> values. 
In addition, it is strongly suggested that you use the default Port 
number and treat “servlet/isn” as a fixed string. Making changes 
to these value can render an Application Server unusable. 

IP Address and DNS name may be used in configuring the base URL 
portion of an Application Server. However, the ISN cannot currently 
support more than one IP address per DNS name, so you must have a 
one-to-one correspondence between a DNS name and IP address for 
each Application Server. 

When defining multiple List of AppServer base URLs settings, enclose 
them in quotes (for example: SetASList “AS_Boston:8000/servlet/isn 
AS_SanJose:8000/servlet/isn”).

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

Note For more information, see “How does the Voice Browser 
connect to an Application Server?”on page 4-3.

ShowAppServerNumTries [/? | /help] 

SetAppServerNumTries [<NewValue> | /? | /help]

(Shorthand commands: sASTries, SetASTries)

Maximum number of times the Voice Browser will try to connect to the 
Application Server before failing and reporting an error. 

Default: 3

System shutdown and startup necessary for changes to take effect.

ShowAppServerTimeout [/? | /help]

SetAppServerTimeout [<NewValue> | /? | /help]

(Shorthand commands: sASTimeout, 
SetASTimeout)

Number of seconds the Voice Browser should wait for a response from 
the Application Server before timing out and generating an error. 

Note This setting must be greater than the Application Server’s 
Server Timeout setting. (For information about setting Server 
Timeout, see Chapter 5, “Application Server Administration.”)

Default: 7 seconds

System shutdown and startup necessary for changes to take effect.
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ShowCalledPartyTimeout [/? | /help] 

SetCalledPartyTimeout [<NewValue> | /? | /help]

(Shorthand commands: sCPT, SetCPT)

Length of time in seconds to wait for additional instructions from the 
ICM after the Called Party (that is, agent) hangs up. If no instructions 
are received, the Voice Browser disconnects the caller.

Default: 2

System shutdown and startup necessary for changes to take effect.

ShowCodec [/? | /help] 

SetCodec [g711Ulaw64k | g711Alaw64k
| /? | /help]

(Shorthand command: sCodec)

Type of codec and rate used in the Voice Browser when communicating 
with another VoIP endpoint.

Default: g711Ulaw64k

Note All H.245 channel signalling and RTP streams are based on the 
codec setting. The Voice Browser will only accept the prompt 
files with the same encoding as the codec setting. If instructed to 
play an audio file with a different encoding, the prompt will not 
be played and an error will be generated.

System shutdown and startup necessary for changes to take effect

ShowGatekeeper [/? | /help] 

SetGateKeeper [<NewValue> | /? | /help]

(Shorthand commands: SGK, SetGK)

IP address for the Gatekeeper serving the Voice Browser. A value of 
“none” or no value means the Gatekeeper is not being used (which 
means calls cannot be transferred).

Valid values: IP address or “none” 

Default: none (or no value)

System shutdown and startup necessary for changes to take effect.

ShowH323ID [/? | /help]

SetH323ID [<NewValue> | /? | /help]

(Shorthand command: sH323ID)

This value defines a unique identification for this H323 endpoint in a 
H323 network. This is the IP address of the machine by convention. 
Only needed if using the IP transfer feature and a gatekeeper.

Valid values: 256 character string

Default: Local IP address

System shutdown and startup necessary for changes to take effect.

ShowMaxIVRPorts [/? | /help] 

SetMaxIVRPorts [<NewValue> | /? | /help]

(Shorthand command: sMaxIVRPorts)

Maximum number of calls in the Voice Browser which are allowed to 
receive IVR treatment at any given time. If the number of calls exceed 
the MaxIVRPorts value, additional calls arriving at the Voice Browser 
will be rejected.

Note Even when a Gateway is acting as the IVR—as can be the case 
in an ISN Comprehensive deployment—you still need a small 
number of IVR ports on the Voice Browser, based on the 
incoming calls per second and subsequent transfers. Use the 
Max IVR Ports listing in the Voice Browser Total Statistics log 
to help make decisions regarding IVR port sizing.

Default: 50

System shutdown and startup necessary for changes to take effect.

Table 4-2 VB Admin Configuration Commands (continued)

Show and Set Command Syntax Description
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ShowMaxTotalCalls [/? | /help] 

SetMaxTotalCalls [<NewValue> | /? | /help]

(Shorthand command: sMaxTotalCalls)

Maximum total number of calls allowed in the Voice Browser.

Default: 135

System shutdown and startup necessary for changes to take effect.

ShowMediaServerTimeout [/? | /help] 

SetMediaServerTimeout [<NewValue> | /? | /help]

(Shorthand command: sMSTime)

Number of seconds the Voice Browser should wait for a response from 
the Media Server before timing out and reporting an error.

The Voice Browser will attempt to get the media file from all the IP 
addresses in sequence resolved by the DNS server for the Media Server 
URL.

The timeout value is for every IP address resolved by DNS server for the 
media server URL.

Default: 10

System shutdown and startup necessary for changes to take effect.

ShowMediaServerTries [/? | /help] 

SetMediaServerTries [<NewValue> | /? | /help]

(Shorthand commands: sMSTries, setMSTries)

Maximum number of retries the Voice Browser will attempt (in addition 
to the original attempt) in trying to connect to the media server before 
failing and reporting an error.

The Voice Browser will attempt to retry every IP address resolved by the 
DNS server for the Media Server URL. The MediaServerTries is the 
number of retries for each IP address resolved by the DNS server. Voice 
Browser does all the tries on each media server before moving to the 
next media server.

Default: 1

System shutdown and startup necessary for changes to take effect.

ShowNewCallOnly [/? | /help] 

SetNewCallOnly [<on | off> | /? | /help]

(Shorthand commands: sNco, setNco)

Determines whether a call will be restarted from the beginning if there 
is a NAM/ICM or Application Server problem during the course of the 
call. Set this value to “on” to restart calls. (Because pre-routed calls 
cannot be restarted, turning this setting on means that you do not expect 
any pre-routed calls to come to this Voice Browser, i.e., only new calls 
arrive at this Voice Browser.)

Note Do not set this value to “on” if you expect any pre-routed calls 
to come to this Voice Browser. The ISN cannot restart pre-routed 
calls. 

Default: off

Valid Values: on, off

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowNumOutOfBand [/? | /help] 

SetNumOutOfBand [<NewValue> | /? | /help]

(Shorthand commands: sOutofBand, 
SetOutofBand)

Number of connections the Voice Browser should reserve per 
Application Server for performing out of band communications, such as 
transferring a queued call.

Default: 3

System shutdown and startup necessary for changes to take effect.

Table 4-2 VB Admin Configuration Commands (continued)

Show and Set Command Syntax Description
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ShowNMRestartTimer [/? /help]

SetNMRestartTimer [value /? /help]

Number of seconds the Node Manager waits to restart the Voice Browser 
if it isn’t operating properly. Delaying the restart gives transferred calls 
ample time to terminate conversations normally. 

Default: 1800 seconds

System shutdown and startup necessary for changes to take effect.

ShowOutOfBandConsecFails [/? | /help] 

SetOutOfBandConsecFails [<NewValue> 
|/? | /help]

(Shorthand commands: sOBFail, SetOBFail)

Maximum number of consecutive times the Voice Browser can try to 
connect to the out of band channels before failing and reporting an error.

Default: 3

System shutdown and startup necessary for changes to take effect.

ShowOutOfBandTimeout [/? | /help] 

SetOutOfBandTimeout [<NewValue> | /? | /help]

(Shorthand commands: sOBTime, SetOBTime)

Number of seconds the Voice Browser should wait to connect to out of 
band Channels before failing and reporting an error.

Default: 60 seconds

Note There is a relationship between this setting and the Application 
Server’s Heart Beat Timeout setting. The Heart Beat Timeout 
should be two times the OutOfBandTimeout setting. (For 
information about setting Heart Beat Timeout, see Chapter 5, 
“Application Server Administration.”)

System shutdown and startup necessary for changes to take effect.

ShowRAIMaxThreshold [/? | /help] 

SetRAIMaxThreshold [<NewValue> | /? | /help]

(Shorthand commands: sRaiMax, SetRaiMax)

(H.323 Stack). A percentage of MaxInCalls. If the number of active 
incoming calls exceeds (RAIMaxThreshold/100)*MaxTotalCalls or 
exceeds (RAIMaxThreshold/100)*maxIVRports - 
(currentTransferedCalls * (takebackPercentage/100)), an RAI indicator 
instructs the Gatekeeper to stop routing further incoming calls to this 
Voice Browser. 

Valid values: 0 - 100

Default: 80

Note RaiMinThreshold must be less than RaiMaxThreshold.

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowRAIMinThreshold [/? | /help] 

SetRAIMinThreshold [<NewValue> | /? | /help]

(Shorthand commands: sRaiMin, SetRaiMin)

(H.323 Stack). A percentage. If the number of active incoming calls 
drops below (RAIMinThreshold/100)*MaxTotalCalls or 
(RAIMinThreshold/100)*maxIVRports - (currentTransferedCalls * 
(takebackPercentage/100)), an RAI indicator instructs the Gatekeeper to 
start routing incoming calls to this Voice Browser.

Valid values: 0 - 100

Default: 70

Note RaiMinThreshold must be less than RaiMaxThreshold.

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

Table 4-2 VB Admin Configuration Commands (continued)

Show and Set Command Syntax Description
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ShowRNATimeout [/? | /help]

SetRNATimeout [<NewValue> | /? | /help]

(Shorthand commands: sRNATimeout)

Ring-no-answer (RNA) timeout. When transferring a call, the number of 
seconds the Voice Browser should wait for the called party to answer the 
call, after it has started ringing, before failing and reporting an error.

Valid Values: 15 - 180

Default: 15 seconds

System shutdown and startup necessary for changes to take effect.

ShowSDDSNRestartLinkTime [/? | /help] 

SetSDDSNRestartLinkTime [<NewValue> | /? | 
/help]

(Shorthand commands: sSDDSNLinkTime, 
SetSDDSNLinkTime)

The number of seconds the Voice Browser should wait before attempting 
to reconnect to SDDSN.

Default: 5

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowSDDSNRetries [/? | /help] 

SetSDDSNRetries [<NewValue> | /? | /help]

(Shorthand command: sSDDSNRetries)

The upper limit of geometric growth for the time between retries when 
both SDDSN instances are having problems. 

Default: 5

Note This means the Voice Browser will retry after 1 minute, then 4 
(2*2) minutes, 9 (3*3) minutes, 16 (4*4) minutes, 25 (5*5) 
minutes. If a default of 5 is being used, all subsequent retry 
attempts will be spaced 25 minutes apart. (For more 
information, see “Understanding SDDSN Retry Settings” in 
Chapter 7, “Alarm Handling and Logging.”)

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowSDDSN1Node [/? | /help] 

SetSDDSN1Node [<NewValue> | /? | /help]

(Shorthand commands: sSDDSN1, SetSDDSN1)

The host name or IP address of the first SDDSN instance. Use this 
command to define the host name or IP address of the SDDSN instance. 
(If there is only one SDDSN in service, set SDDSN2Node to the same 
value as SDDSN1Node.)

Default: NULL

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowSDDSN1Port [/? | /help] 

SetSDDSN1Port [<NewValue> | /? | /help]

(Shorthand command: sSDDSN1Port)

The listening port number for the first SDDSN instance. Use this 
command if you want to change the listening port number to a value 
other than the default. 

Default: 40080

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

Table 4-2 VB Admin Configuration Commands (continued)

Show and Set Command Syntax Description
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ShowSDDSN2Node [/? | /help] 

SetSDDSN2Node [<NewValue> | /? | /help]

(Shorthand commands: sSDDSN2, SetSDDSN2)

The host name or IP address of the second SDDSN instance. (If there is 
only one SDDSN in service, SDDSN2Node should be set to the same 
node as SDDSN1Node.) Use this command to define the host name or 
IP address of the SDDSN instance. (If there is only one SDDSN in 
service, set SDDSN2Node to the same value as SDDSN1Node.)

Default: NULL

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowSDDSN2Port [/? | /help]

SetSDDSN2Port [<NewValue> | /? | /help]

(Shorthand command: sSDDSN2Port)

The listening port number for the second SDDSN instance. Use this 
command if you want to change the listening port number to a value 
other than the default. 

Default: 40080

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowSDDSNLastNode [/? | /help]

(Shorthand command: sSDDSNLastNode)

Read-only parameter. Indicates the last node where a successful 
connection was made:

1 - SDDSN1 

2 - SDDSN2

ShowSDDSNTimeout [/? | /help] 

SetSDDSNTimeout [<NewValue> | /? | /help]

(Shorthand command: sSDDSNTimeout)

Number of seconds the Voice Browser should wait for the initial 
message from SDDSN after a connection has been established before 
failing and reporting an error.

Default: 5

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowSetupCallingNum [/? | /help]

SetSetupCallingNum [CLI|DNIS /? /help]

Controls whether the Dialed Number (DNIS) or Calling Line 
Identification (CLI) is used as the Calling Party Number in VoIP 
messages during IP Call Transfer. When this value is set to “CLI”, CLI 
(if present) will be passed in the Calling Party Number parameter of the 
Setup message during IP Transfer; when set to “DNIS”, DNIS will be 
passed.

Valid Values: CLI, DNIS

Default: CLI

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

Table 4-2 VB Admin Configuration Commands (continued)

Show and Set Command Syntax Description
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ShowTakebackPercentage [/? | /help] 

SetTakebackPercentage [<NewValue> | /? | /help]

(Shorthand commands: sTakePct, SetTakePct)

Percentage of currently transferred calls for which IVR ports should be 
reserved for queuing or other IVR treatment.

Default: 0 (zero)

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

For example, if the MaxIVRPorts setting is 100, MaxTotalCalls is 300, 
and TakebackPercentage is 10, it would mean the following:

• If no calls are currently transferred, the Voice Browser would accept 
up to 100 calls IVR.

• If 50 calls are currently transferred, the Voice Browser would accept 
up to 95 calls IVR (then there would be 145 total calls and the Voice 
Browser would stop accepting new ones).

• If 200 calls currently transferred, the Voice Browser would accept 
up to 80 IVR (then there would be 280 total calls and the Voice 
Browser would stop accepting new ones).

• At 300 calls, the Voice Browser would still have room for 70 IVR 
but would stop taking calls, anyway, because the total number of 
calls would have been reached.

ShowTechPrefix [/? | /help]

SetTechPrefix [<NewValue> | /? | /help]

(Shorthand command: sTechPrefix)

Controls a prefix required for inbound call routing. The value must 
match the tech-prefix value of the Gateway dial-peer(s) that route to this 
Voice Browser and the tech-prefix value in the Gatekeeper.

Default: 2#

System shutdown and startup necessary for changes to take effect.

ShowTransferCLI [/? | /help]

SetTransferCLI [<on | off> | /? | /help]

(Shorthand command: sTransferCLI)

Controls whether the Dialed Number (DNIS) or Calling Line 
Identification (CLI) is used as the source address in VoIP messages 
during IP Call Transfer. When this value is set to “on,” the CLI (if 
present) will be passed in the SrcInfo parameter of the ARQ message 
during IP Transfer; when set to “off,” the DNIS will be passed.

Valid Values: on, off

Default: off

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowVbRestartTimer [/? /help]

SetVbRestartTimer [value /? /help]

Number of seconds the Voice Browser should wait to restart itself if it 
isn’t operating properly. Delaying the restart gives transferred calls 
ample time to terminate conversations normally.

Default: 1800 seconds

Changes to this default take effect immediately.

Table 4-2 VB Admin Configuration Commands (continued)

Show and Set Command Syntax Description
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Note The Voice Browser has two types of connections to the Application Server: one initiated by the Voice 
Browser for normal call steps, such as playing media, and one where the Application Server is supplying 
the processing information asynchronous to the normal call steps, for example, for transferring a queued 
or already-transferred call. The later form of communication is referred to as “out of band.”

VB Admin Logging Commands
For more information about logging, see Chapter 7, “Alarm Handling and Logging.” 

Table 4-3 VB Admin Logging Commands

Show and Set Command Syntax Description

ShowCallTrace [/? | /help] 

SetCallTrace [<on | off> | /? | /help]

(Shorthand command: sCallTrace)

When “on,” the Voice Browser logs basic call detail information to the 
console and log files. 

Valid Values: on, off

Default: off

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowInterfaceTrace [/? | /help]

SetInterfaceTrace [<on | off> | /? | /help]

(Shorthand command: sIntTrace, setIntTrace)

When “on,” the Voice Browser logs interface details to the console and 
log files.

Valid Values: on, off

Default: off

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowTraceMask [/? | /help]

SetTraceMask [<NewValue> | /? | /help]

(Shorthand command: sTraceMask)

For use by Technical Support, only.

Default: 101003HEX

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)
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VB Admin Metric and Control Commands
The Voice Browser keeps track of significant events and measurements; these metrics are logged at 
regular intervals and can be displayed on demand. Measurements of latency for particular actions 
(retrieving a voice file, for instance), are counted for the interval in which they complete, as opposed to 
the interval in which they start. 

Most VB Admin Metric commands are display-only (that is, in show<Parameter> syntax).

Note For information on how Voice Browser metrics are logged, see “Voice Browser Logging and Metrics” in 
Chapter 7, “Alarm Handling and Logging.”

Table 4-4 VB Admin Metric and Control Commands

Command Syntax Description

DisconnectCall [<LocalID> | /? | /help]

(Shorthand command: DisCall)

Disconnects the call identified by Local ID from the active call list (after 
confirmation).

ShowActiveCalls [/? | /help] Displays the following information about each call active in the Voice 
Browser:

• Local ID

• Unique Call ID

• Creation Time

• State

• Duration

• DNIS

• ANI

• Last Application Server the call accessed

• Last Media Server the call accessed

ShowCallHistory [<CallID> | /? | /help]

(Shorthand command: sCallHist)

For use by Technical Support, only.

Can be used to print out a detailed call history of an active call. Either the 
long or short call id may be entered as the argument. 

Default: none 
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ShowIntervalStatistics [/? | /help] Displays the interval time, and a series of counts, averages and 
maximums during that interval. The statistics include:

• Interval size.

• Number of new calls.

• Number of calls transferred.

• Number of calls rejected (if Voice Browser is out of service).

• Number of transfer errors.

• Number of prompts not ready - this is the number of times a prompt 
was playing, and before the end of the prompt was reached, the Voice 
Browser had to stop playing the prompt because the next part of the 
file had not yet been received.

• Number of prompts not found.

• Number of calls using critical media, that is, that were prematurely 
terminated because of internal errors (in which case a “system error” 
message is played to the caller).

• Number of calls terminated (call may have begun in a previous 
interval).

• Percent of total system CPU used - average, minimum, maximum 
and standard deviation.

• For each Voice Browser, average, minimum, maximum and standard 
deviation of the latency statistics in processing a new call arrival.

• For each Voice Browser, average, minimum, maximum and standard 
deviation of the latency statistics in processing a successful transfer, 
measuring the time from when the Voice Browser receives the 
Transfer command from the Application Server to the time of 
alerting.

• For each Voice Browser, average, minimum, maximum and standard 
deviation of the latency statistics in processing a successful transfer, 
measuring the time from alerting to when the called party answers.

• For each Application Server, average, minimum, maximum and 
standard deviation of the latency statistics in communicating with 
Application Server for call processing requests, and the number of 
message exchanges (requests to the Application Server from the 
Voice Browser). 

Note Averages, minimums, maximums and standard deviation 
statistics are calculated by using current data (occurring within 
this interval), not rolling averages (occurring over multiple 
intervals). Call latency is displayed in milliseconds. 

Table 4-4 VB Admin Metric and Control Commands (continued)

Command Syntax Description
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ShowLogMeters [/? | /help]

SetLogMeters [<on | off> | /? | /help]

(Shorthand command: sLogMeters)

Controls logging metrics. When “on,” the Voice Browser will log metrics 
to the console and log files at the interval specified by the Message Meter 
Interval setting. Metrics are always available on demand for the last 
interval(s).

Valid Values: on, off

Default: on

Changes to this value take effect immediately.

ShowMeterInterval [/? | /help] 

SetMeterInterval [<NewValue> | /? | /help]

(Shorthand command: sMeterInterval)

Time interval, in seconds, at which metrics will be calculated. Note that, 
if logging of metrics is “on,” setting the interval to a short time will cause 
the log files to roll over more quickly. Also, the Meters parameter must 
be set to “on” to activate logging.

Default: 1800 seconds (30 minutes)

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

ShowServiceMode [/? | /help]

SetServiceMode [<in | out> | /? | /help]

(Shorthand commands: sServMode, setServMode)

Controls the processing of calls. When “out” (out of service), the Voice 
Browser will not accept new calls but will process all existing calls to 
completion. When “in” (in service), the Voice Browser will accept new 
calls.

Valid Values: in, out

Changes to this value take effect immediately. (System shutdown and 
startup unnecessary.)

Table 4-4 VB Admin Metric and Control Commands (continued)

Command Syntax Description
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ShowSnapshot [/? | /help] Gives a count of all the calls in progress, and subtotals for the count in 
each state. The states include:

• Waiting for VXML (or for response from Application Server)

• Playing Prompt

• Waiting for DTMF

• Transferred

• Disconnecting

• Disconnected (caller has been disconnected and software is just 
finishing up)

• New (call has arrived, but processing has not started yet)

• IVR Ports in use (a call is in one of two states at any point in time: 
receiving IVR treatment, or transferred. Time spent in all call 
setup— H.323 activity plus communications to the ICM—counts as 
being in the IVR state. Therefore, even though a call may be 
‘immediately’ transferred upon arrival at ISN, there is still a brief 
period—several seconds—that the call is in the IVR state until the 
endpoint answers the call. IVR Ports in use shows the number of calls 
in the IVR state at any point in time)

• Wait (a transient internal state; calls should never stay in this state 
any length of time; this number increasing over time indicates a 
problem)

• Other (calls should never be in this state; a catch-all for problem 
calls)

• Internal (for debugging purposes only; shows the total number of 
calls in the internal call object map in the Voice Browser; includes 
all active call legs, plus calls that are marked for deletion)

Table 4-4 VB Admin Metric and Control Commands (continued)

Command Syntax Description
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VB Admin Error Handling
VB Admin validates configuration commands and settings before accepting them. If a command is not 
valid, VB Admin displays an error message. Table 4-5 shows some examples of invalid commands and 
their resulting error messages:

Note Although VB Admin validates the syntax of the Voice Browser configuration commands, it performs no 
checks regarding the syntax or existence of values such as IP addresses/DNS names.

ShowStatus [/? | /help] Status gives the overall status for the ISN Application Server for the 
entire time the Voice Browser has been up, including:

• Total Calls

• Disconnect Disposition (Rejected, Caller Hangup, Called Party 
Hangup, ICM Release, Critical Media)

• Maximum Simultaneous Calls

• Maximum IVR Ports

• Total Prompts Not Found

• Total Transfer Errors (Busy, Ring No Answer, Gatekeeper Problem, 
Destination Problem, Other)

• System Startup Time

• System Up Time

• Current System State (In Service, Out of Service)

• Packets Transmitted

ShowVersion [/? | /help] Displays release number (2.0) and build number of the software.

Table 4-4 VB Admin Metric and Control Commands (continued)

Command Syntax Description

Table 4-5 VB Admin Error Message Examples

Command Error Message

DoesNotExist The command is not recognized. Valid commands are 
show[Parameter], set[Parameter], and Help.

SetAppServerNumTries –7 Entered value needs to be a positive integer.

SetNumCalls Read only variable.

ShowDoesNotExist This command does not support the parameter you have entered. 
Use Help to see a list of parameters.
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C H A P T E R 5

Application Server Administration

This chapter provides the following:

• An overview of the ISN Application Server.

• Instructions for using the Application Administrator tool.

Note The primary audience for this chapter is ISN System Managers.

Application Server Overview
The Application Server is a Web Server application, which interprets messages from Cisco ICM 
software and generates VXML documents that it uses to communicate with the Voice Browser. 

Note ISN 2.0 uses two types of Voice Browsers:

-- ISN Voice Browser (same as ISN 1.0 Voice Browser)
-- Non-ISN Voice Browser; for example, Cisco VXML-enabled Voice Gateway

References to “Voice Browser” in this chapter refer to both types unless explicitly specified.
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Figure 5-1 Roles of the Application Server

The Application Server never directly controls a telephone call. The VXML commands it sends to the 
Voice Browser contain instructions for:

• Transferring the telephone call.

Note Currently, the Non-ISN Voice Browser does not perform asynchronous transfers.

• Delivering recorded messages and prompts.

• Processing user responses to the prompts.

• ASR or TTS treatment.

The sections that follow describe how to administer the Application Server.

Application Server Administration
The Application Administrator tool provides a Web browser interface you can use to perform tasks 
such as:

• Start or Stop Application Server Engine.

• Take the Application Server engine in and out of service.

• Monitor system and call status.

• Configure the engine, DNIS numbers, and log setups.

The sections that follow describe how to use this tool.
5-2
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 5      Application Server Administration
Application Server Administration
How to use the Application Administrator tool

Step 1 Do one of the following:

• Select Start > Programs > Cisco Internet Service Node > Application Server > Application 
Administrator. 

• Enter http://<HOSTNAME>/AppAdmin (where <HOSTNAME> is the name of the machine 
where the Application Server is installed.

The Application Administration Main Page appears. 

Use this page to navigate to other Application Administration pages. 

Step 2 When finished using the Application Administrator tool, select File > Close. 

Note You must close the web browser to shut down the Application Administrator tool. The tool runs 
as a web application under IIS (Internet Information Server). This means that it will not close 
even if you use Service Control to stop the Application Server.
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Engine Administration
This section describes the pages you use to administer the Application Server engine:

• Engine Status page

• Active Calls page

• Call Statistics page

• Diagnostic Information page

• Log Configuration page

• Log Files page

Engine Administration: Engine Status

Use this page to:

• Obtain information about the status of the Application Server Engine and its subsystems.

• Start or Stop the Application Server Engine, or put it Out of Service or Back in Service.

• Link to other Engine Administration pages.

Step 1 From the Application Administration Main Page, click the Engine link. The Engine Status page appears.
5-4
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 5      Application Server Administration
Application Server Administration
Table 5-1 describes the different Status settings and traffic light icon colors. 

Step 2 Do one of the following:

• Click Start to start the Application Server.

• Click Stop to stop the Application Server.

• Click Go Out of Service to stop accepting calls. The label on the button changes to Go Into Service. 
Click this button to start accepting calls again.

• Using the checkbox and text field, specify an Auto-refresh setting for the Status page.

Note Whenever you click a button on this page, a confirmation dialog box appears. Click OK to continue.

Step 3 When finished, link to another page or select File > Close to close the Application Administrator.

Table 5-1 Engine Status Information

Light Color Status Description

Red STOPPED System not running. 

Yellow STOPPING System shutting down.

INITIALIZING System starting up. (It is not ready to accept 
calls.)

GOING OUT OF SERVICE System not accepting new calls but finishing 
processing calls currently in system. (After call 
processing is complete, state changes to OUT OF 
SERVICE.)

OUT OF SERVICE System Out of Service or HTTP is not 
functioning. System is not accepting calls and has 
no calls, but is running.

ICM OFFLINE Application Server is waiting for a connection 
from ICM software. It will not accept calls in this 
state.

PORTS BUSY System is fully loaded. It is not accepting new 
calls but finishing processing calls currently in 
system.

Green RUNNING System running and receiving new calls.
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Engine Administration: Active Calls 

Use this page to display the following information about each call active in the Application Server.

Note See the “MRCP logging tag” section on page 5-19 for more information about the call ID.

Step 1 From any Engine Administration page, click the Active Calls link. The following happens:

• First, a caution message appears. Click OK to continue. 

• Then, the following information displays for each call active in the Application Server:

Note The ID value matches the Unique Call ID shared with the Voice Browser.

Step 2 To remove a call from service, click its Delete Command link.

Step 3 Click OK in the confirmation dialog box that appears.

Step 4 When finished, link to another page or select File > Close to close the Application Administrator.
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Engine Administration: Call Statistics 

Use this page to monitor and control the display of statistical information for calls and HTTP 
transactions:

• During the current interval.

• Since the Application Server engine started.

Step 1 From any Engine Administration page, click the Call Statistics link. The Call Statistics page appears. 

The top of the page shows statistics logged for calls and HTTP transactions. The bottom of the page 
contains controls for displaying the statistics.

Table 5-2 describes the statistics contained in each category:
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Step 2 Optionally, change the Statistical Controls settings:

• Log Metrics. (Radio buttons.) Controls logging of statistics. When “on,” the Application Server 
writes the statistics to the log file in the interval specified by Meter Interval setting. Default: “on”.

• Meter Interval. Length-of-time interval for logging statistics, in seconds. Default: 1800 seconds 
(30 mintues). 

Note The Log Metrics setting must be “on” to activate logging, but statistics are always available 
from the Web interface.

Step 3 Do one of the following:

• Click Update to change the Statistical Controls information. All changes take effect immediately. 
(System shutdown and startup unnecessary.)

• Click Cancel to cancel any changes and return to the previous page.

Step 4 When finished, link to another page or select File > Close to close the Application Administrator.

Table 5-2 Call and HTTP Statistics

Category For Calls For HTTP Sessions

This Interval • The number of calls currently in 
progress.

• The maximum number of 
simultaneous calls handled during 
the interval.

• The number of new calls this 
interval.

• Number of calls that finished this 
interval.

• The average and maximum latency in 
processing a new call arrival and 
subsequent call event.

• The number of requests currently 
in progress.

• The maximum number of HTTP 
requests being processed 
simultaneously during the interval.

• The total number of requests 
received this interval.

• The average number of HTTP 
requests being processed 
simultaneously during the interval.

Note Call latencies are displayed in 
milliseconds.

Since Start • The total number of calls that 
received since server start-up.

• The maximum number of 
simultaneous calls since server 
start-up.

• The total number of requests 
received since Server start-up.

• The maximum number of HTTP 
requests being processed 
simultaneously since Server 
start-up.
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Engine Administration: Diagnostic Info 

Use this page to display information that your support organization can use for troubleshooting system 
problems. 

Note The Diagnostic page is not available unless the Application Server Engine is running.

Step 1 From any Engine Administration page, click the Diagnostic Info link. The following happens:

• First, a caution message appears. Click OK to continue. 

• The Diagnostic Info page appears, displaying the current system status for:

– Thread groups (system, main, engine, RMI runtime), their Max Priority and size

– Threads under each thread group

– System memory

– System properties

Step 2 When finished, link to another page or select File > Close to close the Application Administrator.

Engine Administration: Engine Configuration 

Use this page to set up how the Application Server will communicate with the Voice Browser and ICM 
software.

Step 1 From any Engine Administration page, click the Engine Configuration link. The Engine Configuration 
page appears.
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Step 2 Use the ISN Voice Browser Settings section to specify the following, clicking Update when done:

• Heart Beat Timeout (seconds). (Default:120 seconds.) Used for ISN Comprehensive and ISN 
Queue and Transfer configurations. Controls how long the Application Server will wait for a 
heartbeat request from the ISN Voice Browser before timing-out. If this timeout is exceeded, all 
calls received from that Voice Browser are terminated.

Note This value should be two times the ISN Voice Browser’s OutofBandTimeout setting.

Step 3 Use the Non-ISN Voice Browser Settings section to specify the following, clicking Update when done:

Note The settings in this section are used in ISN Comprehensive and ISN Advanced Speech 
configurations. The “Gateway” in this section represents a Non-ISN Voice Browser.

• Last Access Timeout (seconds). (Default:7320 seconds.) How long the Application Server will 
wait for a call request from a Non-ISN Voice Browser before removing that Non-ISN Voice 
Browser from its current client list. This value must be greater than or equal to the call timeout; this 
is enforced by the software.

• Hold Music. (Default: flash:fetchwait.wav.) Controls where music is retrieved from when a caller 
is on hold while a non-ISN Voice Browser is retrieving VXML from the Application Server. If left 
blank, no hold music will be played. (This setting controls call results only. The initial NEW_CALL 
hold music path is controlled through the fetchaudio property within the bootstrap VXML in flash 
memory on the Gateway.) 

• HTTP Media Server Timeout. (Default:5 seconds.) The number of seconds the Gateway should 
wait to connect to the HTTP Media Server before timing out.

• Number of Tries for HTTP Media Server. (Default:2 tries.) Maximum number of times the 
non-ISN Voice Browser will attempt to connect to an HTTP Media Server to retrieve a single 
prompt. If the Voice Browser fails after this many attempts, it will try the same number of times to 
retrieve the media from a backup media server before failing and reporting an error. (The backup 
media server is defined as <mediaserver>-backup.)

Note This backup mechanism is only useful when there is no CSS content switch sitting between the 
Non-ISN Voice Browser and the HTTP media servers. Otherwise, a CSS, if configured properly, 
could find a backup media server on the second attempt using the original URL of the prompt. 
When not using a CSS, in order to achieve failover redundancy, it is necessary to have the 
backup media server configured in DNS as the mediaserver name appended with -backup. Also 
note that if both the primary and backup media servers are down, the call will eventually return 
an error code to ICM software to indicate media fetch failure. 

• Number of Tries for ASR/TTS Server. (Default: 2 tries.) Maximum number of times the Gateway 
will try to connect to an ASR/TTS server. If the Gateway fails to connect this many attempts, it will 
try the same number of times to connect to a backup ASR/TTS server before failing and reporting 
an error. (The backup ASR and TTS servers are defined as asr-<locale>-backup and 
tts-<locale>-backup.) 
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Note This backup mechanism is really only useful when there is no CSS content switch sitting 
between the Gateway and the ASR/TTS servers. Otherwise, a CSS, if configured properly, could 
find a backup ASR/TTS server on the second attempt using the original server name. When not 
using a CSS, in order to achieve failover redundancy, it is necessary to have the backup 
ASR/TTS servers configured in DNS as asr-<locale> and tts-<locale> appended with -backup.

• Application Server Timeout. (Default: 7 seconds.) The number of seconds the Gateway should 
wait to connect to the Application Server before timing out. This timeout should be longer than the 
server timeout setting on the Application Server. (This setting controls call results only. The initial 
NEW_CALL timeout from the Gateway to the Application Server is controlled through the 
fetchtimeout property within the bootstrap VXML in flash memory on the Gateway.)

• Number of Tries for Application Server. (Default: 3 tries.) Maximum number of times the 
Gateway will try to connect to the Application Server before failing and reporting an error. (This 
setting controls Call Results only. The initial NEW_CALL retry count from the Gateway to the 
application server is controlled from within the bootstrap VXML in flash memory on the Gateway.)

Step 4 Use the Load-Limiting Settings section to specify the following, clicking Update when done:

• New Call Throughput Upper Threshold (ms). (Default: 1000 ms.) The average Application 
Server upper threshold throughput time in milliseconds of processing new calls allowed before the 
Application Server takes itself out of service. Throughput calculations are done at regular intervals 
(default is 30 seconds), and this test is done at every interval while in service. The calculation is 
done with ICM software and network response time excluded, so that the throughput represents the 
true Application Server’s own response time.

• Call Event Throughput Upper Threshold (ms). (Default: 400 ms.) The average Application 
Server upper threshold throughput time in milliseconds of processing call events allowed before the 
Application Server takes itself out of service. Throughput calculations are done at regular intervals 
(default is 30 seconds), and this test is done at every interval while in service. The calculation is 
done with ICM software and network response time excluded.

• Call Event Throughput Lower Threshold (ms). (Default: 200 ms.) The average Application 
Server lower threshold throughput time in milliseconds of processing call events required for the 
Application Server to return to service after exceeding one of the two throughput upper thresholds. 
Throughput calculations are done at regular intervals (default is 30 seconds), and this test is done at 
every interval when out of service. The calculation is done with ICM software and network response 
time excluded.

• Active Calls Upper Threshold (%). (Default: 99 percent.) The maximum percentage of total calls 
allowed that can be active before the Application Server takes itself out of service. The percentage 
is calculated with respect to the total number of calls allowed.

• Active Calls Lower Threshold (%). (Default: 97 percent.) If the Application Server has been 
previously taken out of service due to exceeding “Active Calls upper threshold”, and the number of 
active calls drops below this percentage level, the Application Server is returned to service. The 
percentage is calculated the same as done for “Active Calls Upper Threshold”.

Step 5 Optionally, modify the Advanced Settings section, clicking Update when done:

Caution In most cases, Advanced Settings never need change. Make changes to this page only if 
absolutely necessary.
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• Call Timeout. (Default: 7200 seconds.) How long the Application Server should wait for a response 
from the Voice Browser before timing-out. This setting should be longer than the longest prompt, 
transfer or digit collection at a Voice Browser. If the timeout is reached, the call is aborted but no 
other calls are affected. The only downside to making the number arbitrarily large is that if calls are 
being stranded, they will not be removed from the Application Server until this timeout is reached.

• Server Timeout. (Default: 5 seconds.) A “backup” timeout setting the Server can use if a Port 
Group Configure timeout setting fails; must be greater than the ICM Timeout setting by at least one 
second.

Note The Voice Browser’s AppServerTimeout setting should be larger than this setting by at least 
one second. (For information about setting AppServerTimeout, see Chapter 4, “Voice 
Browser Administration.”)

• ICM Timeout. (Default: 4.) The number of seconds the Application Server waits for the ICM 
response for each transaction with ICM software for the call; must be less than the Server Timeout 
setting.If this timeout is exceeded, the Application Server returns an error to the Voice Browser, 
which will play the default VXML file and disconnect the call.

Note This setting needs to be long enough to accommodate processing within the Application Server 
as well as ICM software processing, including any Wait nodes that exist in the ICM script.

• Alarm Forwarder Port. (Default: 8163.) Port number required for the Alarm Forwarder process. 
This must be the same as the port number configured in the Alarm Forwarder.

• RMI Port Number. (Default: 1099.) Port number required for an RMI (Java) process.

• Maximum Number of Executed Steps. (Default: 1000.) Internal setting to prevent a runaway 
scenario in case of an internal error. 

• Maximum Number of Concurrent Sessions. (Default: 425.) Internal work flow setting. This 
number should be slightly larger than the number of simultaneous calls in the Application Server.

Caution If the maximum number of concurrent sessions is not larger than the number of calls, latencies 
can rise dramatically.
Also note that the number of ports you define will determine the number of calls that can be 
processed simultaneously. You should configure about 10 percent more ports than the 
maximum number of simultaneous calls you expect. The extra ports will enable the system to 
accommodate any error-related delays in releasing call resources. 

• Allow External VXML. (Checkbox.) Select this checkbox to allow VXML to be imported from an 
external HTTP source.

Step 6 Do one of the following:

• Click Update to change the Engine Configuration information. 

Note The system will displays a message if any of your changes require Application Server reboot 
before taking effect.

• Click Cancel to cancel any changes and return to the previous page.
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Step 7 When finished, link to another page or select File > Close to close the Application Administrator.

Engine Administration: Log Configuration 

Use this page to set up how the Application Server will perform error handling and provide information 
for remote monitoring of the system. Use the SDDSN section of this page to set the host name or IP 
address of the SDDSN instance and, optionally, to modify the default listening port.

Note For detailed information regarding how the Application Server handles logs files, see Chapter 6, “Node 
Manager and ICM Service Control.”

Step 1 From any Engine Administration page, click the Log Configuration link. The Log Configuration page 
appears.

Step 2 Use the Log File section to specify the following:

• Log File Output. (Checkbox.) When “on” (checked), the Application Server will produce log files. 

Note It is recommended that the log file output setting always be “on”. If “off”, errors and 
statistics will not be logged.

• File name. A base file name for the log file and an extension, for example, CiscoISN_ and log.

• Number of Log files. (Default: 10.) Maximum number of log files to be retained.

• Log File Size. (Default: 1048576.) Maximum size for each log file, in bytes.
5-13
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 5      Application Server Administration
Application Server Administration
Step 3 Use the Interface Tracing section to specify how interactions between the Application Server and 
external interfaces should be logged:

• Call. Select to log call-handling information, such as:

– Call arrival

– Call disconnection

– Call transfer

– Call rejection

Note Call interface tracing does not include tracing each step taken by ICM software.

• Basic. Select to log basic information—such as message type—regarding the component’s interface 
interactions with other components. 

• Detailed. Select to log more complete information about the component’s interface interactions 
with other components. 

Caution Depending on the call load, using Basic or Detail tracing can severely impact Application Server 
performance. To get the most out of interface tracing performance, minimize the Application Server 
console window. 

Step 4 Use the SDDSN section to specify settings which are needed by the Alarm Forwarder process:

• SDDSN Node 1. (Default: no default.) The host name or IP address of the first SDDSN instance.

• SDDSN Node 2. (Default: no default.) The host name or IP address of the second SDDSN instance.

• SDDSN Port 1. (Default: 40080.) The listening port number for the first SDDSN instance.

• SDDSN Port 2. (Default: 40080.) The listening port number for the second SDDSN instance.

• SDDSN Ascending Retries. (Default: 5.) The upper limit of geometric growth for the time between 
retries when both SDDSN instances are having problems. 

Note A setting of 5. This means the Application Server will retry after 1 minute, then 4 (2*2) 
minutes, 9 (3*3) minutes, 16 (4*4) minutes, 25 (5*5) minutes. All subsequent retry attempts 
will be spaced 25 minutes apart. (For more information, see “Understanding SDDSN Retry 
Settings” in Chapter 7, “Alarm Handling and Logging.”)

• SDDSN Open Response Timeout (seconds). (Default: 5.) Number of seconds the Alarm Forwarder 
should wait for the initial message from SDDSN after a the connection has been established before 
failing and reporting an error.

• SDDSN Restart Links (seconds). (Default: 5.) The number of seconds the Alarm Forwarder should 
wait before attempting to reconnect to SDDSN.

Step 5 Scroll down to the Debug settings section of the page.
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Step 6 Optionally, use the checkboxes in the Debugging column to select the Subfacilities you want traced and 
reported in the log file. 

Note Only turn Debugging “on” when instructed to do so by your support organization, as doing so 
will affect system performance. They should never be needed but may be used by the support 
organization to diagnose unforeseen problems.

Step 7 Do one of the following:

• Click Update to change the Log Configuration information. Changes take effect as follows:

– Changes to active trace level options take effect immediately. 

– Changes to inactive trace level option take effect when the subfacility is used next time. 

– Changes to SDDSN link configuration take effect immediately. 

– Changes to other option take effect when engine is restarted.

• Click Cancel to cancel any changes and return to the previous page.

Step 8 When finished, link to another page or select File > Close to close the Application Administrator.
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Engine Administration: Log Files 

Use this page to access Application Server Log files that currently exist.

Step 1 From any Engine Administration page, click the Log files link. The Log files page appears, displaying 
a list of the Application Server Log files that currently exist.

Note File names with the extension .old are log files from previous runs. These files will be deleted 
the next time the Application Server starts, or when the number of log files exceeds the 
maximum number of log files allowed.

Step 2 Click a File name link. The Log file displays in a Browser window.

Step 3 When finished with the Log files page, link to another page or select File > Close to close the 
Application Administrator.
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Call Definition Administration 
The Application Server’s Call Definition Administration pages let you:

• Display the existing Call Definition information.

• Modify port and Dialed Number (DNIS) settings. 

• Define the Dialed Number Maximum Length if no Correlation ID Present setting.

• Define the Maximum Number of Calls Allowed setting.

Caution The number of ports you define will determine the number of calls that can be processed 
simultaneously. You should configure about 10 percent more ports than the maximum number 
of simultaneous calls you expect. The extra ports will enable the system to accommodate any 
error-related delays in releasing call resources. 
The maximum number of concurrent sessions should also be larger than the maximum number 
of simultaneous calls.

Application Server Group Numbers

The Application Server divides Web-based calls into two groups:

• Calls pre-routed with a Translation Route or Correlation ID, identified as the ID from ICM group.

• Calls to be presented to ICM software as a new call, identified as the New Call group. 

Note ID for ICM calls result in a “Request Instructions” message being sent to ICM software, which continues 
to run the script for the call. New Call calls result in a “New Call” message being sent to ICM software 
and the call being treated as a new call, even if it had been pre-routed by ICM software.

Each group is set up with a trunk group number. The default for the New Call group is 100; the ID from 
ICM group is 200. The Application Server creates virtual port numbers for handling Web calls. These 
virtual port numbers make it easier to monitor system activity and load. The port numbers must be 
unique (that is, none can be shared between the two groups). If all the port numbers within a group are 
in use, no additional calls will be accepted within the group until a port number is freed.

Correlation ID

ICM software might attach a Correlation ID to the Called Party Number (dialed number) when 
pre-routing a call to the ISN. The Gateway and Voice Browser pass the entire dialed number (with or 
without a Correlation ID) to the Application Server. 

You use the Dialed Number Maximum Length if no Correlation ID Present field on the Call Definitions 
page to identify whether a number has an appended Correlation ID and, if so, which portion of the 
number precedes the Correlation ID: 

• If a dialed number is longer than this value, then the number has the Correlation ID appended, 
starting with the digit indicated in the Dialed Number Maximum Length if no Correlation ID Present 
field. The Application Server places the Correlation ID in a separate field and passes the information 
to ICM software, which uses it to identify the call.
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• If Correlation IDs are not being used for any call in the system, this value is set to 10, the default.

Note ISN does not require DNIS configuration for the Correlation ID.

Translation Route

ICM software might preroute the call using a translation route which defines a temporary DNIS number 
dedicated for the purpose of identifying the call when the VRU informs ICM software of its arrival. The 
Application Server must be configured with all the DNIS numbers that will be used for a translation 
route. A limitation is that each “ID from ICM” call group number must be configured individually.

New Call Group 

ISN does not require DNIS configuration for New Calls.

Example

Suppose the Application Server has been set up with the following configuration:

• Dialed Number Maximum Length if no Correlation ID Present: 10

• ID from ICM group phone numbers: 1000, 1001, 1002, 1003, 1004, 1005, 1006, 1007, 1008, 
1009, 1010, 9005551212

Table 5-3 shows how different Dialed Numbers would be processed:

The sections that follow describe how configure the Call Definition pages.

Table 5-3 Dialed Number Processing

Dialed Number of 
Call Sent to ISN Message Type Sent to ICM

Dialed Number 
Sent to ICM Correlation ID Sent to ICM 

90055512129876 Request Instruction 9005551212 9876 (the digits appearing 
after the Dialed Number 
Maximum Length of 10)

1003 Request Instruction 1003 Not sent

8005551212 New Call 8005551212 Not sent
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MRCP logging tag

The MRCP logging tag is a unique identifier that lets you correlate data records stored on an MRCP 
Voice Recognition Server with data stored in other application databases. Table 5-3 describes how The 
MRCP logging tag for ISN functions.

Table 5-4 MRCP Logging Tag

ISN Deployment 
Model Call Flow Comment

ISN 
Comprehensive

1. A call arrives to an ISN Voice Browser. The Voice Browser 
extracts the H.323 conference ID from the call data and passes it 
to the ISN Application Server in the NEW_CALL message. The 
Application Server sends this identifier to ICM software as the 
user.media.id ECC variable. This ECC variable is then available 
in the Termination_Call_Variable ICM database table. Sample 
value: 02194dbf-3a6d-c683-1bf9-5634343434ef

2. The ISN Voice Browser then sends the call to a VXML-enabled 
Voice Gateway through IP for voice treatment. The Gateway 
extracts the H.323 conference ID of the call and sends this value 
to the ISN Application Server. (This is the same value as the 
conference ID mentioned in Step 1, although formatted 
differently (02194DBF.3A6DC683.1BF95634.343434EF). The 
Application Server inserts this value as the MRCP logging tag 
into the VXML that it returns to the Gateway. The Gateway then 
sends this value to the recognition server via the MRCP interface.    

3. When the script result is returned from the Gateway to the 
Application Server and passed to ICM software, the logging tag 
is then available in the Termination_Call_Variable ICM database 
table. 

Note If the caller hangs up before the first script result is returned 
from the Gateway to the Application Server, the logging tag 
from Step 2 will not be stored in ICM software.

The logging tag format described 
in Step 1 will be available for 
correlating the logging tag on the 
ASR server with the ICM 
database. However, you will 
need to write a script to 
compensate for the formatting 
difference. 

The logging tag format described 
in Step 2 will be available for 
correlating the logging tag on the 
ASR server with the ICM 
database directly (no 
reformatting required) except in 
cases where the caller abandons 
before the script result is 
returned to ICM software. 

ISN Advanced 
Speech

1. A call arrives to a VXML-enabled Voice Gateway. The Gateway 
extracts the unique call identifier of the call and passes it to the 
ISN Application Server in the NEW_CALL message. The 
Application Server sends this identifier to ICM software as the 
media.resource.id ECC variable. This ECC variable is then 
available in the Termination_Call_Variable ICM database table.   
Sample value: 02194DBF.3A6DC683.1BF95634.343434EF

The logging tag format described 
in Step 1 will be available for 
correlating the logging tag on the 
ASR server with the ICM 
database directly (no 
reformatting is required).
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Call Definition Administration: Call Definitions

Use this page to:

• Display the existing Call Definition information.

• Access pages to configure the port group and set up a DNIS value (ID from ICM only). 

• Define the Dialed Number Maximum Length if no Correlation ID Present setting.

• Define the maximum number of calls allowed

Step 1 From the Application Administration Main Page, click the Call Definitions link. The Call Definitions 
page appears.

Step 2 Optionally, click a Group Number link to access port group configuration pages. The defaults are:

• 100 (Type: New Call.) Clicking this link accesses the Port Group Configuration (New Call) page. 
See the “How to modify the New Call Port Group settings” section on page 5-21 for instructions on 
how to use this page.

• 200 (Type: ID from ICM). Clicking this link accesses the Port Group Configuration (ID from ICM) 
page. See the “How to modify the ID from ICM Port Group settings” section on page 5-22 for 
instructions on how to use this page.

Note Each defined Group Number assigns virtual port numbers for handling calls. These virtual port 
numbers make it easier to monitor system activity and load. Port numbers must be unique (that 
is, none can be shared between the two groups). If all the port numbers within a group are in use, 
no additional calls will be accepted within the group until a port number is freed.
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Step 3 Optionally, change the Dialed Number Maximum if no Correlation ID Present setting.

Note You can specify a value up to five characters long to represent the maximum length of the 
DNIS allowed before the remaining digits sent as DNIS by the Voice Browser are treated as 
a Correlation ID. The default is 10, meaning the DNIS can be 10 digits long. 

Step 4 Optionally, change the Maximum Number of Calls Allowed setting. This is the maximum number of 
simultaneous calls allowed in one Application Server, independent of which port group the call is in.

Caution The number of ports you define will determine the number of calls that can be processed 
simultaneously. You should configure about 10 percent more ports than the maximum number 
of simultaneous calls you expect. The extra ports will enable the system to accommodate any 
error-related delays in releasing call resources. 
The maximum number of concurrent sessions should also be larger than the maximum number 
of simultaneous calls.

Step 5 Click Update.

Step 6 When finished, link to another page or select File > Close to close the Application Administrator.

How to modify the New Call Port Group settings

Step 1 Use the Port Group Configuration (New Call) page to modify the New Call settings. 

• Group Number. (Default: 100 for New Call group; 200 for ID from ICM group.) Identifier for the 
group.
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Note While there is no need to change these default settings, making group numbers unique 
throughout a group of Application Servers can help in troubleshooting.

• Initial Port. (Default: No default.) First port in the range of ports configured to handle calls for this 
group.

• Last Port. (Default: No default.) Last port in the range of ports configured to handle calls for this 
group.

Caution The number of ports you define will determine the number of calls that can be processed 
simultaneously. You should configure about 10 percent more ports than the maximum number 
of simultaneous calls you expect. The extra ports will enable the system to accommodate any 
error-related delays in releasing call resources. 
The maximum number of concurrent sessions should also be larger than the maximum number 
of simultaneous calls.

Step 2 Click Update to change the port information or Cancel to return to the previous page. The Port Group 
Configuration (New Call) page closes and the Call Definitions page reappears.

Step 3 When finished, link to another page or select File > Close to close the Application Administrator.

How to modify the ID from ICM Port Group settings

Step 1 Use the Port Group Configuration (ID from ICM) page to modify the ID from ICM settings. 
5-22
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 5      Application Server Administration
Call Definition Administration
• Group Number. (Default: 100 for New Call group; 200 for ID from ICM group.) Group identifier.

Note While there is no need to change these settings, making group numbers unique throughout 
a group of Application Servers can help in troubleshooting.

• Initial Port. (Default: No default.) First port in the range of ports configured to handle calls for this 
group.

• Last Port. (Default: No default.) Last port in the range of ports configured to handle calls for this 
group.

Caution The number of ports you define will determine the number of calls that can be processed 
simultaneously. You should configure about 10 percent more ports than the maximum number 
of simultaneous calls you expect. The extra ports will enable the system to accommodate any 
error-related delays in releasing call resources. 
The maximum number of concurrent sessions should also be larger than the maximum number 
of simultaneous calls.

Step 2 Optionally, click an existing ID from ICM value or the Add New DNIS link. The ID from ICM 
Configuration page appears: 

Step 3 Define or modify a DNIS value. The ISN supports 1-32 numeric DNIS characters. 

Note This differs from DNIS definition in ICM software, which allows alphanumeric characters.
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Step 4 Do one of the following:

• Click Update to add the DNIS information. 

• Click Delete to remove the DNIS information.

• Click Cancel to cancel any changes.

The ID from ICM Configuration page closes and the Port Group Configuration (ID from ICM) 
reappears.

Step 5 Click Update to change the port information or Cancel to return to the previous page. The Port Group 
Configuration (ID from ICM) closes and the Call Definitions page reappears.

Step 6 When finished, link to another page or select File > Close to close the Application Administrator.

ICM Subsystem Configuration 
Use this page to specify the VRU Connection Port Number to be used by both ICM software and the 
Application Engine. 

Step 1 From the Application Administration Main Menu page, click the ICM link. The ICM Subsystem 
Configuration page appears.

Step 2 Specify a VRU Connection Port value. This is the TCP/IP socket number the Application Server will use 
to receive messages from the Cisco ICM’s PIM. (Default: 5000.) 

Step 3 Do one of the following:

• Click Update to save the ICM Configuration information. 

• Click Cancel to cancel any changes and return to the previous page.
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Step 4 When finished, link to another page or select File > Close to close the Application Administrator.
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Directory Administration 
Use this page to set up LDAP directory service access.

Note You should never find it necessary to change these settings.

Step 1 From the Application Administration Main Page, click the Directory link. The Directory Configuration 
page appears.

Step 2 Specify the following:

• Directory hostname. (Default: localhost.) The hostname or IP address of the Cisco IP Telephony 
Directory Server the current application engine uses. 

• Directory port number. (Default: 8404.) The port number used to connect to the Cisco IP 
Telephony Directory. 

Note You only need to change this setting if a conflict arises with this port number. To make 
changes to the port number, you need to stop the Application Server, make the change, and 
then restart the Application Server.

• Directory user (DN). (Default: Directory Manager.) The user name (called a distinguished name) 
on the directory server configured with permission to modify the Cisco IP Telephony Directory tree 
and object entries.

• Directory password. (Default: ciscocisco.) The password that authenticates the distinguished name 
(DN). 
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Step 3 Click OK to update any changes.

Step 4 When finished, link to another page or select File > Close to close the Application Administrator.
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Node Manager and ICM Service Control 

This chapter describes how ISN uses:

• ICM Node Manager.

• Service Control.

Note The primary audience for this chapter is ISN System Managers.

ICM Node Manager
The Node Manager is a process that runs on each physical node (computer) in the ICM system and 
manages other ICM processes on that system. The Node Manager is responsible for initializing nodes, 
monitoring component status, and restarting failed processes. The Node Manager is guided by a 
configuration file that is stored on each node. The file describes, among other things, which processes 
must be started, and, if necessary, restarted on the node.

The Application Server and Voice Browser use the same Node Manager interface as the ICM. You can 
view the states of each node with the ICM Service Control tool. 

ICM Service Control
ICM Service Control is installed on each ICM Admin Workstation, ICM Logger, ICM Peripheral 
Gateway, and ISN machine. It allows you to view, start, and stop all Windows services related to all the 
ICM and ISN software components that have been installed. By enabling the All checkbox, ICM Service 
Control also provides control over all other Windows services. In addition, the Select button provides 
control over services running on other machines. 

How to use ICM Service Control

Step 1 To start the ICM Service Control tool, do one of the following:

• Double-click the ICM Service Control icon in the ICM Software Admin Workstation group.

• Select Start > Programs > Cisco Internet Service Node > ICM Service Control.
6-1
Configuration and Administration Guide



 

Chapter 6      Node Manager and ICM Service Control
ICM Service Control
The ICM Service Control dialog box contains the following:

• Computer Name. (Read-only.) Displays the name of the selected computer where Service Control 
is viewing and controlling services. 

• Select. (Button.) Accesses the Select Computer dialog box. This option allows you to select a 
machine and remotely view and control the services on that machine. To select a remote computer, 
enter the computer name in the text field of the Select Computer dialogue box (or choose it from the 
list) and click OK.

• Close. (Button.) Click this button to exit and close the ICM Service Control tool.

Note All services remain in their current state (running services continue to run) after you close the 
Service Control tool.

• Services. (Column.) Lists the name of the Windows 2000 service. This column also displays a traffic 
light icon which indicates the state of the service.

• State. (Column.) Describes the state of the service. Possible states include: 

– Stopped. The service is stopped.

– Stop Pending. ICM Service Control is in the process of stopping the service.

– Start Pending. ICM Service Control is in the process of starting the service.

– Running. Service is running.

• Startup. (Column.) Indicates whether the Windows 2000 service is automatic (service starts when 
you turn on the computer) or manual (user must start the service).

• All. (Checkbox.) If checked, displays all Windows 2000 services on the machine specified in the 
Computer Name. If not checked, displays only those Windows 2000 services related to ICM 
software.

• Start/Start All. (Button.) Use this button to start a service or services:

– Start All. (The All checkbox is not checked and no services are selected.) Click the Start All 
button to start all ICM services. 
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– Start. (The All checkbox is checked.) You can only control one service at a time. Highlight a 
service and click Start.

Note Do not attempt to start multiple customer AW services or switch between customer AW services 
using Service Control. To properly start and stop AW services, use the AW Select tool.

• Stop/Stop All. (Button.) Use this button to stop a selected service or services.

– Stop All. (The All checkbox is not checked and no services are selected.) Click the Stop All 
button to stop all ICM services. 

– Stop. (The All checkbox is checked.) You can only control one service at a time. Highlight a 
service and click Stop.

Note The Application Administrator tool runs as a web application under IIS (Internet Information 
Server). It doesn’t get shut down when you stop the Application Server. (For more information 
about this tool, see Chapter 5, “Application Server Administration.”)

• Cycle. (Button.) Click this button to stop and restart an active service in a single action.

• Manual/Automatic. (Buttons.) These buttons allow you to switch the startup mode of a selected 
service between manual (user-initiated) and automatic (starts when the computer is turned on). 

Step 2 To remotely view and control services on another machine, click Select. The Select Computer dialog box 
appears.

Step 3 Type a computer name or select a name from the list and click OK. The ICM Service Control window 
reappears, displaying the computer you specified.
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Alarm Handling and Logging

This chapter includes:

• An overview of the Standalone Distributed Diagnostics and Services Network (SDDSN), including 
how to install and configure SDDSN for ISN.

• An introduction to ISN logging and error reporting.

• A discussion of Application Server logging and metrics.

• A discussion of Voice Browser logging and metrics.

Note The primary audience for this chapter is ISN System Managers.

Overview: The Standalone Distributed Diagnostics and 
Services Network (SDDSN) 

The Standalone Distributed Diagnostics and Services Network (SDDSN)—sometimes referred to as the 
Mini Logger—is a component that provides alarm reporting for ISN through a variety of mechanisms:

• SNMP traps.

• CiscoWorks 2000 Syslog, which receives log messages and permits queries on the logs.

• “Phone Home” and NAM/ICM Event Management System (Cisco Remote Monitoring Suite).

Note In an integrated ISN / ICM environment, each product will use its own DDSN mechanism. The ISN has 
an integrated DDSN.
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Figure 7-1 SDDSN Support

The AlarmTracker Client displays alarms from a number of devices which are reporting their alarms 
through the Remote Monitoring Suite. 

Note For more information about the AlarmTracker tool, see Cisco ICM Software (ISN) AlarmTracker Client 
User's Guide.

Installing and Configuring SDDSN for ISN 

The SDDSN software—including Node Manager—is included in the ISN installation by clicking the 
SDDSN checkbox on the Select Components screen.

Note SDDSN needs to be installed on its own machine—it cannot be co-resident with any other ISN or ICM 
product. In addition, Cisco Listener and AlarmTracker software needs to be updated with support files 
for SDDSN. This is done by installing the ISN component Update External SDDSN Components on 
any machine that runs Listener or AlarmTracker.

After ISN is installed, you need to define SDDSN communication settings for each Voice Browser and 
Application Server your ISN configuration. 

• Setting SDDSN in the Voice Browser. For more information, see Chapter 4, “VB Admin 
Configuration Commands.” 
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• Setting SDDSN in the Application Server. For more information, see Chapter 5, “Engine 
Administration: Log Configuration.”

Note For more information about VB Admin, see Chapter 4, “Voice Browser Administration.” For more 
information about Application Administration, see Chapter 5, “Application Server Administration.”

Understanding SDDSN Retry Settings

Another SDDSN setting that may need to be configured on the Application Server and Voice Browser is 
SDDSN Ascending Retries. This setting relates to how the components communicate with instances.

SDDSN can have two instances for redundancy. When the Voice Browser and Application Server report 
alarms to SDDSN, they try one instance and—if unable to connect—then the second SDDSN instance. 
Each time the retry timer expires, the Voice Browser or Application Server attempts to connect again. 

The retries follow a geometric growth for the time between retries. For the Voice Browser, the upper time 
limit for retries is defined through the SetAscendRetries command; for the Application Server, this limit 
is defined through the SDDSN Ascending Retries field on the Engine Administration’s Log 
Configuration page. 

In both cases, a the default value is 5. This means, when both SDDSN instances are having problems, 
the Voice Browser/Application Server will retry after 1 minute, then 4 (2*2) minutes, 9 (3*3) minutes, 
16 (4*4) minutes, then 25 (5*5) minutes. Since the default value is 5, all subsequent retry attempts will 
be spaced 25 minutes apart. 

For example if you changed SetAscendRetries command/SDDSN Ascending Retries field to 4, the 
Voice Browser/Application Server will retry after 1 minute, 4 minutes, 9 minutes, 16 minutes and every 
16 minutes—the upper limit of 4*4—thereafter. 

Event Management System (EMS)
The NAM/ICM Event Management System (EMS) logs events from processes throughout the system 
and stores the event data. For example, a typical EMS event might record that a system component has 
been disconnected.

The EMS also saves events from individual processes, such as the Voice Browser or Application Server, 
in per-process log files on the local computer. These files document events for a specific process running 
on that specific computer.

EMS funnels error messages and log entries into a log file ending with the suffix .ems. This is a file of 
Event Source Records (ESRs). The ESR are the readable strings themselves; to view the events, you must 
use the dumplog utility. 

Note Instructions for using the dumplog utility are given later in this chapter.
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Simple Network Management Protocol (SNMP) and the Management 
Information Base (MIB) 

The Simple Network Management Protocol (SNMP) is the language for communication between a 
managing system running a network management application (such as HP Open View) and a managed 
system running an agent (which for ISN would be SDDSN). Between them they share the concept of a 
Management Information Base (MIB) that defines the information that the agent can make available to 
the manager. 

MIBs and an agent are commonly provided in networked systems to allow remote observation and 
control using management applications on other systems.

ISN’s Voice Browser and Application Server generate messages that are sent to SDDSN. SDDSN then 
generates the SNMP traps that are presented to the managing system. 

MIB File

The Management Information Base (MIB) defines all the information about a managed system that a 
manager can view or modify. The MIB is located on the managed system and can consist of standard and 
proprietary portions. The agent and manager each have their own view of the MIB:

• The agent presents the contents of the MIB and knows how to retrieve that information. 

• The manager might use a MIB description to know what to expect in a given MIB and might store 
that information in a translation that it prefers. 

The Isnlarms.mib file is provided for third party software interpretation of the SNMP traps. The 
Isnlarms.mib file is a text file in standard MIB format and is installed on the Voice Browser and 
Application Server target machine in the directory <destination location>\bin. (For example, 
C:\Cisco\ISN\bin.)

The ISN MIB specifies a number of alarms. Each alarm must include the six variables shown in 
Table 7-1:

Table 7-1 ISN MIB Variables

Variable Description Valid Setting

Originating Node The name of the node (computer) 
within the ISN that originated this 
alarm.

String with maximum size of 32 
characters

Node Type The type of ISN node that 
originated this alarm.

0 - unknown

1 - Voice Browser

2 - Application Server

Originating Process The name of the process that 
originated this alarm.

String with maximum size of 32 
characters
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Other variables may appear in the ISN MIB. 

Alarm Message Text

Alarm message text has the following format:

Alarm Class

Trap ISN can generate for the alarm to SDDSN 

Event ID 

Alarm Text (%# gets replaced with optional parameters)

Alarm Help text 

Alarm severity 

Some alarm classes can generate multiple traps, as show in the example below:

Example 7-1 Sample Alarm Traps for the Voice Browser Status Alarm Class

CLASS_VOICEBROWSER_STATUS
TRAP_VB_RUNNING

EMSG_VB_RUNNING
Voice Browser %1<VB name or IP address> is running.

Voice Browser %1<VB name or IP address> is running.  Call processing is now possible.
Severity : Informational

TRAP_VB_SHUT_DOWN
EMSG_VB_SHUT_DOWN

Voice Browser %1<VB name or IP address> is shut down.
The voice browser %1<VB name or IP address> is shut down.  No calls are being 

processed by this component.
Severity : Informational

Severity The severity of this alarm. 1 - fatal

2 - major

3 - minor

4 - informational

5 - debug

6 - restoral

Timestamp The ISN time at which the alarm 
originated.

In the format YYYMMDD HH:MM:SS 
(24 hour time)

Alarm Event Text The full text of the ISN event that 
generated this alarm. 

For more information, see “Alarm 
Message Text” below. 

Table 7-1 ISN MIB Variables (continued)

Variable Description Valid Setting
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ISN Logging and Error Reporting 
The goal of ISN logging and error reporting is to generate information the system can use to:

• Diagnose a system remotely.

• Automatically report service-affecting events. 

As described in the previous section, SDDSN provides a mechanism for remote diagnosis. Voice 
Browser and Application Server log files—accessible through the dumplog utility—enable local 
diagnosis.

The sections that follow describe:

• Log and trace levels available to the ISN.

• The different methods the Voice Browser and Application Server ISN components use to handle 
logging and error reporting tasks.

Caution You should closely monitor the size of your ISN log files. If they consume too much disk space then the 
ISN will not function properly.

Trace Message Levels 
Log files provide trace messages. Trace levels are defined during ISN installation and configuration. 
Some trace messages—such as catastrophic and service-effecting events—will always be logged, 
regardless of the current trace level settings.

Table 7-2 describes the different message levels.
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In the Application Server, the error-level messages are further subdivided:

• ALERT - Error condition is not recoverable. Results in loss of service or shutdown.

• FATAL - Error condition is not recoverable. Results in loss of service.

• ERROR - Error condition is not recoverable. Results in loss of service.

• WARNING - Recovered from error condition. Does not result in loss of service.

Table 7-2 Trace Message Levels

Message Purpose Message Level Description

Messages intended to help 
diagnose problems caused by 
configuration or network 
errors. 

Informational Includes messages such as:

• Version number at startup

• Initialization messages

• Administrative actions including:

– Registry changes

– Configuration changes

– Shutdown and in/out of service requests

Error Includes messages such as:

• Alarm set/clear – Events that “Phone Home,” create a trap, and go 
to Cisco Works 2000 logs. (Alarm SETs are logged in the 
Operating System Event Log.)

• Events that are not alarms:

– Application errors (that is, errors in the customer 
application).

– Inability to complete ICM requests successfully (the 
Gatekeeper can’t look up a number, called party doesn’t 
answer, busy, etc.).

– Malformed VXML.

– Retries.

– Recoverable internal errors.

Basic Call Detail Includes messages about:

• Call arrival

• Call disconnect

• Call transfer

• Call rejection

Messages intended solely for 
use by your support 
organization or Cisco software 
developers to diagnose 
problems which may be 
software bugs.

Component-Level 
Call Detail 

For use by Cisco Engineering, only.

Debug For use by Cisco Engineering, only.
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In addition, Application Server debug messages are logged as DEBUGGING level messages and tracing 
messages are logged as NOTIFICATION level messages.

Application Server Logging and Metrics
The Application Server has several levels of logging. These settings are turned on/off through the 
Application Administration Web pages. 

Some logging is controlled by the user; some logging–such as entries related to error conditions–is always 
reported. 

Controlling Application Server Logging
You use the Application Administrator tool’s Log Configuration page to define:

• Whether or not the Application Server should produce log files. (It is recommended that the Log 
File Output setting always be “on.” If it is set to “off,” errors and statistics will not be logged.)

• A file name for the log file, consisting of a base and its extension.

• The maximum number of log files to be retained. (The default is 10.) 

• The maximum size for each log file, in bytes. (The default is 1048576.) 

The Application Server uses the file name and maximum number of log files settings to form a list of log 
file names. For example, if the base of the file name is CiscoISN_, its extension is log, and the maximum 
number log files setting is 10, the Application log file list would consist of the following:

CiscoISN_01.log
CiscoISN_02.log
CiscoISN_03.log
CiscoISN_04.log
CiscoISN_05.log
CiscoISN_06.log
CiscoISN_07.log
CiscoISN_08.log
CiscoISN_09.log
CiscoISN_10.log

If you restart the Application Server or exceed the maximum number of files allowed, the Application 
Server renames the existing logs with the extension old (CiscoISN_01.log.old, etc.) and resumes 
logging to the first file in the list (CiscoISN_01.log).

How to configure Application Server log files

Step 1 From any Engine Administration page, click the Log Configuration link. The Log Configuration page 
appears.

Step 2 Use the Log File section to specify the following:

• Log File Output. (Checkbox.) When “on” (checked), the Application Server will produce log files. 

Note It is recommended that the log file output setting always be “on.” If “off,” errors and 
statistics will not be logged.
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• File name. A base file name for the log file and an extension, for example, CiscoISN_ and log.

• Number of Log files. (Default: 10.) Maximum number of log files to be retained.

• Log File Size. (Default: 1048576.) Maximum size for each log file, in bytes.

Step 3 Use the Interface Tracing section to specify the level of how interactions between the Application 
Server and external interfaces should be logged: Call, Basic or Detailed.

Note For a description of each of these levels, see “Application Server Interface Tracing” section on 
page 7-11.

Step 4 Click Update to submit the changes.

Note Accept the defaults for other settings; only turn Debugging “on” when instructed to do so by 
your support organization. (When Debug is “on,” it can affect system performance>)

Application Server Metrics
The Application Server calculates metrics internally for significant events and measurements. These 
metrics are logged at intervals. The interval is configurable and defaults to 30 minutes; any change in its 
setting will take affect at the end of the current interval. 

Note The Application Server metrics counters have been implemented to be light-weight so that they will not 
impact overall system performance. As such, they will generally be accurate most of the time (>99%). 
However, there are some concurrency scenarios that might temporarily make the metrics results slightly 
inaccurate (for instance, counters off by 1 for a given interval). If this occurs, the inaccuracy is corrected 
later when discovered in an interval check. This approach was implemented for performance reasons.

How to view Application Server log files

Step 1 From any Engine Administration page, click the Log files link. The Log files page appears, display a list 
of the Application Server Log files that currently exist.

Step 2 Click a File name link. The Log file displays in a Browser window.

Step 3 When finished with the Log files page, link to another page or select File > Close to close the 
Application Administrator.

Example 7-2 shows metric information written to a Application Server log file. The top lines of the log 
file contain ISN metrics; the final two lines display the ICM metrics. Descriptions of the metric 
categories follow the example. 
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Example 7-2 Sample Log File from Application Server 

16110: Sep 23 19:30:42.250 EDT %ISN-SS_HTTP-6-INFORMATIONAL:
% Sep 23 19:30:42 EDT %ISN metrics -------------------------------------
% Sep 23 19:30:42 EDT % HTTP counts:
% Sep 23 19:30:42 EDT %  Total requests:                 90
% Sep 23 19:30:42 EDT %  Requests in progress:           1
% Sep 23 19:30:42 EDT %  Maximum requests:               2
% Sep 23 19:30:42 EDT % Call counts:
% Sep 23 19:30:42 EDT %  New calls:                      0
% Sep 23 19:30:42 EDT %  Calls ended:                    0
% Sep 23 19:30:42 EDT %  Calls in progress:              0
% Sep 23 19:30:42 EDT %  Maximum calls in progress:      0
% Sep 23 19:30:42 EDT % Throughput in milliseconds:
% Sep 23 19:30:42 EDT %  New call roundtrip average (ms):          0
% Sep 23 19:30:42 EDT %  New call throughput average (ms):0
% Sep 23 19:30:42 EDT %  New call GED average(ms):0
% Sep 23 19:30:42 EDT %  New call roundtrip maximum (ms):          0
% Sep 23 19:30:42 EDT %  New call GED maximum (ms):0
% Sep 23 19:30:42 EDT %  Call event roundtrip average (ms):        0
% Sep 23 19:30:42 EDT %  Call event throughput average (ms):0
% Sep 23 19:30:42 EDT %  Call event GED average(ms):0
% Sep 23 19:30:42 EDT %  Call event roundtrip maximum (ms):        0
% Sep 23 19:30:42 EDT %  Call event GED maximum(ms):0
% Sep 23 19:30:42 EDT %  Node manager ping average (ms): 0
% Sep 23 19:30:42 EDT %  Node manager ping maximum (ms): 0
% Sep 23 19:30:42 EDT
% Sep 23 19:30:42 EDT %  Interval 18 result at Mon Sep 23 19:30:42 EDT 2002
% Sep 23 19:30:42 EDT %  Object memory in use, bytes:    2685272
% Sep 23 19:30:42 EDT %  Object memory free, bytes:      555248
% Sep 23 19:30:42 EDT %  System up 9:30:00

1580: Jun 22 01:11:04.859 EDT %ISN-LIB_ICM-6-INFORMATIONAL:ICM Metrics: ---
% Jun 22 01:11:04 EDT %  ICM Messages in interval:    10
% Jun 22 01:11:04 EDT %  Interval size, seconds:      305.0
% Jun 22 01:11:04 EDT %  ICM messages since startup:  73

Application Server log files report the following metrics:

• HTTP request activity: 

– Number of total requests received this interval 

– Number of requests currently in progress 

– Maximum number of simultaneous requests seen during this interval 

• Calls: 

– Number of new calls this interval. 

– Number of calls ended this interval. 

– Number of calls in progress at snapshot. 

– Maximum number of simultaneous calls handled during this interval. 

• Throughput: 

– New call roundtrip average. Average number of milliseconds a new call took from the time it 
reached the Application Server to the time it returned from the Application Server, including 
ICM and network time. 

– New call throughput average. Average number of milliseconds a new call spent in the 
Application Server itself, excluding ICM and network time.
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– New call GED average. Average number of milliseconds a new call spent waiting in the 
Application Server for the ICM, including network time. 

– New call GED maximum. Maximum number of milliseconds a new call took waiting in the 
Application Server for the ICM, including network time.

– New call roundtrip maximum. Maximum number of milliseconds a new call took from the 
time it reached the Application Server to the time it returned from the Application Server, 
including ICM and network time. 

– Call event roundtrip average. Average number of milliseconds a call event took from the time 
it reached the Application Server to the time it returned from the Application Server, including 
ICM and network time. 

– Call event throughput average. Average number of milliseconds a call event spent in the 
Application Server, excluding ICM and network time.

– Call event GED average. Average number of milliseconds a call event spent waiting in the 
Application Server for the ICM, including network time.

– Call event roundtrip maximum. Maximum number of milliseconds a call event took from the 
time it reached the Application Server to the time it returned from Application Server, including 
ICM and network time. 

– Call event GED maximum. Maximum number of milliseconds a call event took waiting in the 
Application Server for the ICM, including network time.

Note Averages and Maximums are calculated by using current averages (average of calls within 
this interval), not rolling averages (average of calls within a few intervals). Calculated 
numbers in the throughput section are sometimes independent of each other, an may not 
always be added together to achieve uniform results. For example, the New call roundtrip 
average does not always exactly match the sum of the New call throughput average and 
the New call GED average. 

• Metrics interval number (for example, “The Nth metrics interval logged”).

• How long the system has been running (for example, “Uptime”).

• Metrics for the ICM/IVR subsystem:

– Number of ICM messages.

– Number of seconds in the ICM metrics interval.

– Number of ICM messages since startup.

Application Server Interface Tracing

In the Application Server, interface tracing tracks the external interfaces to a component. This tracing is 
useful for troubleshooting solution-level problems. (It is not meant for tracing information within a 
component, which is a debugging effort.) 

Interface tracing messages are logged as NOTIFICATION level messages. There are three levels of 
interface tracing:

• Call. Logs call-handling information. This includes any information about:

– Call arrival

– Call disconnection
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– Call transfer

– Call rejection

Note Call interface tracing does not include tracing each step taken by the ICM.

• Basic. Logs the basic information—such as message type—regarding the component’s interface 
interactions with other components. 

• Detailed. Logs more complete information about the component’s interface interactions with other 
components. 

Table 7-3 provides detailed descriptions of basic and detailed interface tracing.

Note Detailed interface tracing is not available for the Voice Browser for ISN Version 2.0.

Voice Browser Logging and Metrics 
The Voice Browser calculates metrics internally for significant events and measurements. These metrics 
are logged at intervals and/or display on demand. (The interval is configurable.) Measurements for 
particular actions (for example, retrieving a voice file), are counted within the interval in which the 
action completes. 

Controlling Voice Browser Logging and Tracing
You use the following VB Admin commands to control whether metrics are logged and the time interval 
of reporting the periodic metrics:

• SetCallTrace. When “on,” the Voice Browser logs basic call detail information to the console and 
log files. 

• SetInterfaceTrace. When “on,” the Voice Browser logs interface details to the console and log files. 

• SetTraceMask. For use by Technical Support, only.

Note For more information on using these commands to configure the Voice Browser log settings, see 
Chapter 4, “Voice Browser Administration.”

Table 7-3 Application Server’s Basic and Detailed Interface Tracing

Basic Interface Tracing Detailed Interface Tracing

The HTTP subsystem logs each type of message 
it sends or receives. 

The Application Server’s HTTP subsystem logs each 
URL it receives from a Voice Browser and the entire 
VXML it sends. 

The ICM/IVR subsystem logs each ICM/IVR 
message it sends or receives.

The ICM/IVR subsystem logs each ICM/IVR 
message it sends and receives, including information 
such as ECC variables.
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Viewing Voice Browser Logs
Each Voice Browser log begins with the prefix VB_, ends with the file extension .ems, and includes the 
date and time the log was created. The log file name syntax is:

VB_YYMMDD_HHMMSS.ems

For example, the following is the name for a log file is for the Voice Browser process created on February 
8, 2001 at 9:48:39 A.M. 

VB_010208_094839.ems

Note The timestamp on a log file is in 24-hour format. For example, 3:00 P.M. is indicated as 15:00; 9:00 A.M 
is indicated as 09:00.

You view the Voice Browser log files by using the dumplog.exe utility. The dumplog.exe command reads 
the file, formats the event data, and writes the formatted data to the workstation screen. 

Note You can also redirect output to a file. For a complete list of dumplog utility features and options, see the 
Cisco ICM Software Administrator Guide.

How to view Voice Browser log files

Step 1 Open a DOS Command Prompt window.

Step 2 Change to the <Drive Letter>:\<Targetdir>\VoiceBrowser\logfiles directory, where:

• <Drive Letter> is the drive location of the logfiles directory, for example, G.

Note To access dumplog from a remote machine, you must first map the drive on the target machine 
so that you can point dumplog to the appropriate directory.

• <Targetdir>is the location of the base ISN directory, for example, Cisco\ISN.

Step 3 Enter the dumplog command using the following syntax:

dumplog /if <filename>

where <filename> is the log file that you want to view (for example, VB_010208_094839.ems). 
The log information displays.

Step 4 When finished, close the DOS Command Prompt window.
7-13
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 7      Alarm Handling and Logging
Voice Browser Logging and Metrics
Example 7-3 shows the contents of a Voice Browser Log file. Descriptions of each file section follow the 
example. 

Example 7-3 Sample Voice Browser Log File (VB Process)

-------Voice Browser Interval Statistics------- 
19:44:34:234 VoiceBrowser-VB Trace: Calls:  
19:44:34:234 VoiceBrowser-VB Trace:   Interval Statistics: 
19:44:34:250 VoiceBrowser-VB Trace:       Interval size:                         180 
19:44:34:265 VoiceBrowser-VB Trace:       New calls this interval:               519 
19:44:34:265 VoiceBrowser-VB Trace:       Max call arrival per second:           5.2 
19:44:34:281 VoiceBrowser-VB Trace:       Calls transferred this interval:       738 
19:44:34:296 VoiceBrowser-VB Trace:       Max IP Transfer per second:            5.2 
19:44:34:296 VoiceBrowser-VB Trace:       Calls rejected this interval:          0 
19:44:34:312 VoiceBrowser-VB Trace:       Transfers not completed this interval: 0 
19:44:34:312 VoiceBrowser-VB Trace:       Prompts not found this interval:       0 
19:44:34:328 VoiceBrowser-VB Trace:       Calls using critical media:            0 
19:44:34:328 VoiceBrowser-VB Trace:       Calls finished this interval:          522 
19:44:34:343 VoiceBrowser-VB Trace:       Avg New Call Latency (ms):             308 
19:44:34:343 VoiceBrowser-VB Trace:       Max New Call Latency (ms):             671 
19:44:34:359 VoiceBrowser-VB Trace:       Min New Call Latency (ms):             156 
19:44:34:359 VoiceBrowser-VB Trace:       Std Dev. New Call Latency:             96 
19:44:34:375 VoiceBrowser-VB Trace:       Avg Transfer Time to Alert(ms):        208 
19:44:34:375 VoiceBrowser-VB Trace:       Max Transfer Time to Alert(ms):        3235 
19:44:34:390 VoiceBrowser-VB Trace:       Min Transfer Time to Alert(ms):        156 
19:44:34:390 VoiceBrowser-VB Trace:       Std Dev. Transfer Time to Alert:       132 
19:44:34:406 VoiceBrowser-VB Trace:       Avg Transfer Time to Answer (ms):      713 
19:44:34:406 VoiceBrowser-VB Trace:       Max Transfer Time to Answer (ms):      2235 
19:44:34:421 VoiceBrowser-VB Trace:       Min Transfer Time to Answer (ms):      78 
19:44:34:421 VoiceBrowser-VB Trace:       Std Dev. Transfer Time to Answer:      337 
19:44:34:437 VoiceBrowser-VB Trace:       Avg CPU Usage (percent):               22 
19:44:34:437 VoiceBrowser-VB Trace:       Max CPU Usage (percent):               31 
19:44:34:453 VoiceBrowser-VB Trace:       Min CPU Usage (percent):               15 
19:44:34:453 VoiceBrowser-VB Trace:       Std Dev. CPU Usage(theta):             4 
19:44:34:468 VoiceBrowser-VB Trace:   -Application Server: boxer:8000 
19:44:34:468 VoiceBrowser-VB Trace:       Avg Call Event Latency (ms):           254 
19:44:34:484 VoiceBrowser-VB Trace:       Max Call Event Latency (ms):           547 
19:44:34:484 VoiceBrowser-VB Trace:       Min Call Event Latency (ms):           125 
19:44:34:500 VoiceBrowser-VB Trace:       Standard Deviation(theta):             87 
19:44:34:500 VoiceBrowser-VB Trace:       Number of Call Events:                 519 
19:44:34:515 VoiceBrowser-VB Trace:   -Application Server: 10.86.137.27:8000 
19:44:34:515 VoiceBrowser-VB Trace:       Avg Call Event Latency (ms):           177 
19:44:34:531 VoiceBrowser-VB Trace:       Max Call Event Latency (ms):           672 
19:44:34:546 VoiceBrowser-VB Trace:       Min Call Event Latency (ms):           0 
19:44:34:546 VoiceBrowser-VB Trace:       Standard Deviation(theta):             76 
19:44:34:562 VoiceBrowser-VB Trace:       Number of Call Events:                 2626 
19:44:34:578 VoiceBrowser-VB Trace: 

-------Voice Browser Snapshot Statistics------- 
19:44:34:578 VoiceBrowser-VB Trace:   Snapshot Statistics:                        
19:44:34:593 VoiceBrowser-VB Trace:       Calls In Progress:                     131 
19:44:34:609 VoiceBrowser-VB Trace:       Calls Waiting for VXML:                2 
19:44:34:625 VoiceBrowser-VB Trace:       Calls Playing Prompts:                 16 
19:44:34:625 VoiceBrowser-VB Trace:       IVR Ports in use:                      22 
19:44:34:640 VoiceBrowser-VB Trace:       Calls Waiting for DTMF:                0 
19:44:34:640 VoiceBrowser-VB Trace:       Calls Transferring:                    4 
19:44:34:640 VoiceBrowser-VB Trace:       Calls Transferred:                     109 
19:44:34:640 VoiceBrowser-VB Trace:       Calls Disconnecting:                   0 
19:44:34:640 VoiceBrowser-VB Trace:       Calls Disconnected:                    0 
19:44:34:656 VoiceBrowser-VB Trace:       New calls:                             0 
19:44:34:656 VoiceBrowser-VB Trace:       Other:                                 0 
19:44:34:656 VoiceBrowser-VB Trace:       Internal Call count:                   407 
19:44:34:671 VoiceBrowser-VB Trace: 
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-------Voice Browser Total Statistics----------- 
19:44:34:671 VoiceBrowser-VB Trace:   Since Startup:                              
19:44:34:687 VoiceBrowser-VB Trace:       Total Calls:                           24962 
19:44:34:687 VoiceBrowser-VB Trace:         Disconnect Disposition:               
19:44:34:703 VoiceBrowser-VB Trace:           Rejected:                          0 
19:44:34:703 VoiceBrowser-VB Trace:           Caller Hangup:                     24828 
19:44:34:703 VoiceBrowser-VB Trace:           Called Party Hangup:               1 
19:44:34:718 VoiceBrowser-VB Trace:           ICM Release:                       3 
19:44:34:718 VoiceBrowser-VB Trace:           Critical Media:                    0 
19:44:34:718 VoiceBrowser-VB Trace:       Max Simultaneous Calls:                149 
19:44:34:734 VoiceBrowser-VB Trace:       Max IVR Ports:                         53 
19:44:34:734 VoiceBrowser-VB Trace:       Total prompts not found:               0 
19:44:34:734 VoiceBrowser-VB Trace:       Total transfers not completed:         1 
19:44:34:750 VoiceBrowser-VB Trace:          Busy:                               0 
19:44:34:750 VoiceBrowser-VB Trace:          Ring-no-answer:                     0 
19:44:34:765 VoiceBrowser-VB Trace:          Gatekeeper problem:                 0 
19:44:34:765 VoiceBrowser-VB Trace:          Destination problem:                1 
19:44:34:765 VoiceBrowser-VB Trace:          Other:                              0 
19:44:34:781 VoiceBrowser-VB Trace:       System Startup Time:                   Feb 24 2003, 17:17:36 
19:44:34:781 VoiceBrowser-VB Trace:       System UpTime:                         0 Days, 02 Hours, 26 
Minutes, 58 Seconds 
19:44:34:796 VoiceBrowser-VB Trace:       Current State:                         In Service 
19:44:34:796 VoiceBrowser-VB Trace:       Packets Transmitted(approx):           9.097e+006 
19:44:34:796 VoiceBrowser-VB Trace: 

--------- Current Alarms --------- 
19:44:34:812 VoiceBrowser-VB Trace:   None

Voice Browser Log Contents
There are four sections in the Voice Browser log file:

• Interval Statistics

• Snapshot Statistics

• Total Statistics

• Current Alarms

Each section is described below.

Interval Statistics

The Interval Statistics section of the log file contains a series of counts, averages, and maximums 
during a specific interval. 

Note Averages, Minimums and Maximums, and Standard Deviations are calculated by using current data (that 
is, the average of calls within this interval), not rolling averages (that is, the average of calls over several 
intervals).

Statistics generated include:

• Interval Size.

• Maximum call arrival per second.

• Number of new calls this interval.

• Number of calls transferred this interval.
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• Max IP Transfer per second.

• Number of calls rejected (calls are rejected when the Voice Browser is out of service).

• Number of transfer errors this interval.

• Number of prompts not found this interval. 

• Number of calls using critical media. This is the number of calls that were prematurely terminated 
because of internal errors. In this case, a “system error” message is played to the caller.

• Calls finished this interval this interval (even if they began during a previous interval).

• Average, Maximum, and Minimum latencies, and Standard Deviation in processing new calls. This 
does not include the “ring wait” time of the caller. It only measures the latency from the time the 
Voice Browser recognizes the incoming call to the time the first voice prompt is played to the caller. 
The gateway and/or switch will have average latencies for the amount of time is spent waiting for 
the Voice Browser to pick up the call.

• Average, Maximum, and Minimum latencies, and Standard Deviation in processing transfers, 
measuring the time from when the Voice Browser receives the Transfer command from the 
Application Server to the time of alerting.

• Average, Maximum, and Minimum latencies, and Standard Deviation in processing transfers, 
measuring the time from alerting to when the called party answers.

• Average, Maximum, and Minimum CPU Usage (in percent) and Standard Deviation (theta).

Note These transfer measurements are taken regardless of whether the called party sits behind a Voice 
Gateway or Call Manager. In addition, if a transfer is not successfully established (for example, 
if the called party does not answer or is busy) the call will not be included in the latency 
statistics.)

• For each Application Server:

– The Average, Maximum, and Minimum Event Latencies, and the Standard Deviation in 
communicating with the Application Server for call processing requests.

– The number of call events. A call event is defined as a request to the Application Server from 
the Voice Browser. 

Note When the Application Server is a DNS hostname, it represents a new call event. The hostname 
will show up only when a hostname has been given in the list of Application Servers. This 
latency will always be slightly less than the New Call latency discussed above because it 
measures only the time spent in making the request to the Application Server. It does not include 
the extra processing overhead in the Voice Browser for preparing the request. When the 
Application Server listed is an IP address, it represents all subsequent call events in the call. 

• For each Media Server (when available):

– The Average, Maximum, and Minimum time to retrieve prompt files expressed in bytes per 
millisecond. 

– The number of prompts (“files”) retrieved.
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Snapshot

The Snapshot section of the log file contains a count of all calls in progress, with subtotals for each call 
state. Call states include: 

– Calls in Progress.

– Calls Waiting for VXML (or response from the Application Server).

– Calls Playing Prompts.

– IVR Ports in use.

– Calls Waiting for DTMF.

– Calls Transferring.

– Calls Transferred.

– Calls Disconnecting. 

– Calls Disconnected (calls that have disconnected but software processing is not complete).

– New Calls (calls that have arrived, but treatment has not started).

– Internal Call Count. 

– Other.

These last two states are important for troubleshooting:

• Calls should not stay in the Calls in a Waiting State for very long. If you see the number in this state 
increasing over time, it indicates that a problem is occurring. 

• Calls should never be in the “Other” state. The state exists solely as a “catch-all” for problem calls.

Total Statistics

The Total Statistics section of the log file contains cumulative statistics since the time the Voice Browser 
was started. This section includes information regarding:

• The number of Total Calls, including their Disconnect Disposition:

– Rejected. If a call comes to the Voice Browser that is Out Of Service or has reached maximum 
capacity, the call is rejected. If alternate endpoints have been set up in the Gatekeeper or 
Gateway dial-peers, these rejected calls will be re-directed to an alternate Voice Browser.

– Caller Hangup. This counter is incremented when the caller initiates the hangup. 

– Called Party Hangup. This counter is incremented if the called party hangs up first during an 
IP transfer. 

– ICM Release. This counter is incremented when the call is disconnected by the Voice Browser 
as a result of a RELEASE instruction from the ICM. For example, it could be incremented in 
the event of a Transfer Error, as the Voice Browser reports back an error to ICM and then ICM 
sends a RELEASE instruction.

– Critical Media. The total number of calls which terminated abnormally and played the “system 
error” message.
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Note Disconnect Disposition reasons are mutually exclusive. For example, if critical media is played 
to the caller and the caller hangs up while listening to the message, this is considered a “critical 
media disconnect,” not a caller hangup. When no calls are going through the Voice Browser, 
Total Calls should equal the total number of calls listed under Disconnect Disposition. While 
calls are in progress, however, this will not be the case, since Total Calls is incremented when 
the call first arrives, but Disconnect Disposition is not incremented until the call is terminated.

• Maximum simultaneous calls.

• Total Prompts not found.

• Total transfers not completed. The total number of transfers that have not completed since startup. 
The errors are sorted into the following categories:

– Busy.

– Ring no answer.

– Gatekeeper problem. (The Gatekeeper was unable to resolve the label for the transfer.)

– Destination problem. (The destination–that is, the Gateway or Call Manager–rejected the call.)

– Other

• System Startup time. Clock time that the Voice Browser started.

• System UpTime. Number of hours/minutes/seconds that the Voice Browser has been running.

• Current State. Either In Service or Out of Service

• Packets transmitted. Total number of RTP packets that have been transmitted since the Voice 
Browser was started.

Current Alarms

Error conditions that the Voice Browser is reporting.

ISN Anti-Virus Guidelines
The following general guidelines are recommended for using anti-virus products with the ISN:

• For on-access scanning, exclude the following Cisco log files:

– \Cisco\ISN\ApplicationServer\*.log

– \Cisco\ISN\ApplicationServer\logfiles\*.ems

– \Cisco\ISN\AlarmForwarder\logfiles\*.ems

– \Cisco\ISN\VoiceBrowser\logfiles\*.ems

Note \Cisco\ISN is the default target directory, however, the ISN target directory might have been 
changed to a different location during installation.

• For on-access scanning, files need not be scanned when being read from local disks, as long as the 
entire set of local files has been previously scanned when written.
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• Scheduled local disk scans are resource-intensive and might impact performance. If required, they 
should be run during “maintenance time,” when there is little-to-no call activity. If calls must be 
handled during this time window, then the scan priority setting should be as low as possible.

Note These guidelines have been tested using the anti-virus product “NetShield for Windows NT and 
Windows 2000 4.5” from Networks Associates. 

Table 7-4 shows settings you might make using NetShield AntiVirus Console.

Table 7-4 Sample Anti-Virus Settings

Task Properties Tab Suggested Settings

Scan > Properties Detection The Outbound files (that is, files being read) need not be 
checked.

Exclusions On both the Voice Browser and Application Server, the 
File, folder or drive to exclude: *.ems, plus the 
following:

• Include subfolders: Off

• Inbound: On

• Outbound: On

On the Application Server, only, the File, folder or drive 
to exclude: *.log, plus the following:

• Include subfolders: Off

• Inbound: On

• Outbound: On

Scan > Local Drives 
(scheduled scan)

Advanced • Scan priority: Low (if no maintenance time window 
exists)

• Schedule tab: (maintenance time window)
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VoIP Configuration

This chapter contains information about VoIP configuration for:

• Using ISN and IP Phones with Cisco Call Manager.

• Inbound routing.

• Outbound routing.

It also describes some limitations that exist in the ISN Version 2.0 Voice Browser concerning interaction 
with VoIP endpoints. 

For an overview of how the ISN uses Voice over IP Routing, see the Cisco Internet Service Node (ISN) 
Product Description. 

Note Audience: Call Center Managers, ISN System Managers, VoIP Technical Experts, ICM/NAM System 
Managers. 

Using ISN and IP Phones with Cisco Call Manager
The ISN can route calls to Cisco IP Phones, using the signaling services of the Cisco Call Manager 
(CCM), which acts as an H.323 Gateway for the IP Phones. 

Note ISN Version 2.0 supports inbound calls to ISN from IP Phones in all three of the deployment models. But see 
ISN Endpoint Limitations, page 8-14.

While the CCM is similar in some respects to Voice Gateways such as the AS5300, there are also 
significant differences. For ISN purposes, the most noteworthy difference is that the CCM does not 
support DNS lookups. Thus, when no Gatekeeper is present, all call routing configuration is performed 
on the CCM.

For ISN to connect to IP Phones through CCM, certain configuration rules must be followed. 
Specifically, the ISN Voice Browsers must be defined as Gateways on CCM, which enables CCM to 
receive multiple calls from the Voice Browsers.
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How to define a Voice Browser as a Gateway

The ISN Voice Browsers must be defined as Gateways on CCM, which allows CCM to receive multiple 
calls from the Voice Browsers. 

Step 1 Logon to the Cisco Call Manager Admin Page.

Step 2 Select Device > Gateway. 

Step 3 Click Find. CCM lists the Gateways that are currently registered. 

Step 4 If your Voice Browser is not listed, click Add A New Gateway and specify the following:

• Gateway Type. H.323 Gateway.

• Device Protocol. H.225.

Step 5 Click Next.

Step 6 Specify the following:

• Device Name. Voice Browser IP address.

• Description. Voice Browser IP address (or other identifying text).

• Device Pool. Default.

• Calling Party. Originator.

• Presentation Bit. Allowed.

• Gatekeeper Name. IP address of Gatekeeper.

Step 7 Click Insert.

Inbound Call Routing
At the highest level, ISN inbound call routing on an H.323 IP network is determined by the absence or 
presence of an H.323 Gatekeeper.

The choice of whether to use a Gatekeeper is typically determined by the network’s size and/or 
complexity. In general:

• Smaller/simpler networks consisting of 100 or less H.323 endpoints can function without using a 
Gatekeeper. 

• Larger, more complex networks often require a Gatekeeper to consolidate routing information.

Gatekeepers can provide additional services such as bandwidth control, and permit access to advanced 
routing servers such as Cisco’s NAM/ICM.

Note A Gatekeeper is required for outbound routing from the ISN, except in Advanced Speech mode. H.323 
protocol states that when a Gatekeeper is used, it must be used for all routing in its zone (that is, for 
inbound calls as well), but this rule is often ignored in practice.
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If a Gatekeeper is not required, then the Gateways should be configured with multiple dial-peers for each 
dialed number requiring ISN treatment. Multiple dial-peers can provide nearest ISN node routing and 
failover routing. The dial-peers can either be explicit IP Addresses or Domain Names (which provide 
additional flexibility). 

If a Gatekeeper is required, then multiple Voice Browser targets should be configured on the Gatekeeper 
for each dialed number requiring ISN treatment. The Gatekeeper updates its target lists with real time 
information, which reduces the risk that a Gatekeeper will route the inbound call to an unavailable Voice 
Browser. 

Note To offset the remaining risk, the Gatekeeper should be configured with a list of alternate endpoints for 
each Voice Browser. While the Gatekeeper does not currently update its alternate endpoint lists with real 
time information, the alternate endpoint functionality is nonetheless useful to provide an extra layer of 
redundancy. 

Finally, if nearest ISN node routing is desired when a Gatekeeper is present, the network can be divided 
into separate H.323 zones.

Inbound Call Routing—Without Gatekeeper
When no Gatekeeper is present, Inbound call routing to the ISN is controlled by dial plan information 
configured at each H.323 originating endpoint. The sections that follow assume that these originating 
endpoints are H.323 Gateways.

Gateway Examples

Figure 8-1 shows an H.323 network with three AS5300 Voice Gateways (Huey, Dewey, and Louie), three 
proximate ISN nodes, and a Domain Name Server (DNS). Each ISN node contains two Voice Browsers 
with the IP addresses shown:

Figure 8-1 Inbound Call Routing, No Gatekeeper

In this example, calls to several toll free numbers {800-555-0020 through 0029} require ISN treatment 
before they are routed to their final destination. To enhance performance, we wish the Gateways to first 
route ISN calls to Voice Browsers in the nearest ISN node. For failover purposes, if the nearest ISN node 
is unavailable, we wish the Gateways to route ISN calls to Voice Browsers in an alternate ISN node.
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There are different ways to accomplish this. We illustrate two of them here, using Gateways Huey and 
Dewey:

Gateway Huey 

Gateway Huey is configured to default route all dialed numbers not defined as dial-peers to the PSTN. 
Huey’s dial-peer Session Targets are IP Addresses, configured as shown in Example 8-1.

Note In this example, it is assumed that ISN_Node1 supports g711 ulaw and ISN_Node2 and ISN_Node3 
support g711 alaw.

Example 8-1 Inbound Call Routing Gateway Huey Configuration

Note In all occurrences of “voice-class codec 1” the actual values are adjustable to your needs.

voice-class codec 1 *\ Defines the class (applies to all dial-peers) \*
codec preference 1 g711ulaw
codec preference 2 g711alaw
codec preference 3 g729r8

dial-peer voice 1 voip
voice-class codec 1
destination-pattern 800-555-002. *\ The “.” is a wildcard \*
session target ipv4: 10.10.10.11
dtmf-relay rtp-nte h245-signal h245-alphanumeric
preference 0
no vad (comprehensive IVR mode only)

dial-peer voice 2 voip 
voice-class codec 1
destination-pattern 800-555-002. *\ The “.” is a wildcard \*
session target ipv4: 10.10.10.12
dtmf-relay rtp-nte h245-signal h245-alphanumeric
preference 0
no vad (comprehensive IVR mode only)

dial-peer voice 3 voip 
voice-class codec 1
destination-pattern 800-555-002. *\ The “.” is a wildcard \*
session target ipv4: 10.10.10.21
dtmf-relay rtp-nte h245-signal h245-alphanumeric
preference 1
no vad (comprehensive IVR mode only)

dial-peer voice 4 voip 
voice-class codec 1
destination-pattern 800-555-002. *\ The “.” is a wildcard \*
session target ipv4: 10.10.10.31
dtmf-relay rtp-nte h245-signal h245-alphanumeric
preference 2
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no vad (comprehensive IVR mode only)

Calls to numbers not in the above list of dial-peers will be routed by Gateway Huey to the PSTN. 

If a call is received for 800-555-0020 through 0029, Huey will first attempt to route the call to one of the 
two Voice Browsers in ISN_1, since they have the lowest preference value (0). This will be done in 
random fashion over successive calls. If none of the Voice Browsers in ISN_1 respond properly, Huey 
will then attempt to route the call to the next lowest preference value (1), which is a Voice Browser in 
ISN_2. Failing that, Huey will attempt to route the call to a Voice Browser in ISN_3.

Note A similar set of dial-peers would be needed for each additional phone number (or contiguous range of 
numbers) requiring routing in this fashion.

Gateway Dewey

Gateway Dewey is also configured to default route all dialed numbers not defined as dial-peers to the 
PSTN. However, Dewey’s dial-peer Session Targets are Domain Names, configured as show in 
Example 8-2.

Example 8-2 Inbound Call Routing Gateway Dewey Configuration

Note In all occurrences of “voice-class codec 1” the actual values are adjustable to your needs.

voice-class codec 1 *\ Defines the class (applies to all dial-peers) \*
codec preference 1 g711ulaw
codec preference 2 g711alaw
codec preference 3 g729r8

dial-peer voice 1 voip 
voice-class codec 1
destination-pattern 800-555-002. *\ The “.” is a wildcard \*
session target dns: isn_2@cisco.com
dtmf-relay rtp-nte h245-signal h245-alphanumeric
preference 0
no vad (comprehensive IVR mode only)

dial-peer voice 2 voip 
voice-class codec 1
destination-pattern 800-555-002. *\ The “.” is a wildcard \*
session target dns: isn2_backups@cisco.com
dtmf-relay rtp-nte h245-signal h245-alphanumeric
preference 1
no vad (comprehensive IVR mode only)

Calls to numbers not in the list of dial-peers will be routed by Gateway Dewey to the PSTN.

If a call is received for 800-555-0020 through 0029, Gateway Dewey will first perform a DNS lookup 
on the Domain Name “isn_2@cisco.com.” In this example, the DNS will map this domain name to 
10.10.10.21 and 10.10.10.22, which will cause Dewey to route the call to a Voice Browser in ISN_2. 
However, if ISN_2 does not respond properly, Dewey will then perform a DNS lookup on the Domain 
Name “isn2_backups@cisco.com.” In this example, the DNS will map this domain name to 10.10.10.11 
and 10.10.10.31, which will cause Dewey to route the call to a Voice Browser in ISN_1 or a VB in ISN_3.
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Inbound Call Routing—With Gatekeeper
When a Gatekeeper is present, Inbound call routing to the ISN is controlled by information kept at one 
or more H.323 Gatekeepers. H.323 enforces the concept of zones, where a single logical Gatekeeper 
(which may be one or more actual Gatekeepers) is responsible for routing control within its zone. 

For ease of illustration, we will initially assume that all the ISN nodes reside within the same H.323 
zone, the “ISN Zone.” 

Gatekeeper Configuration Example

Figure 8-2 shows the ISN nodes and Gateways separated into three different H.323 zones:

• ISN_1 and GW Huey are assigned to Zone 1, which is controlled by GK_1.

• ISN_2 and GW Dewey are assigned to Zone 2, which is controlled by GK_2.

• ISN_3 and GW Louie are assigned to Zone 3, which is controlled by GK_3. 

Each ISN node contains three Voice Browsers, with the IP addresses shown. As with the “Gateway 
Examples” section, it is assumed that each of the Voice Browsers have registered with its Gatekeeper, 
and that the Gateways are configured—for details, see “Gateway Configuration” section on page 8-8—to 
perform RAS lookups in their Gatekeeper for incoming calls.

Figure 8-2 Inbound Call Routing, With Gatekeepers

Each Gatekeeper is configured with the complete list of supported numbers, which only point to Voice 
Browsers at the ISN node in its zone. Each Gatekeeper is also configured with alternate endpoint 
information for each Voice Browser, with each Voice Browser indicating two alternate endpoints from 
its own ISN node, as shown in Example 8-3.

Example 8-3 Inbound Call Routing GK_1 Configuration

zone local gk_1 cisco.com 10.10.10.00 *\ Must include GK IP address \*
gw-type-prefix 1#* default-technology *\ Default for calls rec’d with no tech-prefix\*
zone prefix gk_1 8005550010 gw-pri 10 isn_1vb1@cisco.com isn_1vb2@cisco.com
endpoint alt-ep h323id isn_1vb1 10.10.10.12
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endpoint alt-ep h323id isn_1vb1 10.10.10.13
endpoint alt-ep h323id isn_1vb2 10.10.10.11 
endpoint alt-ep h323id isn_1vb2 10.10.10.13

The two Voice Browsers in the zone prefix command have equal priorities (pri 10), so under normal 
circumstances the GK will route all calls randomly between vb1 and vb2. For the purpose of our 
example, however, GK_1 knows that vb1 (at ISN_1) is completely Out-of-Service.

Each of the Gateways queries its own Gatekeeper for Inbound calls, so if Gateway Huey receives a call 
for 800-555-0010, it will query GK_1 for routing information, using the number 2#8005550010. Since 
vb1 is Out-of-Service, GK_1 will return the IP Address of vb2 to Huey, as the target endpoint. In the 
same response message (an H.323 ACF message) GK_1 will also pass the IP Addresses of vb2's 
Alternate Endpoints (which in this example are vb1 and vb3 at ISN_1). Huey will first attempt to route 
the call to vb2. If for some reason vb2 fails to respond to the call setup, Huey will try the alternate 
endpoints in turn, until it receives a response. Huey will pass the number 2#8005550010 to the Voice 
Browsers during call setup, which will in turn strip off the tech prefix 2#.

Caution When defining a zone prefix, it strongly suggested that you use the “*” wildcard, rather than the “...” 
wildcard pattern to avoid zone prefix conflicts within the Gatekeeper.

ISN Voice Browser Configuration

The Gatekeeper processes Voice Browser registration as follows:

• RRQ registration. ISN Voice Browsers register with the ISN Zone Gatekeeper through the H.323 
Registration Request (RRQ) message. As part of RRQ registration, each Voice Browser sends its 
name (for example, “isn_1vb1@cisco.com”) and IP address.

• IP Addresses for Alternate Endpoints. The Gatekeeper allows each registering endpoint to send a 
list of IP Addresses for its alternate endpoints. This registration list is merged with any alternate 
endpoint information statically configured on the Gatekeeper. 

Note This feature is not supported by ISN Version 2.0. 

• Supported Numbers. The Gatekeeper allows each endpoint to register with a list of E.164 numbers 
it supports, but it is recommended that the Voice Browsers don't do this. The reason for this is that 
multiple Voice Browsers can support the dialed numbers, but the Gatekeeper does not permit 
multiple endpoints to register with the same number.

• Technology Prefix. Each ISN Voice Browser is automatically registered with its Gatekeeper with 
the Tech Prefix 2#. The Voice Browser’s software is shipped with the tech-prefix 2# pre configured. 
If necessary, this number may be changed using the VB Admin’s SetTechPrefix command.
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Gateway Configuration

Since a Gatekeeper is present in the configuration, the Gateway’s role can be minimized. It is 
recommended that the Gateways be configured to always query the Gatekeeper for routing information. 
This can be done using a wildcard dial-peer, as shown in Example 8-4.

Example 8-4 Inbound Call Routing Gateway Configuration

Note In all occurrences of “voice-class codec 1” the actual values are adjustable to your needs.

dial-peer voice 1 voip 
voice-class codec 1
destination-pattern 888800... *\ The wildcard pattern\*
session target ras
dtmf-relay rtp-nte h245-signal h245-alphanumeric
preference 0
no vad (comprehensive IVR mode only)
tech-prefix 2#

Gateways not in the ISN zone must be configured to query their own zone Gatekeeper for routing 
information. The originating Gatekeeper will discover the ISN Zone Gatekeeper through the H.323 
Location Request (LRQ) message. The ISN Zone Gatekeeper will determine proper routing, which will 
be returned to the originating Gateway (via the originating Gatekeeper).

Call Transfers and Outbound Routing
This section examines initial call transfer from the ISN, specifically, how the NAM/ICM, ISN, 
Gatekeeper, and Voice Gateways work together to perform H.323-based call transfer.

Note Subsequent call transfers (such as agent initiated transfers), being similar to the examples described 
below, are not discussed separately. One important difference, however, is that the 
Call.NetworkTransferEnabled variable must be set to 1 in each script that contains network transfer 
instructions.

IP Transfer Example (ACD Routing)
The ISN uses a Gatekeeper to determine the correct VoIP endpoint to transfer calls to when it uses the 
IP mode. In Figure 8-3, our endpoints are two AS5300 Voice Gateways, Moe and Larry, which provide 
redundant access to a call center ACD. Moe has the IP address 10.10.10.1, while Larry has the IP address 
10.10.10.2. For simplicity’s sake, we assume the Gateways and the ISN are in the same H.323 zone, 
controlled by Gatekeeper Stooge.
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Figure 8-3 IP Transfer Routing

In this example, the ACD uses a numbering plan in the format xxxxyyzzzz, where:

• xxxx is a location code (8888 for the ACD in our example)

• yy is the destination trunk group on the ACD

• zzzz is the DNIS (Dialed Number Identification Service), identifying an ACD agent skill group, 
service, extension, etc. 

The ISN initiates the transfer using all these digits:

• The Gatekeeper uses the xxxx digits to determine a destination Gateway.

• The Gateway uses the yy digits to determine the correct ACD trunk group. 

• The Gateway outpulses the zzzz digits to the proper ACD trunk group, which uses them to connect 
the call to an agent.

Since the ACD numbering plan is simple and well-known, we specify the routing 
information—including Alternate Endpoint instructions—directly on the Gatekeeper, instead of having 
the Gateways pass the information during Gatekeeper registration. (In fact, since Moe and Larry support 
the same set of numbers, the Gatekeeper would not even allow them to jointly register with those same 
numbers).

Caution In cases where an agent is reserved on the ICM, it is strongly recommended that the outbound alternate 
endpoint functionality not be used when the ISN routes the call to the agent. This will prevent the 
unacceptable condition where the agent reserve timer expires before the call arrives, allowing a different 
call to reach the agent that does not match the call data previously sent to the agent by the ICM software. 
Router requery is the preferred method.

Gatekeeper Stooge is configured as shown in Example 8-5. 

Example 8-5 Gatekeeper Stooge Configuration

zone local gk-stooge cisco.com 10.10.10.00 *\ Must include GK IP address 
gw-type-prefix 1# default-technology

* \ Default for calls received with no tech-prefix indicated.
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zone prefix gk-stooge 8888* gw-pri 10 gwMoe@cisco.com gwLarry@cisco.com 
* \ GK to route calls with leading digits 8888 to either 
* \ GW Moe or GW Larry with equal priority. 

endpoint alt-ep h323id gwMoe@cisco.com 10.10.10.02
* \ Defines GW Larry as GW Moe’s alternate endpoint

endpoint alt-ep h323id gwLarry@cisco.com 10.10.10.01 
* \ Defines GW Moe as GW Larry’s alternate endpoint

Gateways Moe and Larry are configured as shown in Example 8-6.

Note The Gatekeeper does take endpoint availability into account when it chooses the Destination Endpoint. 
However, it does not take it into account when selecting the destination’s alternate endpoints.

Example 8-6 Gateways Moe and Larry Configuration

dial-peer voice 1 pots
* / GW to route calls with leading digits 888800 to GW voice port 0:1
* / (T1/E1 controller # :D Channel), with highest preference (0)
destination-pattern 888800….
port 0:1
preference 0 *\ 0 is the default 

dial-peer voice 2 pots
* \ Defines backup voice port (0:2) for same digits
destination-pattern 888800…. 
port 0:2
preference 1

dial-peer voice 3 pots
* \ Routes calls with different yy digits (01) to a different GW voice port (1:1). 
* \ (This is how the GW differentiates the ACD trunk groups.)
destination-pattern 888801….
port 1:1
preference 0

dial-peer voice 4 pots
* \ Defines backup voice port (1:2) for the same trunk group
destination-pattern 888801….
port 1:2
preference 1

dial-peer voice 5 pots
* \ Routes calls to a third trunk group
destination-pattern 888802….
port 2:1
preference 0
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dial-peer voice 6 pots
* \ Backup voice port for third trunk group
destination-pattern 888802….
port 2:2
preference 1

h323-gateway voip tech-prefix 1# * \ Registers the GW with the GK with the tech-prefix 1#

To define the codec to be used during the transfer:

dial-peer voice <some label> voip
incoming called-number 888800….

codec g729r8

Note If necessary, more dial-peers may be added for additional destination patterns.

Label Definition for Outpulse Transfer
Labels for ISN calls which will require outpulse transfer mode must be pre-pended with the characters 
DTMF. By configuring the target label with the form DTMFnnnnn (where nnnnn are the digits to 
outpulse) the ISN will send the digits to the ingress endpoint for outpulsing. 

For example, to use the AT&T Transfer Connect feature to transfer the call to the number “4441234” the 
label would be configured as DTMF*84441234. 

Note In outpulse transfer mode, the ISN will send whatever digits are in the label to the Gateway for 
outpulsing. It is the customer’s responsibility to confirm interoperability with the target switch.

Codec Support
There is a codec used for IVR prompting in ISN and a codec used for transfers (actually it is possible, 
though not likely, that a different codec could be used by each transfer during the life of a call). As 
depicted in the examples above, the ingress gateway dial-peer was configured for all possible codecs that 
may be used in the life of the call (in this case we limited it to g711alaw, g711ulaw and g729r8).

Codec Support differs somewhat between ISN Queue and Transfer mode and ISN Comprehensive mode.

Queue and Transfer: All prompts are played by the ISN Voice Browser. Therefore, it is the ISN Voice 
Browser itself which defines the IVR codec through the SetCodec CLI command. It is the egress gateway 
dial-peer that defines the codec that will be used during the transfer. In our example above, we chose 
g729r8.

Comprehensive: In this mode, no prompts are played by the Voice Browser. Instead, the Voice Browser 
transfers the call to a VXML-enabled voice gateway which provides IVR treatment which may in the 
form of prerecorded prompts or ASR/TTS. In this case it is always the egress dial-peer that determines 
both prompt codec and transfer codec. If using ASR/TTS, the codec must be g711ulaw for IVR 
treatment. The transfer codec may be anything. 
8-11
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Chapter 8      VoIP Configuration
Call Transfers and Outbound Routing
Miscellaneous Gateway Configuration Tasks

Configuring the Ethernet Connections

To insure call survivability for transfers when the ISN Voice Browser dies, place this configuration 
element on all gateways in the ISN solution (applies to ISN Queue and Transfer and ISN Comprehensive 
modes only):

interface FastEthernetN
keepalive 1800

OR (if you do not have FastEthernet)

interface EthernetN
keepalive 1800

To optimize Ethernet traffic:

ip cef

interface FastEthernetN
ip route-cache
ip route-cache same-interface

OR (if you do not have FastEthernet)

ip cef

interface EthernetN
ip route-cache
ip route-cache same-interface

Aiding Troubleshooting and Debugging

To aid Cisco troubleshooting and debugging:

debug vxml puts (leave this setting on at all times)

service timestamps debug datetime msec localtime

logging buffered 2000000 debugging

Additional Gateway Files

For ISN Comprehensive and ISN Advanced Speech, depending on the ISN configuration being used, it 
may be necessary to copy files from your ISN Application Server machine to the gateway(s). Use the 
following table to determine which files need to be copied. Examine the first three columns for the 
combination of features that you are using in your ISN. Copy all files from the folder specified in the 
fourth column from your ISN Application Server machine to flash memory on your gateways. Refer to 
the “copy” CLI command in the gateway documentation for instructions on how to copy files to your 
gateways. Typically, you would first copy these files to a tftp or ftp server, then login to the gateways 
and copy the files from the tftp or ftp server. IMPORTANT: DO NOT rename the destination files on the 
gateway when copying.
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What the columns below mean:

Voice Browser: You use an ISN Voice Browser when the ISN is used to queue calls or provide call 
transfer after an agent has answered the call.

CSS: A CSS can be used to provide enhanced failover and load-balancing capabilities between the Voice 
Gateways and the ASR/TTS servers, HTTP media servers, and ISN application servers. Note that when 
a CSS is used, it must be used for ALL of the afore-mentioned servers. You cannot, for example, use it 
for ASR servers but not ISN servers.

Call Restart: The Call Restart feature will restart the call in the event of an ISN application server 
failure mid-call. The restarted call will appear to the ICM as just another new call. Note that the Call 
Restart feature can only be used when the ISN is a type 5 or type 6 VRU or when the ISN is the main 
routing client for the call. In configurations where a call is pre-routed by a NIC to an ISN (ISN is a type 
2, 3, 7 or 8 VRU), the restart feature can not be used.

IP Transfer Example (IPCC Routing)
An IP transfer to an IPCC agent is very similar to an IP transfer to an ACD (TDM) agent with the 
following exceptions: 

• The egress Gateway for this case is a Call Manager. In the Gatekeeper, the agent extensions are 
configured to point to the Call Manager’s IP address. 

• When Call Manager receives the new call, it uses the “Skinny protocol” to connect to the agent at 
an IP phone. The voice channels are then connected from the ingress Gateway to the IP phone. 

Table  8-1 Files to be Copied from ISN Application Server to Gateway(s)

Voice 
Browser CSS Call Restart Copy all files from folder:

Yes Yes Yes <basedir>/ApplicationServer/Downloads/VB-CSS-CallRestart

Yes Yes No <basedir>/ApplicationServer/Downloads/VB-CSS-noCallRestart

Yes No Yes <basedir>/ApplicationServer/Downloads/VB-noCSS-CallRestart

Yes No No <basedir>/ApplicationServer/Downloads/VB-noCSS-noCallRestart

No Yes Yes <basedir>/ApplicationServer/Downloads/noVB-CSS-CallRestart

No Yes No <basedir>/ApplicationServer/Downloads/noVB-CSS-noCallRestart

No No Yes <basedir>/ApplicationServer/Downloads/noVB-noCSS-CallRestart

No No No <basedir>/ApplicationServer/Downloads/noVB-noCSS-noCallRestart
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ISN Endpoint Limitations
Table 8-2 lists endpoint limitations of the ISN 2.0 Voice Browser.

Table 8-2 ISN Endpoint Limitations

Limitation Description

Gatekeeper single point failure. If a Gatekeeper fails and no hot standby is configured, the 
following features of call routing will be affected:

• If Gatekeeper is used for inbound call routing, it is not 
clear which Voice Browser would route the call to.

• No switch transfers will succeed.

Registering to different H.323 zones on a 
single Gatekeeper is not implemented.

The Voice Browser is lacking a parameter that would 
permit it to register into different zone on the same physical 
Gatekeeper box.

Outbound Alternate Endpoint 
functionality not fully supported when 
transferring to agents reserved by ICM. 

The agent reserve timer can expire before the call arrives, 
allowing a different call to reach the agent that does not 
match the call data previously sent to the agent by the ICM 
software. 

Use the router requery feature instead.

DTMF originating from an IP Phone is 
not supported for Comprehensive IVR 
Mode.

DTMF input in Comprehensive IVR mode requires the 
dtmf-relay capability of rtp-nte when the DTMF must be 
passed to the ASR recognition server for processing. Call 
Manager and IP phones do not support rtp-nte.

IP Phone cannot transfer in VoIP network 
in Advanced Speech IVR mode.

Because this version of the IOS does not support IP to IP 
transfers, it is only possible for a caller originating from an 
IP Phone to perform a transfer back to the TDM network.

G711ulaw is required codec when doing 
ASR/TTS.

The ASR/TTS vendors currently only support g711ulaw 
for voice recognition and synthesis.
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Troubleshooting

This appendix contains troubleshooting information for the ISN and the Cisco products it interacts with.

Note Audience: ISN System Managers, VoIP Technical Experts, ICM/NAM System Managers. 

Table A-1 summarizes the symptoms discussed in this appendix and points to where to find information 
for possible solutions:

Table A-1 Troubleshooting Table of Contents

Category Symptom See page

Application Server Window 2000 Application Log fills up Page A-4 

Application Server will not start correctly after IP Address is 
changed

Page A-5

Callers hear critical error message Page A-5

“ISN does not support transfer to audio file” error in log Page A-5

Cannot start Application Server Page A-5

“Invalid ICM VRU Script Configuration Parameter” error 
message

Page A-6

Unable to open the DOS command window or other 
applications

Page A-6

The following error appears frequently in the App Server log:

                "%ISN-SS_HTTP-4-WARNING:Retrying ASR 
Server. Last tried 

BACKUP asr-en-US-backup.  primary 
tried:0, backup tried:1"

Page A-6
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Voice Browser Windows 2000 Application Log fills up Page A-7

Voice Browser is not running; no console window present Page A-7

“Voice Browser to Application Server Connection 
Unsuccessful” alarm

Page A-7

Voice Browser fails to retrieve a media file Page A-8

Callers hear critical error message Page A-8

Calls are rejected by the ISN Voice Browser Page A-9

Error code 9 is returned from a Micro-application request 
node

Page A-9

Error code 32 is returned from a Micro-application request 
node

Page A-10

Error message in the Voice Browser logs states “INFO: No 
gatekeeper configured. 

Page A-10

Error message in the Voice Browser logs states “ERROR: 
Voice Browser must be registered with Gatekeeper to perform 
IP transfers” during a call.

Page A-10

An error message in the Voice Browser logs states 
“unexpected event for the gatekeeper registration.

Page A-10

A prompt file from Media Server didn’t run. Page A-11

Audio Numerical data is not playing the expected format or 
Application Server is reporting a “Variable Data is invalid” 
error

Page A-12

One-Way Audio on a Voice Gateway after IP Transfer Page A-12

Caller does not hear prompted or an expected event does not 
take place

Page A-13

Caller hears nothing; ICM and Application Server do not 
detect any problems

Page A-13

Speech recognition fails Page A-13

Speech and DTMF keystroke recognition seem to take a long 
time to complete, and initial words or keystrokes are missed

Page A-13

With Nuance Vocalizer TTS, Caller hears, "Sorry, Sound 
Bank Card is not Available" when non-English text is being 
played

Page A-13

Cannot Play Announcements on 5300 IOS GW. Page A-14

Table A-1 Troubleshooting Table of Contents (continued)

Category Symptom See page
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Transfer and Connect Taking a call back for IVR treatment or network transfer does 
not work

Page A-14

The call could transfer from Agent 1 to Agent 2, but not from 
Agent 2 to Agent 3.

Page A-14

The caller does not hear a prompt or an expected event does 
not take place

Page A-14

Switch transfer is not going to the Gateway defined in the 
Gatekeeper zone prefix command

Page A-15

An Agent cannot transfer calls back to the ISN or to another 
Agent.

Page A-15

Establishing Calls When a call is IP transferred, the caller is disconnected Page A-16

Calls do not get established to the Voice Browser; “H.225 
port 1720 required” message appears in Voice Browser Log

Page A-17

A call placed from an analog phone on an FXS port does not 
appear to trigger the new_call.vxml application

Page A-17

Calls are dropped when a caller tries to invoke supplementary 
services like Call Hold, consult or conference.

Page A-17

An error message in the VB logs states: “ERROR: 
Supplementary service invoked by Caller. This feature is not 
supported.”

Page A-17

Calls are dropped when trying to transfer the call the in 
“Queue and Transfer” deployment model.

Page A-18

The call is disconnected when attempting to get VRU 
Treatment in the “Comprehensive” deployment model.

Page A-18

The call is disconnected during IP transfer and the 
Gatekeeper is configured on ISN Voice Browser.

Page A-18

The call is disconnected when you attempt to get VRU 
treatment in a “comprehensive” deployment model and 
Gatekeeper is configured on ISN Voice Browser

Page A-18

Table A-1 Troubleshooting Table of Contents (continued)

Category Symptom See page
A-3
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Appendix A      Troubleshooting
Application Server
Application Server
Table A-2 describes how to resolve problems you might encounter with the Application Server interface.

ICM Call might not go through the ISN so a prompt will not be 
played; an error warning message appear in the Application 
Server log

Page A-19

When an agent becomes available during prompt play in a 
Queue to Skill Group script, the transfer never happens.

Page A-19

The ICM script fails on a Run VRU script node; no failure is 
indicated in the Application Server log.

Page A-19

In a NAM/CICM environment, an ICM timeout occurs;no 
error is indicated in the Application Server or Voice Browser 
logs.

Page A-19

The contents of an ECC Variable configured in Script Editor 
are truncated after passing through the Application Server.

Page A-20

A new call arriving at the ISN receives a default route label 
from the ICM.

Page A-20

Call Manager .asp errors occur on the Call Manager; Call Manager does not 
function normally

Page A-21

Problems with IP transfer Page A-21

IP Phone One-way audio occurs after IP transfer Page A-23

Table A-1 Troubleshooting Table of Contents (continued)

Category Symptom See page

Table A-2 Application Server Troubleshooting

Symptom Possible Cause and Solution

Windows 2000 Application 
Log fills up. Clearing the log 
only remedies this 
temporarily.

Possible Cause: Event log settings are not set to roll over.

Possible Solution: Change the Event setting so that the Application Log rolls over by doing 
the following:

1. Select Start > Programs > Administrative Tools > Event Viewer.

2. Right-click Application Log and select Properties from the menu.

3. Select the Overwrite events as needed option.

4. Click Apply and OK.

Possible Cause: Some unnecessary protocols might have been installed. For example, 
NetBEUI has been known to fill the event log.

Possible Solution: Uninstall protocols that are not necessary in this application.
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Application Server
After changing the IP 
Address of the Application 
Server machine, the 
Application Server will not 
start correctly.

Possible Cause: Information is not registered with Windows 2000 Services.

Possible Solution: Do the following:

1. Select Start > Programs > Administrative Tools > Services.

2. Stop and start the DC Directory Service.

3. Stop and start the IIS service.

Callers hear critical error 
media and “Dialogue Failure 
Event” errors appear in the 
Application Server log files.

Possible Cause: If a call reaches the end of ICM script processing without being queued 
or released, the ICM sends a “Dialogue Failure Event” message to the 
Application Server. The Application Server, in turn, sends an error 
message to the Voice Browser.

Possible Solution: The author of the script must ensure that each path in the script should 
end with one of the following Script Editor nodes: Release, Label, Skill 
Group, or Queue to Skill Group.

“ISN-SS_TEL-3_ERROR: 
ISN does not support transfer 
to audio file” error appears in 
the Application Server log 
file.

Possible Cause: The ISN script on the NAM/ICM includes a Busy or Ring node.

Possible Solution: ISN Version 2.0 does not support the Busy or Ring nodes; remove them 
from the script. 

Cannot start Application 
Server with error message 
“5:May 30 11:46:30.403 
EDT %ISN-ENG-3-Error in 
initializing RMI Manager:
com.cisco.wfapi.WFExcep-
tion:Failed to start RMI 
Server:java.rmi.server.
ExportException:Port 
already in use:1099; nested 
exception is: java.net.Bind-
Exception:Address in use”

Possible Cause: ISN uses 1099 as the default RMI port for the communication between 
Application Administration and the Application Server Engine. If this 
port is used by other application, ISN will not be able to start up. 
Possible reasons include: 

• The port is used by the operating system for other purposes, such as 
a Mapped Network Drive to another machine. 

• The port is used by another application, such as the Voice Browser 
or Messenger, which is given the port to use by the Windows 2000 
operating system from the ephemeral port range (ports which are 
not designated as “well known” and, thus, available for use).

Possible Solution: If the application using ISN default RMI port 1009 is not necessary, such 
as Messenger, you need to shut down the application and restart it after 
starting ISN. 

If the application must be run on the same server as the Application 
Server, and if it cannot be configured to avoid the use of port 1099, 
change the RMI port number configured at the Application Server. If the 
Cisco ISN Application Server Service is running, shut it down. Then 
change the RMI port in Application Administration to another available 
TCP port in the range 1024-64000 and restart the service.

Note You can enter netstat -a in a DOS command window to view the 
list of currently in-use TCP ports; choose a port number not in that 
list.

By changing the RMI port, on the Application Administration Engine 
Status page, you will see the yellow traffic light appear with the 
UNAVAILABLE state temporarily before all subsystems states change 
to the RUNNING state.

Table A-2 Application Server Troubleshooting (continued)

Symptom Possible Cause and Solution
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Application Server
An error similar to the 
following is seen in the 
Application Server log: 
“83320:Oct 02 18:03:48.429 
EDT %ISN-STEP_
PARSEINPUT-4-WARNING
:Invalid ICM VRU Script 
Configuration Parameter 
:103404660020957405”

Possible Cause: There might be a problem with how the ECC variables are defined 
through Configure ICM or the Script Editor’s Set node.

Possible Solution: Verify all ECC variable configuration information: length, spelling, 
what values are specified through Set nodes, etc. 

Note Remember that the word grammar ends with an ar.

Unable to open the DOS 
command window or other 
applications

Possible Cause: The number of ISN ports is set too high for the rated capacity of the ISN 
Voice Browser

Possible Solution: Make sure the following configuration settings do not exceed the 
maximum capacity of your ISN Voice Browser machine. 

In ISN Voice Browser:

• Check ShowMaxTotalCalls in VBAdmin.

• In ISN Application Server (if the Application Server resides on the 
same machine as ISN Voice Browser), select Engine 
Configuration > Advanced Settings > Max Number of 
Concurrent Sessions.

• Select Call Definitions > Maximum Number of Calls.

• Select Call Definitions > Total Number of Ports.

The following error appears 
frequently in the App Server 
log:

                
"%ISN-SS_HTTP-4-WARN
ING:Retrying ASR 
Server. Last tried 

BACKUP 
asr-en-US-backup.  
primary tried:0, 
backup tried:1"

Possible Cause: Missing parameters in the nuance-resources.txt file.

Possible Solution: If you are using Nuance speech recognition to recognize DTMF digits, 
be sure the following parameters are in your nuance-resources.txt file 
on the recognition server machine:

                 dtmf.SuppressNotifications=FALSE

Table A-2 Application Server Troubleshooting (continued)

Symptom Possible Cause and Solution
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Voice Browser
Table A-3 describes how to resolve problems you might encounter with the Voice Browser interface.

Table A-3 Voice Browser Troubleshooting

Symptom Possible Cause and Solution

Windows 2000 Application 
Log fills up. Clearing the log 
only remedies this 
temporarily.

Possible Cause: Event log settings are not set to roll over.

Possible Solution: Change the Event setting so that the Application Log rolls over by doing 
the following:

1. Select Start > Programs > Administrative Tools > Event Viewer.

2. Right-click Application Log and select Properties from the menu.

3. Select the Overwrite events as needed option.

4. Click Apply and OK.

Possible Cause: Some unnecessary protocols might have been installed. For example, 
NetBEUI has been known to fill the event log.

Possible Solution: Uninstall protocols that are not required by this application.

The Voice Browser does not 
appear to be running and no 
Voice Browser console 
window is present. Attempts 
to run VBAdmin generate a 
“Failure to Connect” error 
message, followed by 
termination of VBAdmin.

Possible Cause: The Voice Browser service has started, meaning the Node Manager is 
running, however, the Voice Browser program itself is not running. The 
Voice Browser might not be able to start because of a bad registry 
setting.

Possible Solution: Check the latest Voice Browser EMS logs for problems with a registry 
entry.

The “Voice Browser to 
Application Server 
Connection Unsuccessful” 
alarm is generated twice for a 
given Application Server. 
One alarm references the 
Application Server by 
hostname; the other 
references the IP Address.

Possible Cause: Depending on the configuration, the Voice Browser contacts the 
Application Server both by hostname and IP Address. 

Possible Solution: Each of the alarms will be cleared independently when the Voice 
Browser successfully contacts the Application Server.
A-7
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Appendix A      Troubleshooting
Voice Browser
Voice Browser fails to 
retrieve a media file even 
though the correct filepath is 
used.

Possible Cause: The IUSR_ComputerName Internet User Account is disabled. IIS 
requires this account to be enabled for anonymous user to access 
Internet Service.

Possible Solution: Enable IUSR_ComputerName in the User Management window:

1. On your Windows Desktop, right-click on My Computer.

2. Select Manage. 

3. Expand the Explorer tree, System Tools > Local Users and Groups 
> Users.

4. Select the User you want to enable.

5. In the Properties dialog box, make sure that the “Account is 
disabled” option is not checked.

6. Click Apply and OK.

Callers hear the critical error 
message.

Possible Cause: The Voice Browser is unable to connect to an Application Server for call 
treatment.

Possible Solution: Do the following:

1. In VBAdmin, enter ShowStatus. 

2. Locate the Current State status. If the Current State is not In 
Service, all calls will hear critical media errors; use the 
SetServiceMode command to place the Voice Browser In Service. 

3. If the Voice Browser Current State is In Service, look at the Voice 
Browser log files for clues. For example, check that the Voice 
Browser is connecting to the Application Server that you would 
expect it to. 

4. In Application Administration, use the Engine Status page to check 
if the Application Server that you are connecting to is In Service. 

Possible Cause: The ICM is returning an error to the Application Server for the call.

Possible Solution: Do the following:

1. From any Engine Administration page in Application 
Administration, click the Log files link. The Log files page appears, 
displaying a list of the Application Server Log files that currently 
exist.

2. Click a File name link to open the log in a Browser window. 

3. Examine the log. If the ICM is returning an error to the Application 
Server, an error message will appear. 

4. If an ICM error appears in the log file, look at the ICM script and 
configuration for more information.

Table A-3 Voice Browser Troubleshooting (continued)

Symptom Possible Cause and Solution
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Voice Browser
Calls are rejected by the ISN 
Voice Browser

Possible Cause: Even though a call may be immediately transferred upon arrival at ISN, 
there is a brief period (a few seconds) that the call is in IVR state until 
the endpoint answers the call. So, even if all calls appear to transfer 
immediately, you still need an adequate value set for MaxIVRPorts to 
handle those few seconds of IVR state for each call.

When a new call arrives at the ISN Voice Browser, it looks to see 
whether it can admit that calls based on how many IVR ports are in use 
and how many total calls there are. If the new call makes either of those 
values exceed the Max limits, the call is rejected.

Possible Solution: Perform the following solution:

1. Determine the capacity of the ISN Voice Browser, based on the 
installed hardware, software version, software licenses and call 
flows.

2. Check ShowMaxIVRPorts and ShowMaxTotalCalls from the 
VBAdmin interface for the current settings.

3. Use the showStatistics option from VBAdmin if the problem is 
currently present. If not, check the log interval statistics “Calls in 
Progress” and “IVR Ports in use” for the period during which the 
problem occurred. If that data is not available, check the log 
statistics since startup: “Max Simultaneous Calls” and “Max IVR 
Ports”. 

4. Determine whether the IVR port max setting is high enough to 
handle the maximum number of calls that may be receiving IVR 
treatment. Remember that even a call that is immediately 
transferred, as in ISN Comprehensive Mode, will be in the IVR state 
for a few seconds.

5. Determine whether the results indicate that the maximum number of 
calls allowed is high enough to handle the number of calls.

6. If there are not enough IVR Ports and there is additional capacity 
rated for the equipment, increase the MaxTotalCalls by using 
SetMaxTotalCalls.

7. If there are not enough IVR ports and/or not enough calls allowed 
and there is no additional capacity on the ISN Voice Browser, you 
must add an additional Voice Browser.

Error code 9 is returned from 
a Micro-application request 
node

Possible Cause: Error code 9 usually means that a media file could not be read. However, 
if you are using external VXML, it may also indicate a format error in 
that VXML document.

Possible Solution: Verify and correct the external VXML document. Voice Browsers 
sometimes differ from one another in their interpretation of the 
standards or in their level of support for various tags and attributes. 
Check the Voice Gateway documentation to ensure that the document 
you provide matches their specifications.

Table A-3 Voice Browser Troubleshooting (continued)

Symptom Possible Cause and Solution
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Voice Browser
Error code 32 is returned 
from a Micro-application 
request node

Possible Cause: Error code 32 usually means that the TTS service was unable to perform 
a request due to resource limitations. However, it may also indicate that 
an unsupported locale was specified.

Possible Solution: Verify that the locale is spelled correctly, and that it is supported by your 
TTS service provider. Also be sure that the necessary TTS language 
package is installed, if required by your service provider.

Error message in the Voice 
Browser logs states “INFO: 
No gatekeeper configured. 
The Voice Browser cannot 
perform IP Transfers” during 
startup.

Possible Cause:

Possible Solution:

The ISN Voice Browser is not successfully registered with the H.323 
Gatekeeper.

Follow these steps:

1. Set the gatekeeper from the VBAdmin using “setGK <Gatekeeper 
IP address>.” Restart the ISN Voice Browser after changing the 
H.323 gatekeeper.

2. Verify that ISN Voice Browser is successfully registered with H.323 
Gatekeeper using the following command in Gatekeeper: “show 
gatekeeper endpoints.” You should see an entry of the ISN Voice 
Browser IP address in the “Gatekeeper endpoint Registration” table.

3. Verify that the ISN Voice Browser reports a successful registration 
confirm from the H.323 Gatekeeper during startup. The following 
messages in ISN Voice Browser logs indicate the successful 
registration of ISN Voice Browser with H.323 Gatekeeper: 

– INFO: Gatekeeper configured is 10.86.137.125 

– INFO: cmEvRASConfirm:: RegistrationConfirm received from 
H.323 GK

Error message in the Voice 
Browser logs states 
“ERROR: Voice Browser 
must be registered with 
Gatekeeper to perform IP 
transfers” during a call.

An error message in the 
Voice Browser logs states 
“unexpected event for the 
gatekeeper registration. 
Please make sure H.323 
Gatekeeper is up and 
running.”

Possible Cause: The configured H.323 Gatekeeper is not running or Gatekeeper is 
configured incorrect.

Possible Solution: Follow these steps:

1. Make sure the H.323 Gatekeeper is running on the IP address 
configured in the ISN Voice Browser. Verify that the correct IP 
address (and not host name) of H.323 Gatekeeper is configured in 
the ISN Voice Browser by using the “sGK” command from Voice 
Browser Admin.

2. Verify that the IP network connectivity between the ISN Voice 
Browser and H.323 Gatekeeper.

Table A-3 Voice Browser Troubleshooting (continued)

Symptom Possible Cause and Solution
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Voice Browser
A prompt file from Media 
Server didn’t run.

Other symptoms of this issue 
may include:

• There is an error 
message in the Voice 
Browser logs stating 
“Invalid encoding.”

• There is an error 
message in the Voice 
Browser logs stating 
“ERROR: Audio file had 
a bad header.”

• There is an error 
message in the Voice 
Browser logs that states 
“ERROR: Payload type 
in audio file doesn’t 
match the payload 
supported by the Voice 
Browser.”

Possible Cause Codec mismatch between the Voice Browser configured codec and 
Audio file codec.

Possible Solution: Follow these steps:

1. Convert the prompt file codec to the Voice Browser configured 
codec (g711Alaw64K or g711Ulaw64K). 

2. Verify that the ISN Voice Browser codec is using the “sCodec” 
command from VBAdmin and check the prompt file properties to 
verify that codec matches the VB configured codec.

Possible Cause: The audio file is not a valid .wav file.

Possible Solution: Re-record or convert the audio file in standard .wav format.

Table A-3 Voice Browser Troubleshooting (continued)

Symptom Possible Cause and Solution
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Audio
Table A-4 describes how to resolve problems you might encounter with the audio interface.

.
Table A-4 Audio Troubleshooting

Symptom Possible Cause and Solution

Numeric data is not playing 
in the expected format or 
Application Server is 
reporting a “Variable Data is 
Invalid” error.

Possible Cause: The ICM script might be:

• Truncating values with leading 0’s or 0’s after decimals.

• Rounding values.

Possible Solution: Put quotes around numbers in a Script Editor Set node so they will be 
processed as a string. This is especially important if: 

• Leading 0’s are present (example: dates). 

• Trailing 0’s are present after a decimal point (example: currency).

• The number is very large (example: a number normally expressed 
through exponential notation).

One-Way Audio on a AS5350 
or AS 5400 Voice Gateway 
after an IP Transfer. 

Possible Cause: One-way audio after a remote H.323 device sends the VoIP-Gateway a 
HOLD or TRANSFER message.

Possible Solution: Disable the voice-fastpath command on the Gateway, using the syntax: 
no voice-fastpath disable 

Note This command is enabled by default and the syntax is hidden. 

Possible Cause: The Gateway and Call Manager are in different subnets and no IP route 
defined in the Gateway.

Possible Solution: Ping from the Gateway to the Call Manager and also from the Call 
Manager to the Gateway. If there is a problem with pinging, add an IP 
route for the different subnet in the Gateway. 

For example, specify the command ip route 0.0.0.0 0.0.0.0 10.86.137.1  
where 10.86.137.1 is the default routing gateway for the Gateway. This 
command enables routing to all subnets.

After entering this command, ping again; you should be able to listen to 
the two-way voice.
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When a call is made, the 
caller does not hear a prompt 
or an expected event (such as 
a transfer) does not take 
place.

Possible Cause: There has been a misconfiguration on the ICM.

Possible Solution: Do the following:

1. In Configure ICM, under Network VRU Scripts, note the Network 
VRU for the Network VRU script in the ICM Run VRU Script node.

2. In Configure ICM, under Labels for the Network VRU that is 
running the ICM Script, click Set Target, click Network VRU and 
select the Network VRU noted in Step 1.

Note When using VRU Types 2 or 5, try running Call Tracer.

Possible Cause: An error has occurred in the ISN.

Possible Solution: Do the following:

1. Use Monitor mode in the ICM Script Editor to see if the call is 
following the expected path (that is, it does not travel through an X 
branch). 

2. Check the Application Server and Voice Browser logs to see what 
the error or warning messages have been generated. 

Caller hears nothing; 
however, ICM and 
Application Server logs do 
not indicate any problems.

Possible Cause: There may be a problem with explicitly appending a .wav extension to 
the Network VRU Script Name.

Possible Solution: In Configure ICM, remove the .wav extension from the Network VRU 
Script name. For example, if the name is PM,welcome.wav, change it to 
PM,welcome.

Speech Recognition fails, 
and the 
user.microapp.error_code 
ECC variable is 31, 32 or 33. 

Possible Cause: Some type of ASR/TTS issue exists.

Possible Solution: Do the following:

1. Check to make sure the ASR/TTS is running. If they are not, start 
the services.

2. Check to make sure the host names that connect the gateway to 
ASR/TTS are configured properly. If they aren’t, configure them 
appropriately.

If these procedures don’t work, contact your ASR/TTS vendor. 

Speech and DTMF keystroke 
recognition seem to take a 
long time to complete, and 
initial words or keystrokes 
are missed

Possible Cause: Using M, GD or GS Micro-applications with input_type set to 'B' (both)

Possible Solution: Virus scanning can severely degrade recognition speed if you have it 
running in your recognition servers. Check with your recognition 
service provider for their recommendations on how to configure virus 
scanning for maximum protection and minimum performance impact.

With Nuance Vocalizer TTS, 
Caller hears, “Sorry, Sound 
Bank Card is not Available” 
when non-English text is 
being played

Possible Cause: This is a problem with Vocalizer 1.0 only. It means that a locale was 
selected whose language pack has not been installed in the Vocalizer 
server.

Possible Solution: Install the proper Nuance Vocalizer language pack.

Table A-4 Audio Troubleshooting (continued)

Symptom Possible Cause and Solution
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Transfer and Connect
Table A-5 describes how to resolve problems you might encounter during call transfer or connection.

Cannot Play Announcements 
on 5300 IOS GW.

Possible Cause: Incorrect VCWARE version on 5300 IOS GW.

Possible Solution: Upgrade the VCWARE version on 5300 IOS GW. The minimum 
VCWARE version requirement can be found using the following 
commands on 5300 GW: “sh vfc 1 v v” and “sh vfc 2 v v” for both slots 
on 5300 to get VCWARE version.

Table A-4 Audio Troubleshooting (continued)

Symptom Possible Cause and Solution

Table A-5 Transfer and Connect Troubleshooting

Symptom Possible Cause and Solution

Taking a call back for IVR 
treatment or a subsequent 
network transfer does not 
work.

Possible Cause: The VRU PIM that connects to the ISN is not set to Type 5.

Possible Solution: In ICM Configuration Manager, Network VRU Explorer, change the 
Type to 5. 

Note For more information, see Chapter 2, “Using NAM/ICM with 
the ISN IVR Solution.”

Possible Cause: The ICM script does not include a Set node setting the 
Call.NetworkTransferEnabled variable to 1.

Possible Solution: In any script that might perform VRU Network Transfer or Takeback for 
IVR treatment, add a Set node at the beginning of the script setting the 
Call.NetworkTransferEnabled variable to 1. 

Note For more information on Network Transfer, see Appendix B, 
“Transferring and Queuing Calls with ISN.”

The call could transfer from 
Agent 1 to Agent 2, but not 
from Agent 2 to Agent.

Possible Cause: The second ICM script does not include a Set node setting the 
Call.NetworkTransferEnabled variable to 1.

Possible Solution: In the second ICM script, add a Set node at the beginning of the script 
setting the Call.NetworkTransferEnabled variable to 1. 

Note The NetworkTransferEnabled variable exists for future 
network transfers, not for the current script. The first script (to 
Agent 1) had the flag set so the Router knew that it had to do the 
extra work that would allow Agent 1 to do a Network Transfer. 
The second script (from Agent 1 to Agent 2) did not have the 
variable set so the Router did not do the extra work needed to 
allow a Network Transfer from Agent 2 to any other destination.

When a call is made, the 
caller does not hear a prompt 
or an expected event (such as 
a transfer) does not take 
place.

Possible Cause: An error has occurred in the ISN.

Possible Solution: Do the following:

1. Use Monitor mode in the ICM Script Editor to see if the call is 
following the expected path (that is, it does not travel through an X 
branch). 

2. Check the Application Server and Voice Browser logs to see what 
the error or warning messages have been generated. 
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Switch Transfer is not going 
to the Gateway defined in the 
Gatekeeper zone prefix 
command.

Possible Cause: The IP address of the outbound Gateway, which is registered with a DNS 
name, is used in the zone prefix.

Possible Solution: Use the same name of the outbound Gateway in zone prefix.

To verify the outbound Gatekeeper priority list, do the following: 

1. Enter the show gatekeeper gw-type-prefix command in the 
Gatekeeper CLI. 

2. Enter the “show gatekeeper end” command in the gatekeeper CLI 
and verify that H323 ID used by egress gateway/endpoint to register 
with gatekeeper is used in the “Zone prefix” configuration of 
gatekeeper.

Agent cannot transfer calls 
back to the ISN or to another 
agent.

Possible Cause: The CCM’s SingleStepTransferViaRedirect setting is incorrect. Other 
symptoms: The OPCTest list indicates that the initial call has not 
cleared; the Agent Desktop displays the initial call.

Possible Solution: In the CCM, modify the SingleStepTransferViaRedirect setting to 1.

Note For more information, see the IPCC documentation.

Table A-5 Transfer and Connect Troubleshooting (continued)

Symptom Possible Cause and Solution
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Establishing calls
Table A-6 describes how to resolve problems you might encounter in establishing calls.

Table A-6 Call Troubleshooting

Symptom Possible Cause and Solution

When a call is IP Transferred, 
the caller is disconnected.

Possible Cause: Gateway and Gatekeeper cannot find each other on the network.

Possible Solution: Make sure that the Gateway can ping the Gatekeeper and vice versa:

ping <gk ip address> from gw

ping <gw ip address> from gk

Make sure that Gateway and Gatekeeper can resolve each other’s names 
to IP address.

Possible Cause: Configuration on the Gateway might be incorrect.
Possible Solution: Check the following:

1. There is a gateway command in the Gateway configuration.

2. The following commands exist in the Gateway “interface 
FastEthernet0” configuration section:

interface FastEthernet0

h323-gateway voip interface

h323-gateway voip id <gk id> ipaddr <gk ip address> 1719

h323-gateway voip h323-id <gw host name or ip address>

h323-gateway voip tech-prefix 1#

3. Turn on debug in the Gateway with the following commands:

debug h225 asn1

debug cch323 ras

term mon

If the Gateway is configured properly, it should send a RAS 
message to register with Gatekeeper.

Note Turn off debug in the Gateway using the following command: 
no debug all
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Calls don’t get established to 
Voice Browser and message 
“ERROR: radMain: H.225 
port 1720 required for Voice 
Browser is in use by some 
other application” appears in 
Voice Browser logs.

Possible Cause: There might be conflicts for both the Voice Browser and the Application 
Server with the Cisco Call Manager or any application that uses port 
1720.

H.323 protocol says that all H.323 applications (like H.323 Gateway and 
H.323 terminals) have to listen on port 1720 to get incoming calls. Thus 
in theory, you cannot have a Voice Browser and Call Manager on the 
same machine because both of them will try to occupy port 1720. The 
one, which starts first, will occupy port 1720 and the other application 
will not work as expected.

Some possible symptoms on the Voice Browser are:

• No trace messages are generated for calls (even if callflow and 
interface tracing are enabled), but you know the Gateway dial peers 
have been configured properly.

• If you just rebooted the PC, one call might get through while the 
Call Manager is starting, but then no more calls will go through after 
the Call Manager is running.

Possible Solution: Put the Voice Browser and/or Application Server and Cisco Call 
Manager on separate machines.

A call placed from an analog 
phone on an FXS port does 
not appear to trigger the 
new_call.vxml application.

Possible Cause: There is no application session command defined on the POTS 
dial-peer for the telephone’s voice port.

Note This command is necessary to enable phones on FXS ports to 
run a VXML script.

Possible Solution: On the POTS dial-peer, model your configuration after the following: 

dial-peer voice 1000 pots

application session

destination-pattern 12016881000

port 1/0/0

Calls are dropped when a 
caller tries to invoke 
supplementary services like 
Call Hold, consult or 
conference.

Possible Cause:

Possible Solution:

Caller is trying to invoke supplementary services like Call Hold, consult 
or conference. This is an unsupported feature.

On CCM 3.3 (with supported ISN version), turn on MTP (Media 
Termination Point) for the ISN Voice Browser defined as an H.323 
gateway. 

An error message in the VB 
logs states: “ERROR: 
Supplementary service 
invoked by Caller. This 
feature is not supported.”

Table A-6 Call Troubleshooting (continued)

Symptom Possible Cause and Solution
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Calls are dropped when 
trying to transfer the call the 
in “Queue and Transfer” 
deployment model.

Possible Cause:

Possible Solution:

The ISN Voice Browser is not successfully registered with the H.323 
Gatekeeper.

Follow these steps:

1. Set the gatekeeper from the VBAdmin using “setGK <Gatekeeper 
IP address>.” Restart the ISN Voice Browser after changing the 
H.323 gatekeeper.

2. Verify that ISN Voice Browser is successfully registered with H.323 
Gatekeeper using the following command in Gatekeeper: “show 
gatekeeper endpoints.” You should see an entry of the ISN Voice 
Browser IP address in the “Gatekeeper endpoint Registration” table.

3. Verify that the ISN Voice Browser reports a successful registration 
confirm from the H.323 Gatekeeper during startup. The following 
messages in ISN Voice Browser logs indicate the successful 
registration of ISN Voice Browser with H.323 Gatekeeper: 

– INFO: Gatekeeper configured is 10.86.137.125 

– INFO: cmEvRASConfirm:: RegistrationConfirm received from 
H.323 GK

The call is disconnected 
when attempting to get VRU 
Treatment in the 
“Comprehensive” 
deployment model.

The call is disconnected 
during IP transfer and the 
Gatekeeper is configured on 
ISN Voice Browser.

Possible Cause:

Possible Solution:

The configured H.323 Gatekeeper is not running or Gatekeeper is 
configured incorrect.

Follow these steps:

1. Make sure the H.323 Gatekeeper is running on the IP address 
configured in the ISN Voice Browser. Verify that the correct IP 
address (and not host name) of H.323 Gatekeeper is configured in 
the ISN Voice Browser by using the “sGK” command from Voice 
Browser Admin.

2. Verify that the IP network connectivity between the ISN Voice 
Browser and H.323 Gatekeeper.

The call is disconnected 
when you attempt to get VRU 
treatment in a 
“comprehensive” 
deployment model and 
Gatekeeper is configured on 
ISN Voice Browser

Table A-6 Call Troubleshooting (continued)

Symptom Possible Cause and Solution
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Table A-7 describes how to resolve problems you might encounter in ICM/ISN interface.

Table A-7 ICM Troubleshooting

Symptom Possible Cause and Solution

The call might not go through 
the ISN, so a prompt will not 
be played. An error or 
warning message might 
appear in the Application 
Server log.

Error messages will appear 
on the PIM console, such as: 
23:28:38Trace: VRU 
APPICATION ERROR: 
Assigning the tag 7 to the 
non-existing ECC variable 
“user.microapp.error_code”.

Possible Cause: The ECC Variable is not configured on the ICM and/or NAM software, 
or the defined length is not the same on both devices.

Possible Solution: Add the identical ECC variable definition to the ICM and/or NAM. 

When an agent becomes 
available during prompt-play 
in a Queue to Skill Group 
script, the transfer never 
happens.

Possible Cause: The Interruptible checkbox in a Network VRU Script configuration is 
not checked. (This is the default setting). The ICM software will not 
interrupt a VRU script to perform a transfer if this feature is not enabled. 

Possible Solution: Select the Interruptible checkbox on all Network VRU script nodes that 
might be run while a caller is waiting in queue for an agent.

Note Before attempting to diagnose this problem, activate call tracing on the ISN.

1. Turn on call tracing on the Application Server using the Application Administrator webpage. 

2. Turn on call tracing on the Voice Browser using the VBAdmin tool.

3. Run another test call. If you do not see a transfer request coming from the ICM to the Application Server, the 
problem could be the “Interruptible” setting, as described above. If you do see a transfer request coming from the 
ICM to the Application Server, the problem could be in the transfer connection; see Table A-5 for a possible solution.

The ICM script fails on a 
Run VRU Script node and 
there is no indication of a 
failure in the Application 
Server log.

Possible Cause: The Dialed Number, Network VRU Script or Network VRU might be 
associated with the wrong Customer.

Possible Solution: Use Configure ICM to ensure that the:

• Dialed Number and Network VRU Script are associated with the 
correct Customer.

• Customer is associated with the correct Network VRU.

In a NAM/CICM 
environment, an ICM timeout 
occurs and there is no 
indication of an error in the 
Application Server or Voice 
Browser logs.

Possible Cause: If the time to retrieve the first script request (or connect) takes longer 
than the NAM’s remote ICM timeouts (system information; Application 
Gateway; Remote ICM; Timeouts), then the default routing occurs. 

Possible Solution: Either decrease delays (such as those specified through Wait nodes in 

the CICM script) or increase the NAM Remote ICM timeouts.
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The contents of an ECC 
Variable configured in Script 
Editor are truncated after 
passing through the 
Application Server. 

For example, the 
Text-To-Speech (TTS) text 
that is spoken to the caller is 
not the complete text that was 
configured. Another example 
of this behavior is where 
there are media fetch failures 
and the URL to the media file 
is only a subset of the 
expected URL.

Possible Cause: The cause of this problem may be that the length of the ECC Variable 
value that was set in Script Editor is longer than the maximum length of 
the ECC Variable configured at setup time.

Possible Solution: The solution is to make the maximum length of the ECC Variables 
longer. This is done using the ICM Configuration Manager. If you do 
alter the maximum length of ECC Variables, you need to restart the 
Application Server after making the change.

Note: In a NAM/ICM environment, the length needs to be identical on 
all NAM and ICM or the variable does not pass.

A new call arriving at the ISN 
receives a default route label 
from the ICM. You do not see 
an Application Server or 
Voice Browser error for this 
type of ICM timeout.

Possible Cause: The ICM is taking a long time to handle new call requests.

Possible Solution: Ensure there are no wait nodes in the ICM script prior to the Run VRU 
Script node. For more information, see the Cisco ICM Software 
Scripting and Media Routing Guide.

Table A-7 ICM Troubleshooting (continued)

Symptom Possible Cause and Solution
A-20
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Appendix A      Troubleshooting
Call Manager
Call Manager
Table A-8 describes how to resolve problems you might encounter with the Call Manager/ISN inter-
face.

Table A-8 Call Manager Troubleshooting

Symptom Possible Cause and Solution

.asp errors occur on the Call 
Manager and the Call 
Manager does not function 
normally.

Possible Cause: If you installed an Application Server on the same machine as the Call 
Manager, and then you uninstalled the Application Server, some files 
the Call Manager needs might have been deleted.

Possible Solution: Reinstall Call Manager. 

Problem with IP Transfer. Possible Cause: Cisco Call Manager in not registered with the Gatekeeper because the 
Gatekeeper information in Call Manager is incorrect.

Possible Solution: Change the Gatekeeper host name used during configuration to an IP 
address.

Possible Cause: Cisco Call Manager in not registered with Gatekeeper because the Reset 
and Restart buttons was not clicked after the Gatekeeper information 
was updated.

Possible Solution: Do the following:

1. In ccmadmin, select Device > Gatekeeper. 

2. Add the Gatekeeper Device Information and select gateway as the 
Terminal Type.

3. Click Update, then Reset Gatekeeper.

4. Finally click, Reset to apply the changes.

Possible Cause: Cisco Call Manager in not registered with Gatekeeper because a 
Gatekeeper registration port is not explicitly configured in Gatekeeper.

Possible Solution: Do the following:

1. Check the Gatekeeper configuration to verify that port 1719 is 
explicitly defined for the local Gatekeeper zone. For example:
zone local gk1 cisco.com 10.86.137.146 1719.

2. Verify the Call Manager registration in Gatekeeper by entering the 
show gatekeeper endpoints command in the Gatekeeper CLI. 
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Problem with IP Transfer.
(continued)

Possible Cause: The Voice Browser is not registered with the Gatekeeper.

Possible Solution: If the Voice Browser displays the message: “ERROR: Voice Browser 
must be registered with Gatekeeper to do IP transfers,” do the following:

1. In VBAdmin, enter SetGateKeeper <NewValue> (where 
<NewValue> is the Gatekeeper IP address.) 

2. Restart the ISN Voice Browser.

Note For more information about the SetGateKeeper command, see 
Chapter 4, “Voice Browser Administration.”)

Possible Cause: If the Call Manager is an egress Gateway, the Voice Browser is not 
defined as a Gateway in the Call Manager configuration.

Possible Solution: If the Voice Browser displays the message: “ERROR: IP Transfer - 
Destination endpoint at IP Address <number1> refused connection for 
phone number <number2> with reason code Unreachable Destination” 
(where: <number1> is the Call Manager IP address and <number2> is 
the label where you want the call to be transferred), do the following:

1. In ccmadmin on the Call Manager machine, select Device > 
Gateway. 

2. Click Find and verify that there is an entry appears configuring the 
Voice Browser as a H.323 Gateway.

Possible Cause: The call is getting routed elsewhere.

Possible Solution: If the Voice Browser displays the message: “ERROR: IP Transfer - 
Destination endpoint at IP Address <number1> refused connection for 
phone number <number2> with reason code Unreachable Destination” 
(where <number1> is not the Call Manager IP address that’s expected 
and <number2> is the label where you want the call to be transferred), 
then there is a problem with Gatekeeper routing. 

Do the following: 

1. From the Gatekeeper CLI, enter show gatekeeper gw-type-prefix 
and examine the Gatekeeper routing table.

Table A-8 Call Manager Troubleshooting (continued)

Symptom Possible Cause and Solution
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IP Phone
Table A-9 describes how to resolve problems you might encounter with the IP Phone interface.

Table A-9 IP Phone Troubleshooting

Symptom Possible Cause and Solution

One-way audio after IP 
Transfer.

Possible Cause: Configuration information is missing in IOS Gateways.

Possible Solution: Please refer the following document from CCO: 
http://www.cisco.com/en/US/tech/tk652/tk698/technologies_tech_note

09186a008009484b.shtml
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Transferring and Queuing Calls with ISN

This appendix provides information additional information about transferring and queuing calls with 
ISN. It includes:

• An outline of the transfer types available to the ISN.

• Information about how ISN uses ICM labels in transferring calls.

• Examples of several ISN call transfer scripts.

Note Audience: ISN System Managers, VoIP Technical Experts, ICM/NAM System Managers. 

IVRs from the NAM/ICM’s Perspective
Essentially, the NAM/ICM categorizes IVRs into one of two types:

• Intelligent Peripheral IVRs, where—under NAM/ICM control—the carrier network routes calls to 
the IVR and then removes calls from the IVR for delivery to agents. With Intelligent Peripheral 
IVRs, once the IVR’s prompting or queuing treatment has been completed, the IVR typically has no 
further role to play for that call.

• Service Node IVRs, where—following prompting/queuing treatment—the IVR initiates call 
delivery to agents, who are under NAM/ICM control. When functioning as a Service Node IVR, the 
ISN can stay involved with a call even after it has been transferred to another VoIP endpoint.

The ISN can act as either IVR type. However, to be able to access all the benefits of the ISN functionality, 
you should deploy the ISN as a Service Node IVR.

Note For complete information about the deployment options available for ISN., see Appendix C, “ISN 
Deployment.”
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Transferring Calls with ISN 
Table B-1 describes the transfer types available to the ISN.

Transferring Calls with the Select Node

An ICM script can use a combination of a Select node and ECC variables to perform a transfer within 
ISN. The label includes information to indicate the type of transfer to be performed as well as the number 
(or representation of the number) to use for the destination. The Application Server then forwards this 
information to the Voice Browser.

Since the transfer is happening as a result of a Select node, there is no way for the ICM or ISN’s software 
to check if the customer label and associated variable is valid or not. Therefore, if the transfer cannot 
occur, no matter what the reason, the call flow diverts to the Select node error branch.

Table B-1 Transfer Types

Type of Transfer Description Notes

TDM Network Transfer 
(traditional take back and 
transfer)

Executes a PSTN transfer. The NAM/ICM sends a 
“transfer” command through the network NIC instead 
of issuing a label to the ISN. 

This method does not directly involve the ISN since the 
transfer messages are sent through the NIC to the 
PSTN.)

Valid for ISN deployed as an Intelligent 
Peripheral IVR. 

The call must have been pre-routed by 
the NAM/ISN, so it can store the 
network call ID and use it to send the 
transfer command to the NIC.

IP Transfer (call delivery 
within the VoIP network)

Executes a “move” within the VoIP network, with the 
option of first providing IVR treatment to the caller. 
The ISN uses VoIP to switch the incoming call to an 
IP-based destination, where the destination may be the 
actual agent (on an IP Phone) or a Gateway that passes 
the call to the agent on a traditional telephone (usually 
behind an ACD/PBX).

A Gatekeeper is required for this type of transfer to 
resolve the NAM/ICM routing label into an IP address 
for the ISN to communicate with to route the call. 

Valid for ISN deployed as a Service 
Node IVR.

The call must be translation routed to a 
peripheral target (agent on TDM ACD) 
or be sent to a device target (IPCC 
agent) in order for the agent to request a 
subsequent transfer.

Outpulse Transfer Executes a PSTN transfer from within the VoIP 
network. The ISN sends DTMF signals to a carrier 
network through the ingress Gateway, then the carrier 
network disconnects the call from the Gateway—and 
the ISN—and delivers it to the agent.

Valid for ISN deployed as a Service 
Node IVR.

IPCC Local Transfer Executes a transfer within the VoIP network using the 
Cisco Call Manager.

Valid for ISN deployed as a Service 
Node IVR.

The CCM is responsible for performing 
the transfer. 
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Label Definition

Labels are part of the ICM configuration. The ICM determines which label to send and includes it in the 
request to transfer the caller. Then, for IP transfers, the ISN does a Gatekeeper look-up on the label from 
ICM to determine the IP address of the called party. 

Note For more information on this process, see Chapter 8, “VoIP Configuration.”

There are some caveats regarding label definition for use with the ISN:

• For requery and network transfer to work, you must define “dummy” VRU labels, even if the ISN 
is the main routing client. In addition, in a NAM/CICM configuration, these labels must be defined 
identically on both the NAM and CICM. 

• A limitation of the ISN software is that you cannot use NAM/ICM feature of substitution variables 
(such as %1).

Labels for ISN calls which will require outpulse transfer mode must be pre-pended with the 
characters DTMF. By configuring the target label with the form DTMFnnnnn (where nnnnn are 
the digits to outpulse) the ISN will send the digits to the ingress endpoint for outpulsing. 
(Conversely, a label not intended for outpulse transfer mode use cannot begin with DTMF.)

For example, to use the AT&T Transfer Connect feature to transfer the call to the number “4441234” 
the label would be configured as DTMF*84441234. 

Note In outpulse transfer mode, the ISN will send whatever digits are in the label to the Gateway 
for outpulsing. It is the customer’s responsibility to confirm interoperability with the target 
switch.

Script Examples
The remainder of this appendix provides examples of ISN call transfer scripts.

Note A limitation of the ISN software is that the Script Editor Busy and Ring nodes are not supported.

Example: Transfer to a Label 
This example shows sample ICM Configuration Manager and Script Editor screen captures for a Menu 
application that plays a prompt presenting a menu (“Our office hours are between 8 AM and 6 PM. If 
you would like to talk to a customer service representative, press 0 at any time.”) and then does the 
following:

• If the call presses 0, collects the digit, and then routes and queues the call.

• If the caller does not press 0, releases the call.
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Figure B-1 Office Hours Menu Configuration 

The Network VRU Script List tool’s Attribute tab in Figure B-1 shows:

1. The VRU Script Name field contains two ISN parameters:

– M. Menu

– OfficeHours. Media File name

2. The Config Params field contains the following ISN parameter:

– 0. The number 0 is the only valid option.
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Figure B-2 Transfer
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Example: Queue and Transfer to a Skill Group
The ICM can queue a call to an agent group and instruct the ISN to entertain the caller with IVR scripting 
using the Run VRU Script and other nodes. When the resource becomes available, the ICM tells the ISN 
to cancel the original request, the ISN then confirms the cancel request, the ICM sends the label for the 
destination, and the ISN or network will transfer the call to a freed-up agent. 

This example shows sample ICM Configuration Manager and Script Editor screen captures for a Menu 
application that plays a prompt presenting a menu (“For Checking, press 1. For Savings, press 2. To 
speak to a customer service representative, press 0.”), retrieves any caller-entered digits, then routes and 
queues the call.

Figure B-3 Queue Menu Configuration 

The Network VRU Script List tool’s Attribute tab in Figure B-3 shows:

1. The VRU Script Name field containing two ISN parameters:

– M. Menu

– Queue. Media File name

2. The Configuration Param field containing the following ISN parameters:

– 1-2,0. The numbers. 1, 2, and 0 are valid options
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Figure B-4 Queue 
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Example: Network Transfer Script
ISN provides capabilities to transfer calls to another destination after they have been answered by an 
agent. These capabilities are referred to as Network Transfer. The Network Transfer feature does not 
require any special installation on the part of ISN. The feature is disabled by default for all PG types 
except Enterprise Agent (EA).

To change the Network Transfer setting, do the following:

• Use the Script Editor’s Set node to specify the Call.NetworkTransferEnabled variable. If you set 
this variable to 1, Network Transfer is enabled; if you set it to 0, Network Transfer is not enabled.

• In EA PG setups where the EA is behind a PBX, use the Network Transfer Preferred checkbox on 
the PG Explorer’s Routing Client tab. If this box is “checked,” Network Transfer is enabled; if 
“unchecked,” Network Transfer is not enabled.

Figure B-5 Network Transfer Script
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Configuring IPCC Re-route On No Answer for ISN
This section describes how to use the Re-route On No Answer function when using ISN as a queue point 
for IPCC.

Summary
When using IPCC with ISN as a queuing point and routing client, Re-route On No Answer needs to be 
configured differently than when using it with IP-IVR. The difference is caused by the fact that when 
using IP-IVR the call control is with CallManager whereas, with ISN, the call control is with ISN.

Re-route On No Answer Operation for IPCC with IP-IVR
The Re-route On No Answer function ensures that when an agent does not answer a call – for example, 
because he walked away from his desk without making himself Not Ready – the call is taken away after 
ringing for a configurable number of seconds, is presented to another agent or put back in queue, and the 
agent is put in Not Ready state.

This function is implemented by setting a Re-route On No Answer timeout in the agent desk settings. 
When the call has been ringing for the configured number of seconds, the CallManager PG will make 
the agent unavailable and send a post-route request to ICM software using a dialed number that is also 
configured in the Agent Desk Settings. A routing script is executed that determines a new destination for 
the call. This can be another agent, or the script can put the call back in a queue. When using Re-route 
On No Answer with IP-IVR, ICM software responds back to CallManager with the new destination for 
the call. CallManager is responsible for sending the call to the right destination (IP-IVR for queuing or 
new agent).

Re-route On No Answer Operation with ISN
When using IPCC with ISN, CallManager does not control the queuing platform (ISN) and can therefore 
not send the call back to ISN for re-queuing. Instead, ISN controls the call and needs to take action.

The solution is to use the Re-route On No Answer function only to make the agent unavailable when he 
does not answer the call, and to use the ICM Router Requery function to take the call away from the 
non-answering agent.

Re-route On No Answer Agent Desk Settings Configuration

The Agent Desk Settings configuration need to have a ‘ring no answer time’ set, but should NOT have 
a ‘ring no answer dialed number’ set. The timeout should be set to the maximum time you want to allow 
the agent to answer a call, for example, 2 rings = 8 seconds. This timer should be set shorter than the no 
answer timeout for router requery (see below).
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Figure B-6 Agent Desk Settings Configuration

This will cause the agent to be made unavailable after the Re-route On No Answer timer expires, but will 
not invoke the Re-route On No Answer mechanism to re-route the call.

Router Requery Configuration

Router Requery is triggered by the routing client (ISN) when a No Answer timer expires (a different 
timer than the Re-route On No Answer timer).

• The No Answer timer for Router Requery is not controlled by ICM, but by the switching fabric, 
which is ISN in this case. ISN 1.0 has a fixed No Answer timer of 15s. ISN 2.0’s Voice Browser has 
a configurable No Answer timer, called RNATimeout (with a default value of 15s). It can be set 
using the VB Admin tool. When using ISN 2.0, set RNATimeout to the desired number of seconds 
that the agent phone should ring before being taken away. This would probably be less than 15 
seconds (4 rings), perhaps 10s. In any case, this timeout must be longer than the Re-route On No 
Answer timeout set in the Agent Desk Settings.

• Enable Requery on the node in the script that selects the first agent. Depending on the type of node 
used, the Requery mechanism will select a new target from the available agents or will require 
additional scripting. The Cisco ICM Software Scripting and Media Routing Guide describes how 
Requery works for the different nodes.

In most cases IPCC will use the Queue node. The Queue node requires additional scripting to handle the 
requeuing of the call in front of the queue. The script example below provides a standard way of handling 
this.
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The Queue node selects the longest available agent from the skill groups configured, if there is an 
available agent. If there is no available agent, it queues the call with a priority set in the node (see screen 
shot below) and continues down the success exit of the node. When an agent becomes available, ICM 
always selects the longest queued call from the ones with the highest priority. When the Queue node 
connects the call to an agent and the agent does not answer the call, the ISN Ring-No-Answer timeout 
will expire, causing the Requery mechanism to kick in.

Figure B-7 Queue to Skill Group Properties

When this happens, the script immediately continues through the failure exit of the Queue node with the 
Requery Status variable set to ‘No Answer’ (= 3). The typical treatment is to put the call back into the 
same queue but with a higher priority than all other calls, since the call needs to go in the front of the 
queue, not the back.
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Figure B-8 Sample Script for Re-Route on NoAnswer

In this script, when the Queue node selects an agent that does not answer the call, the script exits through 
the failure exit (X) of the Queue node. The If node tests the RequeryStatus variable. If it has value of 
greater than zero, this is a requery call, and the script re-queues the call. In the example above it also sets 
a flag using a call variable for reporting purposes (see below). Assuming that there are no agents 
available, the Queue node immediately exits through the success exit (Checkmark). The If node checks 
to see if this is a requeried call. If so, it increases the Queue Priority of the call so that it will be handled 
before any other calls in queue. It then enters the normal wait loop with RunScripts.

The call flow is as follows:

• Script connects call to agent by sending connect message to ISN (with requery enabled).

• Agent phone rings.

• After the Re-route On No Answer timeout expires, ICM makes the agent unavailable. The agent 
state does not actually change until the call gets taken away from the agent. The agent phone 
continues to ring and the agent can still pick up the phone (if he does pick up the phone, he will be 
left in Ready state after the call, even if it was after the Re-route On No Answer timer expired).

• After the ISN VB RNATimeout expires, the VB/AS/PG sends an EventReport=No Answer to the 
router. The router picks another target according to the routing script and sends the Connect message 
to ISN. The target might be another agent or it might be a VRU label to requeue the call.

• When the call disappears from the first agent he is put in Not Ready state.
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Limitations
The configuration described in this section has the following limitations:

• The disposition of the requeried call is not correctly reported. The Redirect No Answer field in the 
agent and skill group reports do not show calls that are redirected by this mechanism. Each call that 
is redirected by this mechanism is counted twice, once as abandoned and once as handled (if the call 
is finally handled). There are two IPCC TerminationCallDetail records for this call, one for the 
rerouted call (with CallDisposition ‘Abandoned while Ringing’, code 3) and one for the handled call 
with a CallDisposition depending on how the call was finally handled. The scripting example above 
shows how a Peripheral Call Variable can be used to mark and count calls Requeried because of no 
answer. A custom reporting template can be written to report on this data.

• CSCma21967 - Network Transfer fails when Requery is enabled. This bug is fixed in ICM 4.6.3 and 
5.0. There is currently no fix available for 4.6.2. When an agent has answered a call and initiates a 
blind transfer, an ICM script selects the destination for the call. If the script node that selects a 
destination for the transferred call has requery enabled, the transfer fails when it is a network 
transfer. This means that the Re-route On No Answer mechanism described here cannot be used for 
calls that are being network transferred to another agent. However, it does not affect the use of 
Router Requery by ISN as recommended above.
B-13
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Appendix B      Transferring and Queuing Calls with ISN
Configuring IPCC Re-route On No Answer for ISN
B-14
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Cisco Internet Service Node (ISN) 
OL-1251-02
A P P E N D I X C

ISN Deployment 

This appendix provides the detailed deployment information required for the deployment models 
supported by ISN Version 2.0. 

This appendix includes information for (or pointers to information for) configuring the Gateway, 
Gatekeeper, ICM VRU handling, and ISN Voice Browser and Application Server.  

This appendix does not include:

• Detailed ICM configuration for configuring agents or writing scripts. 

• Complete configuration for every component of the system (for example, the TDM side of the Voice 
Gateway configuration). 

• Configuration steps for all the components as they relate to the ISN deployment models described 
in the Cisco Internet Service Node (ISN) Product Description.

The information in this appendix assumes that you are already familiar with:

• Configuring Cisco Gateways and Gatekeepers. 

• The ICM Configuration Manager and ICM Script Editor tools for call center operations and 
management.

Note You should have a copy of the following Cisco ICM software documentation available in addition to 
this manual in order to successfully configure ICM software and use its features in conjunction with ISN: 
Cisco ICM Software Configuration Guide and Cisco ICM Software ICM Script Editor Guide. 
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Before You Begin
In order to use the information in this appendix, you need to know the following:

• The ISN deployment model you will be implementing. 

Note For descriptions of the ISN Deployment models, see the Cisco Internet Service Node (ISN) 
Product Description.

• The network topology for your system, including addresses and names of the solution components.

• The failover strategy for Gateways, ISN components, and media servers.

• The strategy for inbound call routing (that is, dial peers versus Gatekeeper).

• The naming resolution system for Gateways (DNS versus configured on the Gateway).

• If using a VRU other than ISN, the VRU trunk group number and number of trunks.

• The locale values to be used for ASR and/or TTS.

• Whether the same set of VRUs are to be used for all cases, or whether that will be determined 
separately for each customer (dialed number).   

Note If all dialed numbers will use the same VRUs, it is easiest to use a default Network VRU, rather 
than to configure multiple Network VRUs. For more information, see the “Common 
Configuration for Differentiating VRUs (ISNs) Based on Dialed Number” section on page C-81.

Routing Calls Through the Network to the VRU
For ISN Comprehensive Deployment models and for deployment models with a NIC:

• Determine the Network Routing Number. This number is the base for routing calls through the 
network to the VRU; a correlation ID is appended to this number to transfer calls to a Network VRU 
through the network.  

• Determine the correlation IDs that will be used for transferring the calls to the VRU through 
the network.  The range needs to be as large as the number of new call arrivals that might occur 
during the longest time it takes to get any to the VRU, that is, the time to execute a Send to VRU 
node.  This time needs to include the network delays and the possibility that alternate endpoints are 
used in the VoIP network. In practice, make sure the number is significantly larger than this to 
ensure there are always enough.  For example, if the time to get to the VRU is 3 seconds and the 
maximum call arrival rate is 5 cps (instantaneous), 15 would be needed, so specify a value of 100.

For deployments with a Customer VRU and in NAM/CICM environments and for NIC Type 2 or 8 
deployments:

• Determine the translation route pools to use for each VRU.  Determine the labels to be sent to 
the network to connect the call to the VRU and the corresponding DNIS that will be seen by the 
VRU.  For example, the label for the network might be 18008889999 and the DNIS received by the 
VRU and sent back to the ICM to identify the call might be 9999.
C-2
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Appendix C      ISN Deployment
Before You Begin
Naming Schemes
Define naming schemes to be used for ICM PGs, Peripherals and routing clients.

Installation
Before using the information in this appendix, you need to do the following:

• Install the ISN software.

• Install all the solution components. 

• Make sure VRU PGs use service control with Service Control Queue Reporting enabled. Also, take 
note of the VRU Connection Port used for each VRU PG peripheral (PIM).

• Make sure the NIC cards, Voice GW and network components all have the Ethernet interfaces 
configured with the appropriate speed and setting. 

Caution Do not use the AUTO setting in NIC cards, Voice Gateway, or network components.

Where to Go from Here?
Instructions for each deployment model follows.
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ISN Comprehensive Deployments
ISN Comprehensive Deployments
This section describes the call flows and provides configuration instructions for the following ISN 
deployment models:

• ISN Comprehensive Deployment, ICM Enterprise

• ISN Comprehensive Deployment, NAM/CICM 

Note The ISN Comprehensive deployment models do not support calls which originate in IP. 

ISN Comprehensive Deployment, ICM Enterprise
In this deployment model, the ISN acts as the Switch, transferring the call to the Network VRU (Type 7 
flow) and to agents. The ISN Application server is also configured to work with the Voice Gateway to 
provide VRU treatment, which may include ASR/TTS. In this deployment model, both the Voice 
Gateway and the Application Server see two calls:

• One for the Switch leg. 

• One for the VRU leg.

For the Switch leg, the Gateway simply provides Gateway capabilities from TDM to VoIP. For the VRU 
leg, the Gateway provides VRU voice treatment.

Figure C-1 shows the call flow for this deployment model.

Note Although Figure C-1 shows two Gateways (one where the call arrives and a separate one for the VRU 
leg), these could be the same physical Gateway. Similarly, the ISN Application Server and the PG could 
be the same physical machine. 

For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.
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ISN Comprehensive Deployments
Figure C-1 ISN Comprehensive Deployment, ICM Enterprise

Configuration overview for this deployment model:

• There are two Network VRUs:

– One for the Switch leg (Type 5). 

– One for the VRU leg (Type 7).

• System Information must include correlation ID settings.

• Use the ICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Note: The numbers in the figure indicate call flow progression.
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ISN Comprehensive Deployments
Table C-1 contains the configuration instructions for this deployment model.

Table C-1 Configuration Checklist, ISN Comprehensive Deployment, ICM Enterprise

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used to receive the calls 
from the network (the Switch leg):

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN Voice 
Browser using dial peers or Gatekeeper 
lookup.

2. Configure the Ethernet connections.

For more information about Steps 1 and 2, see Chapter 8, “VoIP 
Configuration.” 

On the Gateways used for the VRU leg:

1. Configure the servers and voice 
application it will use. 

2. If a different GW is used for the VRU, 
configure the Ethernet connections.

3. If a different GW is used for the VRU, 
copy the bootstrap files from ISN 
Installation.

4. Configure the characteristics for the 
VRU leg. 

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 2, 3, and 4, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are as follows:

• If you are using a content switch for failover, the files are in:

<basedir>/ApplicationServer/Downloads/
 VB-CSS-CallRestart

• Otherwise, they are in:

<basedir>/ApplicationServer/Downloads/
VB-noCSS-CallRestart

For Step 4:

dial-peer voice <Dial-Peer Number> voip

application vru-leg

incoming called-number <Network Routing Number> T

*\ For example, 8001112222T \*

Dtmf-relay rtp-nte H45-signal h245-alphanumeric

Codec g711ulaw

No vad

Note These characteristics are for VRU legs requiring ASR 
and/or TTS treatment. If you have other requirements for 
DTMF relay, Codecs or VAD settings, you should modify 
the commands accordingly.

On the Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

2. Configure the Gatekeeper to send all the 
VRU connections to the applicable 
Gateway.

For instructions for Step 1, see Chapter 8, “VoIP Configuration.”

For Step 2, include the following: 

zone prefix <GK> <Network Routing Number>* gw-priority 10 
<GW address(es)>

For example:

zone prefix gk-stooge 8001112222* gw-priority 10
vru1@provider.com vru2@provider.com
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On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU.

Specify the following:

• Type: 5. 

• Name: isnSwitch. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnSwitch will be 
assumed.

On the ICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
Switch leg.

2. Configure a peripheral for each ISN 
Application Server to be used for a Switch 
leg connected to each PG. 

For each ISN Application Server connected to this PG, in the tree 
view pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, for example, 
<location>_A for side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this ISN peripheral, for 
example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Select the Enable Post-routing checkbox.

On the Advanced tab, select the name isnSwitch from the Network 
VRU field drop-down list.

Routing Client tab:

• Name: By convention, use the same name as the peripheral.

• Client Type: VRU. 

On the ICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
VRU Client leg.

2. Configure a peripheral for each ISN 
Application Server to be used for a VRU 
leg connected to each PG. 

Note If the ISN Application Servers to use 
for the VRU legs are the same as those 
for the Switch legs, this step as this 
configuration is already completed. If 
the PGs are the same but the 
Application Servers are different, 
then only the second part of the step 
needs to be performed.

For each ISN Application Server connected to this PG, in the tree 
view pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, for example, 
<location>_A for side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this ISN peripheral, for 
example, <location>_<isn1> or <dns_name>. 

• Client Type: VRU.

• Do not select the Enable Post-routing checkbox.

Table C-1 Configuration Checklist, ISN Comprehensive Deployment, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for each ISN Switch.

Specify the following:

• Type: 7. 

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for each Application Server that is handling the 
Switch leg:

– Label: Network routing number.

– Type: Normal. 

– Routing client: Select the routing client configured for that 
ISN Application Server peripheral from the drop-down list.

ICM Configuration Manager, System 
Information tool:

1. Define the correlation IDs.

2. Define a default Network VRU.

Specify following in the General section of the System Information 
tool:

• Set maximum and minimum correlation ID values.

– Minimum correlation ID: Starting number for the 
correlation ID, for example, 1000.

– Maximum correlation ID: Ending number for the 
correlation ID, for example, 1099.

• Define the Default Network VRU: IsnVRU.

On each ISN Application Server: 

1. Configure the ports for the both legs of 
the call.

2. Check other settings.

Specify the following: 

• On the Call Definitions page, set the Dialed Number 
Maximum Length if no Correlation ID present field to the 
length of the Network Routing Number.

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the ports for both groups according to the licenses 
purchased, call profiles, and capacity. The “New Calls” group 
is used for the Switch leg; the “ID for ICM” group is used for 
the VRU leg.

• See Chapter 5, “Application Server Administration” for other 
settings you might want to adjust from the default values. 

Table C-1 Configuration Checklist, ISN Comprehensive Deployment, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ISN Comprehensive Deployments
On each ISN Voice Browser: 

1. Configure the Gatekeeper.

2. Configure the capacity.

3. Check other settings.

Specify the following: 

• SetGateKeeper <NewValue>

Where <NewValue> is the IP address for the Gatekeeper 
serving the Voice Browser. 

• Configure the total number of calls and IVR ports according to 
the licenses purchased, call profiles and capacity. (For 
instructions, see Chapter 4, “Voice Browser Administration”.)

• See Chapter 4, “Voice Browser Administration” for other 
settings you might want to adjust from the default values. 

ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts.

Create scripts to be used for IVR treatment and agent transfer. The 
VRU scripts are associated with the applicable Network VRU, that 
is, IsnVRU.

Use the ICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. For more information about creating scripts, see 
Chapter 2, “Using NAM/ICM with the ISN IVR Solution.” 

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the ICM, ICM Configuration Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch (CSS):

1. If necessary, configure the CSS.

For more information, see the Cisco Content Services Switch user 
documentation.

Table C-1 Configuration Checklist, ISN Comprehensive Deployment, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ISN Comprehensive Deployment, NAM/CICM
In this deployment model, the ISN is deployed at the NAM where it acts as the Switch, transferring the 
call to the Network VRU (Type 7 flow) and to agents. The ISN Application Server is also configured to 
work with the Voice Gateway to provide VRU treatment, which may include ASR/TTS. In this 
deployment model, both the Voice Gateway and the Application Server see two calls:

• One for the Switch leg. 

• One for the VRU leg.

For the Switch leg, the Gateway simply provides Gateway capabilities from TDM to VoIP. For the VRU 
leg, the Gateway provides VRU voice treatment.

ICM sees these as a single call routed through different peripherals for different purposes.

Figure C-2 shows the call flow for this deployment model.

Note Although Figure C-2 shows two Gateways (one where the call arrives and a separate one for the VRU 
leg, these could be the same physical Gateway. Similarly, the ISN Application Server and the PG could 
be the same physical machine. 

For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-2 ISN Comprehensive Deployment, NAM/CICM 

Configuration overview for this deployment model:

• There are three Network VRUs:

– One on the NAM for the Switch leg (Type 5).

– One for the NAM for the VRU leg (Type 7).

Note: The numbers in the figure indicate call flow progression.
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– One for the CICM for the INCRP connection. 

• System Information on the NAM and CICM must include correlation ID settings.

• The Network VRU names (where applicable), correlation ID settings, and the ECC variable 
configurations must be identical on the NAM and CICM. All Labels must also be duplicated but 
their routing clients will be different.

• Use the ICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Table C-2 contains the configuration instructions for this deployment model.

Table C-2 Configuration Checklist, ISN Comprehensive Deployment, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used to receive the calls 
from the network (the Switch leg):

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN VB 
using dial peers or Gatekeeper lookup.

2. Configure the Ethernet connections.

For more information about Steps 1 and 2, see Chapter 8, “VoIP 
Configuration.” 

On the Gateways used for the VRU leg:

1. Configure the servers and voice 
application it will use. 

2. If a different GW is used for the VRU, 
configure the Ethernet connections.

3. If a different GW is used for the VRU, 
copy the bootstrap files from ISN 
Installation.

4. Configure the characteristics for the 
VRU leg. 

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 2, 3, and 4, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are as follows:

• If you are using a content switch for failover, the files are in:

<basedir>/ApplicationServer/Downloads/
 VB-CSS-CallRestart

• Otherwise, they are in:

<basedir>/ApplicationServer/Downloads/
VB-noCSS-CallRestart

For Step 4:

dial-peer voice <Dial-Peer Number> voip

application vru-leg

incoming called-number <Network Routing Number> T

*\ For example, 8001112222T \*

Dtmf-relay rtp-nte H45-signal h245-alphanumeric

Codec g711ulaw

No vad

Note These characteristics are for VRU legs requiring ASR 
and/or TTS treatment. If you have other requirements for 
DTMF relay, Codecs or VAD settings, you should modify 
the commands accordingly.
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On the Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

2. Configure the Gatekeeper to send all the 
VRU connections to the applicable 
Gateway.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.”

For Step 2, include the following: 

zone prefix <GK> <Network Routing Number>* gw-priority 10 
<GW address(es)>

For example:

zone prefix gk-stooge 8001112222* gw-priority 10
vru1@provider.com vru2@provider.com

On the NAM and CICMs:

1. Configure the Network VRUs and PGs for 
the Switch leg.

For instructions see “Common NAM/CICM Configuration for ISN 
Switch Leg” section on page C-77.

On the NAM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
VRU Client leg.

2. Configure a peripheral for each ISN 
Application Server to be used for a VRU 
leg connected to each PG. 

Note If the ISN Application Servers to use 
for the VRU legs are the same as those 
for the Switch legs, this step as this 
configuration is already completed. If 
the PGs are the same but the 
Application Servers are different, 
then only the second part of the step 
needs to be performed.

For each ISN Application Server connected to this PG, in the tree 
view pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, for example, 
<location>_A for side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this ISN peripheral, for 
example, <location>_<isn1> or <dns_name>. 

• Client Type: VRU.

• Do not select the Enable Post-routing checkbox.

On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for reaching the NAM.

Specify the following:

• Type: 7. 

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for routing the calls through the network to the 
VRU:

– Label: The network routing number. 

– Type: Normal. 

– Routing client: Select the INCRP routing client from the 
drop-down list.

Note Make sure the Network VRU label is identical in the NAM 
and CICM. It is recommended that the Network VRU Name 
be identical as well to avoid confusion.

Table C-2 Configuration Checklist, ISN Comprehensive Deployment, NAM/CICM  (continued)

Where To Go/What to Do Settings Specific to This Deployment
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On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for each ISN Switch.

Specify the following:

• Type: 7. 

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for each Application Server that is handling the 
Switch leg:

– Label: The number to be used as the base for routing calls 
through the network to the VRU.

– Type: Normal

– Routing client: Select the routing client configured for that 
ISN Application Server peripheral from the drop-down list.

Note Make sure the Network VRU label is identical in the NAM 
and CICM. It is recommended that the Network VRU Name 
be identical as well to avoid confusion.

In the NAM, ICM Configuration Manager, 
System Information tool:

1. Define the correlation IDs.

2. If there will be Routing Scripts on the 
NAM, define a default Network VRU.

For Step 1, do the following in the General section of the System 
Information tool:

• Set maximum and minimum correlation ID values.

– Minimum correlation ID: Starting number for the 
correlation ID, for example, 1000.

– Maximum correlation ID: Ending number for the 
correlation ID, for example, 1099.

For Step 2, do the following in the General section of the System 
Information tool:

• Define the Default Network VRU: IsnVRU.

On the CICM, ICM Configuration Manager, 
System Information tool:

1. Define a default Network VRU.

For Step 1, do the following in the General section of the System 
Information tool:

• Define the Default Network VRU: IsnVRU.

Table C-2 Configuration Checklist, ISN Comprehensive Deployment, NAM/CICM  (continued)

Where To Go/What to Do Settings Specific to This Deployment
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On each ISN Application Server: 

1. Configure the ports for the both legs of 
the call.

2. Check other settings.

Do the following: 

• On the Call Definitions page, set the Dialed Number 
Maximum Length if no Correlation ID present field to the 
length of the Network Routing Number.

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the ports for both groups according to the licenses 
purchased, call profiles, and capacity. The “New Calls” group 
is used for the Switch leg; the “ID for ICM” group is used for 
the VRU leg.

• See Chapter 5, “Application Server Administration” for other 
settings you might want to adjust from the default values. 

On each ISN Voice Browser: 

1. Configure the Gatekeeper.

2. Configure the capacity.

3. Check other settings.

Do the following: 

• SetGateKeeper <NewValue>

Where <NewValue> is the IP address for the Gatekeeper 
serving the Voice Browser. 

• Configure the total number of calls and IVR ports according to 
the licenses purchased, call profiles and capacity. (For 
instructions, see Chapter 4, “Voice Browser Administration”.)

• See Chapter 4, “Voice Browser Administration” for other 
settings you might want to adjust from the default values. 

On the CICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts.

Create scripts to be used for IVR treatment and agent transfer. The 
VRU scripts are associated with the applicable Network VRU, that 
is, IsnVRU.

Use the CICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. For more information about creating scripts, see 
Chapter 2, “Using NAM/ICM with the ISN IVR Solution.”

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

Table C-2 Configuration Checklist, ISN Comprehensive Deployment, NAM/CICM  (continued)

Where To Go/What to Do Settings Specific to This Deployment
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On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch (CSS):

1. If necessary, configure the CSS.

For more information, see the Cisco Content Services Switch user 
documentation.

Table C-2 Configuration Checklist, ISN Comprehensive Deployment, NAM/CICM  (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ISN Queue and Transfer Deployments
This section describes the call flows and provides configuration instructions for the following ISN 
deployment models:

• ISN Queue and Transfer Deployment, ICM Enterprise

• IISN Queue and Transfer Deployment with “Other” Network VRU, ICM Enterprise

• ISN Queue and Transfer Deployment, NAM/CICM 

• ISN Queue and Transfer Deployment with “Other” Network VRU, NAM/CICM 

• ISN Queue and Transfer Deployment with “Other” Customer VRU, NAM/ICM 

ISN Queue and Transfer Deployment, ICM Enterprise 
In this deployment model, the ISN acts as the VRU and as the switch to transfer the call to agents. The 
ISN Voice Browser provides voice treatment; ASR/TTS processing is not possible.

Figure C-3 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-3 ISN Queue and Transfer Deployment, ICM Enterprise Edition

Configuration overview for this deployment model:

• There are two Network VRUs configured: 

– One for the Switch leg (Type 5). 

– One for the VRU leg (Type 5).

Note: The numbers in the figure indicate call flow progression.
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• Use the ICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Table C-3 contains the configuration instructions for this deployment model.

Table C-3 Configuration Checklist, ISN Queue and Transfer Deployment, ICM Enterprise

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used to receive the calls 
from the network (the Switch leg):

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN Voice 
Browser using dial peers or Gatekeeper 
lookup.

2. Configure the Ethernet connections.

For more information about Steps 1, and 2, see Chapter 8, “VoIP 
Configuration.” 

On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the switch 
function.

Specify the following: 

• Type: 5. 

• Name: isnSwitch. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnSwitch will be 
assumed.

On the ICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the ISN.

2. Configure a peripheral for each ISN 
Application Server connected to each PG. 

For each ISN Application Server connected to this PG, in the tree 
view pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, that is <location>_A for 
side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this ISN peripheral, for 
example, <location>_<isn1> or <dns_name>. 

• Client Type: VRU.

• Select the Enable Post-routing checkbox.

Advanced tab, select the name isnSwitch from the Network VRU 
field drop-down list.

Routing Client tab:

• Name: By convention, this is the same name as the peripheral.

• Client Type: VRU. 
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On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU 
function. 

2. Define Labels for each ISN switch.

Specify the following:

• Type: 5. 

• Name: isnVRU. 

Note This name is used by convention; however, any name will 
do. Although you could use the same Network VRU Name 
defined earlier in this process (isnVRU), defining a separate 
name here enable the possibility of easily changing deployment 
models later in the process. 

• Define one Label for each ISN application Server that is 
handling the Switch leg: 

– Label: Any number. 

Note Although this label is not used, it must be configured; its 
value is not meaningful.

– Type: Normal

– Routing client: Select the routing client configured for the 
ISN Application Server peripheral from the drop-down list.

ICM Configuration Manager, System 
Information tool:

1. Define a default Network VRU.

In the General section of System Information specify the 
following: 

• Default Network VRU Name: IsnVRU.

On each ISN Application Server: 

1. Configure the ports.

2. Check other settings.

Do the following: 

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the ports for the “New Calls” group according to the 
licenses purchased, call profiles, and capacity; the “ID for 
ICM” group is not used since the switch and VRU functions are 
handled in the call leg. 

• See Chapter 5, “Application Server Administration” for other 
settings you might want to adjust from the default values. 

On each ISN Voice Browser: 

1. Configure the Gatekeeper.

2. Configure the capacity.

3. Check other settings.

Specify the following: 

• SetGateKeeper <NewValue>

Where <NewValue> is the IP address for the Gatekeeper 
serving the Voice Browser. 

• Configure the total number of calls and IVR ports according to 
the licenses purchased, call profiles and capacity. (For 
instructions, see Chapter 4, “Voice Browser Administration”.)

• See Chapter 4, “Voice Browser Administration” for other 
settings you might want to adjust from the default values. 

Table C-3 Configuration Checklist, ISN Queue and Transfer Deployment, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts.

Create scripts to be used for IVR treatment and agent transfer. The 
VRU scripts are associated with the applicable Network VRU, that 
is, IsnVRU.

Use the ICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. For more information about creating scripts, see 
Chapter 2, “Using NAM/ICM with the ISN IVR Solution.” 

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the ICM, ICM Configuration Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch 
(CSS):

1. If necessary, configure the CSS.

For more information, see the Cisco Content Services Switch user 
documentation.

Table C-3 Configuration Checklist, ISN Queue and Transfer Deployment, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ISN Queue and Transfer Deployment with “Other” Network VRU, ICM 
Enterprise

In this deployment model, the ISN is used only as the switch to transfer calls to the VRU and agents; all 
of the VRU treatment at the “other” VRU, that is, a VRU which is not an ISN.

Figure C-4 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-4 ISN Queue and Transfer Deployment with “Other” Network VRU, ICM Enterprise

Configuration overview for this deployment model:

• There are two Network VRUs configured: 

– One for the Switch leg (Type 5). 

– One for the VRU leg (Type 7).

• System Information must specify correlation ID settings.

• Use the ICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Note: The numbers in the figure indicate call flow progression.
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Table C-4 contains the configuration instructions for this deployment model.

Table C-4 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Network VRU, ICM Enterprise

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used to receive the calls 
from the network (the Switch leg):

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN Voice 
Browser using dial peers or Gatekeeper 
lookup.

2. Configure the Ethernet connections.

For more information about Steps 1, and 2 , see Chapter 8, “VoIP 
Configuration.” 

On the Gatekeeper:

1. Configure the Gatekeeper to send all the 
VRU connections to the “other VRU.

2. Register the Gateway.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.” 

For Step 1, include the following: 

zone prefix <GK> <Network Routing Number>* gw-priority 10 
<VRU address(es)>

For example:

zone prefix gk-stooge 8001112222* gw-priority 10
vru1@provider.com vru2@provider.com

On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU.

Specify the following:

• Type: 5. 

• Name: isnSwitch. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnSwitch will be 
assumed.

On the ICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
Switch leg.

2. Configure a peripheral for each ISN 
Application Server to be used for a Switch 
leg connected to each PG. 

For each ISN Application Server connected to this PG, in the tree 
view pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, that is <location>_A for 
side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this ISN peripheral, for 
example, <location>_<isn1> or <dns_name>. 

• Client Type: VRU.

• Select the Enable Post-routing checkbox.

Advanced tab, select the name isnSwitch from the Network VRU 
field drop-down list.

Routing Client tab:

• Name: By convention, use the same name as the peripheral. 

• Client Type: VRU. 
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On the ICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
VRU Client leg.

2. Configure a peripheral for each VRU leg 
connected to each PG. 

Note If the ISN Application Servers to use 
for the VRU legs are the same as those 
for the Switch legs, this step as this 
configuration is already complete. If 
the PGs are the same but the 
Application Servers are different, 
then only the second part of the step 
needs to be performed.

For each VRU connected to this PG, in the tree view pane, select the 
applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, that is <location>_A for 
side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this VRU peripheral.

• Client Type: VRU.

• Do not select the Enable Post-routing checkbox.

On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU and its Labels for 
the VRU function.

Specify the following:

• Type: 7. 

• Name: other_vru. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, other_vru will be 
assumed.

• Define a Label for each ISN Application Server that is handling 
the Switch leg:

– Label: The number to be used as the base for routing calls 
through the network to the VRU. 

– Type: Normal. 

– Routing client: Select the routing client configured for the 
peripheral from the drop-down list.

ICM Configuration Manager, System 
Information tool:

1. Define the correlation IDs.

2. Define a default Network VRU.

On the System Information tab, General section:

• Define the Minimum correlation ID: A starting number for the 
correlation ID, for example, 1000.

• Define the Maximum correlation ID: An ending number for the 
correlation ID, for example, 1099.

• Define the Default Network VRU name, other_vru.

Table C-4 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Network VRU, ICM Enterprise 

Where To Go/What to Do Settings Specific to This Deployment
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On each ISN Application Server: 

1. Configure the ports.

2. Check other settings.

Do the following: 

• On the Call Definitions page, set the Dialed Number 
Maximum Length if no Correlation ID present field to the 
length of the Network Routing Number.

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the ports for the “New Call” groups according to the 
licenses purchased and capacity; the “ID from ICM” group is 
not used since this leg of the call will not go to the “other” VRU. 

• See Chapter 5, “Application Server Administration” other 
settings you might want to adjust from the default values. 

On each ISN Voice Browser: 

1. Configure the Gatekeeper.

2. Configure the capacity.

3. Check other settings.

Specify the following: 

• SetGateKeeper <NewValue>

Where <NewValue> is the IP address for the Gatekeeper 
serving the Voice Browser. 

• Configure the total number of calls and IVR ports according to 
the licenses purchased, call profiles and capacity. (For 
instructions, see Chapter 4, “Voice Browser Administration”.)

• See Chapter 4, “Voice Browser Administration” for other 
settings you might want to adjust from the default values. 

ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts.

Create scripts to be used for IVR treatment and agent transfer. The 
VRU scripts are associated with the applicable Network VRU, that 
is, other_VRU.

Use the ICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. For more information about creating scripts, see 
Chapter 2, “Using NAM/ICM with the ISN IVR Solution.”

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the ICM, ICM Configuration Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch (CSS):

1. If necessary, configure the CSS.

For more information, see theCisco Content Services Switch user 
documentation.

Table C-4 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Network VRU, ICM Enterprise 

Where To Go/What to Do Settings Specific to This Deployment
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ISN Queue and Transfer Deployment, NAM/CICM
In this deployment model, the ISN is at the NAM. It acts as the VRU and as the Switch to transfer calls 
to agents. The ISN Voice Browser provides voice treatment; ASR/TTS processing is not possible.

Figure C-5 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-5 ISN Queue and Transfer Deployment, NAM/CICM 

Configuration overview for this deployment model:

• There are three Network VRUs configured:

– One on the NAM for the Switch leg (Type 5).

– One for the NAM for the VRU leg (Type 5).

– One for the CICM for the INCRP connection. 

• The Network VRU names (where applicable) and the ECC variable configurations must be identical 
on the NAM and CICM. All Labels must also be duplicated but their routing clients will be different.

• Use the CICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Note: The numbers in the figure indicate call flow progression.
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Table C-5 contains the configuration instructions for this deployment model.

Table C-5 Configuration Checklist, ISN Queue and Transfer Deployment, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used to receive the calls 
from the network (the Switch leg):

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN Voice 
Browser using dial peers or Gatekeeper 
lookup.

2. Configure the Ethernet connections.

For more information about Steps 1 and 2, see Chapter 8, “VoIP 
Configuration.” 

On the Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.”

On the NAM and CICMs:

1. Configure the Network VRUs and PGs for 
the Switch leg.

For instructions see “Common NAM/CICM Configuration for ISN 
Switch Leg” section on page C-77.

On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and a Label for each ISN peripheral.

Specify the following:

• Type: 5. 

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for each ISN peripheral:

– Label: Any number.

Note Although this label is not used, it must be configured, and 
the same number must be used for all ISN peripherals.

– Type: Normal. 

– Routing client: Select the routing client configured for that 
ISN Application Server peripheral from the drop-down list.

Note Make sure the Network VRU label is identical in the NAM 
and CICM. It is recommended that the Network VRU Name 
be identical as well to avoid confusion.
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On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and a Label for reaching the NAM.

Specify the following:

• Type: 5. 

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for the NAM.

– Label: Any number.

Note Although this label is not used, it must be configured, and 
the same number must be used for all ISN peripherals.

– Type: Normal. 

– Routing client: Select the INCRP Routing Client from the 
drop-down list.

In the NAM, ICM Configuration Manager, 
System Information tool:

1. If there will be Routing Scripts on the 
NAM, define a default Network VRU.

In the General section of the System Information tool:

• Define the Default Network VRU: IsnVRU.

On the CICM, ICM Configuration Manager, 
System Information tool:

1. Define a default Network VRU.

In the General section of the System Information tool:

• Define the Default Network VRU: IsnVRU.

On each ISN Application Server: 

1. Configure the ports for the both legs of 
the call.

2. Check other settings.

Do the following: 

• Configure the ports for the “New Call” groups according to the 
licenses purchased and capacity; the “ID from ICM” group is 
not used since this leg of the call will not go to the “other” VRU. 

• See Chapter 5, “Application Server Administration” for other 
settings you might want to adjust from the default values. 

On each ISN Voice Browser: 

1. Configure the Gatekeeper.

2. Configure the capacity.

3. Check other settings.

Specify the following: 

• SetGateKeeper <NewValue>

Where <NewValue> is the IP address for the Gatekeeper 
serving the Voice Browser. 

• Configure the total number of calls and IVR ports according to 
the licenses purchased, call profiles and capacity. (For 
instructions, see Chapter 4, “Voice Browser Administration”.)

• See Chapter 4, “Voice Browser Administration” for other 
settings you might want to adjust from the default values. 

Table C-5 Configuration Checklist, ISN Queue and Transfer Deployment, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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On the CICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
script.

Create scripts to be used for IVR treatment and agent transfer. The 
VRU scripts are associated with the applicable Network VRU, that 
is, IsnVRU.

Use the ICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. For more information about creating scripts, see 
Chapter 2, “Using NAM/ICM with the ISN IVR Solution.”

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the NAM and CICM, ICM Configuration 
Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch (CSS):

1. If necessary, configure the CSS.

For more information, see the Cisco Content Services Switch user 
documentation.

Table C-5 Configuration Checklist, ISN Queue and Transfer Deployment, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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ISN Queue and Transfer Deployment with “Other” Network VRU, NAM/CICM
In this deployment model, the ISN is at the NAM. It acts as the Switch to transfer calls to the Network 
VRU and agents. The Network VRU (not an ISN) is deployed at the NAM; it is not an ISN, but rather, 
some other VRU which provides voice treatment.

Figure C-6 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-6 ISN Queue and Transfer Deployment with “Other” Network VRU, NAM/CICM 

Configuration overview for this deployment model:

• There are three Network VRUs configured:

– One on the NAM for the Switch leg (Type 5).

– One for the NAM for the VRU leg (Type 7).

– One for the CICM for the INCRP connection. 

• System Information on the NAM and CICM must specify correlation ID settings.

• The Network VRU names (where applicable), correlation IDs, and the ECC variable configurations 
must be identical on the NAM and CICM. All Labels must also be duplicated but their routing 
clients will be different.

• Use the CICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Table C-6 contains the configuration instructions for this deployment model.

Note: The numbers in the figure indicate call flow progression.
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Table C-6 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Network VRU, NAM/CICM

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used to receive the calls 
from the network (the Switch leg):

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN Voice 
Browser using dial peers or Gatekeeper 
lookup.

2. Configure the Ethernet connections.

For more information about Steps 1 and 2, see Chapter 8, “VoIP 
Configuration.” 

On the Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

2. Configure the Gatekeeper to send all the 
VRU connections to the applicable 
Gateway.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.”

For Step 2, include the following: 

zone prefix <GK> <Network Routing Number>* gw-priority 10 
<VRU address(es)>

For example:

zone prefix gk-stooge 8001112222* gw-priority 10
vru1@provider.com vru2@provider.com

On the NAM and CICMs:

1. Configure the Network VRUs and PGs for 
the Switch leg.

For instructions see “Common NAM/CICM Configuration for ISN 
Switch Leg” section on page C-77.

On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for each ISN Switch.

Specify the following:

• Type: 7. 

• Name: otherVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, otherVRU will be 
assumed.

• Define a Label for each Application Server that is handling the 
Switch leg.

– Label: Network Routing Number.

– Type: Normal. 

– Routing client: Select the routing client configured for that 
ISN Application Server peripheral from the drop-down list.

Note Make sure the Network VRU label is identical in the NAM 
and CICM. It is recommended that the Network VRU Name 
be identical as well to avoid confusion.
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On the NAM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the VRU 
Client Leg.

2. Configure a peripheral for each VRU 
connected to each PG. 

For each VRU connected to this PG, in the tree view pane, select the 
applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, that is <location>_A for 
side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this VRU peripheral, 
for example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Do not select the Enable Post-routing checkbox.

On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for each ISN Switch.

2. Define a Label for reaching the NAM.

Specify the following:

• Type: 7. 

• Name: otherVRU. 

Note This name is used by convention; however, any name will 
do.

• Define a Label for routing the calls through the network to the 
VRU.:

– Label: The Network Routing Number.

– Type: Normal. 

– Routing client: Select the INCRP Routing Client from the 
drop-down list.

In the NAM, ICM Configuration Manager, 
System Information tool:

1. Define the correlation IDs.

2. If there will be Routing Scripts on the 
NAM, define a default Network VRU.

For Step 1, do the following in the General section of the System 
Information tool:

• Set maximum and minimum correlation ID values.

– Minimum correlation ID: Starting number for the 
correlation ID, for example, 1000.

– Maximum correlation ID: Ending number for the 
correlation ID, for example, 1099.

For Step 2, do the following in the General section of the System 
Information tool:

• Define the Default Network VRU: otherVRU.

On the CICM, ICM Configuration Manager, 
System Information tool:

1. Define a default Network VRU.

In the General section of the System Information tool:

• Define the Default Network VRU: otherVRU.

Table C-6 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Network VRU, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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On each ISN Application Server: 

1. Configure the ports for the both legs of 
the call.

2. Check other settings.

Do the following: 

• On the Call Definitions page, set the Dialed Number 
Maximum Length if no Correlation ID present field to the 
length of the Network Routing Number.

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the ports for the “New Call” groups according to the 
licenses purchased and capacity; the “ID from ICM” group is 
not used since this leg of the call will not go to the “other” VRU. 

• See Chapter 5, “Application Server Administration” for other 
settings you might want to adjust from the default values. 

On each ISN Voice Browser: 

1. Configure the Gatekeeper.

2. Configure the capacity.

3. Check other settings.

Specify the following: 

• SetGateKeeper <NewValue>

Where <NewValue> is the IP address for the Gatekeeper 
serving the Voice Browser. 

• Configure the total number of calls and IVR ports according to 
the licenses purchased, call profiles and capacity. (For 
instructions, see Chapter 4, “Voice Browser Administration”.)

• See Chapter 4, “Voice Browser Administration” for other 
settings you might want to adjust from the default values. 

On the CICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts.

Create scripts to be used for IVR treatment and agent transfer, as 
described in other sections of this manual and in the ICM manuals. 
The VRU scripts are associated with the applicable Network VRU, 
that is, otherVRU.

Use the ICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. For more information about creating scripts, see 
Chapter 2, “Using NAM/ICM with the ISN IVR Solution.”

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

Table C-6 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Network VRU, NAM/CICM 
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On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch (CSS):

1. If necessary, configure the CSS.

For more information, see the Cisco Content Services Switch user 
documentation.

Table C-6 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Network VRU, NAM/CICM 
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ISN Queue and Transfer Deployment with “Other” Customer VRU, NAM/ICM
In this deployment model, the ISN is at the NAM. It acts as the Switch to transfer calls to the Customer 
VRU and agents. The Customer VRU is deployed at the CICM; it is not an ISN, but rather, some other 
VRU which provides voice treatment.

Tip For failover and redundancy, it might be appropriate to configure a service array for the Customer 
VRU. This appendix only gives instructions for configuring a service; for information about for 
configuring a service array, for configuring a service array, see the Cisco ICM Software user 
documentation.

Figure C-7 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-7 ISN Queue and Transfer Deployment with “Other” Customer VRU, NAM/CICM 

Configuration overview for this deployment model:

• There are three Network VRUs configured:

– One on the NAM for the Switch leg (Type 5).

– One for the NAM for the VRU leg (Type 8).

– One for the CICM for the INCRP connection. 

Note: The numbers in the figure indicate call flow progression.
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• You must define a Translation Route and Labels for the VRU at the CICM, together with matching 
labels in the NAM.

• Use the CICM Script Editor’s TranslationRouteToVRU node to connect the call to the VRU at the 
CICM.

Table C-7 contains the configuration instructions for this deployment model.

Table C-7 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Customer VRU, NAM/CICM

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used to receive the calls 
from the network (the Switch leg):

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN Voice 
Browser using dial peers or Gatekeeper 
lookup.

2. Configure the Ethernet connections.

For more information about Steps 1 and 2, see Chapter 8, “VoIP 
Configuration.” 

On the Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

2. Configure the Gatekeeper to send all the 
VRU connections to the applicable 
Gateway.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.”

For Step 2, include the following: 

zone prefix <GK> <Network Routing Number>* gw-priority 10 
<VRU address(es)>

For example:

zone prefix gk-stooge 8001112222* gw-priority 10
vru1@provider.com vru2@provider.com

On the NAM and CICMs:

1. Configure the Network VRUs and PGs for 
the Switch leg.

For instructions see “Common NAM/CICM Configuration for ISN 
Switch Leg” section on page C-77.

On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for each ISN Switch.

Specify the following:

• Type: 8. 

• Name: otherVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, otherVRU will be 
assumed.
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On the CICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
VRU.

2. Configure a peripheral for each VRU 
connected to each PG. 

For each VRU connected to this PG, in the tree view pane, select the 
applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, that is <location>_A for 
side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this VRU peripheral, 
for example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Do not select the Enable Post-routing checkbox.

Advanced tab:

• Network VRU: otherVRU.

On the CICM, ICM Configuration Manager, 
Service Explorer tool:

1. Configure a Service and Route for each 
VRU.

Note You can also use service arrays. Refer 
to the ICM documentation set for 
more information.

Specify the following: 

• Service Name: otherVRU. 

• Route Name: PeripheralName_otherVRU. 

• Do not configure a peripheral target or label.

On the CICM, ICM Configuration Manager, 
Network Trunk Group Explorer tool:

1. Configure the network trunk group.

2. Configure the trunks.

Note You must configure one Network 
Transfer Group and one associated 
Trunk Group for each VRU leg ISN 
Application Server.

For Step 1, specify the following: 

• Network Trunk Group Name: A name descriptive of this trunk 
group. 

For Step 2, specify the following: 

• Peripheral Name: A name descriptive of this trunk group.

• Peripheral Number: The VRU trunk group number (from the 
VRU).

• Peripheral Trunk Count: Trunk count from the VRU.

• Configure the trunks within the trunk group.

Table C-7 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Customer VRU, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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On the CICM, ICM Configuration Manager, 
Translation Route Explorer tool:

1. Define a Translation Route for each VRU 
Peripheral.

2. Configure translation route and label 
information for each VRU peripheral.

For Step 1, do the following:

• Translation Route tab:

– Name: The name of the target VRU peripheral. (This is by 
convention; this value must be unique in the enterprise.)

– Type: DNIS and select the Service defined in the previous 
step.

For Step 2, do the following:

• Route tab:

– Name: By convention, this is the name of the target VRU 
peripheral, followed by the DNIS that this route will use 
(for example, MyVRU_2000).

– Service Name drop-down: Select 
PeripheralName.otherVRU

• Peripheral Target tab:

– Enter the first DNIS that will be seen by the VRU that you 
will be using for this translation route.

Note The DNIS pool used for each VRU peripheral must be 
unique.

– Select a Network Trunk Group which belongs to the 
target VRU from the drop-down list. 

• Label tab:

– Label: The translation route label (which may or may not 
be the same DNIS you entered on the Peripheral Target 
tab).

– Type: Normal

– Routing Client: INCRP Routing Client that is mapped to 
the applicable NAM Routing Client.

Note Repeat the Route and corresponding Peripheral Target and 
Label information for each DNIS in the pool.

Table C-7 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Customer VRU, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for each translation route 
number.

Specify the following:

• Type: 8.

• Name: otherVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, otherVRU will be 
assumed.

• Define a Label for every translation route label created in the 
Translation Route Explorer in the CICM. The entire set must 
also be duplicated for each ISN routing client.

– Label: Enter each translation route number in each translation 
route DNIS pool.

– Type: Normal. 

– Routing client: Select each ISN from the drop-down list.

Note Because of the large number of labels involved, you might 
prefer to perform this task with the application Bulk 
Configuration tool.

On each ISN Application Server: 

1. Configure the ports for the both legs of 
the call.

2. Check other settings.

Do the following: 

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the ports for the “New Call” groups according to the 
licenses purchased and capacity; the “ID from ICM” group is 
not used since this leg of the call will not go to the “other” VRU. 

• See Chapter 5, “Application Server Administration” for other 
settings you might want to adjust from the default values. 

On each ISN Voice Browser: 

1. Configure the Gatekeeper.

2. Configure the capacity.

3. Check other settings.

Specify the following: 

• SetGateKeeper <NewValue>

Where <NewValue> is the IP address for the Gatekeeper 
serving the Voice Browser. 

• Configure the total number of calls and IVR ports according to 
the licenses purchased, call profiles and capacity. (For 
instructions, see Chapter 4, “Voice Browser Administration”.)

• See Chapter 4, “Voice Browser Administration” for other 
settings you might want to adjust from the default values. 

Table C-7 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Customer VRU, NAM/CICM 
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On the CICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts.

Create scripts to be used for IVR treatment and agent transfer. The 
VRU scripts are associated with the applicable Network VRU, that 
is, otherVRU.

Use the CICM Script Editor’s TranslationRouteToVRU node to 
connect the call to the Network VRU. For more information about 
creating scripts, see Chapter 2, “Using NAM/ICM with the ISN 
IVR Solution.”

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch (CSS):

1. If necessary, configure the CSS.

For more information, see the Cisco Content Services Switch user 
documentation.

Table C-7 Configuration Checklist, ISN Queue and Transfer Deployment with “Other” Customer VRU, NAM/CICM 
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ISN Advanced Speech 
This section describes the call flows and provides configuration instructions for the following ISN 
deployment models:

• ISN Advanced Speech Deployment, ICM Enterprise

• ISN Advanced Speech Deployment, NAM/CICM 

ISN Advanced Speech Deployment, ICM Enterprise
In this deployment model, the ISN works with the Voice Gateway to act as the VRU and as the Switch 
to transfer the call to an agent. The VRU voice treatment is provided at the Voice Gateway, and may 
include ASR/TTS. 

Note Queuing and network transfers are not possible and the ISN Voice Browser is not part of this 
deployment.

Figure C-8 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-8 ISN Advanced Speech Deployment, ICM Enterprise

Note: The numbers in the figure indicate call flow progression.
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Configuration overview for this deployment model:

• There are two Network VRUs configured: 

– One for the Switch leg (Type 5). 

– One for the VRU leg (Type 5).

Note Although the same Network VRU could be used for both purposes on the NAM, it is 
recommended that you keep them separate for flexibility in changing deployment models at 
some other time.

• Use the ICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Table C-8 contains the configuration instructions for this deployment model.

Table C-8 Configuration Checklist, ISN Advanced Speech Deployment, ICM Enterprise

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used for the VRU leg:

1. Configure the servers and voice 
application it will use. 

2. Configure the Ethernet connections.

3. Copy the bootstrap files from ISN 
Installation.

4. Configure the characteristics for the 
VRU leg. 

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 2, 3, and 4, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are as follows:

• If you are using a content switch for failover, the files are in:

<basedir>/ApplicationServer/Downloads/
 VB-CSS-CallRestart

• Otherwise, they are in:

<basedir>/ApplicationServer/Downloads/
VB-noCSS-CallRestart

For Step 4:

dial-peer voice <Dial-Peer Number> pots

application vru-leg

incoming called-number <dialed number pattern> T

direct-inward-dial 

If the ISN is going to transfer calls, on the 
Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.” 

On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the Switch 
leg.

Specify the following:

• Type: 5. 

• Name: isnSwitch. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnSwitch will be 
assumed.
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On the ICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the ISN.

2. Configure a peripheral for each ISN 
Application Server connected to each PG. 

For each VRU connected to this PG, in the tree view pane, select the 
applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, that is <location>_A for 
side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this ISN peripheral, for 
example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Select the Enable Post-routing checkbox.

Advanced tab, select the name isnSwitch from the Network VRU 
field drop-down list.

Routing Client tab:

• Name: By convention, use the same name as the peripheral. 

• Client Type: VRU. 

On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU and its labels.

Specify the following:

• Type: 5. 

• Name: isnVRU 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed. 

• Define one Label for each ISN peripheral:

– Label: Any number. 

Note This label is not used, however, it must be configured.

– Type: Normal

– Routing client: Select the routing client for the ISN 
Application Server from the drop-down list. 

ICM Configuration Manager, System 
Information tool:

1. Define a default Network VRU.

On the System Information tab, define the Default Network VRU 
name, IsnVRU.

Table C-8 Configuration Checklist, ISN Advanced Speech Deployment, ICM Enterprise (continued)
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On each ISN Application Server: 

1. Configure the ports.

2. Check other settings.

Do the following: 

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the ports for the “New Call” groups according to the 
licenses purchased and capacity; the “ID from ICM” group is 
not used since the switch and VRU functions are handled in the 
single call leg.

• See Chapter 5, “Application Server Administration” other 
settings you might want to adjust from the default values. 

ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts.

Create scripts to be used for IVR treatment and agent transfer. The 
VRU scripts are associated with the applicable Network VRU, that 
is, IsnVRU.

Use the ICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. For more information about creating scripts, see 
Chapter 2, “Using NAM/ICM with the ISN IVR Solution.”

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the ICM, ICM Configuration Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch (CSS):

1. If necessary, configure the CSS.

For more information, see the Cisco Content Services Switch user 
documentation.

Table C-8 Configuration Checklist, ISN Advanced Speech Deployment, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ISN Advanced Speech Deployment, NAM/CICM 
In this deployment model, the ISN (Application Server only) is deployed at the NAM where it works 
with the Voice Gateway to act as the VRU and as the Switch to transfer the call to an agent. The VRU 
voice treatment is provided at the Voice Gateway, and may include ASR/TTS. 

Note Queuing and network transfers are not possible and the ISN Voice Browser is not part of this 
deployment.

Figure C-9 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-9 ISN Advanced Speech Deployment, NAM/CICM 

Configuration overview for this deployment model:

• There are three Network VRUs configured: 

– One on the NAM for the Switch leg (Type 5). 

– One on the NAM for the VRU leg (Type 5).

– One on the CICM for the INCRP connection. 

Note Although the same Network VRU could be used for both purposes on the NAM, it is 
recommended that you keep them separate for flexibility in changing deployment models in the 
future.

Note: The numbers in the figure indicate call flow progression.
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• Use the ICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Table C-9 contains the configuration instructions for this deployment model.

Table C-9 Configuration Checklist, ISN Advanced Speech Deployment, NAM/CICM

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used for the VRU leg:

1. Configure the servers and voice 
application it will use. 

2. Configure the Ethernet connections.

3. Copy the bootstrap files from ISN 
Installation.

4. Configure the characteristics for the 
VRU leg. 

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 2, 3, and 4, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are as follows:

• If you are using a content switch for failover, the files are in:

<basedir>/ApplicationServer/Downloads/
 VB-CSS-CallRestart

• Otherwise, they are in:

<basedir>/ApplicationServer/Downloads/
VB-noCSS-CallRestart

For Step 4:

dial-peer voice <Dial-Peer Number> pots

application vru-leg

incoming called-number <dialed number patter>

direct-inward-dial

If the ISN is going to transfer calls, on the 
Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.” 

On the NAM and CICMs:

1. Configure the Network VRUs and PGs for 
the Switch leg.

For instructions see “Common NAM/CICM Configuration for ISN 
Switch Leg” section on page C-77.
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On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for reaching the NAM.

Specify the following:

• Type: 5. 

• Name: isnVRU 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define Label for the NAM.

– Label: Any number. 

Note This label is not used, it must be configured and it must 
match the label configured at the NAM for the VRU leg.

– Type: Normal

– Routing client: Select the INCRP routing client from the 
drop-down list.

On the CICM, ICM Configuration Manager, 
System Information tool:

1. Define a default Network VRU for the 
VRU leg.

On the System Information tab, define the Default Network VRU 
name, IsnVRU.

On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU and its labels for 
the VRU leg.

Specify the following:

• Type: 5. 

• Name: isnVRU.

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for each ISN peripheral:

– Label: Any number.

Note Although this label is not used, it must be configured, and 
the same number must be used for all ISN peripherals.

– Type: Normal.

– Routing client: Select the routing client configured for that 
ISN Application Server peripheral from the drop-down list.

Note Make sure the Network VRU label is identical in the NAM 
and CICM. It is recommended that the Network VRU Name 
be identical as well to avoid confusion.

If there will be routing scripts on the NAM, 
ICM Configuration Manager, System 
Information tool:

1. Define a default Network VRU.

On the System Information tab, define the Default Network VRU 
name, IsnVRU.

Table C-9 Configuration Checklist, ISN Advanced Speech Deployment, NAM/CICM (continued)

Where To Go/What to Do Settings Specific to This Deployment
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On each ISN Application Server: 

1. Configure the ports.

2. Check other settings.

Do the following: 

• Configure the ports for the “New Call” groups according to the 
licenses purchased and capacity; the “ID from ICM” group is 
not used since the switch and VRU functions are handled in the 
single call leg.

Note See Chapter 5, “Application Server Administration” other 
settings you might want to adjust from the default values. 

CICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts.

Create scripts to be used for IVR treatment and agent transfer. The 
VRU scripts are associated with the applicable Network VRU, that 
is, IsnVRU.

Use the CICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. 

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure dialed numbers, call types and 
applicable customers.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the NAM and CICM, ICM Configuration 
Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco Content Services Switch (CSS):

1. If necessary, configure the CSS.

For more information, see the Cisco Content Services Switch user 
documentation.

Table C-9 Configuration Checklist, ISN Advanced Speech Deployment, NAM/CICM (continued)
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ISN VRU Deployments with NIC Routing 
This section describes the call flows and provides configuration instructions for the following ISN 
deployment models:

• “NIC with Type 2, ISN Queue and Transfer Deployment, ICM Enterprise”

• “NIC with Type 2, ISN Queue and Transfer Deployment Customer VRU, NAM/CICM”

• “NIC with Type 2 or 8 ISN Advanced Speech Deployment, ICM Enterprise”

• “NIC with Type 2 or 8 ISN Advanced Speech Deployment Customer VRU, NAM/CICM”

• “NIC with Type 3 or 7 ISN Advanced Speech Deployment Network VRU, NAM/CICM”

NIC with Type 2, ISN Queue and Transfer Deployment, ICM Enterprise
In this deployment model, a NIC is being used to preroute the call. The ISN is deployed as a Customer 
VRU; the VRU voice treatment is provided by the ISN Voice Browser. The ISN also acts as a switch to 
transfer the call to an agent; queuing is supported.

Note Network transfers and ASR/TTS processing are not available in this deployment.

Figure C-10 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-10 NIC with Type 2, ISN Queue and Transfer Deployment, ICM Enterprise

Note: The numbers in the figure indicate call flow progression.
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Configuration overview for this deployment model:

• Set the Network VRU to Type 2.

• Define a Translation Route and labels for the VRU Peripheral (Network VRU labels do not need to 
be configured.)

• Use the ICM Script Editor’s TranslationRouteToVRU node to connect the call to the Network VRU.

Table C-10 contains the configuration instructions for this deployment model.

Table C-10 Configuration Checklist, NIC with Type 2, ISN Queue and Transfer Deployment VRU, ICM Enterprise

Where To Go/What to Do Settings Specific to This Deployment

On the Gateway:

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN Voice 
Browser using dial peers or Gatekeeper 
lookup.

2. Configure the Ethernet connections.

3. Copy the bootstrap files from the ISN 
application:

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 1, 2, and 3, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are in:

<basedir>/ApplicationServer/Downloads/
VB-noCSS-CallRestart

On the Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

2. If the ISN is going to transfer calls, 
register all the Gateways with the 
Gatekeeper.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.” 

On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU.

Specify the following:

• Type: 2.

• Name: isnVRU.

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.
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ISN VRU Deployments with NIC Routing
On the ICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
VRU.

2. Configure a peripheral for each ISN 
Application Server connected to each PG. 

For each Application Server connected to this PG, in the tree view 
pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU.

• Name: A name descriptive of this PG, for example, 
<location>_A for side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this VRU peripheral, 
for example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Select the Enable Post-routing checkbox.

Advanced tab, select the name isnVRU from the Network VRU 
field drop-down list.

Routing Client tab:

• Name: By convention, this is the same as the peripheral.

• Client Type: VRU.

• Do not select the Network Transfer preferred checkbox. (This 
allows the Customer ISN to receive the transfer request.)

On the ICM, ICM Configuration Manager, 
Service Explorer tool:

1. Configure a Service and Route for each 
VRU.

Note You can also use service arrays. Refer 
to the ICM user documentation for 
more information.

Specify the following: 

• Service Name: isnVRU.

• Route Name: PeripheralName_isnVRU.

• Do not configure a peripheral target or label.

On the ICM, ICM Configuration Manager, 
Network Trunk Group Explorer tool:

1. Configure the network trunk group.

2. For each ISN Application Server for the 
VRU leg, configure an associated trunk 
group.

Note You must configure one Network 
Transfer Group and one associated 
Trunk Group for each VRU leg ISN 
Application Server.

For Step 1, specify the following: 

• Network Trunk Group Name: A name descriptive of this trunk 
group. 

For Step 2, specify the following: 

• Peripheral Name: A name descriptive of this trunk group.

• Peripheral Number: 200 (this much match the group number of 
type “ID fro ICM” in the Application Server, which is 200 by 
default).

• Trunk Count: Select Use Trunk Data from the drop-down list. 

• Do not configure any trunks.

Table C-10 Configuration Checklist, NIC with Type 2, ISN Queue and Transfer Deployment VRU, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ISN VRU Deployments with NIC Routing
On the ICM, ICM Configuration Manager, 
Translation Route Explorer tool:

1. Define a Translation Route for each VRU 
Peripheral.

2. Configure translation route and label 
information for each VRU peripheral.

For Step 1, specify the following:

• Translation Route tab:

– Name: The name of the target VRU peripheral. (This is by 
convention; this value must be unique in the enterprise.)

– Type: DNIS and select the Service defined in the previous 
step.

For Step 2, specify the following:

• Route tab:

– Name: By convention, this is the name of the target VRU 
peripheral, followed by the DNIS that this route will use, 
for example, MyVRU_2000. (This is by convention; this 
value must be unique in the enterprise.)

– Service Name drop-down: Select 
PeripheralName.isnVRU.

• Peripheral Target tab:

– Enter the first DNIS that will be seen by the VRU that you 
will be using for this translation route.

Note The DNIS pool used for each VRU peripheral must be 
unique.

– Select a Network Trunk Group which belongs to the 
target VRU from the drop-down list. 

• Label tab:

– Label: Enter the translation route label (which might or 
might not be the same DNIS you entered on the Peripheral 
Target tab).

– Type: Normal.

– Routing Client: Select NIC Routing Client.

You must configure an additional label for each NIC routing 
client.

Note Repeat the Route and corresponding Peripheral Target and 
Label information for each DNIS in the pool.

Table C-10 Configuration Checklist, NIC with Type 2, ISN Queue and Transfer Deployment VRU, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ISN VRU Deployments with NIC Routing
On each ISN Application Server, Call 
Definitions and ICM pages: 

1. Configure the group number and ports for 
both legs of the call.

2. Configure the dialed numbers used in the 
translation route.

3. Check other settings.

Do the following: 

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the group number for the “ID from ICM” call group. 
The group number must match the trunk group number in the 
Network Trunk group used for the translation route. Configure 
the number of ports according to the licenses purchased and 
capacity. Configure each of the DNIS numbers used for 
translation routes. (The “New Call” group is not used since the 
calls are being sent to the VRU (ISN) after some initial 
processing by the NIC/ICM.)

Note See Chapter 5, “Application Server Administration” for 
other settings you might want to adjust from the default 
values. 

On the ICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts to be used for IVR treatment and 
agent transfer, as described in other 
sections of this manual and in the ICM 
manuals. The VRU scripts are associated 
with the applicable Network VRU, that 
is, isnVRU.

Use the ICM Script Editor’s TranslationRouteToVRU node to connect 
the call to the Network VRU. 

On the ICM, ICM Configuration Manager: 

1. Configure the ECC variables.

For more information, see the “Common NAM/CICM 
Configuration: Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers and call types.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

Table C-10 Configuration Checklist, NIC with Type 2, ISN Queue and Transfer Deployment VRU, ICM Enterprise (continued)
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ISN VRU Deployments with NIC Routing
NIC with Type 2, ISN Queue and Transfer Deployment Customer VRU, 
NAM/CICM 

In this deployment model, a NIC is being used to preroute the call. The ISN is deployed as a Customer 
VRU at the CICM; VRU voice treatment is provided by the ISN Voice Browser. The ISN also acts as a 
switch to transfer the call to an agent; queuing is supported.

Note Network transfers and ASR/TTS processing are not available in this deployment.

Figure C-11 shows the call flow for this deployment model.

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-11 NIC with Type 2, ISN Queue and Transfer Deployment Customer VRU, NAM/CICM 

Configuration overview for this deployment model:

• Set the Network VRU to Type 2.

• Define a Translation Route and labels for the VRU Peripheral in the CICM. (Network VRU labels 
need to be configured in the NAM.)

• The Network VRU names (where applicable) and the ECC variable configurations must be identical 
on the NAM and CICM. All labels must be duplicated, but their routing clients will be different.

• Use the CICM Script Editor’s TranslationRouteToVRU node to connect the call to the Network 
VRU.

Note: The numbers in the figure indicate call flow progression.
C-52
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Appendix C      ISN Deployment
ISN VRU Deployments with NIC Routing
Table C-11 contains the configuration instructions for this deployment model.

Table C-11 Configuration Checklist, NIC with Type 2, ISN Queue and Transfer Deployment VRU, NAM/CICM

Where To Go/What to Do Settings Specific to This Deployment

On the Gateway:

1. Configure the Gateway inbound routing 
to send the call over IP to the ISN Voice 
Browser using dial peers or Gatekeeper 
lookup.

2. Configure the Ethernet connections.

3. Copy the bootstrap files from the ISN 
application:

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 1, 2, and 3, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are in:

<basedir>/ApplicationServer/Downloads/
VB-noCSS-CallRestart

On the Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.” 

On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU and its label.

Specify the following:

• Type: 2. 

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

On the CICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
VRU.

2. Configure a peripheral for each VRU 
peripheral connected to each PG. 

For each VRU connected to this PG, in the tree view pane, select the 
applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, for example, 
<location>_A for side A of a particular location.

Peripheral tab:

• Peripheral Name: A name descriptive of this VRU peripheral, 
for example, <location>_<vru1> or <dns_name>.

• Client Type: VRU.

• Select the Enable Post-routing checkbox.

On the Advanced tab, select the name isnVRU from the Network 
VRU field drop-down list.

Routing Client tab:

• Name: By convention, this is the same as the peripheral.

• Client Type: VRU.

• Do not select the Network Transfer Preferred checkbox.
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ISN VRU Deployments with NIC Routing
On the CICM, ICM Configuration Manager, 
Service Explorer tool:

1. Configure a Service and Route for each 
VRU.

Note You can also use service arrays. Refer 
to the ICM documentation set for 
more information.

Specify the following: 

• Service Name: isnVRU. 

• Route Name: PeripheralName_isnVRU. 

• Do not configure a peripheral target or label.

On the CICM, ICM Configuration Manager, 
Network Trunk Group Explorer tool:

1. Configure the network trunk group.

2. For each ISN Application Server for the 
VRU leg, configure an associated trunk 
group.

Note You must configure one Network 
Transfer Group and one associated 
Trunk Group for each VRU leg ISN 
Application Server.

For Step 1, specify the following: 

• Network Trunk Group Name: A name descriptive of this trunk 
group. 

For Step 2, do the following: 

• Peripheral Name: A name descriptive of this trunk group.

• Peripheral Number: 200 (this much match the group number of 
type “ID from ICM” in the Application Server, which is 200 by 
default).

• Trunk Count: Select Use Trunk Data from the drop-down list. 

• Do not configure any trunks.

Table C-11 Configuration Checklist, NIC with Type 2, ISN Queue and Transfer Deployment VRU, NAM/CICM (continued)

Where To Go/What to Do Settings Specific to This Deployment
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ISN VRU Deployments with NIC Routing
On the CICM, ICM Configuration Manager, 
Translation Route Explorer tool:

1. Define a Translation Route for each VRU 
Peripheral.

2. Configure translation route and label 
information for each VRU peripheral.

For Step 1, specify the following:

• Translation Route tab:

– Name: The name of the target VRU peripheral. (This is by 
convention; this value must be unique in the enterprise.)

– Type: DNIS and select the Service defined in the previous 
step.

For Step 2, do the following:

• Route tab:

– Name: By convention, this is the name of the target VRU 
peripheral, followed by the DNIS that this route will use, 
for example, MyVRU_2000. (This is by convention; this 
value must be unique in the enterprise.)

– Service Name drop-down: select 
PeripheralName.isnVRU.

• Peripheral Target tab:

– Enter the first DNIS that will be seen by the VRU that you 
will be using for this translation route.

Note The DNIS pool used for each VRU peripheral must be 
unique.

– Select a Network Trunk Group which belongs to the 
target VRU from the drop-down list. 

• Label tab:

– Label: The translation route label (which might or might 
not be the same DNIS you entered on the Peripheral Target 
tab).

– Type: Normal.
– Routing Client: Select INCRP Routing Client.

Note Repeat the Route and corresponding Peripheral Target and 
Label information for each DNIS in the pool.

On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU.

2. Define a label for each NIC routing client 
and each translation route.

Specify the following:

• Type: 2. 

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for each NIC routing client and each translation 
route.

– Label: Translation Route number.

– Type: Normal.
– Routing client: Select the NIC routing client from the 

drop-down list.

Table C-11 Configuration Checklist, NIC with Type 2, ISN Queue and Transfer Deployment VRU, NAM/CICM (continued)

Where To Go/What to Do Settings Specific to This Deployment
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On each ISN Application Server: 

1. Configure the ports for both legs of the 
call.

2. Check other settings.

Do the following: 

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the group number for the “ID from ICM” call group. 
The group number must match the trunk group number in the 
Network Trunk group used for the translation route. Configure 
the number of ports according to the licenses purchased and 
capacity. Configure each of the DNIS numbers used for 
translation routes. (The “New Call” group is not used since the 
calls are being sent to the VRU (ISN) after some initial 
processing by the NIC/ICM.)

Note See Chapter 5, “Application Server Administration” for 
other settings you might want to adjust from the default 
values. 

On each ISN Voice Browser: 

1. Configure the Gatekeeper.

2. Configure the capacity.

3. Check other settings.

Specify the following: 

• SetGateKeeper <NewValue>

Where <NewValue> is the IP address for the Gatekeeper 
serving the Voice Browser. 

• Configure the total number of calls and IVR ports according to 
the licenses purchased, call profiles and capacity. (For 
instructions, see Chapter 4, “Voice Browser Administration”.)

• See Chapter 4, “Voice Browser Administration” for other 
settings you might want to adjust from the default values. 

On the CICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts to be used for IVR treatment and 
agent transfer, as described in other 
sections of this manual and in the ICM 
manuals. The VRU scripts are associated 
with the applicable Network VRU (for 
example, isnVRU).

Use the CICM Script Editor’s TranslationRouteToVRU node to 
connect the call to the Customer VRU. 

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure dialed numbers and call types.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the NAM and CICM, ICM Configuration 
Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

Table C-11 Configuration Checklist, NIC with Type 2, ISN Queue and Transfer Deployment VRU, NAM/CICM (continued)
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ISN VRU Deployments with NIC Routing
NIC with Type 2 or 8 ISN Advanced Speech Deployment, ICM Enterprise
In this deployment model, the ISN works with the Voice Gateway to act as the VRU; VRU voice 
treatment is provided the Gateway and can include ASR/TTS.

When deployed with a NIC being used to queue and transfer calls (VRU Type 8), the NIC interfaces to 
the TDM switch to transfer the call to an agent. When deployed with a NIC used to preroute the call 
(VRU Type 2), the ISN also acts as a switch to transfer the call to an agent; queuing and network 
transfers are not possible.

Note The ISN Voice Browser is not part of this deployment.

Figure C-12 shows the call flow for the Type 2 deployment model; in this figure, the ISN transfers the 
call. Figure C-13 shows the call flow for the Type 8 deployment model; in this figure, the NIC transfers 
the call. 

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-12 NIC with Type 2, ISN Advanced Speech Deployment, ICM Enterprise

Note: The numbers in the figure indicate call flow progression.
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Figure C-13 NIC with Type 8, ISN Advanced Speech Deployment, ICM Enterprise

Configuration overview for this deployment model:

• There are two Network VRUs:

– A Type 2 if NIC is prerouting calls.

– A Type 8 if NIC is queuing and transferring calls.

• Define a Translation Route and labels for the VRU Peripheral (Network VRU labels do not need to 
be configured.)

• Use the ICM Script Editor’s TranslationRouteToVRU node to connect the call to the Network VRU.

Note: The numbers in the figure indicate call flow progression.
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ISN VRU Deployments with NIC Routing
Table C-12 contains the configuration instructions for this deployment model.

Table C-12 Configuration Checklist, NIC with Type 2 or Type 8, ISN Advanced Speech, ICM Enterprise

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used for the VRU leg:

1. Configure the servers and voice 
application it will use. 

2. Configure the Ethernet connections.

3. Copy the bootstrap files from ISN 
Installation.

4. Configure the characteristics for the 
VRU leg. 

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 2, 3, and 4, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are as follows:

• If you are using a content switch for failover, the files are in:

<basedir>/ApplicationServer/Downloads/
 noVB-CSS-CallRestart

• Otherwise, they are in:

<basedir>/ApplicationServer/Downloads/
noVB-noCSS-CallRestart

For Step 4:

dial-peer voice <Dial-Peer Number> pots

application vru-leg

incoming called-number <dialed number pattern for translation 
route numbers>

direct-inward-dial 

If the ISN is going to transfer calls, on the 
Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.” 

On the ICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU.

Specify the following:

• Type: 2 or 8, depending on the specific deployment model.

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.
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On the ICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG.

2. Configure a peripheral for each ISN 
Application Server connected to each PG. 

For each ISN Application Server connected to this PG, in the tree 
view pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: To something representative of this PG, for example, 
<location>_A for side A of a particular location.

Peripheral tab:

• Peripheral Name: Something representative of this ISN 
peripheral, for example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Specify one of the following:

– If using Type 2, select the Enable Post-routing checkbox 
and continue.

– If using Type 8, do not select the Enable Post-routing 
checkbox and skip the Routing Client tab instructions 
below.

Advanced tab:

• Select the name isnVRU from the Network VRU field 
drop-down list.

Routing Client tab (for Type 2 only):

• Name: By convention, this is the same as the peripheral.

• Client Type: VRU.

• Do not select the Network Transfer preferred checkbox. (This 
allows the Customer ISN to receive the transfer request.)

On the ICM, ICM Configuration Manager, 
Service Explorer tool:

1. Configure a Service and Route for each 
VRU.

Note You can also use service arrays. Refer 
to the ICM documentation set for 
more information.

Specify the following: 

• Service Name: isnVRU. 

• Route Name: PeripheralName_isnVRU. 

• Do not configure a peripheral target or label.

Table C-12 Configuration Checklist, NIC with Type 2 or Type 8, ISN Advanced Speech, ICM Enterprise (continued)

Where To Go/What to Do Settings Specific to This Deployment
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On the ICM, ICM Configuration Manager, 
Network Trunk Group Explorer tool:

1. Configure the network trunk group.

2. For each ISN Application Server for the 
VRU leg, configure an associated trunk 
group.

Note You must configure one Network 
Transfer Group and one associated 
Trunk Group for each VRU leg ISN 
Application Server.

For Step 1, specify the following: 

• Network Trunk Group Name: A name descriptive of this trunk 
group. 

For Step 2, specify the following: 

• Peripheral Name: A name descriptive of this trunk group.

• Peripheral Number: 200 (this much match the group number of 
type “ID fro ICM” in the Application Server, which is 200 by 
default).

• Trunk Count: Select Use Trunk Data from the drop-down list. 

• Do not configure any trunks.

On the ICM, ICM Configuration Manager, 
Translation Route Explorer tool:

1. Define a Translation Route for each VRU 
Peripheral.

2. Configure translation route and label 
information for each VRU peripheral.

For Step 1, specify the following:

• Translation Route tab:

– Set the Name field to the name of the target VRU 
peripheral. (This is by convention; this value must be 
unique in the enterprise.)

– Set the Type field to DNIS and select the Service defined 
in the previous step.

For Step 2, do the following:

• Route tab:

– Set the Name. By convention, this is the name of the target 
VRU peripheral, followed by the DNIS that this route will 
use, for example, MyVRU_2000. (This is by convention; 
this value must be unique in the enterprise.)

– Service Name drop-down: Select 
PeripheralName.isnVRU.

• Peripheral Target tab:

– Enter the first DNIS that will be seen by the VRU that you 
will be using for this translation route.

Note The DNIS pool used for each VRU peripheral must be 
unique.

– Select a Network Trunk Group which belongs to the 
target VRU from the drop-down list. 

• Label tab:

– Set the Label: Enter the translation route label (which 
might or might not be the same DNIS you entered on the 
Peripheral Target tab).

– Type: Normal.

– Routing Client: Select NIC Routing Client.

You must create and additional label for each NIC routing 
client.

Note Repeat the Route and corresponding Peripheral Target and 
Label information for each DNIS in the pool.

Table C-12 Configuration Checklist, NIC with Type 2 or Type 8, ISN Advanced Speech, ICM Enterprise (continued)
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On each ISN Application Server Call 
Definition and ICM pages:

1. Configure the group number and ports for 
both legs of the call.

2. Configure the dialed numbers used in the 
translation route.

3. Check other settings.

Do the following: 

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the group number for the “ID from ICM” call group. 
The group number must match the trunk group number in the 
Network Trunk group used for the translation route. Configure 
the number of ports according to the licenses purchased and 
capacity. Configure each of the numbers used for translation 
routes. (The “New Call” group is not used since the calls are 
being sent to the VRU (ISN) after some initial processing by the 
NIC/ICM.)

Note See Chapter 5, “Application Server Administration” for 
other settings you might want to adjust from the default 
values. 

On the ICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts to be used for IVR treatment and 
agent transfer, as described in other 
sections of this manual and in the ICM 
manuals. The VRU scripts are associated 
with the applicable Network VRU (for 
example, isnVRU).

Use the ICM Script Editor’s TranslationRouteToVRU node to connect 
the call to the Network VRU. 

On the ICM, ICM Configuration Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the ICM, ICM Configuration Manager: 

1. Configure dialed numbers and call types.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the ICM, ICM Configuration Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco CallManager (CCM):

1. Configure the CCM.

For more information, see the Cisco CallManager user 
documentation.

Table C-12 Configuration Checklist, NIC with Type 2 or Type 8, ISN Advanced Speech, ICM Enterprise (continued)
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ISN VRU Deployments with NIC Routing
NIC with Type 2 or 8 ISN Advanced Speech Deployment Customer VRU, 
NAM/CICM

In this deployment model, the ISN is deployed as a Customer VRU at the CICM. The ISN Application 
Server works with the Voice Gateway to act as the VRU; VRU voice treatment is provided at the Voice 
Gateway and can include ASR/TTS.

When deployed with a NIC being used to queue and transfer calls (VRU Type 8), the NIC interfaces to 
the TDM switch to transfer the call to an agent. When deployed with a NIC used to preroute the call 
(VRU Type 2), the ISN also acts as a switch to transfer the call to an agent; queuing and network 
transfers are not possible.

Note The ISN Voice Browser is not part of this deployment.

Figure C-14 shows the call flow for the Type 2 deployment model; in this figure, the ISN transfers the 
call once. Figure C-15 shows the call flow for the Type 8 deployment model; in this figure, the NIC 
transfers the call. 

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-14 NIC with Type 2, ISN Advanced Speech Deployment Customer VRU, NAM/CICM 

Note: The numbers in the figure indicate call flow progression.
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Figure C-15 NIC with Type 8, ISN Advanced Speech Deployment Customer VRU, NAM/CICM 

The setup for these deployment models is virtually the same; you must:

• Set the Network VRU:

– To Type 2 if NIC is prerouting calls.

– To Type 8 if NIC is queuing and transferring calls.

• The Network VRU Names (where applicable) and the ECC variable configurations must be identical 
on the NAM and CICM. All labels must be duplicated, but their routing clients will be different.

• Define a Translation Route and labels for the VRU Peripheral in the CICM. (Network VRU labels 
need to be configured in the NAM.)

• Use the CICM Script Editor’s TranslationRouteToVRU node to connect the call to the Network 
VRU.

Note: The numbers in the figure indicate call flow progression.
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Table C-13 contains the configuration instructions for this deployment model.

Table C-13 Configuration Checklist, NIC with Type 2 or 8, ISN Advanced Speech Deployment Customer VRU, NAM/CICM

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used for the VRU leg:

1. Configure the servers and voice 
application it will use. 

2. Configure the Ethernet connections.

3. Copy the bootstrap files from ISN 
Installation.

4. Configure the characteristics for the 
VRU leg. 

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 2, 3, and 4, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are as follows:

• If you are using a content switch for failover, the files are in:

• <basedir>/ApplicationServer/Downloads/
 noVB-CSS-CallRestart

• Otherwise, they are in:

• <basedir>/ApplicationServer/Downloads/
noVB-noCSS-CallRestart

For Step 4:

dial-peer voice <Dial-Peer Number> pots

application vru-leg

incoming called-number <dialed number pattern for translation 
route numbers>

direct-inward-dial 

If the ISN is going to transfer calls, on the 
Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.”

On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU.

Specify the following:

• Type: 2 or 8, depending on the specific deployment model.

• Name: PeripheralName_isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.
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On the CICM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG.

2. Configure a peripheral for each 
Application Server connected to each PG.

For each VRU connected to this PG, in the tree view pane, select the 
applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name representative of this PG, for example, 
<location>_A for side A of a particular location.

Peripheral tab:

• Peripheral Name: A name representative of this VRU 
peripheral, for example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Specify one of the following:

– If using Type 2, select the Enable Post-routing checkbox 
and continue.

– If using Type 8, do not select the Enable Post-routing 
checkbox and skip the Routing Client tab instructions 
below.

On the Advanced tab, select the name isnVRU from the Network 
VRU field drop-down list.

Routing Client tab (Type 2 only):

• Name: By convention, this is the same as the peripheral name.

• Client Type: VRU.

• Do not select the Network Transfer preferred checkbox. (This 
allows the Customer ISN to receive the transfer request.)

On the CICM, ICM Configuration Manager, 
Service Explorer tool:

1. Configure a Service and Route for each 
VRU.

Note You can also use service arrays. Refer 
to the ICM documentation set for 
more information.

In the filter data pane, select each ISN peripheral defined above and 
specify the following: 

• Service Name: isnVRU. 

• Route Name: PeripheralName_isnVRU. 

• Do not configure a peripheral target or label.

On the CICM, ICM Configuration Manager, 
Network Trunk Group Explorer tool:

1. Configure the network trunk group(s).

2. For each ISN Application Server for the 
VRU leg, configure an associated trunk 
group.

Note You must configure one Network 
Transfer Group and one associated 
Trunk Group for each VRU leg ISN 
Application Server.

For Step 1, do the following: 

• Network Trunk Group Name: A name that is descriptive of this 
network trunk group. 

For Step 2, do the following: 

• Peripheral Name: A name descriptive of this trunk group.

• Peripheral Number: 200 (this much match the group number of 
type “ID from ICM” in the Application Server, which is 200 by 
default).

• Trunk Count: Select Use Trunk Data from the drop-down list. 

• Do not configure any trunks.

Table C-13 Configuration Checklist, NIC with Type 2 or 8, ISN Advanced Speech Deployment Customer VRU, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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On the CICM, ICM Configuration Manager, 
Translation Route Explorer tool:

1. Define a Translation Route for each VRU 
Peripheral.

2. Configure routes, peripheral targets, and 
labels for each DNIS to be used for each 
VRU peripheral.

For Step 1, do the following:

• Translation Route tab:

– Name: The name of the target VRU peripheral. (This is by 
convention; this value must be unique in the enterprise.)

– Type: DNIS.

For Step 2, do the following:

• Route tab:

– Name: By convention, this is the name of the target VRU 
peripheral, followed by the DNIS that this route will use, 
for example, MyVRU_2000. (This is by convention; this 
value must be unique in the enterprise.)

– Service Name drop-down: Select 
PeripheralName.isnVRU.

• Peripheral Target tab:

– Enter the first DNIS that will be seen by the VRU that you 
will be using for this translation route.

Note The DNIS pool used for each VRU peripheral must be 
unique.

– Select a Network Trunk Group that belongs to the target 
VRU from the drop-down list. 

• Label tab:

– Routing Client: Select the INCRP Routing Client that was 
mapped to the applicable NAM Routing Client.

– Label: Enter the translation route number (which might or 
might not be the same DNIS you entered on the Peripheral 
Target tab).

– Type: Normal

Note Repeat the Route and corresponding Peripheral Target and 
Label information for each DNIS in the pool.

On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg.

2. Define a label for each NIC routing client 
and each translation route number.

Note For each NIC routing client, define all 
the same labels you defined above in 
the CICM Translation Route 
Explorer.

Specify the following:

• Type: 2. or 8, depending on the specific deployment model.

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for each NIC routing client and each translation 
route number. 

– Label: Translation Route number.

– Type: Normal.
– Routing client: Select the NIC routing client from the 

drop-down list.

Table C-13 Configuration Checklist, NIC with Type 2 or 8, ISN Advanced Speech Deployment Customer VRU, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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On each ISN Application Server Call 
Definitions and ICM pages: 

1. Configure the group number and ports for 
both legs of the call.

2. Configure the dialed numbers used in the 
translation route.

3. Check other settings.

Do the following: 

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the group number for the “ID from ICM” call group. 
The group number must match the trunk group number in the 
Network Trunk group used for the translation route (usually 
200). Configure the number of ports according to the licenses 
purchased and capacity. Configure each of the DNIS numbers 
used for translation routes. (The “New Call” group is not used 
since the calls are being sent to the VRU (ISN) after some initial 
processing by the NIC/CICM.)

Note See Chapter 5, “Application Server Administration” for 
other settings you might want to adjust from the default 
values. 

On the CICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts to be used for IVR treatment and 
agent transfer, as described in other 
sections of this manual and in the ICM 
manuals. The VRU scripts are associated 
with the applicable Network VRU (for 
example, isnVRU).

Use the CICM Script Editor’s TranslationRouteToVRU to connect the 
call to the VRU. 

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure dialed numbers and call types.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the NAM and CICM, ICM Configuration 
Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco CallManager (CCM):

1. Configure the CCM.

For more information, see the Cisco CallManager user 
documentation.

Table C-13 Configuration Checklist, NIC with Type 2 or 8, ISN Advanced Speech Deployment Customer VRU, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
C-68
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Appendix C      ISN Deployment
ISN VRU Deployments with NIC Routing
NIC with Type 3 or 7 ISN Advanced Speech Deployment Network VRU, 
NAM/CICM

In this deployment model, the ISN is deployed as a Network VRU at the NAM. The ISN Application 
Server works with the Voice Gateway to act as the VRU; VRU voice treatment is provided at the Voice 
Gateway and can include ASR/TTS.

The NIC interfaces to the TDM switch to transfer calls to the ISN for VRU treatment and to queue and 
transfer calls using a VRU Type 3 or 7 call flow.

Note The ISN Voice Browser is not part of this deployment.

Figure C-16 shows the call flow for this deployment model. 

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover. Also, the 
Gatekeeper is not shown.

Figure C-16 NIC with Type 3 or 7, ISN Advanced Speech Deployment Network VRU, NAM/CICM 

Configuration overview for this deployment model:

• Set the Network VRU Type to a 3 or 7.

• System Information on the NAM and CICM must include correlation ID settings.

• The Network VRU names (where applicable), correlation IDs, and the ECC variable configurations 
must be identical on the NAM and CICM. All Labels must also be duplicated, but their routing 
clients will be different. 

• Use the CICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

Note: The numbers in the figure indicate call flow progression.
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Table C-14 contains the configuration instructions for this deployment model.

Table C-14 Configuration Checklist, NIC with Type 3 or 7, ISN Advanced Speech Deployment Network VRU, NAM/CICM

Where To Go/What to Do Settings Specific to This Deployment

On the Gateways used for the VRU leg:

1. Configure the servers and voice 
application it will use. 

2. Configure the Ethernet connections.

3. Copy the bootstrap files from ISN 
Installation.

4. Configure the characteristics for the 
VRU leg. 

For instructions for Step 1, see “Common Gateway Configuration 
for VRU Leg” section on page C-75.

For more information about Steps 2, 3, and 4, see Chapter 8, “VoIP 
Configuration.” 

For Step 3, the files to be copied from the Application Server 
machine to the Gateway are as follows:

• If you are using a content switch for failover, the files are in:

<basedir>/ApplicationServer/Downloads/
 noVB-CSS-CallRestart

• Otherwise, they are in:

<basedir>/ApplicationServer/Downloads/
noVB-noCSS-CallRestart

For Step 4:

dial-peer voice <dial-Peer Number> voip

application vru-leg

incoming called-number <network routing number> T
(for example, incoming called-number 8001112222T

dtmf-relay rtp-nte H245-signal h245-alphanumeric

codec g711ulaw

no vad

Note These characteristics are for VRU legs requiring ASR 
and/or TTS treatment. If you have other requirements for 
dtmf relay, codecs, or vad settings, you should modify the 
command accordingly.

On the Gatekeeper:

1. Register all the Gateways with the 
Gatekeeper.

For more information and instructions, see Chapter 8, “VoIP 
Configuration.” 

On the NAM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
VRU Client leg.

2. Configure a peripheral for each 
Application Server to be used as a VRU 
leg connected to each PG. 

For each ISN Application Server connected to this PG, in the tree 
view pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name representative of this PG, for example, 
<location>_A for side A of a particular location.

Peripheral tab:

• Peripheral Name: A name representative of this VRU 
peripheral, for example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Do not select the Enable Post-routing checkbox.
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On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the VRU leg 
and labels for reaching the NAM.

Specify the following:

• Type: 3 or 7, depending on the specific deployment model.

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for the NAM.

– Label: Network routing number.

– Type: Normal.

– Routing client: Select the INCRP Routing Client from the 
drop-down list.

On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU and a label for 
each NIC that is using this VRU.

Specify the following:

• Type: 3 or 7, depending on the specific deployment model.

• Name: isnVRU. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnVRU will be 
assumed.

• Define a Label for each NIC that is using this VRU:

– Label: Network routing number.

– Type: Normal.

– Routing client: Select the routing client for that NIC from 
the drop-down list.

Note Make sure the Network VRU label is identical in the NAM 
and CICM. It is recommended that the Network VRU Name 
be identical as well to avoid confusion.

On the NAM, ICM Configuration Manager, 
System Information tool:

1. Define the correlation IDs.

2. If there will be routing scripts on the 
NAM, Define a default Network VRU.

Do the following in the General section of the System Information 
tool:

• Set minimum and maximum correlation ID values.

– Minimum correlationID: Starting number for the 
correlation ID, for example, 1000.

– Maximum correlationID: Ending number for the 
correlation ID, for example, 1099.

• Define the Default Network VRU: IsnVRU.

If there will be routing scripts on the NAM, on 
the NAM, ICM Configuration Manager, 
System Information tool:

1. Define a default Network VRU.

In the General section of the System Information tool:

• Define the Default Network VRU: IsnVRU.

Table C-14 Configuration Checklist, NIC with Type 3 or 7, ISN Advanced Speech Deployment Network VRU, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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On the CICM, ICM Configuration Manager, 
System Information tool:

1. Define a default Network VRU.

In the General section of the System Information tool:

• Define the Default Network VRU: IsnVRU.

On each ISN Application Server: 

1. Configure the length of the Network 
Routing Number. .

2. Configure the ports for the VRU legs of 
the call

3. Check other settings.

Do the following: 

• On the Call Definitions page, set the Dialed Number 
Maximum Length if no Correlation ID present field to the 
length of the Network Routing Number.

• Set the VRU Connect Port to match the VRU Connection Port 
defined in ICM Setup for the corresponding VRU PG peripheral 
(PIM).

• Configure the “ID from ICM” call group. Configure the number 
of ports according to the licenses purchased and capacity. (The 
“New Call” group is not used since the calls are being sent to 
the VRU (ISN) after some initial processing by the NIC/CICM.)

Note See Chapter 5, “Application Server Administration” for 
other settings you might want to adjust from the default 
values. 

On the CICM, ICM Script Editor tool:

1. Create the VRU scripts and routing 
scripts to be used for IVR treatment and 
agent transfer, as described in other 
sections of this manual and in the ICM 
manuals. The VRU scripts are associated 
with the applicable Network VRU (for 
example, isnVRU.)

Use the ICM Script Editor’s SendToVRU node to connect the call to 
the Network VRU. 

Note A RunVRU Script or Queue node is an “implicit” 
SendToVRU node, although error handling will be easier if 
the explicit “SendToVRU” node is used.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure the ECC variables.

For more information, see “Common NAM/CICM Configuration: 
Define ISN ECC variables” section on page C-79.

On the NAM and CICM, ICM Configuration 
Manager: 

1. Configure dialed numbers and call types.

For more information, see the Cisco ICM Software Configuration 
Guide. 

On the NAM and CICM, ICM Configuration 
Manager: 

1. If necessary, differentiate VRUs (ISNs) 
based on dialed number.

2. Define customers and their Network 
VRU.

For more information, see“Common Configuration for 
Differentiating VRUs (ISNs) Based on Dialed Number” section on 
page C-81.

On the Cisco CallManager (CCM):

1. Configure the CCM.

For more information, see the Cisco CallManager user 
documentation.

Table C-14 Configuration Checklist, NIC with Type 3 or 7, ISN Advanced Speech Deployment Network VRU, NAM/CICM 

Where To Go/What to Do Settings Specific to This Deployment
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This section describes two special deployment modesl:

• ISN Queue and Transfer Deployment with ISN Advanced Speech Deployment Customer VRU, 
NAM/CICM

• ISN Queue and Transfer Deployment as Queue Point for Consultative Transfers

ISN Queue and Transfer Deployment with ISN Advanced Speech Deployment 
Customer VRU, NAM/CICM

In this deployment, there are two ISNs:

• One is at the NAM where it acts as the Switch to transfer the call to the Customer VRU and agents. 

• The other is deployed as a Customer VRU at the CICM.

Figure C-17 shows the call flow for this deployment model. 

Note For simplicity, the figure does not illustrate a deployment for redundancy and failover; also the 
Gatekeeper is not shown.

Figure C-17 ISN Queue and Transfer Deployment with ISN Advanced Speech Deployment, Customer VRU, NAM/CICM 

The configuration for the ISN at the NAM (the switch) is identical to that where a Customer VRU is used 
at the CICM; for more information, see ISN Queue and Transfer Deployment with “Other” Customer 
VRU, NAM/ICM, page C-33.

In this case the “other VRU” is, in fact, the ISN deployed at the CICM.

The configuration for the ISN at the CICM (the VRU) is identical to that where a NIC is used to route 
the call; for more information, see NIC with Type 2 or 8 ISN Advanced Speech Deployment Customer 
VRU, NAM/CICM, page C-63. 

Note: The numbers in the figure indicate call flow progression.
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A separate Application Server is required for the two ISN since one is connected to the NAM and the 
other to the CICM. The Voice Gateway may be used for both ISNs but the configuration of the bootstrap 
files is beyond the scope of the standard product and professional services must be employed. 

ISN Queue and Transfer Deployment as Queue Point for Consultative Transfers
In this deployment, the ISN as a Customer VRU; in a NAM/CICM environment, the ISN is at the CICM. 
When an IPCC agent does a consultative transfers and needs to be queued, an ISN at the Customer site 
is the queue point.   

Figure C-18 ISN Queue and Transfer Deployment as Queue Point for Consultative Transfers

The configuration for the ISN is identical to that where a NIC (or the ISN) is using type 2 ISN Customer 
VRU for VRU treatment: see section “NIC with type 2 or 8 ISN Advanced Speech Deployment VRU, 
ICM”. This configuration is also applicable to a NAM/CICM environment since the ICM is not aware 
of the consultation and the NAM is not involved in the “new call” which is presented to the ICM. 

If an ISN is deployed as the switch in this solution, a separate Application Server is required for the 2 
ISN since one is connected to the NAM and the other to the CICM. The Voice Gateway may be used for 
both ISNs but the configuration of the bootstrap files is beyond the scope of the standard product and 
professional services must be employed.

Note: The numbers in the figure indicate call flow progression.
The starting point for this diagram is that the caller is talking to the IPCC agent.
C-74
Cisco Internet Service Node (ISN) Configuration and Administration Guide

OL-1251-02



 

Appendix C      ISN Deployment
Common Gateway Configuration for VRU Leg
Common Gateway Configuration for VRU Leg
Table C-15 describes Gateway configuration instructions common to all ISN Comprehensive and 
ISN Advanced Speech deployments where the Gateway is providing VRU voice treatment.

Table C-15 Configuration Checklist, Common Gateway Configuration for Leg

Where To Go/What to Do Settings Specific to This Deployment

1. Register the Gateway to its respective 
Gatekeeper.

Specify the following command:

interface FastEthernet0/0
h323-gateway voip interface
h323-gateway voip id <GK-Zone-name> ipaddr

<ipaddr of GK> 1719
 h323-gateway voip h323-id <H323-id>
h323-gateway voip tech-prefix 1#

1. If you will use ASR and TTS Servers, 
specify IP addresses for those Servers for 
each locale using the applicable name 
resolution system for the Gateway (DNS or 
“ip host” commands.

Do one of the following:

• If using a CSS, the server name is configured to the virtual IP 
(VIP) of the Application Server service on the CSS. (For more 
information, see Appendix D, “Configuring Cisco Content 
Services Switch (CSS) for Use with ISN.”) 

If using name resolution local to the Gateway (rather than 
DNS), specify:

ip host isn-vxml <VIP of application server service on CSS>

• If not using a CSS, primary and backup servers must be 
configured. If using name resolution local to the Gateway 
(rather than DNS) specify:

ip host asr-<locale> <ASR server for locale>

ip host asr-<locale>-backup <backup ASR server for locale>

ip host tts-<locale> <TTS server for locale>

ip host tts-<locale>-backup <backup TTS server for locale>

1. If you are using ASR and/or TTS with 
“external grammar” and expect the 
Gateway to resolve the addresses for 
those server give the following 
commands to the Gateway, specify ASR 
and/or TTS commands.

Specify the following commands:

ivr asr-server rtsp://<hostname or ip address of ASR server>
/recognizer

ivr tts-server rtsp://<hostname or ip address of TTS server>
 /synthesizer

Note This setting does not accommodate multiple locales and 
assumes a CSS is deployed for failover handling.
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1. Configure the IP address(es) for the ISN 
Application Servers to be used by the 
Gateway using the applicable name 
resolution system for the Gateway (DNS 
or “ip host” commands). 

Specify the following commands:

• If using a CSS, the server name is configured to the address of 
the CSS; failover is handled by the CSS. If using name 
resolution local to the GW (rather than DNS), the command 
would be:

ip host isn-vxml <AppServer>

• If not using a CSS, primary and backup servers must be 
configured. If using name resolution local to the GW (rather 
than DNS):

ip host isn-vxml <AppServer>

ip host isn-vxml-backup <backup AppServer>

1. Configure the Gateway to provide voice 
treatment:

Specify the following commands:

call application voice vru-leg flash:bootstrap.tcl

call application voice vru-leg language 0 en

call application voice vru-leg set-location en 0 flash

call application voice load vru-leg

call application voice new-call flash:bootstrap.vxml

call application voice new-call language 0 en

call application voice new-call set-location en 0 flash

call application voice load new_call

call application voice handoff flash:handoff.tcl

call application voice handoff language 0 en

call application voice handoff set-location en 0 flash

Note The name vru-leg is used by convention. Any name will do; 
since it is referenced elsewhere in this document, the name 
“vru-leg” will be assumed.

Table C-15 Configuration Checklist, Common Gateway Configuration for Leg (continued)

Where To Go/What to Do Settings Specific to This Deployment
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Common NAM/CICM Configuration for ISN Switch Leg
The steps in Table C-16 below describe NAM/ICM configuration instructions common to all 
NAM/CICM deployments for ISN switch legs. 

Table C-16 Configuration Checklist, Common NAM/CICM Configuration for ISN Switch Leg

Where To Go/What to Do Settings Specific to This Deployment

On the NAM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU for the Switch 
leg. 

2. For ISN Queue and Transfer and ISN 
Advanced Speech deployments, define 
Labels for each ISN switch.

Specify the following:

• Type: 5. 

• Name: isnSwitch. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnSwitch will be 
assumed.

• Define one Label for each ISN Application Server that is 
handling the Switch leg: 

– Label: Any number. 

Note Although this label is not used, it must be configured.

– Type: Normal

– Routing client: isnSwitch

On the CICM, ICM Configuration Manager, 
NIC Explorer tool:

1. Set the client type for the INCRP NIC.

Specify the following on the Routing Client tab for the INCRP 
NIC:

• Client Type: VRU. 

On the CICM, ICM Configuration Manager, 
Network VRU Explorer tool: 

1. Define a Network VRU with a label that 
uses INCRP as its routing client. 

Specify the following:

• Type: 5. 

• Name: isnSwitch. 

Note This name is used by convention. Any name will do; since it 
is referenced elsewhere in this document, isnSwitch will be 
assumed.

• Define one Label for each ISN Application Server that is 
handling the Switch leg: 

– Label: Any number. 

Note Although this label is not used, it must be configured.

– Type: Normal. 
– Routing client: INCRP NIC. 
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On the NAM, ICM Configuration Manager, 
PG Explorer tool:

1. Configure each PG to be used for the 
Switch leg.

2. Configure a peripheral for each 
Application Server to be used for a 
Switch leg connected to each PG. 

For each ISN Application Server connected to this PG, in the tree 
view pane, select the applicable PG.

Logical Controller tab:

• Client Type: VRU. 

• Name: A name descriptive of this PG, for example, 
<location>_A, for side A of a particular location.

Peripheral tab:

• Peripheral Name: A name representative of this ISN peripheral, 
for example, <location>_<isn1> or <dns_name>.

• Client Type: VRU.

• Select the Enable Post-routing checkbox.

On the Advanced tab, select the name isnSwitch from the Network 
VRU field drop-down list.

Routing Client tab:

• Name: By convention, use the same name as the peripheral.

• Client Type: VRU. 

• Do not select the Network Transfer Preferred checkbox.

Table C-16 Configuration Checklist, Common NAM/CICM Configuration for ISN Switch Leg (continued)

Where To Go/What to Do Settings Specific to This Deployment
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Common NAM/CICM Configuration: Define ISN ECC variables
You need to set up ECC variables that the ISN uses to exchange information with the NAM/ICM.

Note Information about how the ISN uses these ECC variables can be found throughout the manual.

Step 1 Within Configuration Manager, select Tools > Miscellaneous Tools > System Information and select 
the Enable expanded call context checkbox.

Step 2 Within Configuration Manager, select Tools > List Tools > Expanded Call Variable List. 

Step 3 In the Expanded Call Variable List window, enable the Add button by clicking Retrieve.

Step 4 Click Add. The Attributes property tab is enabled.

Step 5 Create each of the variables in Table C-17, clicking Save after defining each variable.

Caution It is important that you enter the ECCs Name values listed in Table C-17 exactly as specified. If you do 
not, the NAM/ICM software will not be able to successfully communicate with the micro-applications 
on the Application Server.

Length values are a bit more flexible. Unless the values listed in Table C-17 are specifically noted as 
“required,” the value in the Length column is the maximum the NAM/ICM can handle for that ECC; you 
can specify a value between 1 and the maximum length. 

Table C-17 Micro-Application ECCs

Name Length Definition 

user.media.id Required 
value: 36

A number identifying a call to the Application 
Server and, optionally, the Voice Browser:

• For a call arriving from the network, consists of 
an H.323 Conference ID. 

• For a call arriving from a non-Voice Browser 
client, consists of a random number. 

user.microapp.currency Required 
value: 6

Currency type. 

user.microapp.error_code Required 
value: 2

Return status error code to be returned from the ISN 
to the NAM/ICM upon a False return code in the 
Run Script Result.

user.microapp.locale Required 
value: 5

Locale, a combination of language and country 
which define the grammar and prompt set to use. 

user.microapp.media_server 30 Root of the URL for all media files and external 
grammar files used in the script.

user.microapp.play_data 40 Default storage area for data for Play Data 
micro-application. 

user.microapp.sys_media_lib 10 Directory for all system media files, such as 
individual digits, months, default error messages, 
etc.
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user.microapp.app_media_lib 10 Directory for all application-specific media files and 
grammar files.

Note The system and application media libraries need message and prompt files created/recorded for 
each locale that will be referenced. For more information, turn to Chapter 3, “Prompt 
Recording and Distribution.”

user.microapp.grammar_choices Configurable 
on the ICM. 
Maximum 
length: 210 
characters.

Specifies the ASR choices that a caller can input for 
the Get Speech micro-application. Each option in the 
list of choices is delimited by a forward slash (/). 

Note If text is placed in this variable that is longer 
than the variable is configured to handle, 
only the first 210 characters are sent.

user.microapp.inline_tts Configurable 
on the ICM. 
Maximum 
length: 210 
characters.

Specifies the text for inline Text To Speech (TTS).

Note If text is placed in this variable that is longer 
than the variable is configured to handle, 
only the first 210 characters are sent.

user.microapp.input_type Required 
value: 1

Specifies the type of input that is allowed. 
Valid contents are:

D - DTMF
B - (Both, the default) DTMF and Voice

user.microapp.caller_input Configurable 
on the ICM. 
Maximum 
length: 210 
characters.

Storage area for any ASR input that is collected from 
Get Speech.

Note Get Speech text results will be written to this 
ECC variable. Results from Get Digits or 
Menu micro-applications will be written to 
the CED. 

user.microapp.pd_tts Required 
value: 1

Specifies whether ISN’s Text To Speech (TTS) or 
media files should be played to the caller.
Valid contents are:

Y - Yes, use TTS capabilities
N - No, do not use TTS capablities; play media files 
instead.

Note Used only with Play Data micro-application.

user.num.steps.executed1 Required 
value: 10

Used by system to track script progress.

user.session.handled1 Required 
value: 5

Used by system to pass information.

user.task.id1 Required 
value: 19

Used by system to pass information.

user.connect.script.config1 Required 
value: 40

Used by system to pass information.

user.connect.script.name1 Required 
value: 39

Used by system to pass information.

Table C-17 Micro-Application ECCs (continued)

Name Length Definition 
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Note If you change the length of the ECC variables while the Application Server is running, you need to restart 
the Application Server for it to work properly.

Step 6 When finished, click Save to apply your changes.

Common Configuration for Differentiating VRUs (ISNs) Based on 
Dialed Number

The Network VRU configuration instructions in this guide assume that all callers will be routed to the 
same VRUs (ISNs) for VRU treatment purposes. Under this assumption, it is always simplest to rely on 
the system default Network VRU. However, it is sometimes necessary to differentiate the VRUs (ISNs) 
based on dialed number. For example, some calls: 

• Require Comprehensive treatment, while others only use Queue and Transfer deployment model 
which does not support ASR/TTS. 

• Need to assign different customers or applications to their own ISN machines.

To configure the ICM to differentiate the VRU, do the following:

• Configure more than one Network VRU.

• On the ICM, ICM Configuration Manager, ICM Instance Explorer tool:

– Configure the customer(s). 

– Configure the network VRU for each customer if that customer will use a Network VRU other 
than the default.   

• Associate the dialed number(s) to the customer in the Dialed Number List tool.

user.connection.type1 Required 
value: 17

Used by system to pass information.

user.last.redirected.address1 Required 
value: 40

Used by system to pass information.

1. These ECCs are required for Application Server internal processing. Set them and forget them!

Table C-17 Micro-Application ECCs (continued)

Name Length Definition 
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A P P E N D I X D

Configuring Cisco Content Services Switch (CSS) 
for Use with ISN

This section outlines the general approach and configuration specifics for using CSS with ISN 
deployments. Users should be familiar with the general concepts of configuring a Cisco Content Services 
Switch outlined in the CSS Administration Guide. 

Hardware: The CSS Model 11500 is used for this implementation.

Software: Version 7.10 of the CSS 11500 should be installed on all CSS switches planned for use.

General Approach
In this application of CSS, the engine is used primarily to direct initial session requests for a particular 
type of service. Sticky and/or stateful connections are not generally configured, primarily because the 
failover and retry logic for ISN voice applications is maintained within other components of the system.

For example, if the callflow of a particular IVR interaction requires the playing of media, the ISN call 
model will initiate separate http requests for each prompt expected to be played. As such, the Content 
Switch will not track state, or necessarily maintain a sticky connection for concurrent requests from the 
client. 

The following general approach will apply to configuring each ISN component type. Specific 
component-type configuration is covered in the following sections.

Services—One CSS Service is configured for each type of ISN component. For general step-by-step 
guidelines for configuring Services, please see Chapter 1 of the CSS Basic Configuration Guide.

Rules—A content rule should be established for each ISN component type. In order to define a content 
rule, a content owner must be defined on the Content Switch. (See Chapter 2 of the CSS Basic 
Configuration Guide.) Media Servers, Application Servers, and ASR/TTS Servers may each have their 
own content rules defined. For general step-by-step guidelines for configuring content rules, please see 
Chapter 3 of the CSS Basic Configuration Guide.

Groups—It may be necessary to define source groups for each service. Group configuration will vary 
depending upon whether a single VLAN or multiple VLANs are used for the CSS’ inbound and 
outbound traffic from the voice gateway and the ISN component servers. If the servers and the voice 
gateway clients are on the same VLAN, then destination services will need to be specified. This 
configuration is sometimes referred to as a ‘one-arm’ configuration because all traffic passes through 
one interface. Please see the online documentation for the Cisco Content Switch entitled “How to 
Configure the CSS to Load Balance Using One Interface”. At the time of this writing, the document was 
located here: 
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http://www.cisco.com/en/US/products/hw/contnetw/ps789/products_configuration_example0
9186a0080093dff.shtml

Also see Chapter 5 of the CSS Basic Configuration Guide for help determining whether your setup will 
require destination services. The examples below incorporate the use of destination services.

Keepalives—Each ISN component type will also have a varying type of keepalive defined. The CSS 
keepalive definitions will allow for an appropriate method of determining whether the component is 
functional and able to participate in receiving requests. 

Media Server Configuration
Media Servers are standard web servers that are responsible for serving ISN prompt files to the voice 
gateway. 

Service
Configure one CSS Service per Media Server. 

The following three services represent three Media Servers that can be accessed for ISN prompt playing.

Example 0-1 Configuring Services for Media Servers

service mediaserver1 
ip address 10.1.1.1
type redirect
port 80 
domain 10.1.1.1
keepalive type http 
keepalive retryperiod 2
keepalive maxfailure 1
keepalive uri "/index.html"

service mediaserver2 
ip address 10.1.1.2
type redirect
port 80 
domain 10.1.1.2
keepalive type http 
keepalive retryperiod 2
keepalive maxfailure 1
keepalive uri "/index.html"

service mediaserver3 
ip address 10.1.1.3
type redirect 
port 80
domain 10.1.1.3
keepalive type http 
keepalive retryperiod 2
keepalive maxfailure 1
keepalive uri "/index.html"
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Http Redirects
In order to reduce streaming media traffic, the CSS media server services are configured as http redirect 
services (also referred to as ‘remote’ services) within the CSS. With the absence of a ‘local’ service, this 
configuration will choose an available service based on the content rule, and present the requesting 
gateway with an http 302 redirect message. Media streaming will occur directly from the GW to the 
individual Media Server. For specific information on http redirection services, please see “Specifying a 
Service Type” in Chapter 1 of the CSS Basic Configuration Guide.

Content Rule
Using the content owner you have defined, define a content routing rule for the ISN Media Servers. CSS 
offers many balancing types for choosing an active media server. This application uses the default 
defined round-robin as the balancing method. Additionally, a primarySorryServer is defined. 

The following content rule implements a layer 5 http round-robin routing rule for two media servers, 
with the third server reserved for failover.

Example 0-2 Content Rule

content MEDIA
vip address 10.1.1.4
protocol any
port 80
url "/*" 
add service mediaserver1
add service mediaserver2
primarySorryServer mediaserver3

Keepalives
The media servers are standard http servers. CSS supports varying methods of keepalives used to 
determine the availability of an individual service.

For media servers, the http keepalive method is recommended. This will ensure that CSS determines the 
availability of a server at the application layer. In order to implement this keepalive method, the service 
must identify an available html page which the keepalive will use to determine http availability. For this 
reason, in addition to the ISN prompt audio files, the server should have an available html document 
defined. The example assumes an “index.html” document is available on the media servers. The http 
keepalive method will continuously check for the availability of this document as a means to determine 
that the server is alive and capable of serving documents. 

It is essential that all media servers included in a Media Server Content rule contain all of the ISN audio 
prompt files intended for use by that content rule to ensure that no matter which server CSS directs the 
request to, the prompt file will be available.

Use these CSS commands to setup the http keepalives while configuring each media server service:

keepalive type http 

keepalive uri "/index.html"
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Keepalive Times
Because these services are directly involved in processing voice calls, the shortest possible failover and 
re-activation times are desired. As such, set the following keepalive parameters:

keepalive retryperiod 2

keepalive maxfailure 1

Groups
Define a group for the participating media servers if your configuration requires source groups (see the 
discussion of Groups in the General Approach section above for details.)

Example 0-3 Defining Media Servers Group

group mediaservers
add destination service mediaserver1 
add destination service mediaserver2 
add destination service mediaserver3 
vip address 10.1.1.4

Activate services, group and rules:

Activate each service and group of media-servers.

Voice Gateway Configuration
The ISN media server names are defined inside the vxml documents which are passed to the Voice 
Gateway for processing. The media server name is set within the ICM routing script using an enterprise 
call variable. (Note that for use with the content switch, the default (not specified) media server name of 
“file:\\..\MediaServer” is an invalid option. You must specify a valid media-server name.) You must also 
ensure that the host name that ICM will deliver to the voice gateway as the name of the media server 
resolves to the virtual ip address of the content rule for the media servers setup on CSS. For example, if 
the ICM script sets a Media Server name as “media”, then the voice gateways to which the request will 
be delivered must resolve the name “media” to the VIP of the media-server content rule. This is 
configured within the voice gateway using the command:

ip host media 10.1.1.4

Note that when using CSS, the media server logic will generate vxml documents that contain “-backup” 
default backup media-server names. For example, if the media server is named “media”, a vxml 
document returned to the gateway for prompt playback will contain failover logic within the vxml that 
includes instructions for trying a server named “media-backup”. 

Although a properly configured, redundant CSS setup should mean that the gateway will never actually 
be required to access the ‘-backup’ host, a ‘-backup’ host should still be configured on the gateway. This 
is recommended as a precaution. The gateway should still contain a definition for “media-backup” that 
points to the same VIP service since it is defined within the vxml.

ip host media-backup 10.1.1.4
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Multiple Media-Server Rules
You can apply the media-server configuration in a CSS to support a logical division of media based upon 
any reasonable grouping that the design might call for. As long as the ICM routing script can decide and 
set the media server name appropriately, CSS can support multiple media server routing rules. 

For example: If an ISN system deployment includes multiple language prompts, English and Spanish, 
the company may elect to house all Spanish versions of media server prompts on 3 media servers, and 
all English prompts on 3 separate media servers.

Note This choice would be independent of the virtual directory setting, which is controlled by the ISN 
“language” parameter. While this parameter alters the path in the url of media, our example assumes that 
the company further wants to house different languages on different servers—perhaps for traffic volume 
purposes. For more information, on the language parameter, see Chapter 3, “Prompt Recording and 
Distribution.”

In this example, the ICM routing script that constructs the VRU call flow would identify and set the 
media-server name differently depending upon whether the caller initially has chosen English or 
Spanish. If they choose English, you might re-set the Media Server name to ‘media-english’ and if 
Spanish is selected, ‘media-spanish’. 

To support this, 6 services would be configured within CSS, one service for each media server. Two (2) 
content rules would also be configured. Each content rule would map to a different vip address and 
contain only those services which match the language the rule is configured for. Finally, the voice 
gateways would have separate host entries for the English and Spanish media-server names (and their 
–backup version) as set within the ICM scripts. Here is what the content rules would look like:

content MEDIA-ENGLISH
vip address 10.2.1.1
protocol any
port 80
url "/*" 
add service mediaserver-english1
add service mediaserver-english2
primarySorryServer mediaserver-english3

content MEDIA-SPANISH
vip address 10.2.1.2
protocol any
port 80
url "/*" 
add service mediaserver-spanish1
add service mediaserver-spanish2
primarySorryServer mediaserver-spanish3

The following host entries would then appear on the voice gateways:

ip host media-english 10.2.1.1

ip host media-english-backup 10.2.1.1

ip host media-spanish 10.2.1.2
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ip host media-spanish-backup 10.2.1.2

Application Server Configuration
CSS should also contain configuration for all application servers used in any IVR leg of a call flow or 
for any application server that is used as a routing client in a non-ISN voice browser call flow. 

Note The Cisco ISN Voice Browser maintains a list of its own application servers used as an interface between 
voice browser and the ICM for route requests. Retry logic within the Voice Browser controls requests to 
the Voice Browser’s application servers for routing requests via the “ApplicationServerList” Voice 
Browser definitions. If separate application servers are used for an ISN Voice-Browser’s interface to 
ICM for route requests, these Application Servers do not require configuration within CSS.

Service
Configure one Service per ISN Application Server. 

The following three services represent Application Servers that will function as IVR application servers, 
or as routing client interfaces to ICM where a non-ISN Voice Browser is making the call request.

Example 0-4 Configuring for Services of Application Servers

service appserver1
ip address 10.1.1.5 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type script ap-kal-httpvxml "10.1.1.5" 

service appserver2
ip address 10.1.1.6 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type script ap-kal-httpvxml "10.1.1.6" 

service appserver3
ip address 10.1.1.7 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type script ap-kal-httpvxml "10.1.1.7" 

Content Rule
Using the content owner you have defined, define a content routing rule for the Application Servers. CSS 
offers many balancing types for choosing an active Application Server. This application uses the default 
defined round-robin as the balancing method. Additionally, a primarySorryServer is defined. 

The AS content rule is implemented as a layer 4 routing rule.
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Example 0-5 Content Rule

content APPSERVERS
protocol tcp
port 8000 
add service appserver1 
add service appserver2 
primarySorryServer appserver3 
vip address 10.1.1.8 

Keepalives
For application servers, a CSS scripted keepalive should be used. Included within the ISN Application 
Server Installation’s ‘Downloads’ directory is a file called ‘ASKeepalive.txt’. This file is a scripted 
keepalive for use with CSS. The scripted keepalive will utilize the application server’s built-in heartbeat 
mechanism to validate that the AS is running at the Application Level. This will ensure that, if an AS is 
taken out of service, CSS will recognize this state change and mark the CSS service unavailable.

Load the CSS Application Server Keepalive Script into the /scripts directory of the CSS by copying it 
from a tftp-enabled server onto the Content Switch. During the copy process, name the script:

ap-kal-httpvxml 

Assign the keepalive script to each of the Application Server services. The ap-kal-httpvxml keepalive 
script accepts one parameter, which is the ipaddress of the application server for which the service is 
configured.

keepalive type script ap-kal-httpvxml "[ipaddress]" 

where [ipaddress] is replaced with the address of the service you are configuring.

Note For detailed instructions on implementing scripted keepalives for CSS, please see the section “Using 
Script Keepalives With Services” located at the end of Chapter 1 of the CSS Basic Configuration Guide.

Keepalive Times
Because these services are directly involved in processing voice calls, the shortest possible failover 
detection is desired. As such, set the following keepalive parameters:

keepalive retryperiod 2 

keepalive maxfailure 1 

Groups
Define a group for the participating application servers if your configuration requires source groups (see 
the discussion of Groups in the General Approach section above for details.)
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Example 0-6 Defining Application Servers Group

group appservers
add destination service appserver1 
add destination service appserver2
add destination service appserver3
vip address 10.1.1.8

Activate Services, Group and Rules
Activate each service and group of application servers.

Voice Gateway Configuration
The ISN Application Server names are defined inside the vxml documents which are passed to the Voice 
Gateway for processing. The names are hard-coded within the initial bootstrap.vxml vxml document 
housed on the Gateway.

Note For more information, see Appendix C, “ISN Deployment.”

For a CSS implementation, the host name embedded within the bootstrap document is “isn-vxml”. You 
must ensure that the host name isn-vxml is set to resolve to the virtual ip address of the content rule for 
the application servers setup on CSS. This is configured within each voice gateway using the command:

ip host isn-vxml 10.1.1.8

where 10.1.1.8 is the VIP address servicing the Application Server content rule.

ASR/TTS Server Configuration
If your ISN deployment includes the use of ASR/TTS resources for call processing, the ASR/TTS 
servers must also be configured within CSS. If your ASR/TTS deployment utilizes a multi-tier 
architecture to separate MRCP requests from recognition and vocalizer functions (such as a multi-tier 
Nuance configuration), only the MRCP servers are load-balanced by CSS. The RTSP traffic generated 
as part of MRCP will be routed around CSS, rather than through it. While this is generally handled by 
default within MRCP, it may be necessary in some MRCP configurations to specifically instruct the 
server to pass the RTSP address. Consult your ASR/TTS documentation for specific details.

In this example, one set of MRCP servers handles both the ASR and TTS needs.

However, since ISN breaks out the ASR and TTS resource host names, it may be desirable to separate 
MRCP server groups by specific function. If separate MRCP servers are used for ASR and TTS 
resources, define the ASR and TTS CSS components (service, rule, groups) separately. (See the Voice 
Gateway Configuration section below.)
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Service
Configure one Service per ASR/TTS Server responsible for handling MRCP requests. 

The following three services represent MRCP ASR / TTS.

Example 0-7 Configuring Services for ASR/TTS Server

service asrtts1 
port 554 
protocol tcp 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type tcp
keepalive port 554
ip address 10.1.1.9 

service asrtts2 
port 554 
protocol tcp 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type tcp
keepalive port 554
ip address 10.1.1.10 

service asrtts3 
port 554 
protocol tcp 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type tcp
keepalive port 554
ip address 10.1.1.11 

Content Rule
Using the content owner you have defined, define a content routing rule for the ASR/TTS Servers. 

The ASR/TTS content rule is implemented as a layer 4 routing rule.

Example 0-8 Content Rule

content ASRTTS 
add service asrtts1 
add service asrtts2 
primarySorryServer asrtts3 
protocol tcp 
port 554 
vip address 10.1.1.12
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Keepalives
For the MRCP ASR/TTS servers, a socket-level keepalive is used. By implementing a socket keepalive, 
the CSS will make a connection to the MRCP port to validate that the MRCP server is running. The 
service is considered down if unable to connect to port 554 for MRCP traffic.

To configure the CSS MRCP Keepalive, use the following:

keepalive type tcp

keepalive port 554

Note For detailed instructions on implementing keepalives for CSS, please see the section “Configuring 
Keepalives for a Service” beginning on page 1-17 of Chapter 1 of the CSS Basic Configuration Guide.

Keepalive Times
Because these services are directly involved in processing voice calls, the shortest possible failover 
detection is desired. As such, set the following keepalive parameters:

keepalive retryperiod 2 

keepalive maxfailure 1 

Groups
Define a group for the participating ASR/TTS Servers if your configuration requires source groups (see 
the discussion of Groups in the General Approach section above for details.)

Example 0-9 Defining ASR/TTS Servers Group

group asrtts 
add destination service asrtts1 
add destination service asrtts2
add destination service asrtts3
vip address 10.1.1.12 

Activate Services, Group and Rules
Activate each service and group of ASR/TTS servers.
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Voice Gateway Configuration
As with media servers and application servers, the ASR / TTS names should resolve to the VIP address 
running the content rule for ASR and/or TTS on the CSS. This name resolution occurs at each voice 
gateway. Note that ASR and TTS requests each utilize separate names within the ISN infrastructure, even 
if the same server(s) handle both ASR and TTS functions. The default English ASR and TTS server 
names are: 

For ASR: 

asr-en-us 

and 

asr-en-us-backup

For TTS: 

tts-en-us 

and 

tts-en-us-backup

These host names should be set to resolve to the VIP address of the content rule that governs each 
service. (Note that in the CSS sample above, both ASR and TTS functions are handled by the same 
content rule and group of resources.)

The voice gateway config would contain ip hosts that look like this:

ip host asr-en-us  10.1.1.12

ip host asr-en-us-backup  10.1.1.12

ip host tts-en-us  10.1.1.12

ip host tts-en-us-backup  10.1.1.12

If a network design contains separate MRCP servers for ASR and TTS functions, CSS would contain 
separate services, separate source groups (if needed), and two separate content rules / vip 
addresses—one for ASR and another for TTS resources.

In this case, the CSS content rules might look like this:

content ASR 
add service asr1 
add service asr2 
primarySorryServer asr3 
protocol tcp 
port 554 
vip address 10.1.3.12

content TTS 
add service tts1 
add service tts2 
primarySorryServer tts3 
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CSS Redundancy
protocol tcp 
port 554 
vip address 10.1.3.13

And the gateway entries at the voice gateway would look like this:

ip host asr-en-us  10.1.3.12

ip host asr-en-us-backup  10.1.3.12

ip host tts-en-us  10.1.3.13

ip host tts-en-us-backup  10.1.3.13

CSS Redundancy
CSS supports several types of failover mechanisms. The Virtual IP redundancy mechanism will allow 
for a rapid failover from a defined Master CSS to it’s backup using VRRP. This failover takes less than 
3 seconds and may or may not additionally incorporate the use of ASR. ISN transactions to servers do 
not require a stateful connection to the gateway. If the CSS fails during a prompt, the vxml documents 
that drive ISN will retry and re-stream the prompt from the new CSS access.

For this reason, general VIP redundancy is implemented. The sample below shows the redundant section 
for each of the two CSSs.

CSS1:

!************************** CIRCUIT **************************

circuit VLAN1 
ip address 10.1.1.100 255.255.255.0 
ip virtual-router 1 priority 230 preempt 
ip redundant-interface 1 10.1.1.200 
ip redundant-vip 1 10.1.1.4 
ip redundant-vip 1 10.1.1.8
ip redundant-vip 1 10.1.1.12 

CSS2:

!************************** CIRCUIT **************************

circuit VLAN1 
ip address 10.1.1.101 255.255.255.0 
ip virtual-router 1 priority 230 preempt 
ip redundant-interface 1 10.1.1.200 
ip redundant-vip 1 10.1.1.4 
ip redundant-vip 1 10.1.1.8
ip redundant-vip 1 10.1.1.12 

For information and step-by step configuration guidelines on implementing CSS Redundancy using the 
VIP and VRRP mechanism, please see Chapter 6 of the CSS Advanced Configuration Guide, 
“Configuring VIP and Virtual IP Interface Redundancy”.
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Complete Configuration Sample
Complete Configuration Sample
The following is a complete CSS sample configuration for each of two CSS Servers configured in a 
Virtual Router Redundancy configuration and implementing each of the ISN services described above. 
Note that in this configuration example, a ‘one-arm’ configuration is used because the inbound traffic 
and the services exist on the same vlan.

*************************** GLOBAL ***************************

ip route 0.0.0.0 0.0.0.0 10.1.1.20 1 

!************************* INTERFACE *************************

interface  2/6 
phy 100Mbits-FD 

interface  2/16
bridge vlan 2 

!************************** CIRCUIT **************************

circuit VLAN1 
ip address 10.1.1.100 255.255.255.0 
ip virtual-router 1 priority 230 preempt 
ip redundant-interface 1 10.1.1.200 
ip redundant-vip 1 10.1.1.4 
ip redundant-vip 1 10.1.1.8
ip redundant-vip 1 10.1.1.12 

!************************** SERVICE **************************

service mediaserver1 
ip address 10.1.1.1
type redirect
port 80 
domain 10.1.1.1
keepalive type http 
keepalive retryperiod 2
keepalive maxfailure 1
keepalive uri "/index.html"
active

service mediaserver2 
ip address 10.1.1.2
type redirect
port 80 
domain 10.1.1.2
keepalive type http 
keepalive retryperiod 2
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Complete Configuration Sample
keepalive maxfailure 1
keepalive uri "/index.html"
active

service mediaserver3 
ip address 10.1.1.3
type redirect 
port 80
domain 10.1.1.3
keepalive type http 
keepalive retryperiod 2
keepalive maxfailure 1
keepalive uri "/index.html"
active

service appserver1
ip address 10.1.1.5 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type script ap-kal-httpvxml "10.1.1.5" 
active

service appserver2
ip address 10.1.1.6 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type script ap-kal-httpvxml "10.1.1.6" 
active

service appserver3
ip address 10.1.1.7 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type script ap-kal-httpvxml "10.1.1.7" 
active

service asrtts1 
port 554 
protocol tcp 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type tcp
keepalive port 554
ip address 10.1.1.9 
active

service asrtts2 
port 554 
protocol tcp 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type tcp
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Complete Configuration Sample
keepalive port 554
ip address 10.1.1.10 
active

service asrtts3 
port 554 
protocol tcp 
keepalive retryperiod 2 
keepalive maxfailure 1 
keepalive type tcp
keepalive port 554
ip address 10.1.1.11 
active

!*************************** OWNER ***************************

owner ISN   content MEDIA
vip address 10.1.1.4
protocol any
port 80
url "/*" 
add service mediaserver1
add service mediaserver2
primarySorryServer mediaserver3
active

content APPSERVERS
protocol tcp
port 8000 
add service appserver1 
add service appserver2 
primarySorryServer appserver3 
vip address 10.1.1.8 
active  

content ASRTTS 
add service asrtts1 
add service asrtts2 
primarySorryServer asrtts3 
protocol tcp 
port 554 
vip address 10.1.1.12
active

!*************************** GROUP ***************************

group mediaservers
add destination service mediaserver1 
add destination service mediaserver2 
add destination service mediaserver3 
vip address 10.1.1.4
active
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Complete Configuration Sample
group appservers
add destination service appserver1 
add destination service appserver2
add destination service appserver3
vip address 10.1.1.8
active

group asrtts 
add destination service asrtts1 
add destination service asrtts2
add destination service asrtts3
vip address 10.1.1.12 
active
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